Microsoft Money 2006 for Dummies
About the Author

Peter Weverka is the bestselling author of several For Dummies books, including Office 2003 All-in-One Desk Reference For Dummies, The Everyday Internet All-in-One Desk Reference For Dummies, and 29 other computer books about various topics. Peter’s books have been translated into 16 languages and sold three-quarter of a million copies. His humorous articles and stories — none related to computers, thankfully — have appeared in Harper’s, SPY, and other magazines for grown-ups.
Dedication

For my pals in the South End Rowing Club.

Author’s Acknowledgments

This book owes a lot to many hard-working people at the offices of John Wiley & Sons in Indiana. I am very grateful to Bob Woerner for giving me the opportunity to write it, and Susan Christophersen for being such a devoted project editor and copy editor.

Thanks go to technical editor Allen Wyatt for dogging my every step to make sure this book is indeed accurate. I would also like to thank TECHBOOKS Production Services for writing the index and Rich Tennant for the witty cartoons you will find on the pages of this book.

The first edition of this book came out in 1998! I would be remiss if I didn’t thank the talented editors who worked on earlier editions of this book, so thank you Steve Hayes, Beth Taylor, Jim McCarter, Kyle Looper, Tammy Castleman, Kathleen Dobie, Stephanie Koutek, Brian Kramer, Patricia Pan, Rev Mengle, Diane Smith, and Gareth Hancock.

Finally, thanks go to my family — Sofia, Henry, and Addie — for indulging my vampire-like work schedule and my eerie demeanor at daybreak.

Peter Weverka

San Francisco

June 2005
Publisher’s Acknowledgments

We’re proud of this book; please send us your comments through our online registration form located at www.dummies.com/register/.

Some of the people who helped bring this book to market include the following:

**Acquisitions, Editorial, and Media Development**

Project and Copy Editor: Susan Christophersen

Acquisitions Editor: Bob Woerner

Technical Editor: Allen Wyatt

Editorial Manager: Carol Sheehan

Editorial Assistant: Amanda Foxworth

Cartoons: Rich Tennant (www.the5thwave.com)

**Composition Services**

Project Coordinator: Shannon Schiller

Layout and Graphics: Carl Byers, Andrea Dahl, Stephanie D. Jumper, Lynsey Osborn

Proofreaders: Leeann Harney, Joe Niesen

Indexer: TECHBOOKS Production Services

---

**Publishing and Editorial for Technology Dummies**

Richard Swadley, Vice President and Executive Group Publisher

Andy Cummings, Vice President and Publisher

Mary Bednarek, Executive Acquisitions Director

Mary C. Corder, Editorial Director

**Publishing for Consumer Dummies**

Diane Graves Steele, Vice President and Publisher

Joyce Pepple, Acquisitions Director

**Composition Services**

Gerry Fahey, Vice President of Production Services

Debbie Stailey, Director of Composition Services
Contents at a Glance

Introduction ................................................................. 1

Part I: Setting Up and Starting Out ......................... 5
Chapter 1: Introducing Money .................................................. 7
Chapter 2: The Basics ................................................................. 17
Chapter 3: Setting Up Your Accounts ...................................... 27
Chapter 4: Recording Your Financial Activity ......................... 39

Part II: Banking with Money ................................. 67
Chapter 5: Categorizing Your Spending and Income .................. 69
Chapter 6: Reconciling, or Balancing, an Account ......................... 89
Chapter 7 Writing and Printing Checks ................................... 101

Part III: Money for Investors ................................. 117
Chapter 8: Setting Up Investment Accounts ......................... 119
Chapter 9: Tracking the Value of Your Investments ..................... 133
Chapter 10: Researching and Analyzing Your Investments ............... 157

Part IV: Getting Your Money’s Worth ...................... 171
Chapter 11: Some Important Housekeeping Chores ..................... 173
Chapter 12: Pinching Your Pennies ......................................... 191
Chapter 13: Planning for the Years Ahead .............................. 215
Chapter 14: Preparing for Tax Time ........................................ 231

Part V: Improving Your Financial Picture .................. 245
Chapter 15: Reports and Charts for Seeing Where You Stand Financially 247
Chapter 16: Tracking Assets, Liabilities, Loans, and Mortgages .......... 267

Part VI: Going Online with Money ......................... 285
Chapter 17: Getting Ready to Go Online .............................. 287
Chapter 18: Banking and Bill Paying Online ............................. 299

Part VII: The Part of Tens ................................. 309
Chapter 19: Ten Things You Should Do Periodically .................... 311
Chapter 20: Ten Ways to Good Health — Financially Speaking, That Is .......... 315
# Table of Contents

## Introduction ................................................................. 1
- About This Book ............................................................ 1
- Foolish Assumptions ......................................................... 2
- Conventions Used in This Book ........................................ 2
- Icons Used in This Book ................................................... 3

## Part I: Setting Up and Starting Out ................................. 5

### Chapter 1: Introducing Money ................................. 7
- Starting Money ................................................................. 8
  - Creating a shortcut icon for Money ........................... 8
  - Pinning Money to the Start menu ............................ 8
- Starting Money for the First Time ................................. 9
- Discovering How Money Can Help You with Your Finances ... 11
  - Keeping accurate records of your spending and income ... 11
  - Categorizing your spending and income ................. 12
  - Estimating your income taxes ................................ 13
  - Handling your investments ..................................... 13
  - Pinching your pennies .............................................. 14
  - Planning ahead ......................................................... 14
  - Banking online ....................................................... 14
- Shutting Down Money ..................................................... 15

### Chapter 2: The Basics .................................................. 17
- Getting Around in Money ............................................... 17
  - Links for going from window to window ................. 17
  - Toolbar buttons for getting around ....................... 18
  - Tabs for going to different windows ..................... 19
- Customizing the Home Page Window ......................... 21
- Browsing the Web in Money .......................................... 22
- Customizing the Toolbar ............................................... 24

### Chapter 3: Setting Up Your Accounts .......................... 27
- Accounts and Registers for Recording Financial Transactions ... 27
- The Basics: Setting Up Checking and Savings Accounts .......... 30
  - Setting up a checking or savings account ............ 30
  - Listing contact names, phone numbers, and other information ... 32
Changing an Account’s Name or Type .........................................................34
Setting Up an Account to Track Credit Card and Line of Credit Transactions ................................................................................................35

Chapter 4: Recording Your Financial Activity .........................39
Opening an Account Register ..........................................................39
Recording Transactions in Registers ...............................................42
  Types of transactions ........................................................................42
  Entering a transaction ........................................................................44
Splitting a Transaction ........................................................................47
Recording a Deposit or Debit Card Purchase with Cash Back ..........49
Transferring Money between Accounts ............................................51
Recording Transactions in Credit Card and Line of Credit Accounts ..........................................................52
  Recording credit card and line of credit charges ........................................52
  Recording a credit ........................................................................54
  Recording a credit card payment ..................................................54
Fixing Mistakes in Account Registers ............................................55
  Finding a transaction so that you can fix it ........................................56
  Changing or editing transactions ...................................................60
Voiding and Deleting Transactions ............................................61
Moving a Transaction from One Account to Another ................63
Printing a Register ..............................................................................64

Part II: Banking with Money ......................................................67

Chapter 5: Categorizing Your Spending and Income ...............69
Looking at the Ways to Categorize Income and Spending ............70
  By category ...................................................................................70
  By subcategory ............................................................................72
  By classification ...........................................................................71
  By tax-related status ....................................................................71
Setting Up Your Own Categories and Subcategories ................71
  Creating a new category in the New Category dialog box ..........72
  Creating a new subcategory ......................................................74
Editing and Refining a Category or Subcategory .......................75
Setting Up and Defining a Classification .........................................77
  Setting up a classification ..............................................................78
  Defining classes and subclasses ..................................................79
Correcting Transactions that Were Recorded in the Wrong Category ...80
  Moving all transactions from one category to another category ...81
  Reassigning transactions to new categories ................................82
Renaming and Deleting Categories and Classifications .............84
  Renaming a category or subcategory ...........................................84
  Renaming a classification ..............................................................85
  Deleting a category or subcategory ...............................................85
  Deleting a classification ...............................................................87
Chapter 6: Reconciling, or Balancing, an Account  ................. 89
How Reconciling Works ................................................................. 89
Balancing an Account .................................................................... 90
  Telling Money which transactions cleared the bank .................. 91
  Fixing mistakes as you reconcile .................................................. 94
Help! The Darn Thing Won’t Reconcile! .................................... 94
  A checklist of things to do if you can’t reconcile ...................... 95
  “AutoReconciling” an account ...................................................... 97
  Forcing an account to balance ..................................................... 97
Reconciling a Credit Card Account .................................................. 98

Chapter 7: Writing and Printing Checks  ................................. 101
Deciding What Kind of Check to Order .................................... 102
Ordering the Checks .................................................................... 103
Getting Your Printer Ready to Print Checks .......................... 105
Recording Checks that You Intend to Print .............................. 106
Testing to See Whether Checks Print Correctly ..................... 108
  Printing a practice check .......................................................... 108
  Making adjustments to the text alignment ................................. 109
Printing Your Checks .................................................................... 111
  Printing a full sheet of checks ..................................................... 111
  Printing partial sheets of checks ................................................ 112
Whoops! My Checks Didn’t Print Correctly .............................. 114

Part III: Money for Investors ................................................... 117

Chapter 8: Setting Up Investment Accounts  ....................... 119
Your Own Electronic Portfolio Manager .................................. 119
Setting Up an Investment Account for Tracking Securities .......... 121
Setting Up a Retirement Account for Tracking Retirement Savings
  and Investments ......................................................................... 124
Setting Up an Account to Track Employee Stock Options .......... 128
Tracking Securities You Don’t Own in a Watch Account ............ 130

Chapter 9: Tracking the Value of Your Investments ................. 133
Recording Payments to (and Disbursements from) Brokers .......... 134
Describing the Securities in Investment and Retirement Accounts .. 135
Handling Stocks ........................................................................... 138
  Recording a purchase of stocks .................................................. 138
  Recording the sale of stocks ....................................................... 139
  Recording and reinvesting dividends from stocks .................... 142
Recording stock splits, short sells, margin purchases, and
  other esoterica ............................................................................. 142
Chapter 10: Researching and Analyzing Your Investments .............157

Analyzing Your Investments .................................................................157
Charting the Performance of an Investment .........................................160
Reviewing Your Portfolio .................................................................161
Seeing How Well Your Investments Are Allocated .............................162
Generating Investment Reports ..........................................................163
Being Alerted When a Security Hits a Certain Price ............................164
Researching Investments at MoneyCentral ............................................165
Other Ways to Research Investments Online ........................................166
  Researching mutual funds on the Internet ........................................166
  Researching stocks on the Internet ..................................................167
  Researching bonds on the Internet ..................................................168
Finding a Broker .................................................................................169

Part IV: Getting Your Money’s Worth .................................171

Chapter 11: Some Important Housekeeping Chores .................173

Backing Up and Restoring Money Files .............................................173
  Telling Money how to back up your financial data ............................174
  Backing up your data file ................................................................176
  Restoring a file from its backup copy ..............................................177
Transferring Your Money File to a New Computer ...........................179
Pruning the Payees List .....................................................................179
Organizing Your Favorite Accounts, Reports, and Web Sites ..........180
Protecting Files with a Password or Passport Network Credentials ....181
  Locking a file with a password or Microsoft passport ........................181
  Opening a file that has been given a password ..................................183
  Changing and removing passwords .................................................184
Chapter 12: Pinching Your Pennies ................................................................. 191
  Scheduling Bills So That They Are Paid on Time ..................................... 191
    Scheduling a bill payment or deposit .................................................. 193
    How Money tells you to pay bills ...................................................... 196
    Scheduling deposits, transfers, and investment purchases .................. 197
    Recording a scheduled transaction in a register .................................. 197
    Skipping a scheduled transaction ..................................................... 198
    Changing a scheduled transaction .................................................... 199
    Canceling a scheduled transaction .................................................... 199
  Budgeting with Money ............................................................................. 200
    Choosing between advanced and essential budgets .............................. 201
    Getting started with an advanced budget ........................................... 202
    Enter your income: Telling Money about your income ....................... 204
    Enter your expenses: Budgeting your monthly expenses .................... 207
    Savings goals: Declaring what to do with extra money ....................... 208
    Budget summary and status .............................................................. 208
    Formulating an essential budget ......................................................... 209
    Seeing whether you met your budget goals ....................................... 210
    Working with more than one budget .................................................. 211
  Tracking Your Frequent Flyer Miles ......................................................... 212

Chapter 13: Planning for the Years Ahead ................................................... 215
  Being Alerted to Important Events .......................................................... 215
  Projecting Your Cash Flow ....................................................................... 217
  Introducing the Lifetime Planner ............................................................. 219
    About you: Telling Money about yourself and your dependents ......... 221
    Income: Describing your present and future income ......................... 221
    Taxes & Inflation: Describing the tax and inflation rate ....................... 222
    Savings & Investments: Describing your retirement savings ............... 223
    Expected Return: Describing how your money will grow .................. 224
    Homes & Assets: Describing things of value that you own or will own .... 224
    Loans & Debt: Describing current and future loans ......................... 224
    Expenses: Describing the cost of living .............................................. 225
    Results: Reading your financial future .............................................. 226
    Action Plan: What you should do next ................................................. 226
    Playing “what if” with your future ...................................................... 227
  Planning to Get Out of Debt .................................................................... 228
Chapter 20: Ten Ways to Good Health — Financially Speaking, That Is .......................................................... 315

- Record Credit Card Transactions As You Make Them .......................................................... 315
- Pay Off All Your Credit Card Debt ....................................................................................... 316
- Leave Your Plastic at Home ................................................................................................ 316
- Create a Spending by Category Chart ................................................................................ 316
- Create a Monthly Income and Expenses Report ................................................................ 317
- Create a Budget .................................................................................................................. 317
- Plan Ahead for Your Retirement .......................................................................................... 317
- Set Aside Money for a Rainy Day ........................................................................................ 317
- Make Like a Young Dog — Learn New Tricks .................................................................... 318
- Take the Day Off ................................................................................................................ 318

Chapter 21: Ten Things to Do If You Are Self-Employed ....................................................... 319

- Diligently Record Your Financial Activity ........................................................................ 319
- Make Sure That All Tax-Related Expenses Are Marked As Such .................................... 320
- Print a Tax-Related Transactions Report for Your Accountant ........................................ 320
- Use the Memo Box Early and Often .................................................................................. 320
- Set Aside a Tenth of Your Income in a Savings Account ..................................................... 321
- Schedule Your Quarterly Tax Payments ............................................................................... 321
- Use Classifications to Track Business Expenses ............................................................... 321
- Open a Checking Account for Business Transactions ....................................................... 322
- Write a Check to Yourself Periodically ............................................................................... 322
- Keep Your Irons on the Fire ................................................................................................. 322

Chapter 22: Ten Things Ex-Quicken Users Should Know about Money ....................................................... 323

- You Can Use Your Old Quicken File in Money .................................................................. 324
- You Can Find the Modified Transactions ........................................................................... 325
- Some Things Are Lost in the Conversion ............................................................................. 325
- Some Quicken Features Have No Equivalent in Money ....................................................... 325
- In Money, Transactions Are Entered on Forms ................................................................... 326
- Some Old Bank Transactions Are not Shown as Reconciled .............................................. 326
- Your Quicken Checks Are Good in Money .......................................................................... 327
- Quicken’s Online Banking Services Are No Good with Money .......................................... 327
- Your Payee List Is Way, Way Too Long ............................................................................... 328
- Money Offers Help for Quicken Users .................................................................................. 328

Glossary of Financial Terms .................................................................................................. 329

Index ...................................................................................................................................... 333
Introduction

This book is for users of these editions of Money 2006: Standard, Deluxe, and Premium. It is for Microsoft Money 2006 users who want to get to the heart of the program without wasting time. Don’t look in this book to find out how Money works. Look in this book to find out how you can manage your finances with Money.

I show you everything you need to know to stay on top of your finances — from recording checks and deposits to tracking investments. On the way, you have a laugh or two. And you can shed light on parts of your finances that have never seen the light of day before. After you read this book, you can start admiring what a financial wizard you have become.

About This Book

This book is jam-packed with instructions, advice, shortcuts, and tips for getting the most out of Money. Here’s a bare outline of the seven parts of this book:

✔ Part I: Setting Up and Starting Out: Part I spells out everything you need to know to use Money wisely. It explains how to find your way around the Money windows, set up accounts, and record transactions.

✔ Part II: Banking with Money: Part II explains how to get the banking done with Money’s help. It explains categorizing your spending and income, reconciling an account, and printing checks.

✔ Part III: Money for Investors: Part III is for investors. It shows how to track your investments with Money, enlist Money’s help in researching investments, and update the prices of securities from the Internet.

✔ Part IV: Getting Your Money’s Worth: In Part IV, you discover how to budget with Money, schedule bill payments so that you make them on time, estimate your income tax bill, plan for retirement, and do the mundane chores, such as backing up your financial data, that make Money run more smoothly.

✔ Part V: Improving Your Financial Picture: Part V explains how to generate reports and charts so that you can see exactly where you stand financially, and analyze investments and loans.
Part VI: Going Online with Money: If your computer is connected to the Internet, you are invited to go online and take advantage of Money’s online features. Among other high-tech tasks, Part VI explains how to download bank statements over the Internet and pay bills online.

Part VII: The Part of Tens: Each of the four chapters in Part VII offers ten tidbits of advice — advice for staying on top of your finances, improving your financial health, using Money if you are self-employed, and converting from Quicken to Money.

But wait — there’s more! Turn to the glossary to look up the financial terms that appear in this book.

Foolish Assumptions

Please forgive me, but I made one or two foolish assumptions about you, the reader of this book. I assumed these things:

- You use one of these Windows operating systems — Windows 98, Windows NT, Windows XP, or higher.
- You are kind to foreign tourists and small animals.

Conventions Used in This Book

I want you to understand all the instructions in this book, and in that spirit, I’ve adopted a few conventions.

To show you how to give commands on menus, I use the symbol. For example, you can choose File: Back Up to make a backup copy of the data you store in Money. The symbol is just a shorthand method of saying “Choose Back Up from the File menu.”

Where you see boldface letters in this book, it means to type the letters. For example, “Type Where Did the Money Go? in the Report name text box” means to do exactly that: Type the words Where Did the Money Go?.

Icons Used in This Book

To help you get the most out of this book, I’ve placed icons here and there. Here’s what the icons mean:

Next to the Tip icon, you can find shortcuts and tricks of the trade to make your visit to Moneyland more enjoyable.

Where you see the Warning icon, tread softly and carefully. It means that you could be about to do something that you may regret later.

When I explain a juicy little fact that bears remembering, I mark it with a Remember icon. When you see this icon, prick up your ears. You will discover something that you need to remember throughout your adventures with Money.

When I am forced to describe high-tech stuff, a Technical Stuff icon appears in the margin. Good news: Only two Technical Stuff icons appear in this entire book (I don’t like reading about technical stuff any more than you do). The first reader who finds both Technical Stuff icons wins a free trip to the Happyland Desert Park in Blythe, California (just kidding!). You don’t have to read what’s beside the Technical Stuff icons if you don’t want to.

When I describe a task that can only be done in the Deluxe version of Money, the MoneyDeluxe icon appears in the margin of the page.
Part I

Setting Up and Starting Out

The 5th Wave

By Rich Tennant

“And tell David to come in out of the hall. I found a way to adjust our project budget estimate.”
Hello, this is your captain speaking. Thank you for flying Money. In the next six chapters, you can take off, soar above the clouds, and discover the basics of tracking your finances with Microsoft Money 2006.

Please observe the “Fasten your seat belt” sign. And if I ask you to hold your breath and flap your arms to help the plane stay aloft, please do so promptly.
Chapter 1

Introducing Money

Microsoft Money 2006 makes managing your personal finances very easy. Well, not “very easy,” but close to it. With Money 2006, you don’t need a bookkeeper to track your finances. You don’t need an accountant or financial counselor, either. And you don’t need to be a computer expert. All you need to know is how to use Money 2006.

After you start using the techniques I describe in this book, you will know how to record financial transactions, how much you spend in different areas, and what your net worth is. You will know what any investments you may have are worth and roughly how much you owe in taxes. You will know how to print checks, generate reports and charts that show in clear terms what your spending habits are, plan for retirement, and analyze different kinds of investments.

Most important, you will be able to make wise financial decisions by taking advantage of the program’s numerous financial analysis tools, all of which I explain in this book. And you will also make wise decisions, because you will have the raw data on hand. After you record transactions in Money, the raw data is right there inside your computer. I show you how to analyze it, scrutinize it, dissect it, investigate it, and contemplate it. I show you how to admire it, too.

Chapter 1 is where you get your feet wet. Don’t be shy. Walk right to the shore and sink your toes in the water. Don’t worry; I won’t push you from behind. Not so bad, is it? In this chapter, you discover the various ways that Money 2006 can help you stay on top of your finances. You also discover how to start and shut down the program.
Starting Money

Starting Money is as easy as falling off a log. You can start the program from the menus or by means of the Microsoft Money shortcut icon on the desktop. Start Money with one of these methods:

- **Microsoft Money shortcut icon:** Double-click the Microsoft Money 2006 shortcut icon on the desktop.
- **From the Program menu:** Click the Start button, choose All Programs (or Programs), and choose Microsoft Money 2006.
- **From the Start menu:** Provided that you pinned Money to the Start menu (see “Pinning Money to the Start menu,” later in this chapter), you can click the Start button and choose Microsoft Money 2006 on the Start menu.

Creating a shortcut icon for Money

When you installed Money, the installation program should have put a Money shortcut icon on the desktop, but if it didn’t, you can still create a shortcut icon for starting Money. To do so, follow the standard Windows procedure for creating shortcut icons:

1. **Click the Start button and choose All Programs (or Programs).**
2. **Locate the Microsoft Money 2006 menu command on the Programs menu and right-click it.**
   A shortcut menu appears.
3. **Choose Send To: Desktop (Create Shortcut).**
   The shortcut icon appears on the Windows desktop.

Pinning Money to the Start menu

Short of double-clicking a shortcut icon on the desktop, the fastest way to start a program is to pin its name to the Start menu. This menu appears right away when you click the Start button. By clicking a program name on the Start menu, you can start a program, as shown in Figure 1-1.
Follow these steps to pin Microsoft Money 2006 to the Start menu:

1. Click the Start button.
2. Choose All Programs.
3. Locate Microsoft Money 2006 on the All Programs menu.
4. Right-click Microsoft Money 2006 and, on the shortcut menu, choose Pin to Start Menu.

Now, when you click the Start button, you see the command for starting Microsoft Money 2006. If you want to remove this command from the Start menu, right-click it and choose Unpin from Start Menu.

**Starting Money for the First Time**

After you install Money and start the program for the first time, Money grasps you by the hand and attempts to help you do a number of things that I respectfully suggest you should wait until later to do. First, Money creates a data file called My Money for storing your financial data. So far, so good. Then, as shown in Figure 1-2, Money asks you to do these things:

- Choose a sign-in name and password. You can secure your financial data by requiring anyone who opens your My Money file to enter a password or a .NET passport, as Chapter 11 explains.
- Create a bank account for recording transactions in your savings or checking account. Money stores financial transactions in accounts, as Chapter 3 explains.
Rather than dealing with passwords or setting up a bank account now, I think you are better off waiting until you know your way around Money. All you have to do is turn to Chapter 3 when you want to set up an account, and turn to Chapter 11 when you have entered enough financial data in Money to warrant locking the data with a password.

Follow these steps to cruise through the initial screens that Money presents when you start the program for the first time:

1. **Click the Next button in the Thank You for Using Microsoft Money window (refer to Figure 1-2).**

   The next window, Help Protect Your Online Privacy and Security, appears. (If you have been using Quicken, Money will ask to convert your Quicken data file for use in Money. Don’t worry about Money converting your Quicken file — the program makes a copy of that file and then converts it. Chapter 22 explains the ins and outs of converting Quicken files to Money files.)

2. **Click the Decline button.**

   By clicking the Decline button, you tell Money that you don’t want to create a Microsoft passport just yet. Remember: You can turn to Chapter 11 to find out about passports and passwords.

3. **Click the Yes button in the message box that asks whether you want to continue without setting up a Microsoft Passport.**
The Add a Password to Your File window appears. Do you get the impression that Money wants you to have a Microsoft Passport? Don’t worry about it. As I’ve already informed you three times, you can find out how to create a password in Chapter 11, if you decide you need one.

4. **Click the I Don’t Want to Use a Password for My Money File check box, and click the Next button.**

   You see the Add Your Accounts window. I don’t know why Money is in such a hurry to make you set up an account and create a password. It’s not as though you can’t do these tasks whenever you want to. I repeat: Turn to Chapter 3 when you want to create an account for tracking your checking and savings account activities.

5. **Click the Skip Account Setup link.**

   You come to the Congratulations! window.

6. **Click the Finish button.**

   Finished at last! Not a moment too soon, the Home Page window appears. This is the window you see each time you start Money.

Chapter 2 explains what the Home Page is, how to find your way around Money, and what the various Money windows are for. Go to Chapter 2 if you are the kind of person who likes to plunge right in. If you like to take your time, consult the rest of this chapter. It describes the many ways that Money can help you track your finances and be a smarter, wiser person — financially speaking, of course. Oh, and the end of this chapter explains how to shut down Money.

**Discovering How Money Can Help You with Your Finances**

This is your tour guide speaking. What follows is a quick tour of Money. Read on to discover the many ways that the Money program can help you. Money is much, much more than an electronic checkbook. It is a research tool and a means of gazing into the future. It’s a way to track your investments and be a better saver. You can bank online and even estimate your income taxes with Money.

**Keeping accurate records of your spending and income**

All the personal finance advisors agree that keeping good, accurate records is the first step toward financial security. Before you can start saving for a down
payment on a house, you have to know how much you are capable of saving. Before you can tell whether your investments are doing well, you have to track them carefully. If you want to make sound financial decisions, you need to know what your spending habits are and how much income you really have.

Microsoft Money makes keeping accurate financial records very, very easy. All financial transactions you make — writing a check, making a deposit, transferring money between accounts, charging an item to your credit card, buying and selling stocks and mutual funds, and so on — are recorded in account registers like the one shown in Figure 1-3. You create one account (and one account register) for each bank account you have and each account you have with a brokerage house. The account register shown in Figure 1-3 is for tracking activity in a checking account. Chapter 3 explains how to create accounts, and Chapter 4 explains how to enter transactions in account registers.

Entering data correctly in Money is essential. Money can’t do its job well unless you carefully and conscientiously enter financial data. If all you want to do is balance your savings and checking accounts, you’ve got it made, because Money offers lots of opportunities for double-checking the accuracy of transactions in savings and checking accounts. However, to track investments and loans, draw up a budget, or do a handful of other sophisticated things, you need to take care when you enter the data.

### Categorizing your spending and income

Each time you record a transaction in an account register, you categorize it. A check you write to a clothing store, for example, is assigned the Clothing...
category. A credit card charge you make after stuffing yourself in a restaurant is assigned the Dining category. A paycheck deposit is assigned the Salary category. After you have recorded transactions for a few months, a picture of how you spend your hard-earned cash will start to come into focus. You can generate reports or charts that show precisely what your expenses are. The guy who generated the chart shown in Figure 1-4 spends the majority of his money on mortgage payments. Chapter 5 explains how to set up categories; Chapter 15 describes how to generate reports and charts.

Figure 1-4: By carefully entering your financial data, you can create meaningful charts like this one.

### Estimating your income taxes

Another advantage of categorizing expenses and income is being able to estimate your income tax bill. Rather than pay an accountant to search for tax-deductible expenses or determine what your income sources were, you can generate tax reports that do the job in lieu of an accountant. By totaling the amount you spent in categories that describe tax-deductible expenses, you can find out what your tax-deductible expenses are. You can see exactly how much you received in income from different clients. Money also offers tools for estimating capital gains taxes and exporting Money data to a tax-preparation program such as TaxCut Deluxe. Chapter 14 explains tax tracking with Money.

### Handling your investments

In the late 1990s, all you had to do to be a successful investor was to plop down money on stocks or mutual funds, but the bull markets of the 1990s have been overrun by bears. These days, you have to be shrewd and insightful to be an investor.
Money makes it possible to find out — literally in seconds — how well your investments are doing. You can find out how much they have grown (or shrunk) and compare the performance of your investments against stocks, mutual funds, and bonds you don’t own, as well as compare your investments to indexes such as NASDAQ or the S&P 500. You can download security prices from the Internet and find out right away what the stocks and mutual funds you own are worth. As long as your computer is connected to the Internet, you can download research stocks, mutual funds, and bonds without leaving the Money program. You will find links throughout Money that you can click to go on the Internet and research investments. Chapters 8, 9, and 10 describe how to handle and research investments with Money.

**Pinching your pennies**

As I already explained, you categorize your income and spending when you record transactions in Money. Categorizing this way makes it easy to formulate a budget. Because you know precisely how much you spend in the different categories, you can set realistic budget goals by limiting your spending on a category-by-category basis. You can tell Money to alert you when you have exceeded your budget goals and in this way tame your spending. Money can also tell you when bills fall due so that you can pay your bills on time. The program can even track your frequent flyer miles. These and other techniques for pinching your pennies are described in Chapter 14.

**Planning ahead**

Planning for your retirement isn’t easy. It’s hard to tell what the future will hold. Money, however, can help you peer into the future and plan for your retirement. If you track your investments with Money, you use the Retirement Planner to project how your investments will grow and see whether your investments will cover your living expenses in retirement. Money allows you to realistically find out whether you are saving enough. The program can also show you how to plan better for your retirement and do the things you need to do now to ensure that your retirement years are golden ones. Planning ahead with Money is the subject of Chapter 13.

**Banking online**

Money was the first computer program to offer online banking services. Over the years, Money has refined these services such that online banking is easier
than it has ever been. You can pay bills online, download bank and credit card statements, and balance your account online. Online banking is covered in Chapters 17 and 18.

**Shutting Down Money**

When the time comes to close the Money program and get on with your real life, do one of the following:

- Click the Close button (the X in the upper-right corner of the program window).
- Choose File ➤ Close.
- Press Alt-F4.

Veteran computer users are accustomed to saving files before exiting a program, but that isn’t necessary with Money because the program saves data as soon as you enter it. If you look for a Save command or button in Money, you will look in vain — there isn’t one.

When you shut down Money for the first time, you see the Back Up When Money Closes dialog box, as shown in Figure 1-5. This dialog box tells you how often Money thinks it is supposed to back up your financial data and

---

### Turning off the ads

As I explain in Chapter 2, Money is modeled after a Web site. Rather than choose options in dialog boxes and opening menus, you do most of your activity in Money by clicking links. I like this computer-program-as-a-Web-site concept very much. I like everything about it except for one thing: As are most Web sites, Money is full of advertisements. Some of the links are thinly disguised advertisements that take you to Web sites that tout different financial services.

Fortunately, you can turn off the ads if they bother you. Follow these steps to turn off advertisements in the Money program:

1. Choose Tools ➤ Settings to open the Settings window.
2. Click the Program Settings link.
3. On the Program Settings tab of the Settings dialog box, click the Turn Off Sponsorship and Shopping Links check box.
4. Click OK.
invites you to back it up now. Chapter 11 explains everything you need to know about backing up a data file. For now, click the Postpone button to be done with it, and click the Postpone button in the Scheduled Backup dialog box as well. Chapter 11 also explains how to schedule when your Money file is backed up.

Figure 1-5:
For now, click the Postpone button instead of backing up your data.
Chapter 2

The Basics

In This Chapter
- Going from window to window
- Deciding what goes on the Home Page
- Surfing the Internet in Money
- Customizing the toolbar

Now that you know how Money can help track your finances, it’s time to take your first baby steps into the program. This chapter gives you the lay of the land. It explains how to get from place to place in Money by clicking links, tabs, and toolbar buttons. You also find out how to customize the Home Page, which is easy and worth knowing how to do, because the Home Page is the window you see each time you start Money. You also find directions in this chapter for surfing the Internet without leaving Money and for customizing the toolbar.

Getting Around in Money

Money is a little different from most computer programs in that it is modeled after a Web site. Rather than negotiate dialog boxes to get things done, you visit different windows. Rather than open menus and choose commands, you click links. This is not to say that there aren’t dialog boxes and file menus in Money — there are. But for the most part, you spend your time clicking links and going to different windows to get things done.

Links for going from window to window

Figure 2-1 shows the Home Page window that you see when you start Money. This window is the starting point for all your excursions in Money. Don’t worry — the Home Page window is not as complicated as it looks. It offers a peek at different aspects of your finances, links that you can click to go to different Money windows, and links to sites on the Internet.
You find many links in this and all other Money windows. To see where the links are, try moving the mouse pointer around the screen. When the mouse pointer changes into a hand and the text is underlined, you have encountered a link. These links look and work exactly like links on a Web page. Click a link to go to a different window and undertake a new task.

**Toolbar buttons for getting around**

No matter where you go in Money, you see the toolbar along the top of the screen, right below the main menu. Does this toolbar look familiar? It looks much like the standard toolbar found in Web browsers such as Internet Explorer and Mozilla’s Firefox — and it works like a Web browser toolbar, too. It includes a Back button and a Forward button so that you can revisit Money windows you saw earlier (the other buttons on the toolbar are for surfing the Internet and are explained in the section “Browsing the Web in Money,” later in this chapter):

- **Back button**: Takes you to the window you looked at previously
- **Forward button**: Takes you to the window you most recently backed away from
Move the mouse pointer over the Back or the Forward button and you see a little downward-pointing arrow. Click the little arrow and you see a shortcut menu that lists the windows you visited. I recommend clicking the little arrows beside the Back and Forward buttons early and often. Clicking the arrows and choosing window names is the fastest way to get from place to place in Money.

**Tabs for going to different windows**

Yet another way to get from place to place is to click a tab — Home, Banking, Bills, Reports, Budget, Investing, Planning, or Taxes. Figure 2-2 shows what you see when you click the Banking tab. You go to the Account List window, the starting point for handling banking account transactions. Click a tab when you want to undertake a certain kind of task. Click the Budget tab, for example, when you want to formulate a budget in the Budget window; click the Taxes tab to estimate how much tax you owe in the Taxes window. Table 2-1 describes the different tabs.
Table 2-1  Tab Buttons and Where They Take You

<table>
<thead>
<tr>
<th>Clicking This Tab</th>
<th>Takes You to . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>The Home Page, where you can see summaries of your financial activity and click links to quickly go to other windows in Money. (See the section “Customizing the Home Page,” later in this chapter.)</td>
</tr>
<tr>
<td>Banking</td>
<td>The Account List window, which lists the name of each account you set up. You can click an account name to go to its account register. Open the Bank Account window when you want to set up an account, enter account transactions, balance an account, or bank online. (See Chapters 4 and 5.)</td>
</tr>
<tr>
<td>Bills</td>
<td>The Bills Summary window, where you can record the bills you pay regularly and enlist the Money program’s help in paying those bills on time. (See Chapter 12.)</td>
</tr>
<tr>
<td>Reports</td>
<td>The Reports window, where you can generate reports and charts that show right away where you stand financially. (See Chapter 15.)</td>
</tr>
<tr>
<td>Budget</td>
<td>The Budget window, where you can formulate a budget and find out whether you’re meeting your budget goals. (See Chapter 12.)</td>
</tr>
<tr>
<td>Investing</td>
<td>The Investing window, where you can track stocks, bonds, mutual funds, and other investment holdings. Start here when you want to download security prices from the Internet. (See Chapters 8, 9, and 10.)</td>
</tr>
<tr>
<td>Planning</td>
<td>The Planning window, where you can plan for retirement, make a plan to get out of debt, and project your cash flow. (See Chapter 13.)</td>
</tr>
<tr>
<td>Taxes</td>
<td>The Taxes window, where you can estimate your income taxes, estimate capital gains taxes, and locate your tax-deductible expenses. (See Chapter 14.)</td>
</tr>
</tbody>
</table>

When you click a tab and go to a new window, you are presented with a whole new set of task links on the left side of the window. You can click these links to undertake tasks pertaining to the window you are in. The Account List window, for example, offers links for creating new accounts and listing accounts in different ways. Each window offers its own set of buttons as well. The Account List window offers the Account Tools, Mortgages & Loans, Bank Services, and Credit Center buttons (refer to Figure 2-2). Click one of these buttons to investigate an area of interest.
Customizing the Home Page Window

When you start Money, you see the Home Page window (refer to Figure 2-1). The Home Page is supposed to give you a quick look at your finances, and if you play your cards right, it can do that. Instead of letting Money decide what goes on your Home Page, you can decide for yourself.

Notice that the Home Page is divided into two columns. In each column are links, reports, and alerts pertaining to different aspects of your finances. It’s up to you to decide what goes in those two columns of the Home Page. Money makes it very easy to customize the Home Page.

Follow these steps to decorate the Home Page after your own fashion:

1. Click the Home tab to go to the Home Page.
2. Click the Customize Content or Layout link.
   This link is found on the right side of the Home Page. After you click it, you see the Change the Way the Home Page Looks window, as shown in Figure 2-3. You can also get to this window by choosing Tools $$\rightarrow$$ Settings and clicking the Home Page Display Settings link in the Settings window.
3. To select which items will be in view, select them one at a time in the Add Content box and click the Add button.
4. To remove an item, select it in the Change Layout box and click the Remove button.
5. To set the order and column in which items appear on the Home Page, select an item in the Change Layout box and click the Move Up, Move Down, Move Left, or Move Right button.

6. Click the Done button when your customized Home Page is just right.

**Browsing the Web in Money**

Money has a split personality. Besides being a program for tracking your finances, Money is a Web browser. The makers of Money want you to be able to go straight from Money to the Internet and back again as you research investment opportunities, check the latest financial news, see how your stocks are doing, visit your online bank, or, on a less serious but certainly more fun note, check the latest baseball scores.

Do you notice anything peculiar about Figure 2-4? How did Dummies.com get in the Money window? It got there because I typed the address of the Dummies.com Web site in the Address box on the toolbar and clicked the Go to this Page button (you can also press Enter).
Choosing which window appears at startup

Suppose that you don’t care to see the Home Page when you start Money. Maybe you prefer another window, an account register, or the last account register you were looking at when you closed the program. Follow these steps to choose which window you see when you start the program:

1. Choose Tools ➪ Settings to go to the Settings window.
2. Click the Program Settings link.

You see the Program Settings tab of the Settings dialog box.

3. Under Display, open the Start Money with This Page Open drop-down list and choose the window you would like to see. The Last Account Register Used option opens Money to whichever account register was showing last when you closed the program.
4. Click OK.

Here are thumbnail instructions for handling the Web browser side of Money’s split personality:

**Getting from Web page to Web page:** The Back and Forward buttons work just like buttons in a standard Web browser. Click Back or Forward to revisit Web pages or travel deeper into the Internet. By clicking the down arrow beside a button and choosing a Web page from the drop-down list, you can leap forward or backward several Web pages simultaneously.

**Returning to the Money windows:** Click a tab or click the Back button as many times as necessary to return to a Money window.

Choose Tools ➪ Settings, click the Browser Settings link in the Settings window, and click the Always Use My Default Browser to Browse the Internet option button to dispense with Money and see a Web page in a real, live browser.
Customizing the Toolbar

Money makes it very easy to add a few buttons to the toolbar. Why not add a few buttons? Without them, you waste the screen space on the right side of the toolbar. Besides, if you decide you don’t want them, removing buttons from the toolbar is as easy as putting them there in the first place.

Money offers buttons that take you to account registers, the Account List, all the different windows, and other places as well. Follow these steps to add buttons to the toolbar:

1. Click the Shortcuts button on the toolbar.

You see the Toolbar Display Settings dialog box shown in Figure 2-5.

Cataloging your favorite Web sites

Suppose that you’re tooling along in the Money browser and you come to a useful or fun Web site that you want to revisit later on. For occasions like that, Money offers you the opportunity to add the Web site to your Favorites list. Favorite Web sites are easy to revisit:

✔ To revisit the Web site in Money, choose Favorites ➤ Favorite Web Sites and the name of the Web site on the submenu that appears.

✔ To revisit the Web site in Internet Explorer, choose Favorites ➤ Financial Links and the name of the Web site. When you installed Money, the program put a new folder called Financial Links in the Internet Explorer Web browser.

With the Web site you want to revisit appearing on-screen, choose Favorites ➤ Add to Favorites.

You see the Add Favorite dialog box. Enter a more descriptive name for the site, if necessary, and click OK.

If you intend to save more than a dozen Web sites, I suggest creating folders to keep track of them. Do that by clicking the New Folder button in the Add Favorite dialog box and entering a name in the Create New Folder dialog box that appears. Click the Create In button and choose a folder name to save a Web site in a particular folder.

Do the Web sites you added to the Favorites menu need reorganizing? Choose Favorites ➤ Organize Favorites ➤ Web Sites. You see the Organize Favorites dialog box. It offers buttons for deleting and renaming Web sites, as well as for moving them to different folders.
2. In the Available list, select a button and then click the Add button to add a button to the toolbar.

   The button you chose appears in the Displayed list.

3. To remove a button from the toolbar, select it in the Displayed list and click the Remove button.

   You can change the order of toolbar buttons by clicking the Move Up or Move Down button.

4. Click the OK button.

If you regret tinkering with the toolbar, open the Toolbar Display Settings dialog box and click the Reset button.
Chapter 3

Setting Up Your Accounts

In This Chapter

- Understanding how accounts and registers record financial activity
- Identifying the 18 kinds of accounts
- Setting up a checking and savings account
- Listing account numbers, contact persons, and the like
- Changing account names and types
- Setting up an account to track credit card charges

Chapters 1 and 2 get you going with Money. In this chapter, you get down to the nitty-gritty: how to set up accounts so that you can track financial activity.

In this chapter, you discover how to set up savings, checking, and credit card accounts. You also find out about Money files, how to put an account on the Favorites menu, and how to change account names and account types.

Accounts and Registers for Recording Financial Transactions

The first step in tracking your financial activity is to set up an account for each type of item you want to track — a checking account, a savings account, or an IRA, for example. When most people hear the word *account*, they think of savings accounts, checking accounts, and other kinds of bank accounts. However, accounts in Money are a little more than that. For example, you can create a home account for tracking the value of a house. You can also create a credit card account for tracking credit card charges.

When you set up an account, you need to name the kind of account you want. Money offers 18 kinds of accounts. Table 3-1 describes the different kinds of Money accounts and mentions where you can turn to read more about them.
<table>
<thead>
<tr>
<th>Account</th>
<th>What the Account Is for</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>Tracking the value of items that you own — real estate, a truck, a baseball card collection. Asset accounts can be useful for finding out your net worth. (See Chapter 16.)</td>
</tr>
<tr>
<td>Bank</td>
<td>Recording transactions made to a bank account, but not a savings account, checking account, or line of credit.</td>
</tr>
<tr>
<td>Car or Other Vehicle</td>
<td>Recording the equity and market value of a car, boat, or other item for which you have taken out a loan. (See Chapter 16.)</td>
</tr>
<tr>
<td>Cash</td>
<td>Recording cash payments and tracking petty cash accounts.</td>
</tr>
<tr>
<td>Checking</td>
<td>Recording activity in a checking account. (See “The Basics: Setting Up Checking and Savings Accounts,” later in this chapter. Chapter 4 explains how to record transactions in checking accounts.)</td>
</tr>
<tr>
<td>Credit Card</td>
<td>Recording credit card purchases, finance charges, and credit card payments. (See “Setting Up an Account to Track Credit Card and Line of Credit Transactions,” later in this chapter. Turn to Chapter 4, as well.)</td>
</tr>
<tr>
<td>Employee Stock Option</td>
<td>Tracking stock options you receive from the company you work for. (See Chapter 8.)</td>
</tr>
<tr>
<td>Home</td>
<td>Tracking how much equity is in a house and determining a house’s market value. (See Chapter 16.)</td>
</tr>
<tr>
<td>Home Equity Line of Credit</td>
<td>Tracking payments and transactions made against a home equity line of credit account. (See “Setting Up an Account to Track Credit Card and Line of Credit Transactions,” later in this chapter.)</td>
</tr>
<tr>
<td>Investment</td>
<td>Tracking the value of something you own and intend to sell later for a profit — stocks, bonds, securities, annuities, treasury bills, precious metals, real estate investment trusts (REITs), and unit trusts. (See Chapter 8.)</td>
</tr>
<tr>
<td>Liability</td>
<td>Tracking debts for which you don’t have to pay interest — income taxes that you owe and private loans, for example. (See Chapter 16.)</td>
</tr>
<tr>
<td>Line of Credit</td>
<td>Recording payments made with a debit card — a charge card that debits, or deducts money from, a bank account. (See “Setting Up an Account to Track Credit Card and Line of Credit Transactions,” later in this chapter.)</td>
</tr>
</tbody>
</table>
### Account | What the Account Is for
--- | ---
Loan | Tracking debts for which you have to pay interest, such as car loans. (See Chapter 16.)
Mortgage | Tracking mortgage payments for which you have to pay interest. (See Chapter 16.)
Other | Recording transactions that — you guessed it — don’t fit neatly in the other 17 categories. Hmm. I’ve been racking my brain for an example of an account that doesn’t fit into the other 17 categories, and for the life of me I can’t think of one. Maybe this account is where someone would keep laundered money.
Retirement | Tracking tax-deferred retirement plans, such as 401(k)s, Keoghs, SEPs (Simplified Employee Pensions), and IRAs. (See Chapter 8.)
Savings | Recording activity in a savings account. (See “The Basics: Setting Up Checking and Savings Accounts,” later in this chapter. Chapter 4 explains how to record transactions in a savings account.)
Watch | Tracking the value of securities you don’t own but want to monitor and perhaps own someday. (See Chapter 8.)

Each time you set up an account, Money creates a new register for recording transactions. As all bookkeepers know, a register is a place for recording income and expenses, withdrawals, deposits, payments, and the like. Figure 3-1 shows a checking account register for recording checks, deposits, and withdrawals in a checking account.
Registers look different, depending on the type of account you have set up, but all registers have places for recording transaction dates and transaction amounts. Registers also show balances. The balance is the amount of money in the account, or, in the case of an asset, liability, or investment account, the value of the thing that you’re tracking.

The Basics: Setting Up Checking and Savings Accounts

After you see the big picture and know what an account and a register are, you can create an account. In the next sections, you find out how to set up a checking account, savings account, and credit card account. Setting up the other kinds of accounts is a bit more complicated, and I explain them elsewhere in this book. (Table 3-1, which appears earlier in this chapter, mentions where to turn.)

Setting up a checking or savings account

Everybody, or just about everybody, has at least one checking and one savings account. Set up an account in Money for each checking and savings account you keep with a bank. Be sure to get out the paperwork before you set up the checking or savings account. You need to know the account number and a few other details.
Follow these steps to set up the account:

1. **Click the Banking tab.**
   
   You land in the Account List window. This window is the starting point for managing accounts you have set up in Money and for starting new accounts.

2. **Click the Add a New Account link, the first one listed under Common Tasks.**
   
   The Choose an Account Type window, shown in Figure 3-2, appears. This window is somewhat misleading. The first option, Banking, appears to be the one for setting up a checking or savings account, but the Banking option is really for setting up online checking and savings accounts. If you click the Banking option, you may be asked for passwords and the like. I suggest that you skip setting up an online banking account at this time and instead set up a conventional account by selecting the fourth option, Other Account Type. If you select that option, you will still be able to set up a checking or savings account. Online banking isn’t for everybody. Later, if you so choose, you can make your conventional checking or savings account into an online banking account (see Chapter 17).

3. **Click the Other Account Type option and then click the Next button.**
   
   As Figure 3-3 shows, the next window, Choose an Account Type, permits you to set up checking and savings accounts.

4. **Choose Checking or Savings and then click the Next button.**
   
   You see the New Account dialog box.

5. **Type a descriptive name for the account and then click the Next button.**
   
   The name you type appears in the Accounts window. Type a descriptive name so that you can distinguish this account from the others you set up in Money.
6. Enter a figure for the account balance, choose a currency if need be, and click the Next button.

Knowing the balance isn’t as important as you may think — you can change the starting balance after you set up the account. You change the starting balance by changing the first entry in the account register.

More power to you if you know the starting balance and you have diligently kept records so that you can enter past transactions and bring the account up-to-date. If you don’t know the opening balance, either enter the balance from your last bank statement or make an estimate. Chapter 4 explains the ins and outs of starting balances.

7. Click the Finish button.

At the end of the ordeal, you return to the Account List window, where the name of your new checking or savings account appears. Be sure to read the next section in this chapter, which explains how to record account numbers, phone numbers, and other useful information about accounts.

**Listing contact names, phone numbers, and other information**

Before you put away the paperwork and say good-bye to an account you set up, take a moment to record information about the account. As Figure 3-4 shows, the program has a special Change Account Settings window for entering a bank’s telephone number, an account’s minimum balance, and anything else you care to enter.
The Change Account Settings window is a handy place to store bank telephone numbers and other information. If you lose your passbook, ATM card, or credit card and need to call the bank, for example, you can get the number from this window. The window also has a check box for making an account appear on the Favorites menu.

Follow these steps to get to the Change Account Settings window and enter the pertinent information or view information about an account you already set up:

1. Click the Banking tab to go to the Account List window.
2. Click the name of the account for which you will enter information.
3. Click the Change Account Settings link.

This link is located under Other Tasks. You see the Change Account Settings window (refer to Figure 3-4).

The fastest way to get to the Change Account Settings window is to right-click an account name in the Account List window and choose See Account Settings from the shortcut menu.
4. Enter or view information about your account in the window.
   
   In Figure 3-4, I entered a contact name and a telephone number, for example.

5. Click the Done button if you entered information in the Change Account Settings window.
   
   Where is the Done button? It’s at the bottom of the window. You may have to scroll down to get there.

### Changing an Account’s Name or Type

Suppose that you got it wrong. Suppose that you gave the account the wrong name or told Money that a checking account was a savings account. All is not lost. You can fix these grievous errors by returning to the Account Details window and clicking the Change Account Details button.

If all you want to do is change the name of an account, here’s the fastest way: Right-click the name of the account in the Account List window, choose Rename from the shortcut menu, enter a new name, and click OK.

Follow these steps to change the name and other information about an account:

1. **Click the Banking tab to go to the Account List window.**

2. **Click the name of the account that needs an overhaul.**
   
   Clicking opens the account register.

3. **Click the Change Account Settings link.**
   
   You land in the Change Account Settings window (refer to Figure 3-4). From here, you can change the account number, the minimum balance, and more trivial things as well. You can also rename an account or change its type.

4. **Rename the account or change the account type:**
   
   - **Rename an account:** Enter a new name in the Account Name text box.
   
   - **Change an account type:** Open the Account Type drop-down list and choose a new account type.

   If you want to change account types but can’t find an option button on the list for the account type you want, you’re out of luck. In its wisdom, Money lists only the accounts to which your account can be changed. Camels can’t fly, and credit card accounts can’t, for example, be changed into investment accounts.
Setting Up an Account to Track Credit Card and Line of Credit Transactions

Except for filling out an extra dialog box or two, setting up a credit card or line of credit account works the same way as setting up a checking or savings account. Set up a credit card or line of credit account for each credit card you have. When you set up the account, Money asks how much you owe and whether you want a reminder when the credit card bill is due.

Get out your last credit card or line of credit statement and follow these steps to set up a credit card or line of credit account:

1. Place a finger of your right hand on this page and, with your left hand, turn back several pages to the “Setting up a checking or savings account” section.
2. Follow Steps 1 through 3 of the instructions for setting up a checking or savings account.

Select your “favorite” accounts

Checking accounts, credit card accounts, and other accounts that you have to dig into on a regular basis are good candidates for “favorite” status. The names of favorite accounts appear on the Favorites menu. All you have to do to open a favorite account is choose Favorites ➪ Favorite Accounts and the name of the account. As Chapter 2 explains, you can also make your “favorite” accounts appear on the Home Page so that account balances stare you in the face, for good or ill, whenever you start Money. By clicking an account name on the Home Page, you can view the account’s register and enter transactions.

Follow these instructions to make an account a favorite account:

- Right-click an account name in the Accounts List window and choose Favorite (click the Account List button to open the Accounts window).

Choose Favorites ➪ Organize Favorites ➪ Accounts and, in the Select Your Favorite Accounts window, check the names of accounts.

Select the Favorite Account check box in the Change Account Settings window.
In other words, go to the Account List window, click the Add a New Account link, select the Other Account Type option, and click the Next button. You come to the Choose an Account Type window (refer to Figure 3-3).

3. Select the Credit Card, Line of Credit, or Home Equity Line of Credit option and click the Next button.

If you are setting up a line of credit account, you see the Choose Level of Detail window. Make sure that the Track Transactions and Other Details option is selected. Unless you select this option, you can’t categorize charges you make against the line of credit.

4. Enter a name for the account and click the Next button.

You see the first of several New Account dialog boxes, as shown in Figure 3-5. The first dialog box asks how much you owe. I hope that you are all paid up and owe nothing, but if you resemble the average citizen, you owe the bank or credit card issuer some money.

5. Type 0 if the credit card is paid in full; otherwise, type how much your last statement says that you owe and then click the Next button.

6. Select the Credit Card or Charge Card option and click the Next button.

This dialog box asks whether your account will track a credit card or charge card. As the dialog box explains, charge cards have to be paid in full each month, but you can carry debt from month to month with a credit card.

Select the Credit Card option if the account tracks credit card spending. Otherwise, select Charge Card. If yours is a credit card that you don’t need to pay in full but you intend to pay off each month, select the Always Pay Entire Balance Each Month check box.
What happens next depends on whether the account tracks a credit card or charge card.

If the account tracks a charge card, skip ahead to Step 8.

If the account tracks a credit card or line of credit, the dialog box that appears asks you to list the interest rate you get charged for carrying debt, as Figure 3-6 shows.

7. Tell Money what rate of interest you are charged for using the credit card or line of credit, and then click the Next button.

List the interest rate in the first % box. If the rate is a temporary, introductory rate, select the An Introductory Rate Is in Effect check box and enter the permanent rate and the date that the temporary rate expires. Money needs this information for the Debt Reduction Planner and other features designed to help you manage debt.

8. In the dialog box that follows, type the maximum amount that you can charge on your credit card or charge card; then click the Next button.

Your credit card statement lists the most you can borrow on your credit card. Get the figure from your statement.

9. Make sure that the first option, No, Don’t AutoBalance This Account, is selected and then click the Next button.

This dialog box is kind of misleading. It seems to say that if you pay your credit card bill in full each month, you should select the second option, Yes, AutoBalance This Account. But you should do no such thing. Select the second option button only if you don’t want to track the charges you run up on your credit card.

10. If you want the bill to appear in the Bills Summary window, make sure that you click the Yes, Remind Me When the Bill Is Due check box. Enter an estimate of how much you owe in the Estimated Monthly
Amount text box; also, enter a date in the Bill Is Due Next On text box. Then click the Next button.

As shown in Figure 3-7, the dialog box asks whether you want to put the monthly credit card payment on the Bill Calendar. If you click Yes, a reminder to pay the bill appears in the Bill Summary window. Chapter 12 explains how to schedule bills and deposits. For now, all you need to know is that the Bills Summary window reminds you when bills are due. If you want, the notice can also appear on the Home Page, where you can see it each time you start Money.

Figure 3-7: You can add the credit card or line of credit payment to the Bills Calendar and maybe pay the bill on time.

I strongly recommend placing a check mark in the Yes, Remind Me When the Bill Is Due check box. Credit cards and lines of credit can get very, very expensive if you don’t work to pay them off or if you forget to pay them on time. Banks charge outrageous interest rates on lines of credit and credit cards. A reminder to pay the bill can help keep you from being squeezed by creditors.

Credit card and line of credit bills fall due on the same day each month. Each month, Money reminds you five days before each payment is due.

11. Click the Next button in the following dialog box, which asks whether you can earn frequent flyer miles with your credit or charge card.

Chapter 12 explains how to track frequent flyer miles. Don’t worry about it for now.

12. Click the Finish button.

You return to the Account List window.

After you set up your credit card account, go to the Change Account Settings window and enter the phone number of the credit card issuer or bank. You may need the number, for example, if you must report a lost credit card. The section “Listing contact names, phone numbers, and other information,” earlier in this chapter, explains how the Change Account Settings window works.
Chapter 4

Recording Your Financial Activity

In This Chapter
- Opening an account register
- Recording transactions in registers
- Splitting transactions
- Recording a cash-back deposit or debit card purchase
- Transferring money between accounts
- Recording credit card transactions and payments
- Locating and fixing errors in registers
- Deleting and voiding transactions
- Printing an account register

This chapter tackles the four or five things you have to do each time you run the Money program. It explains how to open an account register and how to record deposits, withdrawals, payments, and charges in registers. You also find out how to record a transfer of money between accounts, how to move around in a register, and how to find transactions in large registers. This chapter describes how to delete and void transactions as well. Finally, for the person who likes to leave behind a wide paper trail, this chapter explains how to print a register.

Accomplish the tasks described in this chapter, and you are well on your way to becoming an ace user of Microsoft Money 2006.

Opening an Account Register

After you set up an account (the subject of Chapter 3), you’re ready to start recording transactions in the account’s register. A register is the place where checks, payments, deposits, charges, and withdrawals are recorded. Figure 4-1 shows a checking account register. As with all registers, this one has places for numbering transactions, recording transaction dates, and viewing balances.
The first step to opening an account register is to go to the Account List window, as shown in Figure 4-2. This window is Account Central as far as Money is concerned. By clicking an account name in the list, you can open the account's register. The Account List window shows each account you have and how much money is in each account. Negative balances — such as credit card balances, which are usually negative because they represent money that you owe — are shown in red and are surrounded by parentheses. At the bottom of the window is your total account balance, the sum of your savings, debts, assets, and liabilities, also known as your net worth.

Because so much of your time in Money is spent in account registers, Money offers no fewer than three ways to get to the Account List window:

- Click the Banking tab.
- On the Home Page, open the Choose a Task drop-down list, choose Enter a Transaction, and click the Go button.
- Press Ctrl+Shift+A.
- In a register window, open the Register drop-down list and select View Account List.
As I explain earlier in this chapter, you can click an account name in the Account List window to open an account register. But what if you’re in a hurry? To bypass the Account List window and go straight to an account register, use one of these techniques:

- Choose Favorites ➪ Favorite Accounts and then click the name of an account, assuming that you opted to make it a favorite. (Chapter 3 explains how to make an account a favorite account.)

- Click the account’s name on the Home Page. (See Chapter 2 for information about placing favorite accounts on the Home Page.)

- In a register window, open the Register drop-down list, choose Other Open Accounts, and choose the name of an account, as shown in Figure 4-3. Use this technique to skip merrily from account register to account register.

To begin with, accounts in the Account List window are arranged by type, but you can change that. You can arrange accounts by name, bank, or brokerage firm. To do so, click the Sort Account List By hyperlink and choose an option from the drop-down list.
Recording Transactions in Registers

At the bottom of the Account Register window is a form for entering transactions in the register, as shown in Figure 4-4. (If you don’t see the form, select the Show Transaction Forms check box in the lower-left corner of the window; if that check box is grayed out, open the View menu and choose Top Line Only.) To enter a transaction, click a tab — Withdrawal, Deposit, or Transfer — and then fill in the transaction form.

Types of transactions

Which tab you click depends on which type of transaction you want to enter:

- **Withdrawal tab:** Taking money out of an account? Stealing from yourself isn’t really stealing, but so that you don’t feel guilty, use this tab to let Money know how much you’re taking out. Use it also when you record check payments and cash withdrawals — any transaction in which money leaves an account.
Deposit tab: When you put money into an account, record the transaction on this tab. Record all deposits to an account on this tab. That includes check deposits and deposits made at a cash machine.

Transfer tab: Shifting money from one account to another? Click the Transfer tab.

Tips for entering transactions quickly

Money offers a bunch of techniques for entering transactions quickly on transaction forms:

✔ **Dates:** A fast way to enter the date is to click the down arrow to the right of the Date text box and make the minicalendar appear. If the calendar shows the right month, simply click a day. Otherwise, click the arrows on either side of the month name to go backward or forward month by month; then, click a day.

Press the + (plus sign) on the keyboard to advance the date by a day; press the – (minus sign) to go back a day.

✔ **Autocomplete:** Money “remembers” all the people and businesses you pay and from whom you receive payments. If you have entered a name in the Pay To or From text box before, all you have to do to make the entire name appear is to type the first few letters — Money fills in the rest. Or you can click the down arrow next to the text box, scroll through the list of people or businesses you entered on past occasions, and click a name to enter it. This feature, which Money calls Autocomplete, ensures that you don’t have to keep entering the same names repeatedly.

✔ **Doing the math:** Click the down arrow to the right of the Amount text box to see a minicalculator that you can use to do calculations — totaling the checks in a deposit, for example. Pressing the equals key (=) enters the total directly into the Amount text box. If you need a calculator that can handle advanced calculations, choose Tools>Calculator to bring up the Windows calculator. You can cut and paste calculations that you make there into the Amount text box.
Entering a transaction

Follow these steps to record a check, deposit, withdrawal, cash-machine withdrawal, or debit card purchase in a register:

1. Open the register of the account in which you want to record a transaction (see the “Opening an Account Register” section, earlier in this chapter).

2. Click the Withdrawal or Deposit tab.

Is money going in or going out of the account? Outgoing money is recorded on the Withdrawal tab; incoming money is recorded on the Deposit tab.

3. Tell Money what kind of transaction you want to record.

In some cases, you have to click the Common Withdrawals or Common Deposits button to describe a transaction.

- **Cash withdrawal**: Do nothing. You’re all set.

- **ATM cash-machine withdrawal**: Click the Common Withdrawals button and choose ATM. If you have made cash withdrawals before, you can choose an amount on the submenu, but if you haven’t withdrawn before, or the amount you want to withdraw isn’t listed, choose Other Amount. When you are done recording the transaction, the letters *ATM* (automatic teller machine) will appear in the Number box of the register so that you know that the withdrawal was made at a cash machine.

- **Check**: Click the Common Withdrawals button and choose Write a Check. Money enters the next available check number in the Number box. If this number is incorrect, enter the correct number.

- **Check to pay a credit card bill**: Click the Common Withdrawals button, choose Credit Card Payment, and choose the name of the credit card issuer from the drop-down list. Later in this chapter, the section “Recording a credit card payment” explains this kind of transaction in detail.

- **Debit card purchase**: Click the Common Withdrawals button and choose Debit Card Purchase. (If you got cash back with your purchase, see “Recording a deposit or debit card purchase with cash back,” later in this chapter.)

- **Cash deposit**: You’re all set. Do nothing.

- **Deposit of a check or checks**: You’re all set, unless you want to record a deposit of more than one check or you got cash back after the deposit. See “Splitting a Transaction” and “Recording a Deposit or Debit Card Purchase with Cash Back,” later in this chapter.
4. **Enter a number in the Number text box, if necessary.**

   To move from place to place on a transaction form, click elsewhere, or press Tab or Shift+Tab.

   Only checks require a number, but you can enter deposit slip and withdrawal slip numbers if you want to track deposits and withdrawals carefully.

   Money should have entered the next available check number, but if it didn’t, click the down arrow to open the Number drop-down list and then choose Next Check Number. If the number that Money enters is incorrect, enter the correct number.

5. **Enter the date in the Date text box, if necessary.**

   Money puts today’s date in the Date text box, so you don’t need to do anything if you are recording a transaction you completed today. See the sidebar “Tips for entering transactions quickly” to discover fast ways to enter future and past dates and to fill in other parts of a transaction tab.

6. **In the Pay To text box, enter to whom you’re paying the money; or, in the From text box, enter from whom you received the money.**

   The Deposit form has a From text box rather than a Pay To text box. As the “Tips for entering transactions quickly” sidebar explains, you can simply type in the first few letters of a name (if you received or paid money to this person or party before) to scroll the list of names and go to the one you want.

   For deposits, enter the name of the person or business who wrote you the check or checks you deposited. For withdrawals, enter **Cash** if you withdrew cash from the bank. For ATM withdrawals, Money enters the word **Cash** automatically.

   If you’ve entered this name in the register before, the amount you last paid or received appears in the Amount text box. Not only that, but the category that you assigned to the last transaction with this person or company appears in the Category text box. You may not have to change the amount or category choices. If this transaction is identical to the one you recorded last time, your work is almost done and you can skip to Step 10.

7. **Enter the amount of the transaction in the Amount text box.**

   To enter a round number, you don’t have to enter the decimal point or trailing zeroes. In other words, to enter “$21.00,” all you have to type is **21**. Money adds the zeroes for you. Money also enters a leading zero if the amount you enter is less than a dollar. For example, to enter .05 to record the purchase of bubblegum, just type **5**.

8. **In the Category text box, enter a category (or category and subcategory).**
Creating and choosing the right categories and subcategories is so important that I devote most of Chapter 5 to the subject. By assigning categories and subcategories to income and expense transactions, you can discover where you spend your hard-earned money and where it comes from — critical information, especially if you itemize on tax forms.

Expense categories are at the top of the drop-down list. Payments require an expense category. Deposits require an income category, which are found in the middle of the drop-down list.

9. If you care to, write a few words in the Memo text box to describe the transaction.

Write a memo if for any reason you may come back to the account register in the future, see the transaction, and not know what it was for.

10. Click the Enter button or press the Enter key.

Click the New button if you want to clear the entry form and record another transaction. By the way, if you start recording a transaction but then decide to finish it later or start all over, click the Cancel button. The Edit button is for altering a transaction you entered already.

---

**Do you have to record past transactions?**

I’m sorry to say it, but almost everyone has to record at least a few transactions from the past. When you set up an account, Money asks you to list or estimate a balance. If you follow Money’s recommendation and enter the closing balance from your last bank statement, you have to enter all the transactions that don’t appear on that statement because they haven’t cleared the bank. In other words, if you wrote a check on June 30 and it didn’t appear on the statement that you received on July 15, you have to enter that check in order to make your account balance.

To enter uncleared transactions, either use your own records or wait until next month’s statement arrives and use it to record the absent transactions.

If you intend to use Money to help with tax returns, you’ll need to record transactions back to the beginning of your tax year, usually January 1. If today is September 30 or December 2, you have a great deal of work to do — or you can wait until next year to use Money in earnest. By way of encouragement, I can tell you that Money makes entering transactions an easy task, as this chapter and Chapter 5 show.

You can always change the opening balance of an account by changing the amount of the initial deposit. The opening balance of a brand new account is easy to figure out, but tracking an account you’ve had for a while requires a little detective work. You have to find out how much money was in the account as of the starting date that you entered when you set it up in Money. That isn’t easy. Rather than dig through old records, you may simply tinker with the initial deposit until the ending balance of the account matches the one on your last bank statement.
Don’t be alarmed if the transaction you just entered doesn’t appear on the register’s last line. Transactions appear in date order.

If you have trouble finding a transaction, open the View drop-down list and choose an option to get a different view. The Sort By options determine the order by which transactions appear in the register. You can also sort transactions by date or see only transactions that haven’t been reconciled.

If you entered a deposit where you should have entered a withdrawal, or entered a withdrawal where you should have entered a deposit, click the Options button on the transaction form, choose Change Transaction Type To, and choose Withdrawal or Deposit from the submenu.

Splitting a Transaction

Suppose that you try to record a transaction in a register but it doesn’t fit in a single category. For example, suppose that you write a check to the Old Country Store to buy motor oil, a blouse, and a rocking chair. The transaction doesn’t fall neatly in the Automotive, Clothing, or Household: Furnishings categories. And suppose that you deposit two checks at one time, one from your place of work and one from the New Jersey Lottery Commission. To record a transaction like that, you *split* it. *Money* offers the Split button on the transaction form for that very purpose, and you use it by following these steps:

1. **Record the transaction as you normally would.**
   
   To total the checks in a deposit, click the down arrow beside the Amount box and total the checks on the minicalculator. After you click the = (equals) button, the total is entered in the Amount box.

2. **Click the Split button or press Ctrl+S.**
   
   You see the Transaction with Multiple Categories dialog box, shown in Figure 4-5. The Category list is already open so that you can select the first category.
   
   By the way, if you are depositing several checks, you can also click the Common Deposits button and choose Deposit Multiple Items from the menu to open the Transaction with Multiple Categories dialog box.

3. **For the first item that you purchased or deposited, select a category on the first line of the dialog box.**

4. **If you care to, enter a description in the Description text box on the first line.**
5. In the Amount text box on the first line, enter the cost of the first item or the amount of the first check you deposited.

6. Repeat Steps 4 through 5 for each item you purchased or for each check you deposited.

   When you finish, the Sum of Splits figure should equal the Total Transaction figure and the Unassigned figure should be 0.00. If the figures don’t add up, tinker with the numbers in the Transaction with Multiple Categories dialog box until they do.

7. Click the Done button to return to the transaction form.

8. Make sure that the transaction form is filled out properly; then click the Enter button.

When a transaction has been split, the words “Split/Multiple Categories” appear in the Category text box, as shown in Figure 4-6. To see how a transaction in a register was divided across categories, click the transaction, click the transaction form, and then click the Split button to open the Transaction with Multiple Categories dialog box. You can also move the pointer over the transaction to see the categories in a pop-up box.

Suppose that you split a transaction but regret doing so. Click the transaction; then choose a single category in the Category box. That’s all there is to it. Money removes the words “Split/Multiple Categories” and enters the name of the category you chose.
Recording a Deposit or Debit Card Purchase with Cash Back

Suppose that you deposit a check or make a debit card purchase and ask for a little cash back. Who doesn’t need a little cash now and then? The problem with recording a cash-back deposit or debit card purchase with extra cash is that the transaction is really two transactions in one. In the case of the debit card purchase, part of the transaction is a debit card purchase and part is a cash withdrawal from a bank account. Likewise with cash-back deposits — part of the transaction is a deposit and part is a cash withdrawal.

Fortunately for you, Money offers special commands for recording these kinds of transactions. Follow these steps to record a cash-back deposit or debit card purchase:

1. Open the register of the account in which you want to record the deposit or debit card purchase.

2. Click the Withdrawal tab to record a cash-back debit card purchase; click the Deposit tab to record a cash-back deposit.

3. Click the Common Withdrawals or Common Deposits button.

   A menu appears with commands for handling special kinds of transactions.
4. To record a cash-back debit card purchase, select Debit Card Purchase with Cash Back; to record a cash-back deposit, select Deposit with Cash Back.

You see one of the dialog boxes shown in Figure 4-7.

5. Enter the amount of the purchase or deposit in the Amount box.
6. In the Category box, categorize the purchase or deposit.
7. In the Cash Back box, enter how much money you took back with the purchase or deposit.
8. Click the OK button.

You return to the account register. Notice, in the Category box, the words “Split/Multiple Categories.” You have entered a split transaction — in this case, a withdrawal of cash as well as a payment or deposit. The Amount box shows how much you actually spent or deposited.

If you need to tinker with the figures, click the Split button to open the Transaction with Multiple Categories dialog box (refer to Figure 4-5). From here, you can review the figures one last time or adjust them if need be.

9. Complete the transaction as you normally would and click the Enter button.

To examine a split transaction in a register, select the transaction, click the transaction form, and click the Split button.
Transferring Money between Accounts

Sometimes, good luck comes your way; you earn a few extra dollars, so you transfer money from your checking account to a savings account or investment account. And sometimes, in a fit of panic, you have to transfer money from a savings account to a checking account to cover a couple of large checks. When you transfer money between real-life bank accounts, record the transfer in your Money account registers as well.

Follow these steps to record a transfer of money from one account to another:

1. **Open the register of the account from which you’re transferring the money.**
   
   In other words, to transfer money from a checking to a savings account, open the checking account register.

2. **Click the Transfer tab.**
   
   You see the transaction form, shown in Figure 4-8.

   The fastest way to record a transfer is to click the Common Transfers button and select a transaction from the drop-down list. The menu lists the last five transfers you recorded. If the transfer you want to record is identical to a transfer on the menu, select it.

3. **Enter the date that the transfer was made in the Date text box.**

4. **In the Amount text box, enter the amount of the transfer.**

5. **Click the down arrow on the To drop-down list and select the account receiving the transferred money.**
   
   All the accounts you set up in Money appear on the To drop-down list. The name of the account from which you are transferring the money should already appear in the From text box. Leave the Pay To text box empty when transferring money between bank accounts.

6. **Click the Enter button or press the Enter key.**
   
   The transfer is counted as a debit — the amount you transferred is deducted from one account and added to the other.
If you slogged through the previous few pages and discovered how to record checking and savings account transactions, you may experience *déjà vu* in the next few pages. Entering credit card and line of credit transactions is mighty similar to recording transactions made in savings and checking accounts.

Besides leaving credit cards at home, one way to keep credit card spending under control is to diligently record charges as you make them. Watching the amount that you owe grow larger and larger in the credit card register should discourage you from spending so much with your credit card.

### Recording Transactions in Credit Card and Line of Credit Accounts

Credit card and line of credit account registers have a Charge form for recording charges. Figure 4-9 shows a Charge form. As does the Withdrawal form, the Charge form has places for entering a transaction date, amount, payee name, category, and memo. All the drop-down lists and keyboard tricks work the same way on a Charge form as on a Withdrawal form.
To fill in the Charge form, follow these steps:

1. Open the account register.
2. Click the Charge tab.
3. Enter a reference number (optional).
4. Enter the charge date.
5. Enter the business you purchased the item(s) from in the Pay To box.
6. Enter the amount of the charge.

Don’t concern yourself with recording service charges and interest on your credit card. You can do that when you reconcile your account (a topic I explain in Chapter 6).

7. Select a category.
8. Enter a description (optional).
9. Click the Enter button (or press Enter).

Credit card and line of credit accounts track what you owe, not what you have. Don’t forget this all-important detail. In the credit card register shown in Figure 4-9, you can clearly see the words *You Owe* where the words *Ending Balance* appear in a savings or checking account register. In effect, the You Owe number is a negative number. It represents an amount that you will have to pay out of your checking account one of these days.
Recording a credit

If you receive a credit from a bank or credit card issuer, perhaps because you overpaid, disputed a bill, or returned an item you bought, record the credit in the credit card account register. To do so, click the Credit tab and fill in the blanks in the Credit form. The Credit form works exactly like the Charge form (see the preceding section, “Recording credit card and line of credit charges”).

Be sure to record the credit in an expense category. Seems odd, doesn’t it, to record credits as expenses? But when you recorded the purchase in the register, you assigned it to an expense category. Now that you’re getting a refund, assign it to the same expense category so that the amount you spent in the category is accurate on your reports.

Recording a credit card payment

Before you make a credit card or line of credit payment, reconcile the credit card or line of credit account (Chapter 6 explains how). Then take note of how much of the debt you intend to pay, and follow these steps to make a payment to the bank or card issuer:

1. Open the register of the account from which you intend to make the payment (see the section, “Opening an Account Register,” earlier in this chapter).
   You probably want to open your checking account register.
2. Click the Withdrawal tab at the bottom of the register window.
3. Click the Common Withdrawals button, choose Credit Card Payment, and then choose the name of the credit card account where you track the credit card that you want to make a payment on, as shown in Figure 4-10.
   The words “Credit Card Payment” and the name of the credit card account appear in the Category box on the transaction form, as shown at the bottom of Figure 4-10.
4. Enter a check number in the Number text box if the number that appears there isn’t correct.
   Remember, you can click the down arrow and choose Next Check Number to enter the next available check number in the box.
5. In the Date text box, enter the date that you wrote or will write on the check.
6. **Enter the amount of the check in the Amount text box.**

   I hope that you can pay off the entire credit card or line of credit bill, but if you can’t, Money doesn’t care. Money continues to track what you owe from month to month.

7. **If you care to, write a few descriptive words in the Memo text box.**

8. **Click the Enter button or press Enter.**

   The amount you paid is deducted from the checking account. Meanwhile, the You Owe amount in the credit card or line of credit register decreases or is brought to zero. In effect, you have transferred money from your checking account to the account where you track credit card charges. Earlier in this chapter, the sidebar, “Transferring is more than meets the eye,” explains the mystery of why you transfer money between accounts to satisfy a credit card debt.

   Right-click a credit card payment in a register and choose Go To Account: *Credit Card Name* (or press Ctrl+X) to go to the account register where you track credit card charges.

### Fixing Mistakes in Account Registers

Everybody makes mistakes, and absolutely everybody makes mistakes when entering transactions in account registers. Most people do not have an expert typist’s nimble fingers or sureness of touch. Therefore, the following sections explain how to find and fix mistakes, how to get from place to place in large registers, how to move transactions from one account to another, and how to delete and void transactions.
Finding a transaction so that you can fix it

Suppose that you made a terrific blunder somewhere in a register but aren’t sure where. You categorized a transaction incorrectly, entered a transaction in the wrong account, or misspelled a name. Suppose that you made the error many times over. How can you fix the mistakes quickly without wasting an entire morning?

Fortunately, editing your transactions is easy in Money. But before you can fix errors, you have to find them. Read on to find out how to get around quickly in a register and how to find transactions with the Tools ➪ Find and Replace command.

It helps to see more transactions on-screen when you are looking for a specific transaction. To see more transactions, deselect the Show Transaction Forms check box. You can also open the View menu and choose Top Line Only.

Moving around in an account register

One way to find a transaction is to eyeball the account register. With this technique, you put the register on-screen, move around in it like mad, and hope you find the transaction you are looking for. Table 4-1 presents keyboard and scroll bar techniques for getting around quickly in an account register.

<table>
<thead>
<tr>
<th>Table 4-1</th>
<th>Keyboard and Scroll Bar Techniques for Moving around in Registers</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Press/Click/Drag</strong></td>
<td><strong>To Go...</strong></td>
</tr>
<tr>
<td>Ctrl+Home</td>
<td>To the first transaction in the register.</td>
</tr>
<tr>
<td>Ctrl+End</td>
<td>To the last transaction in the register.</td>
</tr>
<tr>
<td>↑ or ↓</td>
<td>To the previous or next transaction in the register.</td>
</tr>
<tr>
<td>PgUp or PgDn</td>
<td>Up or down an entire screen of transactions.</td>
</tr>
<tr>
<td>Scroll bar arrows</td>
<td>To the preceding or next transaction. Click the arrow at the top of the scroll bar to go up, the one at the bottom to go down.</td>
</tr>
<tr>
<td>Scroll bar</td>
<td>Up or down an entire screen of transactions. With this technique, you click the scroll bar but not the arrows or the scroll box. Click above the scroll box to go up; click below to go down.</td>
</tr>
<tr>
<td>Scroll box</td>
<td>Willy-nilly through the register. Drag the scroll box, the elevator-like object in the middle of the scroll bar, to go up or down very quickly.</td>
</tr>
</tbody>
</table>
Searching with the Find and Replace command

The surest way to pinpoint a transaction or a bunch of similar transactions is to choose Tools ➪ Find and Replace (or press Ctrl+H). This command looks for transactions in all the registers, not just the one that is open, so you don’t have to be in a specific register to start looking for transactions.

Follow these steps to look for transactions in your account registers:

1. Choose Tools ➪ Find and Replace.

   You see the Find and Replace dialog box, shown in Figure 4-11. You can also press Ctrl+F to see this dialog box.

   From here, you can conduct a simple search of all your accounts, or an advanced search in which you tell Money in great detail where to search and what to search for.

2. If you want to search only in investment or loan accounts, open the Search Across drop-down list and make a choice.

   You may as well start with a simple search and hope for the best. If you don’t find what you are looking for, you can try an advanced search.

3. Type what you are looking for in the Find This Text box, and if you know in which column of the register the thing is located, make a choice from the In This Field drop-down list; then click the Next button.
Figure 4-11 shows the fields you can choose from — Category, Payee, and so on — when you search regular accounts. If you are searching in a particular field, choose it in the In This Field drop-down list before you type anything in the Find This Text box. That way, you can simply choose a field in the Find This Text drop-down list instead of typing one in. For example, if you choose Payee, a list of payees appears on the Find This Text drop-down list.

With a little luck, Money finds what you are looking for and you see search results like those shown in Figure 4-12. Examine the transactions and click the scroll bar, if necessary, to find the one you are looking for. A couple of pages hence, the “Changing or editing transactions” section explains how to fix transactions in the search results.

Try clicking the Num, Date, Account, Payee, Category, or Amount button at the top of the columns to arrange the transactions in a new way. For example, clicking the Date button arranges the transactions in date order. Clicking Payee arranges them in alphabetical order by payee. Click a button a second time to reverse the order (a little arrow on the button shows whether the column is arranged in ascending or descending order).

4. If you found the transaction you want to change, double-click it to open the Edit Transaction window and change it there.

What if Money can’t find what you are looking for — or, as often happens, the Search Results list is too long and you need to pinpoint one or two transactions? I’m afraid you have to click the Back button to return to the Find and Replace dialog box (refer to Figure 4-11) and start your search all over: It’s time to conduct an advanced search.
Conducting an advanced search

Sometimes you really have to beat the bushes to find the transaction you are looking for. To begin searching, click the Advanced Search option button in the Find and Replace dialog box (refer to Figure 4-11) and then click Next. The dialog box offers seven tabs (more if you classify as well as categorize transactions) for entering search criteria. Table 4-2 explains what the different tabs are. Fill out one tab or a combination of tabs. You needn't fill out all the tabs. Do your best to tell Money precisely where the thing you are looking for is located and what you know about it.

Click the Next button when you are done. You see a list of transactions that met your criteria (refer to Figure 4-12). Double-click a transaction to change it in any way. The next section explains how to edit transactions.

Table 4-2 Advanced Searching for Transactions in the Find and Replace Dialog Box

<table>
<thead>
<tr>
<th>Tab</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Searches for specific words. For example, if you are searching for a check on which you wrote “Damn the torpedoes” on the Memo line, type Damn the torpedoes in the Find Transactions with This Text box.</td>
</tr>
<tr>
<td>Account</td>
<td>Selects which accounts to search in. To search in specific accounts, click the Clear All button and then click the names of the accounts you want to search.</td>
</tr>
<tr>
<td>Date</td>
<td>Searches in specific date ranges. Either click the down arrow next to the Range text box and select a time period, or enter a From and To date in the text boxes.</td>
</tr>
<tr>
<td>Amount</td>
<td>Searches for transactions of a certain amount. Enter a specific amount or number range in the From and To box.</td>
</tr>
<tr>
<td>Category</td>
<td>Searches in specific categories. Click the Clear All button and then click a Select button to narrow the search to income, expense, or tax-related categories. You can also click next to individual categories to search for them. Select the Show Subcategories check box to narrow the search to subcategories. (Chapter 5 explains more about fixing categorization errors.)</td>
</tr>
<tr>
<td>Payee</td>
<td>Searches for specific payees. Click the Clear All button and then click the name of the payee or names of the payees for which you recorded transactions.</td>
</tr>
</tbody>
</table>

(continued)
Table 4-2 (continued)

<table>
<thead>
<tr>
<th>Tab</th>
<th>What It Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Searches by transaction type (payments, deposits, unprinted checks, unsent online bill payments, transfers), reconciliation status (unreconciled and reconciled), and check number.</td>
</tr>
<tr>
<td>Classification</td>
<td>Searches for transactions that you classified a certain way, if you use classifications. (Chapter 5 explains classifications.)</td>
</tr>
</tbody>
</table>

**Changing or editing transactions**

All right, so you found the transaction that you entered incorrectly. What do you do now? If you are staring at the transaction in an account register, either double-click it or click it and then click the Edit button on the transaction form. Then go right into the transaction form, fix the mistake in whatever text box or drop-down list it is located in, and click the Enter button.

If you found the error by way of the Tools ➤ Find and Replace command (see the “Searching with the Find and Replace command” section in this chapter), double-click the transaction in the Search Results list (refer to Figure 4-12). When the Edit Transaction dialog box appears, repair the transaction and click OK.

Suppose, however, that an error was made in numerous places. You misspelled a payee’s name. You categorized several transactions incorrectly. In that case, follow the directions in the “Searching with the Find and Replace command” section of this chapter to display the errant transactions in the Find and Replace dialog box (refer to Figure 4-12). Then follow these steps to fix the transactions *en masse*:

1. **Click the Replace button in the Find and Replace dialog box.**
   
   You see the dialog box shown in Figure 4-13.

2. **On the Replace drop-down list, choose which part of the transactions needs repairing.**
   
   You can change payee names, category assignments, memo text, or transaction numbers.

3. **In the With box, either type a new entry or choose one from the drop-down list.**
   
   If you chose Payee or Category on the Replace drop-down list, a list of payees or categories is made available on the With menu.
4. Select the check boxes next to transactions you want to edit, or select the Replace All the Transactions Found radio button to edit all the transactions in the list.

5. Click the Next button.

A “last chance” dialog box appears and lists all the transactions that will be altered. If you are prudent, look through the list one last time. If you are daring and reckless, click the Finish button right away. You can click the Back button if you get cold feet.

6. Click the Finish button.

Select the transactions that need replacing.

---

**Voiding and Deleting Transactions**

To strike a transaction from an account register, either delete or void it. What’s the difference? A deleted transaction is erased permanently from your financial records. It may as well have never happened. But a voided transaction stays in the account register, where **VOID** clearly shows that you entered the transaction but voided it later on. What’s more, a voided transaction can be “unvoided.”

Void a transaction when you want to keep a record of having made it. For example, if you start writing check number 511 but accidentally enter the wrong payee name, void the check instead of deleting it. That way, the account register records what happened to check number 511, and you know that the check wasn’t lost or stolen. Likewise, if you stop payment on a check, void it (and explain on the Memo line why you stopped payment).

History records what happened to voided transactions, but deleted transactions are lost forever in the prehistoric murk.
**Voiding a transaction**

Follow these steps to void a transaction:

1. Select the transaction in the register.
2. Right-click the transaction and choose Mark As Void or press Ctrl+V.

After a transaction has been voided, **VOID** appears in the balance column of the register, and R (for Reconciled) appears in the C (for Cleared) column to show that the transaction has cleared. Figure 4-14 shows a voided transaction in a register. (Chapter 5 explains what reconciling is.)

![Figure 4-14](image)

**Deleting a transaction**

Follow these steps to delete a transaction:

1. Select the transaction in the register.
2. Right-click and choose Delete from the shortcut menu, or press Ctrl+D.

   Sorry, you can’t delete a transaction by pressing the Del key.
3. Click Yes when Money asks whether you really want to go through with it.

If you try to delete a transaction that is marked as cleared in the register (R appears in the C column), Money warns you that deleting the transaction could upset your account balance and put the account out of sync with bank records. I strongly suggest clicking No in the dialog box to keep the transaction from being deleted. Very likely, the transaction was cleared because it appeared on bank records, so it should appear on your records as well. Investigate the matter before deleting the transaction.
Flagging transactions so that you can review them

It so happens now and then that a check you’ve written or charge you’ve made needs looking after. A charge on your credit card is under dispute. A check you wrote hasn’t been cashed and you’re not sure why. In cases like these, you can flag the transaction. Flagging makes it easier to follow up on checks and credit card charges. A flag appears in account registers beside transactions that have been flagged. Move the pointer over the flag icon and you’ll see a pop-up box that tells you why the flag is there.

To flag a transaction, right-click it in the register and choose Flag for Follow-Up. You see the Flag for Follow-Up dialog box. In the Follow Up By text box, enter a date to tell Money how long to leave the flag icon in the register. In the Notes text box, enter the note that will appear when you move the pointer over the flag icon.

To remove the flag from a transaction, right-click it and choose Edit Flag for Follow-Up. Then, in the Flag for Follow-Up dialog box, deselect the Flag This Transaction check box and click OK.

To find a transaction that you flagged, scroll through the account register or go to the Home Page. On that page is a list of flagged transactions. Click a transaction to see it in the Edit Transaction dialog box.

You cannot delete an online payment that has been sent to Online Services. You can, however, send instructions to cancel the payment, as long as you do so within a couple of days of sending it. (See Chapter 18 for more information.)

Moving a Transaction from One Account to Another

Suppose that you discover an error that has nothing to do with incorrect categories, amounts, or payee names. Suppose that you committed the grievous error of entering a transaction in the wrong account register. Before you are put in leg-irons, move the transaction to the correct account.
Money gives you two ways to move transactions between accounts:

- **From an account register:** If you find the errant transaction in a register, right-click it and choose Move to Account from the shortcut menu. You see the Account dialog box. In the Select New Account for Transaction list, select the name of the account to which you want to move the transaction; then click OK.

- **From the Find and Replace dialog box:** If you find the errant transaction by way of the Tools ➪ Find and Replace command (the “Finding a transaction so that you can fix it” section a few pages back explains how), double-click it to open the Edit Transaction dialog box. Then click the down arrow on the Account drop-down list box and select the name of the account in which the transaction rightfully belongs.

After you move a transaction to a different account, go to the other account and make sure that the transaction landed correctly. Very likely, the transaction needs to be renumbered or given a new date.

**Printing a Register**

Besides fretting over income taxes in April, you also have to print all your account registers from the previous year. Your accountant, if you have one, wants to see them. Even if you don’t have an accountant, you should still print the account registers and tuck them away with copies of your income tax forms. Leaving behind a paper trail is important in case a posse from the IRS comes to track you down.

Follow these steps to print all or part of an account register:

1. Open the account register that you want to print (see the section, “Opening an Account Register,” earlier in this chapter).

2. Choose File ➪ Print or press Ctrl+P.

You see the Print Report dialog box, shown in Figure 4-15. Theoretically, you can print part of a register from this dialog box by entering page numbers in the From and To text boxes. However, it is impossible to tell by looking at a register what page you are on or how many pages are in the register altogether. Oh well, so much for printing a handful of pages — although you can blindly try your luck with the From and To text boxes if you want.
3. If you want to try your luck with printing less than the entire register, select the Pages radio button and enter page numbers in the From and To text boxes.

4. Click OK.

If the register doesn’t print correctly, the problem could be that Money and your printer aren’t on speaking terms. (See Chapter 14 for more information.)

To solve the problem of printing part of a register, create an Account Transactions report and customize it so that only transactions from a certain year or other time period appear. (See Chapter 15 for more information.)
Part II
Banking with Money

The 5th Wave
By Rich Tennant

"Oh yeah, he's got a lot of money. When he tries to check his balance online, he gets a computer message saying there's 'Insufficient Memory' to complete the task."
In this part . . .

Part II explains how to do banking chores with Money. Who likes to do banking chores? Not me. But at least Money takes some of the tedium out of banking.

In this part, you find out how to categorize your spending and income so that reports, budgets, and financial projections that rely on categories are more meaningful to you. You also discover how to balance a bank account. And for people whose handwriting is impossible to decipher, Part II explains how to print checks.
Chapter 5

Categorizing Your Spending and Income

In This Chapter

- Identifying categories, subcategories, and classifications
- Creating your own categories and subcategories
- Setting up a classification
- Recording transactions by category, subcategory, and classification
- Reassigning transactions to different categories
- Changing and deleting category and subcategory names

You’ve probably withdrawn money from an ATM, noticed the dwindling account balance, and asked yourself, “Where did the money go?” Or perhaps you balanced a checking account and scratched your head, asking, “Why did I write so many checks?”

Money can help you find out. By assigning each transaction to a category, you can discover a great deal about your spending habits and sources of income. You can generate a report or graph and find out how much you spent on clothing and dining and office supplies. You can find out how much you earned in interest income and how much you earned from different clients. You can even find out how much you are allowed to deduct for income tax purposes.

This chapter explains how to categorize and classify transactions in account registers. You figure out how to choose categories and how to create meaningful categories that work for you. You also explore how to rename categories, delete categories, and recategorize transactions. You may still have to write the same number of checks, but at least you’ll have a better idea why.
Looking at the Ways to Categorize Income and Spending

Money offers four ways to categorize a financial transaction. What are the four ways? You can categorize a transaction by category, subcategory, classification, and tax-related status.

By category

By assigning transactions to categories, you can create neat-looking charts that give you the big picture on your spending, as shown in Figure 5-1. You can create spending reports as well. (See Chapter 14 for more about reports and charts.) You can see by category where all your money is spent and where the money comes from.

By subcategory

Divide a category into subcategories when you want to closely examine spending or income. The report in Figure 5-2 shows yearly expenses in three Automobile subcategories: Repair, Insurance, and Fuel. After you have used Money for a while, try running a report like this one to show how much it costs to drive your car for one year.
By classification

Most people don’t need to bother with classifications, but they can be useful for tracking things such as rental properties. As the owner or manager of an apartment building or office building, you need to know precisely how much income the property generates and how much it costs to maintain. The only way to track income and costs, which fall into lots of different expense and income categories and subcategories, is to create a classification.

By tax-related status

By giving a category tax-related status, you can tell Money to include categories and subcategories in tax reports. An accountant may need two or three hours to examine account registers, find all the tax-related transactions, and total them — time that you will be charged for. Money can do it in about six seconds. (Chapter 14 looks at tax preparation with Money.)

Setting Up Your Own Categories and Subcategories

Money gives you a set of generic categories and subcategories so that you can start entering transactions right away. The list is fine and dandy, but sooner or later you have to give serious thought to which categories and subcategories suit you, especially if you use Money to manage a business or track tax-deductible expenses. If you don’t see what you need in the generic lists, you can create your own!
Sit down and compose a list of all the categories and subcategories that you need for your business or personal finances before you begin creating categories and subcategories. That way, you get it right from the start and you lower the odds of having to recategorize transactions later on.

Money offers two different ways to create categories and subcategories. You can make them up as you go along with the fast-but-dicey method, or you can thoughtfully create them all at one time in the New Category dialog box. The following sections describe the thorough way and the fast way to create categories and subcategories.

Creating a new category in the New Category dialog box

Follow these steps to set up a new category in the New Category dialog box:

1. **Open the Set Up Your Categories window.**
   - Press Ctrl+Shift+C.
   - Click the Banking tab, click the Account Tools button, and then choose Categories & Payees.
   
   If you don’t see the Categories list, click the Categories link on the left side of the window.

   Figure 5-3 shows the Categories list. While you’re viewing the window, you may want to scroll down the list of categories and subcategories and examine the ones that are already there. Expense categories appear at the top of the list, and Income categories appear at the bottom.

2. **Click the New button at the bottom of the screen.**

   The New Category dialog box appears.

3. **The Create a New Category option button is already selected, so click the Next button.**

   As shown in Figure 5-4, the New Category dialog box offers places for entering a category name and category type.

4. **Type a name for the category in the Name box.**

   The name that you enter will appear in the Category drop-down list when you record transactions, so be sure to choose a meaningful name.

5. **Select the Income or Expense option button and click the Next button.**

   All categories fall under the Income or Expense heading. Income categories describe sources of income; expense categories describe how you spend money.
6. Select a category group from the list.

A **category group** is a broad means of defining the category. Money uses category groups to make calculations in budgets and in tax estimations (see Chapters 12 and 14). When you select a category group, a description appears on the right side of the dialog box.

7. Click the Finish button.

There it is — your new category, alive and kicking in the Set Up Your Categories window.
Open the View menu in the Categories window and experiment with the different views (refer to Figure 5-3). For the screen shown in Figure 5-3, I chose Categories, Subcategories, and Category Groups from the View menu. The other options can be useful when you are looking for a category in the list.

**The fast-but-dicey way to set up categories**

When you're in a hurry, you can create a category as you enter a transaction. I don't recommend doing this, because you don't get a chance to look at the big picture. You can't see where your new category or subcategory goes in the Category list or whether your new category or subcategory is really necessary. Anyhow, if you're a daredevil, follow these steps to create a category as you enter a transaction:

1. **Enter the entire transaction on the transaction form, except for the category and subcategory.**
   In other words, enter numbers or letters in the Number, Date, Amount, Pay To, From, and Memo text boxes.

2. **In the Category text box, enter the name of the new category.**

   Or, to create a new subcategory, choose a category, type a colon (:) and then type a subcategory name.

3. **Press Tab.**
   You see the New Category dialog box. I hope it looks familiar.

4. **Make sure that the name you entered appears correctly in the dialog box; then click the Next button.**

5. **Select a category group.**

6. **Click the Finish button.**
   The name of the category that you created takes its place in the Category drop-down list so that you can select it in the future.

---

**Creating a new subcategory**

The best way to create a new subcategory is to go straight to the Set Up Your Categories window and start from there. Follow these steps:

1. **Open the Set Up Your Categories window:**
   - Press Ctrl+Shift+C.
   - Click the Banking tab, click the Account Tools button, and then choose Categories & Payees.

   If necessary, click the Categories link to view categories. You can find this link on the left side of the window under View.
2. Select the parent category of the subcategory that you want to create.
   In other words, to create a subcategory of the Education category, scroll to and select Education in the Categories window.

3. Click the New button.
   You see the New Category dialog box.

4. Select the Add a Subcategory to an Existing Category option button; then click the Next button.

5. Enter a name for the subcategory in the Name box; then click the Next button.

6. Select a category group.
   Category groups are another one of those bold attempts by Microsoft to do your thinking for you. They are used in budget projections and tax estimations.

7. Click the Finish button.
   Check it out — your new subcategory appears in the Categories window underneath its parent category.

**Editing and Refining a Category or Subcategory**

To change a category name, assign it to a new category group, view transactions that were assigned to the category, or do a number of other activities that pertain to a category, Money offers the Category window. Figure 5-5 shows the window for a category called Groceries that tracks money spent at the supermarket. Follow these steps to visit a Category window:

1. **Open the Set Up Your Categories window.**
   You can get there by pressing Ctrl+Shift+C or by clicking the Banking tab, clicking the Account Tools button, and then choosing Categories & Payees.

2. **Select a category and then click the Go to Category button at the bottom of the window.**
   You can quickly scroll down the category list by pressing a key. For example, press the N key to quickly scroll to categories with names that begin with the letter N.

   You see a Category window like the one shown in Figure 5-5. You can also get to this window by double-clicking a category in the Categories window.
The window presents a bunch of different amenities. For example, you can see a graph showing how much you spent or took in, as well as a miniregister that shows account activity in the category. Here are some things you can do in a Category window:

**Change category names:** Click the Modify button, and in the Modify Category dialog box, enter a new name for the category. When you change a category name, names in transactions that you’ve already entered are changed as well.

**Use abbreviations instead of category names:** The Abbreviation box represents an alternate way to assign a category to a transaction. Besides selecting a category from the drop-down list on the transaction form or typing the first few letters of the category name, you can type a two- or three-letter abbreviation. After you type the two or three letters and press Tab to move to the next part of the transaction form, Money enters the entire category name for you. (Big deal, I say. It’s not as if selecting from the drop-down list or typing the first few letters of a category name is very difficult.)

**Enter comments:** The Comment box is worth visiting. Enter a few words to describe the category and why you created it. That way, if you forget what the new category is for, you can always come back to the Categories window and find out.
Assign a category group: When you draw up a budget, you are given the choice of declaring how much you will spend or earn in each category or in each category group. Budgeting by category is hard work because there are so many categories. Many people opt to budget by category group to save time. You may choose a new category group from this drop-down list. (Chapter 12 explains budgets.)

Project your cash flow: Money can project how much money you will have at future dates. The program does its soothsaying by examining the amount of money in different accounts over time. If earning or spending in the category that you just created is done mostly by way of a certain bank account, choose it to help with cash-flow projections. (See Chapter 12.)

Mark for budgeting: When you draw up a budget (see Chapter 12), you are also asked to declare by category which spending is necessary and which is discretionary. Choose one or the other if you intend to get Money’s help with budgeting.

Include categories in tax reports: Select the Include on Tax Reports check box if you want transactions that are made under this category to be calculated in tax reports.

Setting Up and Defining a Classification

At the beginning of this chapter, I explain that a classification is an umbrella grouping under which you track income and expenses in many different categories and subcategories. You can create two classifications in each Money file. When you generate some types of reports, you can ask Money to tell you everything it knows about transactions assigned a certain classification.

Classifications permit you to track income or expenses in several different categories and subcategories simultaneously. A property manager, for example, can create a class named after each building that he or she manages. As well as categorizing expenses for building repairs and income from rent, the manager may classify them by property. Then, from time to time, the manager may run classification reports to see precisely how much each property generates in income and costs in upkeep.

The following sections explain how to set up a new classification. You also find out how to define the classes and subclasses that go into the classification. When you enter a transaction, you can select a class and subclass from special drop-down lists on the transaction form. In Figure 5-6, the user has named the classification Properties, the class in question is the building at 1020 Lakeshore Drive, and Apt. 2 is a subclass. The transaction records a check that was written to cover plumbing repairs done to Apartment 2 at 1020 Lakeshore Drive.
Setting up a classification

As with categories and subcategories, the starting point for setting up a classification is the all-purpose Set Up Your Categories window. Follow these steps to set up a classification:

1. Press Ctrl+Shift+C or click the Banking tab, click the Account Tools button, and then choose Categories & Payees.

   If necessary, click the Categories link to view categories. You can find this link on the left side of the window under View.

2. Click the Classification 1 link.

   You see the Add Classification dialog box, as shown in Figure 5-7.

3. Select one of Money's names by clicking an option button, or click the last option button and enter an original name for the classification.
Money’s six suggestions for naming the new classification appear next to the six option buttons. If you click the Properties option button, for example, the new classification is called Properties, and the word Properties appears on your transaction forms (refer to Figure 5-6).

If you don’t like Money’s suggestions for a name, you can always click the last option button and enter a name of your own in the text box.

4. **After you select or enter a name, click OK.**

You return to the Set Up Your Classification window, where the name that you chose or entered appears on the left side of the window on a button below the Categories button.

The next step is to define classes and perhaps subclasses for the new classification. By the way, if you set up two classifications in a Money file, you get two sets of classification drop-down lists on the transaction forms that appear in the account registers.

**Defining classes and subclasses**

Starting in the Set Up Your Category window, follow these steps to define the classes and subclasses that appear in the first classification drop-down list on transaction forms:

1. **Click the classification link that is named after the classification to which you want to add the classes.**

In other words, to create classes for the Properties classification, click the Properties link. The Set Up window lists classes and subclasses in the classification, if you have already created any, as shown in Figure 5-8.
2. If you are creating a subclass, click the class under which you want to define a subclass.

   For example, to define a subclass called Apt. 1 that is to be subordinate to the 1020 Lakeshore Drive class, select 1020 Lakeshore Drive.

3. Click the New button.

   You see the New Class or Subclass dialog box, as shown previously in Figure 5-8.

4. Under Add, select the first option button to create a new class; select the second option button to create a new subclass.

5. Enter a name for the class or subclass in the Name text box and click OK.

   The name that you enter appears in the Set Up Your Classification window.

To rename a class or subclass, right-click its name in the Set Up Your Classification window, choose Rename from the shortcut menu, enter a new name in the Modify Class or Modify Subclass dialog box, and click OK.

**Correcting Transactions that Were Recorded in the Wrong Category**

Don’t feel foolish if you recorded transactions in the wrong category or subcategory. It happens all the time. Luckily for you, Money offers a special button called Move for reassigning all the transactions in one category to another category. And if you need to reassign only a handful of transactions, you can use the Find and Replace command to reassign transactions one at a time.

The Move button is very powerful indeed. When you use the Move button to reassign all the transactions in one category to another category, you delete the first category as well. For example, suppose that you assigned the Vacation category to a bunch of transactions when you should have assigned the Leisure category. If you use the Move button to move all the Vacation transactions to the Leisure category, you delete the Vacation category from the Categories list as well as move the transactions. Use the Move button only when you want to drop one category altogether and move all its transactions elsewhere.

Another point about the Move button: If you attempt to move transactions in one category to another category, and the category that you want to move includes subcategories, you lose the subcategory assignments when you make the move. However, you can move subcategory assignments from one subcategory to another subcategory with the Move button.
Moving all transactions from one category to another category

To change category or subcategory assignments throughout your account registers, follow these steps:

1. Press Ctrl+Shift+C or click the Banking tab, click the Account Tools button, and then choose Categories & Payees.

   You land in the Set Up Your Categories window. If necessary, click the Categories link to make category and subcategory names appear.

   To see the categories and subcategories, you may need to open the View menu and choose Categories and their Subcategories.

2. Scroll down the list and select the name of the category or subcategory whose transactions you want to reassign.

   For example, if you erroneously assigned transactions to the Education: Kids subcategory when you should have assigned them to the Childcare category, select the Education: Kids subcategory from the list.

   Remember, the category or subcategory that you select is deleted from the Categories window after you finish reassigning the transactions. Be sure to examine transactions carefully before you delete anything.

3. Click the Move button.

   As shown in Figure 5-9, you see the Move Transactions dialog box. This is where you tell Money where to reassign the transactions in the category or subcategory that you chose in Step 2.

4. In the Category text box, select the category or subcategory to which you want to reassign the transactions.

5. Click OK.
In the Categories list, the category or subcategory that you chose in Step 2 has been deleted. Meanwhile, all transactions in your registers that were assigned the old category or subcategory are assigned the one that you chose in Step 4.

**Reassigning transactions to new categories**

Instead of making a wholesale reassignment of one category or subcategory to another, you may decide to examine transactions one at a time and choose which ones need reassigning. To do that, you have to search for transactions in the account registers, examine each transaction, and then either choose a new category or subcategory or move on without moving the transaction.

The section “Finding a transaction so that you can fix it,” in Chapter 4, explains everything that you need to know about finding transactions. However, here are shorthand instructions to find and fix transactions that were assigned the wrong category or subcategory:

1. **Choose Tools:** Find and Replace, or press Ctrl+H.

   You see the Find and Replace dialog box.

2. **Select Category from the In This Field drop-down list; then, from the Find This Text drop-down list, select the category or subcategory whose transactions need reassigning; finally, click the Next button.**

   As shown at the top of Figure 5-10, the Search Results list shows transactions that are assigned to the category you chose. At this point, you can reassign the transactions one at a time or click the Replace button to reassign several transactions simultaneously.

3. **Assign the transactions to new categories:**

   - **One at a time:** Double-click a transaction that needs a new category. You see the Edit Transaction dialog box, as shown at the bottom of Figure 5-10. Choose a new category or subcategory from the drop-down list, and click the OK button.

   - **Several at one time:** Click the Replace button. You see the Find and Replace dialog box, as shown in Figure 5-11. Select the check box next to each transaction that needs a new category assignment, choose Category from the Replace drop-down list, choose a new category from the With list, and click the Next button. Then click the Finish button on the next screen, which asks whether you really want to make the reassignment.
By the way, when you reassign a transaction that has been reconciled, Money beeps and warns you not to change the amount of the transaction you are about to edit. Don’t worry about the warning. You are concerned with the category assignment, not the amount of the transaction.
Finding transactions that weren’t assigned to categories

It happens. Sometimes by mistake you enter transactions without categorizing them. You can find these transactions and assign them categories by following these steps:

1. Choose Tools ➪ Find and Replace to open the Find and Replace dialog box.
2. Select the Advanced Search option button and click Next.
3. In the next dialog box, select the Category tab and click the Clear All button.
4. Click the Next button.

You see a list of transactions that weren’t assigned categories. One by one, double-click these transactions to open the Edit Transaction dialog box and assign a category to the transactions.

Renaming and Deleting Categories and Classifications

After you have worked with Money for a while and you have refined the list of categories and classifications that you want to work with, you can delete unnecessary categories and classifications. And if a category or classification isn’t descriptive enough, you can rename it. The following sections explain how to delete and rename categories, subcategories, and classifications.

After you rename a category or classification, transactions throughout the account registers that were assigned the old category or classification name are automatically given the new name. So, when you rename, you also change the names of category, subcategory, or classification assignments throughout your registers.

Renaming a category or subcategory

Follow these steps to rename a category or subcategory:

1. Press Ctrl+Shift+C or click the Banking tab, click the Account Tools button, and then choose Categories & Payees.

If necessary, click the Categories link in the window to see the list of categories and subcategories. If you don’t see subcategory names but need to see them, open the View menu and choose Categories and their Subcategories.
2. Scroll down the list and select the category or subcategory whose name you want to change.

3. Click the Modify button, or right-click and choose Modify (choose Rename if you are dealing with a subcategory) from the shortcut menu.

You see either the Modify Category dialog box or the Modify Subcategory dialog box.

4. Enter a name in the New Name text box and click OK.

**Renaming a classification**

Follow these dance steps to change the name of a classification:

1. Press Ctrl+Shift+C or click the Banking tab, click the Account Tools button, and then choose Categories & Payees.

2. On the left side of the window, click the link named after the classification whose name you want to change.

3. Click the Rename Classification link.

Look for the link under Common Tasks on the left side of the window. The Rename Classification dialog box appears.

4. Enter a name in the New Name text box and click OK.

Back in the Categories window, the button that you clicked in Step 2 has a new name. Classification assignments throughout your account registers have new names as well.

**Deleting a category or subcategory**

When you no longer need a category or subcategory, you can delete it. However, be careful, because if you delete a category or subcategory to which transactions are assigned, the transactions lose their category assignments. In other words, you end up with transactions to which no category is assigned — and that defeats one of the primary reasons people use Money, which is to categorize their spending and income to find out where the money came from and where it went.

Try to delete a category or subcategory to which categories are assigned, and you see the Delete Category dialog box. From this dialog box, you can assign transactions to a different category before you delete the category in question, but do you really want to do that? Suppose that some transactions belong in one category and others belong in another category. No, reviewing
the transactions one at a time before you delete the category to which they are assigned is wiser. The section “Reassigning transactions to new categories,” earlier in this chapter, explains how to review transactions as you change their category or subcategory assignments.

After you reassign the transactions whose category you want to delete, follow these steps to delete a category or subcategory:

1. Press Ctrl+Shift+C or click the Banking tab, click the Account Tools button, and then choose Categories & Payees.
   
   If necessary, click the Categories link in the window to see the list of categories and subcategories.

2. Click the Categories button in the window, if necessary, to see the list of categories and subcategories.
   
   If you intend to delete a subcategory, you may need to open the View menu and choose Categories and their Subcategories to see subcategories.

3. Scroll through the list and select the category or subcategory that you want to delete.

4. Click the Delete button, or right-click and choose Delete from the shortcut menu.

---

**A fast way to remove deadwood categories**

When you install Money on your computer, the program gives you a bunch of generic categories that you may or may not need. Very likely, you don’t need many of them. To quickly remove them, you can use a special button called Remove Unused Categories. After you click this button, Money removes all categories and subcategories on the Categories list to which no transaction has been assigned.

Follow these steps to remove deadwood categories that take up space on the Categories list:

1. Choose Tools ➪ Settings.

2. In the Settings window, scroll to and click the Category Settings link. The Category Settings tab of the Options dialog box appears.

3. Make sure that the Ask Me Before Removing Each Category check box is selected (it is selected by default).

4. Click the Remove Unused Categories button. A dialog box asks whether you want to remove a certain category.

5. Click the Yes or the No button.

6. Keep clicking the Yes or the No button until you ax all the deadwood categories and subcategories.
That’s all she wrote — the category is gone from the Categories window. However, if you try to delete a category with subcategories underneath it, a dialog box warns you that deleting a category also deletes its subcategories. If you try to delete a category to which transactions are assigned, you see the Delete Category dialog box.

Whatever you do, don’t cavalierly delete a category with subcategories. Investigate the matter first and find out whether you need the subcategories for tracking your finances.

**Deleting a classification**

After you delete a classification, all transactions throughout the registers that were assigned the classification are no longer assigned to it. Therefore, I suggest that you think twice before deleting a classification. Think twice and think hard. Going back through the registers and reassigning transactions to a classification that you deleted is hard work that you’ll want to avoid.

Follow these steps to delete a classification that you no longer need:

1. Press Ctrl+Shift+C or click the Banking tab, click the Account Tools button, and then choose Categories & Payees.
2. Select the classification that you want to delete.
3. Click the Delete Classification link.
   You can find this link under Common Tasks on the left side of the window. A dialog box warns you of the drastic nature of what you are about to do.
4. Ignore the dialog box and click the Yes button to delete the classification.
   Back in the Set Up Your Categories window, the classification link now has the generic name Classification 1 or Classification 2, and all class and subclass names have disappeared from the screen.

You can delete a class or subclass by right-clicking it and choosing Delete from the shortcut menu.
Chapter 6

Reconciling, or Balancing, an Account

In This Chapter

- Finding out what reconciling is and how to do it in Money
- Reconciling a savings or checking account
- Recognizing and fixing reconciliation problems
- Forcing an account to balance
- Reconciling a credit card account

Until I started using Money, I never reconciled, or balanced, my checking or savings accounts, not to mention my credit cards. But Money makes balancing an account very easy indeed. No kidding — you can do it in four or five minutes.

This chapter explains what reconciling is, how to reconcile the transactions in your records with the bank’s records, and what to do if you can’t get an account to reconcile. Because reconciling a credit card account can be slightly tricky, you can find instructions in this chapter for reconciling credit card accounts as well as checking and savings accounts. Bon voyage!

How Reconciling Works

Reconciling is your opportunity to examine your records closely to make sure that they are accurate. When you reconcile an account, you compare your records to the bank’s, fix any discrepancies you find, enter transactions that appear on the statement that you forgot to enter in the register, and click in the C (for Cleared) column next to each transaction that appears both in the register and on the bank statement.
In an account register, transactions that have cleared the bank — transactions that you have reconciled with the bank's records — show an R (for Reconciled) in the C (for Cleared) column, as shown in Figure 6-1. Here, you can see that some transactions have cleared the bank and some are still waiting to clear.

Balancing an Account

Balancing an account is a two-step business. First, you tell the program how much interest the account earned (if it earned any) and how much you had to pay the bank for checks, ATM withdrawals, and other services (if you had to pay anything). Then you move ahead to the Balance Account window, where you make your records jibe with the bank's and click off each transaction that appears both on your bank statement and in the register.

Before you begin comparing the register to the bank statement, lay the bank statement flat on your desk. And you may want to put checks in numerical order (if you intend to reconcile a checking account) and your ATM slips in date order (you have been saving your ATM slips, haven't you?). With a little luck, you can reconcile without having to glance at checks and ATM slips. But if something goes amiss, you may have to examine the paperwork closely.
What does *reconcile* mean, anyway?

In financial terms, *reconcile* means to compare one set of records to another for the sake of accuracy. In other words, reconciling means to make sure that your records agree with the bank’s records. When you reconcile an account in Money, you compare the transactions on the statement that the bank or brokerage house sent you to the transactions that you entered in the Money register.

If you find a discrepancy between your records and the bank’s, you can be pretty sure that the error was made on your side. Not that it doesn’t happen, but banks don’t err very often when recording financial transactions. Yes, bank lines move too slowly, and banks have been known to nickel-and-dime their customers with all kinds of petty charges, but banks are sticklers for accuracy. If you find a discrepancy between your records and the bank’s, chances are the error was made on your side, not the bank’s.

**Telling Money which transactions cleared the bank**

Open the register of the account that you want to reconcile and follow these steps to tell Money to reconcile the account:

1. **Click the Balance This Account link.**

   You see a Balance dialog box like the one in Figure 6-2. This dialog box is where you enter information from the bank statement. The Starting Balance text box shows the amount of money in the account as of the last time you reconciled it (or the account’s opening balance, if you recently opened the account).

![Figure 6-2: The Balance dialog box, where you tell Money what the bank told you.](image)
2. At the top of the Balance dialog box, enter information from your bank statement:

- **Statement date:** Enter the date listed on the bank statement.

- **Starting balance:** If this number is incorrect, enter the starting balance from your bank statement. If you reconciled this account last month, the correct number is already listed.

- **Ending balance:** Enter the closing balance from the bank statement.

3. At the bottom of the Balance dialog box, enter any service charges or interest income that is listed on your bank statement:

- **Service charge:** If you have to pay a service charge, enter it in this text box. Banks are like mosquitoes: They like to bite. Banks do it by charging customers all sorts of miscellaneous fees. The fees appear on bank statements. You may get charged for ordering checks, calling for information, using an ATM, or sneezing too loudly. Scour the statement for evidence of service charges, and enter the sum of those charges in the Service Charge text box. For a category, choose Bank Charges: Service Charge or something similar. (For more on categorizing, turn to Chapter 5.)

- **Interest earned:** If the account earned any interest, enter the amount and categorize the interest payment.

Before you click the Next button to move ahead, compare what you entered in this dialog box to what is on your bank statement one last time. Entering numbers incorrectly in this dialog box is one of the primary reasons that people have trouble reconciling their bank accounts.

4. Click the Next button to move ahead to the Balance Account window, as shown in Figure 6-3.
Only transactions in the register that have not been reconciled appear in the window. Deposits and other transactions that brought money into the account appear at the top of the window; following that are withdrawals and other transactions that record when money was taken out of the account.

If you entered a service charge and/or interest payment in the Balance dialog box (in Step 3), the amounts already appear in the window, along with a check mark to show that they have been cleared.

Many people think that reconciling accounts is easier when transactions are shown on one line rather than two. To show transactions on one line, open the View menu and choose Top Line Only.

5. **Examine your bank statement and click the C column next to each transaction on the statement that also appears in the register.**

The left side of the window lists the difference between the ending balance on your bank statement (you listed it in the previous dialog box) and the amount as tabulated by Money. When you click the C column in the register to clear transactions, this amount changes. Gradually, as the account is reconciled, the number approaches 0.00.

To remove a check mark in the C column, click the column again. The next section in this chapter explains how you can fix mistakes in the register while you reconcile. The section after that offers strategies for recognizing and fixing reconciliation problems.

If you have trouble finding a transaction in the register, open the View menu and choose Sort By: ↪ Sort by Date or Sort ↪ Sort by Number. The Sort by Date command lists transactions in date order, and the Sort by Number command lists them in numerical order in the Num column.

6. **Click the Next button when the difference amount is 0.00 and you are satisfied that the account is reconciled correctly.**

You can find the Next button in the lower-left corner of the window. A Balanced! screen appears and tells you that your account is balanced.

7. **Click the Finish button.**

Back in the register, all those check marks in the Balance Account window turn to Rs in the register. The transactions that you clicked off in the Balance Account window have cleared the bank and are reconciled with your records.

If the reconciling business makes you tired or if you find something better to do, click the Postpone button. Later, you can pick up where you left off by clicking the Balance This Account button in the Account window.
Fixing mistakes as you reconcile

Glancing at the bank statement, you discover that you made a mistake when you entered a transaction in a register — you entered the wrong amount or check number. Or perhaps you forgot to enter a transaction altogether. It happens. Cash withdrawals from ATMs, which usually are made on the spur of the moment, often fail to get recorded in account registers.

Follow these steps to fix a mistake in a transaction:

1. **Click the transaction that needs correcting.**
   If you need to enter a brand-new transaction, go straight to Step 2.

2. **Select the Show Transaction Forms check box.**
   As shown in Figure 6-4, a transaction form appears in the window. The form looks and works like the transaction forms that you know and love in account registers.

3. **Fix the error or enter a new transaction:**
   - **Repair an error:** Click the Edit button, enter the correct amount, check number, date, or anything that needs correcting.
   - **New transaction:** Click the New button and enter the transaction.

4. **Click the Enter button.**

Help! The Darn Thing Won’t Reconcile!

Not being able to reconcile a bank account is frustrating. You pore over the bank statement. You examine checks and ATM slips. You gnash your teeth
and pull your hair, but still the thing won’t reconcile. No matter how hard you try, the Difference figure, which lists the difference between the cleared amount and the statement amount, cannot be brought to 0.00.

To help get you out of the jam you are in, Money offers techniques for recognizing and fixing reconciliation problems. And Money also has a gizmo called AutoReconcile (which gets its own section later in this chapter) that may be able to help you reconcile your bank account.

A checklist of things to do if you can’t reconcile

If an account won’t balance, a number of different things can be wrong. The following sections explain how to recognize and fix reconciliation problems.

A transaction was not entered

The primary reason that accounts don’t reconcile is because a transaction that is listed on the bank statement has not been entered in the register. ATM withdrawals, for example, are easy to forget and often do not get entered in account registers.

Remedy: Look for a transaction on the bank statement that is equal to the Difference amount in the Balance Account window. For example, if the Difference amount is $35.20, chances are you forgot to record a $35.20 transaction in the register. Look for a $35.20 transaction on the bank statement and, if necessary, click the Show Transaction Forms check box to display a form and enter the transaction. Be sure to enter the date correctly. If the difference is $20.00, $40.00, or another round number, you probably forgot to enter an ATM withdrawal.

An amount in the register is incorrect

Another reason accounts don’t reconcile is that amounts were entered incorrectly in the register. This problem is a sticky one and is hard to track down. Look for transposed numbers and numbers that were entered backward. For example, $32.41 and $34.21 look alike at a glance, but the difference of $1.80 between those numbers will cause your totals to go awry just sneakily enough to quietly drive you crazy.

Here’s an old accountant’s trick: If the difference between what you have and what you should have is evenly divisible by 9, you probably transposed a number.

Remedy: Click the transaction, select the Show Transaction Forms check box, and change the amount on a transaction form.
A transaction was entered twice

Look for duplicate transactions in the register to make sure that no transaction was entered twice.

Remedy: Delete one of the transactions by right-clicking it and choosing Delete from the shortcut menu.

A check was entered as a deposit, or vice versa

Making an error like this is easy. Fortunately, detecting it is easy, too.

Remedy: Clear your checks and withdrawals first; then clear your deposits. During this process, you’ll notice whether a deposit, check, or withdrawal is missing. Click the transaction and then click the Show Transaction Forms check box. On the transaction form, click the Options button, choose Change Transaction Type To, and choose Withdrawal or Deposit.

The Ending (statement) balance is incorrect

If you enter the Ending balance incorrectly in the Balance dialog box (refer to Figure 6-2), you cannot reconcile an account, no matter how hard you try.

Remedy: Return to the Balance dialog box (refer to Figure 6-2) and enter a correct Ending balance figure. To do so, click the Postpone button to return to the Accounts window, click the Balance This Account link, and then click the Next button. You see the Balance dialog box again, where you can enter a correct Ending balance this time. Click the Next button again to return to the Balance Account window.

A service charge or interest earned amount is incorrect

Besides entering the ending balance incorrectly, you may have entered an incorrect amount in the Service Charge or Interest Earned text box in the Balance dialog box (refer to Figure 6-2). Compare the interest and service charges on your statement to the ones in the Balance Account window to see whether an amount is incorrect.

Remedy: Click the service charge or interest entry in the Balance Account window, select the Show Transaction Forms check box, and enter a correct figure on the transaction form.

The bank statement was not flipped over

I’m embarrassed to admit it, but one or two times I wasn’t able to reconcile an account because I forgot to turn over the bank statement and examine the transactions listed on the other side of the page — very stupid of me.

Remedy: Turn the page, note the transactions, and click to put a check mark next to them.
“AutoReconciling” an account

If all else fails, you can try using Money’s AutoReconcile gizmo to find out why the account won’t balance. This contraption scours the register for transactions that it thinks were entered incorrectly and gives you the chance to enter them correctly so that the account can be reconciled. Follow these steps to try the AutoReconcile feature:

1. Click the Next button in the Account Register window.

   Although the account isn’t balanced, click the Next button as though it is in balance. You see the Balance dialog box shown in Figure 6-5.

2. Select the second option button, Use AutoReconcile to Help Find the Error.

   If you are in luck and Money can find the error, the Possible Error dialog box appears.

3. Read the description of the error and click the Yes or the No button to change the transaction in question or to let it stand.

Forcing an account to balance

If, despite your detective work, you can’t find the problem that keeps your account from balancing, you can force the account to balance. Forcing an account to balance means entering what accountants call an “adjustment transaction” — a fictitious transaction, a little white lie that makes the numbers add up. Don’t tell anybody that I said so, but if the difference between what your statement says and what the Balance Account window says is just
a few pennies, enter the adjustment transaction and spare yourself the headache of looking for the error. A few pennies here and there never hurt anybody.

The words *Account Adjustment* appear in the register on the Payee line when you force an adjustment transaction. Money gives you the chance to categorize the transaction on your own. After you have torn out your hair trying to discover why an account doesn’t balance, follow these steps to force an adjustment transaction:

1. **Click the Next button in the Balance Account window.**
   Click the Next button even though the account has not been reconciled. The Balance dialog box appears (refer to Figure 6-5). It tells you that the account isn’t in balance and asks what you want to do about it.

2. **Select the Automatically Adjust the Account Balance option button.**

3. **Choose a category from the Category drop-down menu.**

4. **Click OK.**

### Reconciling a Credit Card Account

Reconciling a credit card account is done in much the same way as reconciling a checking or savings account. The only difference is in the Balance dialog box (refer to Figure 6-2), where you tell Money how much the statement says that you owe.

When you reconcile an account, you clear credits as well as charges made to your credit card. Before you start reconciling, make sure that the credits the card issuer owes you have been entered in the credit card register.

Open the credit card account register and follow these steps to reconcile a credit card account:

1. **Click the Balance This Credit Card Account link.**
   The link is located under Common Tasks on the left side of the window.
   You see the Balance dialog box, as shown in Figure 6-6. The amount you owed as of the last time you reconciled the account appears in the Total Amount You Owed Last Month text box.
2. At the top of the Balance dialog box, enter information from your credit card statement:

- **Statement date**: Enter the date listed on your credit card statement.

- **Total amount you owed last month**: You don’t have to enter anything here. This text box lists how much you owed as of the last time you reconciled your credit card account.

- **Total amount you owe this month**: Enter the amount that the statement says you owe, including all service and interest charges. In other words, enter the amount that you would have to pay if you were to pay off all debt you owe to the credit card issuer.

3. At the bottom of the Balance dialog box, enter any service charges or interest charges listed on your credit card statement:

- **Service charge**: Some credit card issuers charge an annual fee. Record an annual fee in the Service Charge box. For a category and subcategory, choose Bank Charges: Service Charge or a similar category.

- **Interest charge**: Enter the amount that you must pay in interest to service the credit card debt. Most people don’t pay off their credit card debt each month, so they have to pay an interest charge. And if you take out cash advances, you have to pay interest for those, too. For a category and subcategory, choose Bank Charges: Interest Paid or a similar category.
4. Click the Next button.

You see the Balance Account window, which lists all transactions in the register that have not been reconciled. If the Balance Account window looks familiar, that is because it looks and works exactly like the Balance Account window for reconciling savings and checking accounts (refer to Figure 6-3).

5. Examine your credit card statement and click the C column next to each transaction on the statement that also appears in the register.

To change the amount of a charge or credit, click it in the register and then select the Show Transaction Forms check box. That step opens the transaction form so that you can alter the transaction.

6. Click the Next button after the account is reconciled.

A Balanced! screen appears.

7. Click the Pay Bill Later button to pay the credit card bill later on, or click the Pay Bill Now button to open the Edit Transaction dialog box and record a bill payment.

Guess what? You can use the same techniques for fixing reconciliation problems in credit card accounts as you can in checking and savings accounts. See the section “Help! The Darn Thing Won’t Reconcile!” earlier in this chapter, to find out how to fix reconciliation problems, or use the AutoReconcile gizmo to find and fix errors.
Chapter 7

Writing and Printing Checks

In This Chapter

- Identifying the different kinds of checks
- Ordering checks
- Preparing your printer to print checks
- Recording checks that you intend to print in registers
- Printing practice checks
- Printing a full or partial sheet of checks
- Reprinting checks that didn’t print correctly

Not every Money user needs to print checks. Checks are expensive, for one thing. If you order checks from Microsoft Money Checks by Deluxe, the official vendor, an order of 500 checks can cost between $70 and $89.50, depending on the kind of check you order, whereas most banks charge about $15 for that many checks. So, printing checks with Money costs five to six times as much as writing checks by hand.

But printing checks with Money can save time, especially if you run a small business and print lots of checks. When you write a check by hand, you have to write it twice (once when you record it in a register and once when you scribble on the paper check). When you print a check with Money, you enter it only once when you record it in a register. The printer handles the rest. What’s more, you can batch-print checks (print a dozen or so at one time). Small-business owners who print lots of payroll checks or monthly expense checks ought to seriously consider printing checks with Money.

Another advantage of printing checks is being able to itemize the payment on the check stub. As long as you print checks on wallet-size or voucher checks (I explain those shortly), you can itemize the payment by splitting it (as I discuss in Chapter 4). The split-transaction information appears on the check stub.
But the best reason for printing checks has nothing to do with saving time or itemizing — it has to do with appearances. Printed checks are more professional looking. They make a good impression on creditors and clients. A printed check says “I mean business,” whereas a handwritten check with spidery lettering says “Thank you, kind sir or madam, for honoring my little check.” Everyone who works in a profession where appearances count — supermodels, for example — ought to print checks.

This chapter explains everything you need to know about printing checks — from choosing the right type of checks to ordering checks, telling your printer how to print checks, and adjusting checks that don’t print correctly. You also discover how to record checks in a register, print a full sheet or a partial sheet of checks, and print addresses on checks. By the way, if you came to this chapter to find out how to record a check in a register, you came to the wrong place. You should be in Chapter 4.

**Deciding What Kind of Check to Order**

Your first decision is what kind of check to order. Checks are printed on sheets and loaded into your printer like sheets of paper. As shown in Figure 7-1, the choices are wallet-size, standard business, or voucher checks. Checks and check envelopes are available in standard as well as European sizes. Most companies that make checks offer the opportunity to print company logos on checks and customize the checks in other ways. Table 7-1 compares and contrasts the three types of checks that you can print with Money. These prices come from Microsoft Money Checks by Deluxe, the Microsoft affiliate that offers checks for use with Money.
Table 7-1 Checks for Use with Money

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Checks per Sheet</th>
<th>Cost per 500/</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wallet-size</td>
<td>2.83” × 8.5”</td>
<td>3 checks</td>
<td>$80/16¢</td>
<td>The smallest check. It includes a 2.5” stub for tracking expenses. This check is for individuals, not businesses.</td>
</tr>
<tr>
<td>Standard</td>
<td>3.5” × 8.5”</td>
<td>3 checks</td>
<td>$85/17¢</td>
<td>The largest check. It does not include a stub, although you can list tax-deductible expenses on the Memo line. For small businesses.</td>
</tr>
<tr>
<td>Voucher</td>
<td>3.5” × 8.5”</td>
<td>1 check</td>
<td>$89.50/19¢</td>
<td>Includes ample room — two-thirds of a page — for listing expenses. For small businesses that need to itemize checks in detail.</td>
</tr>
</tbody>
</table>

*Prices listed here are from Microsoft Money Checks by Deluxe, are for standard-color checks, and are current as of June 2005. Premier-color checks, which come in a variety of colors, cost more. You can buy checks in sets of 250, 500, 1,000, or 2,000. Third-party vendors offer different prices for checks.

Ordering the Checks

Besides ordering from Microsoft Money Checks by Deluxe, you can order checks from third-party vendors. Table 7-2 lists vendors whose checks are compatible with Money. Checks are available in many different colors and designs, so shop around. Perhaps you can find checks in soft lilac, paprika, icy periwinkle, and the other chichi colors whose names grace clothing catalogues.

Table 7-2 Vendors Offering Checks for Use with Money

<table>
<thead>
<tr>
<th>Company</th>
<th>Phone</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best Checks</td>
<td>800-521-9619</td>
<td><a href="http://www.bestchecks.com">www.bestchecks.com</a></td>
</tr>
<tr>
<td>Compuchecks</td>
<td>800-333-3494</td>
<td><a href="http://www.compuchecks.com">www.compuchecks.com</a></td>
</tr>
<tr>
<td>EiPrinting</td>
<td>800-245-5775</td>
<td><a href="http://www.checksforless.com">www.checksforless.com</a></td>
</tr>
<tr>
<td>Microsoft Money Checks by Deluxe</td>
<td>800-432-1285</td>
<td><a href="http://www.microsoftchecks.com">www.microsoftchecks.com</a></td>
</tr>
<tr>
<td>PC Checks &amp; Supplies</td>
<td>800-467-0714</td>
<td><a href="http://www.checkstomorrow.com">www.checkstomorrow.com</a></td>
</tr>
</tbody>
</table>
After you know how many checks you want and in what size you want them, your next step is to contact a company that sells checks. Do that by calling the company or visiting its Web site (refer to Table 7-2). I recommend calling the company, because the friendly human on the other side of the phone connection can likely answer all your questions.

When you order checks, you will be asked for the following information, most of which appears on the face of a check:

- Your name, address, and phone number.
- Your bank’s name and the city, state, and ZIP Code in which it is located.
- Your bank’s fractional number, also known as the routing number. When you deposit a check, you usually list the first four numbers of the fractional number on the deposit slip. Here’s an example of a fractional, or routing, number: 66–55/4321.
- Your checking account number.
- The starting check number. See the sidebar “Choosing a starting number for the checks” to discover the ins and outs of choosing a number.
- The size of the checks — wallet-size, standard business, or voucher.
- Whether you have a laser printer, an ink-jet printer, or an antique continuous-feed printer.

### Choosing a starting number for the checks

When you choose a starting number for the checks, be sure to choose one that won’t conflict with the numbers on checks that you write by hand. Bankers frown and even call you on the telephone when you write two checks with the same check number. And if you try to record two checks with the same number in a checking register, a dialog box asks whether you really want to do that.

Writing checks with duplicate numbers is a faux pas, but it is easy to do when you write checks and print checks from the same account. Your spouse, checkbook in hand, could be on a shopping spree while you are at home printing checks. Or, you could write a few checks from the checkbook, forget to record them in Money, and then print checks with the same numbers without thinking about it.

To keep from writing checks with duplicate numbers, choose a starting number for the printed checks that is far, far removed from the check numbers in your checkbook. For example, if the checks in your checkbook are numbered 601 to 650, choose 1501 as the starting check number for printed checks. That way, you can’t write and print checks with duplicate numbers.

Printing the checks that you order isn’t absolutely necessary. You can always tear one off and write it by hand when you buy a pillbox hat at the thrift store or pay for a pizza.
Getting Your Printer Ready to Print Checks

To print checks, Money and your computer have to be on speaking terms. They have to understand each other and be able to work together. And your printer has to know which kind of check to print — a wallet-size check, standard business check, or voucher check.

Very likely, Money and your printer have already been introduced. When you install Money, the program gets information about your printer from the Windows operating system. You probably don’t have to tinker with the printer settings, but you do need to tell the printer what kind of check to print.

Follow these steps to open the Check Setup dialog box and tell your printer everything it needs to know to print checks, including which font to use:

1. **Choose File** ➤ **Print Setup** ➤ **Check Setup**.

   You see the Check Setup dialog box, shown in Figure 7-2.

2. **In the Printer drop-down list, select which printer to print the checks with, if necessary.**

   More than one printer appears in the drop-down list if you or someone else has set up a second or third printer to work with your computer. Select the printer from which you will print the checks.

3. **Click the down arrow on the Type drop-down list and select which style of check you will print.**

   Select an option from the top of the list if you have a laser printer. Choices for continuous-feed printers, also known as pinwheel printers, appear at the bottom of the list. (If you migrated to Money from Quicken, additional choices appear in the Type drop-down list for printing on Quicken check forms. For more details, see Chapter 22.)
4. If necessary, click the down arrow on the Source drop-down list and select the tray through which you will feed checks to the printer.

Don’t bother with the Source drop-down list if your printer has only one tray.

5. Click the Font button and choose a font for printing your checks, if you want.

A font is a typeface design. Unless you choose otherwise, checks are printed in Courier New font in 12-point type. But you can choose a more stylish font or different type size in the Check Printing Font dialog box. Click OK when you’re done.

6. Select the Require Address for Payee When Printing Checks check box if you want payee addresses to appear on your checks.

As long as an address is on file for a person or business to which you write a check, the address appears on the check — that is, it appears if you select this check box. As Chapter 11 explains, Money gets addresses from the Set Up Your Payees window. If you ordered window envelopes along with checks, you can print addresses on the checks, insert the checks in window envelopes, and save yourself the trouble of having to address envelopes. (Later in this chapter, the sidebar “Including addresses on checks” explains how to enter a payee’s address.)

7. If your computer is connected to a network and you intend to print checks on a network printer, click the Network button and select the printer in the Connect to Printer dialog box.

8. Click OK to close the Check Setup dialog box.

Recording Checks that You Intend to Print

Recording a check that you intend to print is not very different from recording a handwritten check. The only difference is that you select Print This Transaction from the Number drop-down list on the Withdrawal form rather than enter a check number, as Figure 7-3 shows.

Chapter 4 explains everything you need or care to know about recording a check, but here are the raw details:

1. Open the checking account register from which you want to write the check.

2. Click the New button.
3. From the Number drop-down list, choose Print This Transaction.

4. Enter the date that you want to appear on the check in the Date text box.

5. Enter the name of the person or business that you are paying in the Pay To text box.
   If you have paid this person or party before, you can enter the payee's name by typing the first couple of letters and pressing Tab.

6. Enter the amount of the check in the Amount text box.

7. Describe the transaction by selecting a category and subcategory.

8. If you want, enter a word or two in the Memo box.
   The words that you type in the Memo box appear on the printed check.

9. Click the Enter button (or press Enter).
   The Print Address dialog box appears.

10. If you want to record an address along with the check, fill out the Print Address dialog box and click OK.
    If you prefer not to see the Print Address dialog box each time you record a check that will be printed, select the Don’t Show Me This Again check box in the Print Address dialog box.

These checks have not been printed yet.
“When does the check get numbered?” you may ask. The check number is entered in the register automatically after the check is printed. Until the check number is entered, the word Print appears in the Num column of the register, as shown in Figure 7-3. Meanwhile, the To Do notice tells you that checks in the register need printing. On the Home Page, the words Print checks also appear under the Reminders notice. (Turn to Chapter 2 to see how to make the Reminders notice appear on the Home Page if it doesn’t appear there.)

When you split a check payment, the split-transaction information appears on the voucher, or stub, of the check, provided that you’re printing on wallet-size or voucher checks. (Wallet-size and voucher checks include a stub.)

Testing to See Whether Checks Print Correctly

Practice makes perfect. The following pages explain how to print a practice check and make adjustments, if necessary, to the way checks are printed.

Printing a practice check

After you’ve recorded a check to print, Print Checks appears in the Reminders notice on the Home Page and under “To Do” on the checking register page (refer to Figure 7-3). You’re ready to go.

Before you print your first check, however, print a practice check. Insert a thin, transparent piece of paper into the printer. After you’re done experimenting, you can lay the sheet of paper over a sheet of real checks and hold both sheets to the light to see whether the text landed in the right places.

Follow these steps to do a test run and see whether your printer handles checks correctly:

1. **Open the checking register, if it is not already open.**
2. **Click the words Print Checks under the To Do notice, or choose File ➪ Print Checks.**

   You see the Print Checks dialog box, shown in Figure 7-4. For now, don’t worry about the confusing options in this dialog box. You’re interested only in the Print Test button.
3. Click the Print Test button.

4. Click the Cancel button to close the Print Checks dialog box.

   Money prints a check with a bunch of Xs on it and the words *This is a VOID check*. How does it look? If all is well, you don’t need to read the next part of this chapter. It explains how to realign checks so that they print correctly.

As I explain in the section “Printing partial sheets of checks,” later in this chapter, to print a partial sheet of checks, you have to load the partial sheet into your printer as if you were loading an envelope. If you want to test how partial sheets print, follow the instructions here, but click the Two or the One option button in the Print Checks dialog box before running the test. Then tear off a practice check or two (or cut off part of the practice piece of paper that you’re using), load the partial sheet into your printer, and click the Print Test button.

### Making adjustments to the text alignment

So, everything is slightly out of whack on your check? You can do something about that if you’re using a laser or ink-jet printer. Visit the Print Checks tab in the Options dialog box and change the vertical and horizontal alignment settings. (If you’re using a dot-matrix printer, you can fix the problem the old-fashioned way — by adjusting the sprockets on the printer.)
Take note of roughly how far out of position the text is and then do the following to realign the text so that it falls correctly on your checks:

1. **Click the words Print Checks under the To Do notice at the left of the register, or choose File➪Print Checks to see the Print Checks dialog box.**

2. **Click the Options button.**
   As shown in Figure 7-5, you see the Print Checks tab in the Settings dialog box.

At the bottom of the tab are four text boxes for changing the horizontal (side-to-side) and vertical (up-and-down) alignment of text on sheets with all three checks and on partial sheets. The horizontal boxes move the text left or right on the check. The vertical boxes move it up or down.

3. **Enter a number or numbers in the text boxes.**

   Enter a 1 to move text by a sixteenth of an inch, enter a 2 to move it by an eighth (two-sixteenths) of an inch — you get the idea.

   To move text side to side, click in one of the horizontal text boxes and enter a positive number to move the text toward the right or a negative number to move it toward the left.

   To move text up or down, click one of the vertical text boxes and enter a positive number to move the text down or a negative number to move it up.
4. Click OK when you’re done.
   You return to the Print Checks dialog box.

5. Click the Print Test button.

   I hope the check prints correctly this time. If it doesn’t, return to the Settings dialog box and keep trying. As the prelate said to the layman, “Persistence and perseverance made a bishop of his reverence.”

Printing Your Checks

The moment of truth has now arrived. You’re ready to print the checks. If only printing money were this easy. These pages explain how to print a full sheet of checks and a partial sheet of checks. If you use wallet-size or standard business checks, the day will arrive when you have only one or two checks left on a sheet. Printing a partial sheet of checks requires a little extra work.

Printing a full sheet of checks

Take note of the number on the first check that you intend to print on, load a sheet or two of checks into the printer, and then follow these steps to print on a full sheet of checks:

1. Open the checking register and click the words Print Checks under the To Do notice, or choose File ➪ Print Checks.
   You see the Print Checks dialog box (refer to Figure 7-4).
   The top of the dialog box lists how many checks need printing and how large of a bite the checks will take out of your checking account. If the bite is too large, you can always click the Selected Checks option button and tell Money to print fewer checks, as Step 4 demonstrates.

2. If necessary, enter a new check number in the Number of First Check in Printer text box.
   The Number of First Check in Printer text box lists what Money thinks is the next available check number. This number may be wrong. Compare it to the first paper check that you loaded in the printer, and enter a new number, if necessary.

3. Make sure that the Three option button is selected.
   The Three button tells Money to print a full sheet of checks. By the way, if you’re printing voucher checks, which come one to a page, you don’t see the Three, the Two, or the One option button because you can print only one check on each page.
4. Select the All Checks option button to print all the unprinted checks in the register; select the Selected Checks option button to pick and choose which ones to print.

Selecting the Selected Checks option button opens the Select Checks dialog box, as shown in Figure 7-6. To begin with, all the checks are selected, or highlighted, in the dialog box.

To print a handful of these checks, either click the Select None button to deselect all the checks and then click each one that you want to print, or simply click each check that you don’t want to print to take its highlighting away and deselect it. Click OK to return to the Print Checks dialog box.

5. Click the Print button.

The Print Checks dialog box shows you the numbers of the checks that “should have printed correctly.” Examine the checks to see whether they printed correctly.

6. Click the Finish button if the checks printed correctly; click the Reprint button if they didn’t print correctly.

If, woe is me, you have to click the Reprint button, then turn a couple of pages ahead to the section “Whoops! My Checks Didn’t Print Correctly.” That section explains what to do next.

Compare the numbers on the printed checks to the numbers in the Num column of the checking register to make sure that the numbers match. And be sure to sign the checks.

**Printing partial sheets of checks**

Wallet-size and standard business checks come three to a sheet, which makes printing them slightly problematic. After you print the first check on the sheet,
for example, you are left with two blank checks. It would be a shame to waste them, so Money offers options in the Print Checks dialog box for printing on partial sheets.

To take advantage of the partial sheet options, you may have to get out the dreary manual that came with your printer. You have to find out how your printer accepts envelopes. Find out whether envelopes are fed to your printer in the center or along the side of the paper tray. Find out as well whether envelopes are fed right-edge first or left-edge first. The settings that apply to envelopes also apply to partial sheets of checks.

The previous section in this chapter explains how to print a full sheet of checks. The only difference between printing a full sheet and a partial sheet of checks is that you have to do three important things in the Print Checks dialog box (refer to Figure 7-4):

- Select the Two or the One option button to tell Money how many checks remain on the sheet.
- Select the Paper Fed option button that describes where on the paper tray the paper is fed to your printer (in the center or on the side).
- Select the Paper Inserted option button that describes which edge of the paper is inserted in your printer first (right or left edge).

---

**Including addresses on checks**

As long as an address is on file for a person or business to which you write a check, the address appears on the check — that is, it appears on the check as long as you select the Require Address for Payee When Printing Checks check box in the Check Setup dialog box. To get to that dialog box, choose File ➪ Print Setup ➪ Check Setup.

Money gets addresses from the Payees Details window, as Chapter 11 explains. To enter or view a payee’s address, follow these steps:

1. **Click the Banking tab to go to the Account List window.**
2. **Click the Account Tools button and choose Categories & Payees.**
3. **Click the Payees link.**
   
   You can find this link on the left side of the window. You see a list of payees after you click it.

4. **Either double-click the payee for whom you want to enter an address or select the payee and then click the Go to Payee button.**
   
   You see the Payees window, with boxes for entering addresses and other kinds of juicy information.

5. **Enter an address.**
   
   The address that you enter appears on printed checks if you instruct your printer to print addresses.
As someone who writes and edits computer books, I shouldn’t admit it, but I have a phobia of printers. I hate them. Rather than dicker with the options for printing on partial sheets of paper, I always try to print checks three at a time. That way, I never have to agonize over the partial sheet options. You can easily find a second or third bill that needs paying and use it to round out a check sheet. And if I can’t find a second or third bill, I simply tear off the extra checks, carry them to a store, and use them like handwritten checks.

**Whoops! My Checks Didn’t Print Correctly**

If you had to click the Reprint button in the Print Checks dialog box because your checks didn’t print correctly, all is not lost; Money gives you a second chance to print the checks. When you click the Reprint button, the Select Checks to Reprint dialog box, shown in Figure 7-7, appears. From this dialog box, you tell Money which checks to reprint.

Before you reprint wallet-size or standard business checks that didn’t print correctly, you may have to load the sheets sideways in your printer. Wallet-size and standard business checks come three to a sheet, so you have to load them sideways when only one or two checks remain on a sheet. The previous section of this chapter explains all the issues that pertain to printing on partial sheets.
After you click the Reprint button in the Print Checks dialog box, follow these steps to reprint checks:

1. **Select the checks that need reprinting.**
   As you click each check in the Select Checks to Reprint dialog box, the check is highlighted.

2. **Make sure that the number in the Begin Reprinting Checks at Check Number text box is correct, and if it isn’t, enter a new number.**
   This number should match the number on the first check that is loaded in your printer.

3. **Make sure that the number in the Checks Remaining on Sheet text box is correct; enter a new number if necessary.**

4. **Click OK.**
   The Print Checks dialog box appears.

5. **Examine your checks and click the Finish button if the checks printed correctly; click the Reprint button if they didn’t print correctly.**
   As someone who has had to battle with printers, I hope that you don’t have to click the Reprint button again.

Be sure to write **VOID** on checks that didn’t print correctly and file them away with your canceled checks. That way, you have a record of what happened to them.

And on the subject of checks that didn’t print correctly, what happens if you have to reprint three or four checks and you end up with a three- or four-check gap in the checking register? If you’re a stickler for keeping good records, enter a transaction in the checking register for each check that needed reprinting and void it. In other words, if you botched check 1501 and reprinted it, enter a check transaction, give it number 1501, right-click the transaction, and choose **Mark As: Void** from the shortcut menu (or press Ctrl-V).
Part III

Money for Investors

The 5th Wave

By Rich Tennant

"Get ready, Mona—here come the stats."
In this part . . .

I hope you didn’t come to this part of the book expecting to find 10-, 20-, and 50-dollar bills folded between the pages. No, you have to get money for your investments elsewhere. After you do, though, you can use Microsoft Money to track your investments.

In Part III, you discover how to record the sale and purchase of mutual fund shares, stock shares, and bonds. You find out how to set up an electronic investment portfolio and examine the investments in the portfolio in different ways. You also discover how to update your investments and research investments online.
In order to track investments, you have to set up accounts. Investment accounts work much like checking or savings accounts. Each transaction — each sale or purchase of stock shares, for example — is recorded in an account register. After you set up investment accounts, you can start recording your investment activity and, more important, you can see how well your investments are performing.

In this chapter, you find out how to set up an electronic investment portfolio with investment accounts, accounts for tracking your retirement investments, and accounts for tracking employee stock options. You also find out how to create a Watch account — an account for monitoring stocks, bonds, and mutual funds you don’t own but are curious about.

Your Own Electronic Portfolio Manager

A portfolio is a collection of investments. After you set up investment and retirement accounts, you can click the Investing tab and see an electronic version of your portfolio, as shown Figure 8-1. After you have set up a portfolio like this one, recording investment transactions is easy. What’s more, the Portfolio Manager window is an excellent place to start analyzing your investments.
Looking at Figure 8-1, you can see the following:

- **The names of the investment or retirement accounts:** Create one investment or retirement account for each statement you receive from a brokerage house, each financial institution you buy certificates of deposit (CDs) or other investments from, and each retirement plan that you participate in. Doing so makes keeping the records easier because you can enter data in the account straight from the brokerage or bank statement and even reconcile your account from the statements that you receive in the mail.

- **The names of the individual investments:** After you set up the accounts, you list the names of the securities — the stocks, bonds, mutual funds, CDs, and so on — that belong in the account. You can then record purchases, sales, share reinvestments, capital gains, dividends, stock splits, and so on in the register.

- **The grand total value of your investments:** This sum appears at the bottom of the window, along with the year-to-date return of your investments.

When your portfolio is complete, you can see at a glance the market value and price of each investment. By changing views, you can see how your investments perform, how they have changed in value, and how you have allocated them, among other things. By clicking the Analyze My Portfolio link, you can analyze investments in various ways.
Before you can analyze your investments, you need to set up an investment account, retirement account, or Employee Stock Option account:

- Create a retirement account to track 401(k)s, Keoghs, SEPs (Simplified Employee Pensions), and IRAs.
- Create an investment account to track stocks, bonds, securities, annuities, treasury bills, precious metals, real estate investment trusts (REITs), and unit trusts.
- Create an Employee Stock Option account to track stock options you receive from the company you work for.

Setting Up an Investment Account for Tracking Securities

The first step in tracking investments is to create a new account for each institution or brokerage house that you trade securities with. After you set up an investment account, you describe the securities that the account tracks. Spread the last statement from the bank or brokerage house across your desk and follow these steps to set up an investment account:

1. Click the Investing tab to go to the Investing window.

After you set up your investment account, its name appears in this window.

2. Click the Portfolio Manager link.

You see the Portfolio Manager window (refer to Figure 8-1). You can also reach this window by clicking the Investment Tools button and choosing Portfolio Manager on the drop-down menu.

3. Click the Work with Accounts link and, on the submenu that appears, choose Add an Account.

The Choose an Account Type window, shown in Figure 8-2, appears. This is your starting point for creating investment, retirement, and employee stock option accounts.
4. Click the Investment option button and then click the Next button.

The Select a Bank or Brokerage window appears. In this window, you tell Money the name of the brokerage house or bank where you maintain your investment account.

Money has made arrangements with some brokerages and banks so that you can enter investment-account transactions into your Money investment-account register by downloading transaction records from your bank or brokerage house. This spares you the trouble of entering the transactions yourself. If your bank or broker has this arrangement with Money and you want to be able to download transactions from your bank or broker, you may be asked to supply the password that your broker or bank gave you in the steps that follow.

Regardless of whether Money has made an arrangement with your broker or bank to download transactions, everyone can update the price of securities online as long as the securities are publicly traded (Chapter 9 explains how to update security prices online). In other words, everyone who uses Money can update the price of the securities he or she owns by downloading the prices from the Internet. The only advantage of being able to download directly from a broker or bank is that you don’t have to enter buy or sell transactions yourself.

5. Click the first letter in the name of your brokerage house or bank, select the name from the list, and click the Next button.

What happens next depends on whether your brokerage house or bank is on the list and whether you can download transaction information straight from your bank or broker:

- **Name on the list, can download directly:** You see the Do You Already Have Sign-In Information? window. Collect the User ID and password information you received from your bank or broker and click the Yes button. In the windows that follow, you enter your User ID and password, and you tell Money what kind of data you want to download from your bank or broker.

  If you don’t have your User ID, password, or other necessary information, click the Finish Later button. After you obtain this information, go to the Account List window and click the Provide Sign-in Information link next to your investment account’s name. Then fill in the windows to provide the information.

- **Name on the list, settings change needed:** You see the Settings Change Required for Online Updates at This Bank window. Click the Update Your Accounts Manually link. You see the Choose an
Account Type window. Select the Investment option and click the Next button. The New Account dialog box appears. Go to Step 6. (Later, to make the required settings changes, click the Provide Sign-in Information link next to your investment account’s name in the Account List window.)

- **Name on the list, can’t download directly:** You see the Choose an Account Type window. Select the Investment option and click the Next button. The New Account dialog box appears. Go to Step 6.

- **Name not on the list:** Click the My Bank or Brokerage Isn’t Listed link (it is located at the bottom of the window). The Choose an Account Type window appears. Select the Investment option and click the Next button. The New Account dialog box appears. Go to Step 6.

6. **Enter a name for your account in the New Account dialog box and click Next.**

   The name you enter will appear in the Account List window after you finish setting up the account. For convenience’ sake, you may want to enter the name of the brokerage house where you keep the account.

7. **Click the Taxable or Tax Deferred or Tax Free option button to specify whether the money you track in this account is tax deferred; then click the Next button.**

   *Tax deferred* means that you don’t have to pay income tax on the money that the account generates until you begin withdrawing it at retirement age. Probably the option to select is Taxable. Most tax-deferred accounts are retirement accounts (how to set up a retirement account is explained shortly).

8. **In the next dialog box, click the No, I’ll Do This Later option button; then click Next.**

   Chapter 9 explains how to record security transactions in an Investment account.

9. **In the next dialog box, enter the approximate value of the account in the Investments text box, as shown in Figure 8-3.**

   Don’t worry about being accurate with these figures — they are used for planning and estimating purposes only. You can get the estimated value of the investments in the account from your most recent statement. Don’t include cash in the estimated value of the account if you keep cash as well as investments in the account. If you recently sold a security or made a deposit in the account, it likely includes a bit of cash.
10. Enter the amount of money in the account in the Cash text box.

As the dialog box explains, you can estimate the amount of money in the cash account if you want. The amounts you enter in the dialog box are used for planning purposes.

11. Click the Finish button.

You go to the Portfolio Manager window, where your new account is listed. Of course, it’s also listed in the Account List window.

After you set up the investment account, right-click its name in the Account List window and choose See Account Settings on the shortcut menu. You go to the Change Account Settings window, where you can enter the name and phone number of your broker. You need that information in case you need to call your broker. You can enter other useful information in the window as well.

**Setting Up a Retirement Account for Tracking Retirement Savings and Investments**

Create a retirement account to track stocks, mutual funds, and bonds you own as part of a 401(k) plan, Keogh plan, SEP (Simplified Employee Pension) fund, or IRA. Income from these accounts is tax deferred. You don’t have to pay taxes on the income until you start withdrawing it at retirement age.
Follow these steps to set up an account for tracking the tax-deferred investments you have made for your retirement:

1. **Click the Investing tab to go the Investing window.**
   The name of your retirement account will appear in this window after you have set it up.

2. **Click the Portfolio Manager link.**
   You see the Portfolio Manager window (refer to Figure 8-1). You can also get to this window by clicking the Investment Tools button and choosing Portfolio Manager on the drop-down menu.

3. **Click the Work with Accounts link and, on the submenu, choose Add an Account.**
   The Choose an Account Type window appears (refer to Figure 8-2).

4. **Select the Retirement option button and then click the Next button.**
   You see the Select a Bank or Brokerage window, where you tell Money the name of the brokerage house or bank where you maintain your investment account.

   Some brokerages and banks permit you to enter retirement-account transactions into your Money investment account register by downloading transaction records from your bank or brokerage house. Downloading the transactions spares you from having to enter the transactions yourself. If your bank or broker can download transactions to your computer, you may be asked to supply the password that your broker or bank gave you in the steps that follow.

   Whether your broker or bank permits you to download transactions, you can update the price of securities online as long as the securities are publicly traded (Chapter 9 explains how to update security prices online). Everyone who uses Money can update the price of the securities they own from the Internet.

---

**Know the tax status of your investment**

Don’t confuse tax-deferred income with tax-exempt income. Income from a tax-deferred account is not taxed until you start withdrawing money from the account. In contrast, you never have to pay any tax on tax-exempt income. Most retirement accounts are tax deferred, not tax exempt.
5. Click the first letter in the name of your brokerage house or bank, select the name from the list, and click the Next button.

What you do next depends on whether your brokerage house or bank is on the list and whether you can download transaction information straight from your bank or broker:

- **Name on the list, can download directly**: You see the Do You Already Have Sign-In Information? window. Collect the User ID and password information you received from your bank or broker and click the Yes option button. In the windows that follow, you enter your User ID and password and tell Money what kind of data you want to download from your bank or broker.

  If you don’t have your User ID, password, or other necessary information, click the Finish Later button. After you obtain this information, go to the Account List window and click the Provide Sign-in Information link next to your investment account’s name. Then fill in the windows to provide the information.

- **Name on the list, settings change needed**: You see the Settings Change Required for Online Updates at This Bank window. Click the Update Your Accounts Manually link. You see the Choose an Account Type window. Select the Investment option and click the Next button. The New Account dialog box appears. Go to Step 6. (Later, to make the required settings changes, click the Provide Sign-in Information link next to your investment account’s name in the Account List window.)

- **Name on the list, can’t download directly**: You see the Choose an Account Type window. Select the Investment option and click the Next button. The New Account dialog box appears. Go to Step 6.

- **Name not on the list**: Click the My Bank or Brokerage Isn’t Listed link (it is located at the bottom of the window). The Choose an Account Type window appears. Select the Investment option and click the Next button. The New Account dialog box appears. Go to Step 6.

6. Enter a name for the account in the New Account dialog box and click the Next button.

   The name you enter will appear in the Account List window after you finish setting up the account.

7. In the next dialog box, shown in Figure 8-4, select the type of retirement account you want to set up; then click the Next button.
If you aren’t sure what kind of retirement account you are dealing with, refer to the glossary or click an account type and read its description in the dialog box.

8. **In the next dialog box, select the No, I’ll Do This Later option button; then click Next.**

In Chapter 9, I show you how to record transactions in the account.

9. **In the next dialog box, enter the approximate value of the account in the Investments text box.**

   These figures are used strictly for planning and estimating purposes. You will be given ample opportunities to enter the exact numbers later on. Check your recent statement for the estimated value of the investments in the account. If cash is in the account at present, don’t include it in the estimated value.

10. **Enter the amount of money in the account in the Cash text box.**

    As the dialog box explains, you can estimate the amount of money in the cash account if you want.

11. **Click the Finish button.**

    You go to the Account List window, where the name of your new account appears in all its glorious splendor.

    Right-click the name of your new retirement account in the Account List window and choose See Account Settings on the shortcut menu. You go to the Change Account Settings window, where you can enter your broker’s name and phone number and other useful information.
Setting Up an Account to Track Employee Stock Options

If you are fortunate enough to work for a company that offers stock options to its employees, you can track the value of that stock with Money. To do so, create an investment account (see the section “Setting Up an Investment Account for Tracking Securities,” earlier in this chapter), fill in the New Account dialog boxes, and choose Employee Stock Option when you are asked what kind of account you want to set up (refer to Figure 8-3).

Follow these steps to set up an account for tracking your employee stock options:

1. Click the Investing tab to go to the Investing window.
   The name of the employee stock option account will appear in this window after you have set it up.

2. Click the Portfolio Manager link.
   The Portfolio Manager window appears (refer to Figure 8-1). You can also see this window by clicking the Investment Tools button and choosing Portfolio Manager on the drop-down menu.

3. Click the Work with Accounts link and, on the submenu, choose Add an Account.
   The Choose an Account Type window appears (refer to Figure 8-2).

4. Click the Employee Stock option button and then click the Next button.
   The Choose Level of Detail window appears, as shown in Figure 8-5.

5. Enter a name for the account in the Account Name text box.
6. Choose the first option button (and enter the value of your company stock in the Total Value text box) if you simply want to track the stock’s value; choose the second option and click the Next button if you want to update the stock’s value online or you want to track the value of the stock because you are vested in company shares.

In most companies, employees are not given stock outright. Instead, they become vested in the stock they own over a period of time.

If you chose the first option, Just Track the Total Value, click the Finish button.

If you chose the second option, you see the first of several New Employee Stock Option dialog boxes. Proceed to Step 7.

7. Speed-read the dialog box, which tells you how you will suffer through the next seven steps, and click the Next button.

8. Enter the stock’s name and click the Next button.

9. Enter the stock’s ticker symbol, if you know it, and click the Next button.

If stock in your company is not publicly traded — if your company is held in private hands — the stock doesn’t have a ticker symbol yet. You can click the Find Symbol button to look up the ticker symbols of publicly traded companies.

10. Click the Online Quotes button if you suspect that the stock has been split recently; then click the Next button.

A stock split is when shares are divided to lower the share price. In a 2-for-1 split, for example, stock owners are given twice as much stock, but the value of individual shares is half of what it was before the split.

11. Enter the strike date, how many shares you were granted, and the strike price in the following dialog box; then click the Next button.

The strike price is the closing price of the stock on the day it was given to you. Be sure to correctly enter the date you were given the stock. Money needs that date to correctly calculate the value of the stock over time.

12. Enter a name for the stock grant in the Grant Name text box and click the Next button.

13. Describe how your company’s plan calls for you to be vested in the stock you were granted; then click the Next button.

As shown in Figure 8-6, the next New Employee Stock Option dialog box is for telling Money how quickly or slowly the stock grant becomes yours. Typically, employees do not receive their stock option grant all at once. They earn it over a period of months or years.
14. Click the Finish button.

When you finish setting up the account, open its register. If you set up a vesting schedule for the ownership of your stocks, you see future entries that describe when you will receive new stock as part of the vesture. As you update the stock price in this register, it shows the stock’s value.

**Tracking Securities You Don’t Own in a Watch Account**

Suppose that you want to track a stock, mutual fund, money market fund, or other security that you don’t own, perhaps to decide whether you want to buy it later. You can do that by placing the security in the Watch account, a special investment account that Money maintains for monitoring security prices.

Getting price quotes for securities on the Watch List is a great way to find out from day to day or week to week how a potential investment performs. You can even download index prices in order to compare and contrast the securities you own to the performance of an index.

Follow these steps to create a Watch account:

1. **Click the Investing tab to go the Investing window.**
2. **Click the Portfolio Manager link.**
   
   The Portfolio Manager window appears (refer to Figure 8-1).
3. **Click the Work with Accounts link and, on the submenu, choose Add an Account.**
   
   The Choose an Account Type window appears (refer to Figure 8-2).
4. Click the Watch option button and then click the Next button.

You see the New Account dialog box, as shown in Figure 8-7.

![Figure 8-7: Listing securities in a Watch account.]

5. Enter a name for your Watch account in the Type a Name for the Account text box.

6. Click the Find Symbol button.

The Find Symbol dialog box appears, as shown in Figure 8-8. Use this dialog box to find ticker symbols for the securities you want to track.

![Figure 8-8: Finding a ticker symbol.]

Enter a name.  Click Find.  Double-click a symbol.
7. For each security you want to track, enter a stock, mutual fund, option, or index name in the Enter Name text box; click the Find button; double-click a ticker symbol in the Make Your Selection box. The ticker symbols appear in the New Account dialog box.

8. If you want, you can play being an investor by selecting the Make This Account a Model Portfolio check box and making choices in the bottom half of the New Account dialog box.

Select an option button to pretend you own 100 shares of each security, pretend you own $10,000 worth of each security, or pretend that all the securities you are tracking are worth $10,000 (or another sum you enter in the Total Value text box).

9. Click the Finish button.

Your Watch account appears alongside all your other accounts in the Account List window. In the Portfolio Manager window, the Watch account is marked with a binoculars icon.

Next time you download quotes from the Internet, you can see how the investment has performed. Right-click a security and choose See Price History to see a chart that shows how well or poorly the security has performed in the past six months.
Chapter 9

Tracking the Value of Your Investments

In This Chapter

- Recording payments to and from brokers
- Describing the investments you own so that Money can track them
- Recording stock transactions
- Recording mutual fund transactions
- Recording bond transactions
- Tracking the value of precious metals and CDs
- Editing and deleting investment transactions
- Updating the price of a security

After you have gone to the significant trouble of setting up investment and retirement accounts, the next step is to describe the investments you own and track in your investment and retirement accounts. For each investment, you tell Money what kind of security you are dealing with — stocks, mutual funds, or bonds. You enter the value of the security and, if possible, a ticker symbol so that Money can track the security’s value by downloading prices from the Internet.

This chapter explains how to trade — how to buy, sell, redeem, disburse, and record interest payments from — different types of securities. When you are finished reading this chapter, you will know precisely how much your investments are worth. You will be able to track the value of your investments and determine whether they are performing like nags or thoroughbreds.
Recording Payments to (and Disbursements from) Brokers

It might seem kind of odd, but when you write a check to your broker so that he or she can purchase securities on your behalf, or when you make a contribution to a retirement account, you record the check in Money as a transfer from your checking account to the account where you track your investments or retirement savings.

Follow these steps to record the check that you write to your brokerage house or bank for securities purchases:

1. Open the checking account register where you will record the check.
2. In the transaction form, click the Transfer tab.
   Figure 9-1 shows the transfer tab.

   ![Figure 9-1: Record payments to brokers as money transfers.]

3. Enter the check number in the Number text box.
4. In the To drop-down list, select the name of the investment or retirement account where you track investment activity.
5. In the Pay To text box, enter the name of your broker or bank.
   Enter the name that you will write on the check.
6. Enter the amount you are contributing to your investment or retirement account in the Amount text box.
7. Click the Enter button.

On the other side, in the investment or retirement account, the transfer is recorded as a deposit. The cash in investment and retirement accounts is used to pay for stock, bond, and other security purchases. To open the investment or retirement account register where you transferred the money, right-click the transfer transaction in your checking account register and choose Go to Account on the shortcut menu.
Similarly, when you sell or collect interest on a security, the proceeds are recorded as a cash deposit in the Deposit column of the investment or retirement account. Suppose that you decide to take money out of an investment or retirement account. When the check comes from your broker and you deposit it in your bank account, record the transaction as a transfer from your investment or retirement account to your checking or savings account. For example, if you sell a stock and the proceeds come to $400, record the transaction as a $400 transfer from your investment account to the checking account where you deposit the $400.

You can click the Cash Transactions link (found on the left side of the register window) when you are looking at an investment or retirement account to see money transfers in and out of the account.

**Describing the Securities in Investment and Retirement Accounts**

After you set up an investment or retirement account, you must describe each security in the account. Securities are the stocks, mutual funds, certificates, bonds, or other financial instruments that the account tracks. Gather the paperwork and follow these steps to describe each security that you own. If you just purchased more shares of a security that you already own and have already described in an investment or retirement account, skip ahead to “Handling Stocks” or “Handling Mutual Funds,” later in this chapter.

1. Click the Investing tab.
2. In the Investing window, click the Portfolio Manager link.
   
   You land in the Portfolio Manager window. You can also get there by clicking the Investing Tools button and choosing Portfolio Manager from the drop-down menu.

3. Click the Work with Investments link and then choose Set Up a New Investment from the drop-down menu.
   
   You’ll find the Work with Investments link under Common Tasks on the left side of the window. After you click Set Up a New Investment, the first New Investment dialog box appears.

4. Click the down arrow to open the Account drop-down list; then choose the investment or retirement account where you track the security and click Next.
   
   If no account names appear on the menu, you haven’t set up an investment or retirement account yet. Chapter 8 explains how to do that.
5. In the Investment Name text box, select the appropriate option button and enter the security’s name or ticker symbol; then click Next.

If you entered a ticker symbol, Money knows the name of the investment and what type of investment you are tracking, you see the Transaction Details dialog box, and you can skip ahead to Step 8. If you entered a name instead of a ticker symbol, you see the Create New Investment dialog box, shown on the left side of Figure 9-2. In this dialog box, you tell Money what kind of investment you are tracking.

![Create New Investment: Pepsi](image1)

6. Select an option to describe the security and then click Next.

Which dialog box you see next depends on which option you selected. In Figure 9-2, I chose the Stock option, so the New Stock dialog box asks me to enter the stock’s symbol. Except for bonds, Money asks for your investment’s ticker symbol. In the case of a bond, you will be asked for the coupon rate, interest paid, maturity date, and call date.

7. Fill in the New dialog box or boxes and then click the Finish button.

If you can, enter the ticker symbol for your mutual fund, stock, or money market fund in the New dialog box (refer to Figure 9-2). That way, you can update the security’s price from the Internet and save a lot of time that you would otherwise spend updating the price by hand. If you don’t know the
ticker symbol, look for it carefully on your brokerage statement — you can usually find it there. Or try clicking the Find Symbol button to go on the Internet and find the ticker symbol.

If you are describing a bond you purchased, see “Recording the purchase of a bond,” later in this chapter.

8. **In the following dialog box, shown in Figure 9-3, enter in the Quantity text box the number of shares of the security you own.**

For mutual funds and stocks, enter the number of shares you own. If you are describing the purchase of a single CD or bond, enter 1. For investments such as precious metals, enter the number of ounces or other unit of measurement.

9. **In the Date Acquired text box, enter the date that you purchased the security; enter the price per unit you paid in the Price text box; enter the commission if you paid one in the Commission and Fees text box; click the Next button.**

When you enter share prices of stock, you can enter fractions. For example, you can enter 50½ or 10¾. Money converts the entry to a decimal.

If you are tracking the value of this security from the day you bought it, be sure to enter data about your original purchase. You may have bought more shares in the security or sold shares in the past. The value may have gone up or down. You need to enter purchase data as of the date you entered back in the Date Acquired text box.
Handling Stocks

Keeping track of stocks is probably the most problematic task you will ever undertake with Money. Merely figuring out what a short sell is, not to mention a margin buy and a stock split, is hard enough to begin with. How can you record these strange events in an investment or retirement account register?

Read on, friend, and you can discover how to record everything from stock sales and purchases to short sells and margin buys.

Recording a Purchase of Stocks

When you purchase shares of a stock, follow these steps to record the purchase:

1. Click the Investing tab.

2. In the Investing window, click the Investing Tools button and choose Portfolio Manager from the drop-down menu.

   The Portfolio Manager window appears.

3. Click the Work with Investments link and then choose Record a Buy from the drop-down menu.

   You see the Edit Transaction dialog box.

4. On the Inv. Account drop-down menu, select the name of the investment or retirement account where you want to record the purchase of the stock shares.

5. In the Date text box, enter the date you purchased the stocks.

   Be sure to enter the date correctly. Money needs this date to calculate the stock’s value over time.

6. In the Investment drop-down menu, click the arrow and select the stock from the drop-down list.

   If this is the first time you have purchased shares of this stock, you see the Create New Investment dialog box (refer to Figure 9-2). The section
“Describing the Securities in Investment and Retirement Accounts,” earlier in this chapter, explains how to handle the Create New Investment dialog boxes.

7. Select Buy from the Activity drop-down list.

New text boxes — Activity, Transfer From, Quantity, Price, Commission, and Total — appear for describing the stock purchase, as shown in Figure 9-4.

8. In the Quantity text box, enter the number of stock shares that you purchased.

When you enter share prices of stock, you can enter fractions. For example, you can enter 50½ or 10¼. Money converts the entry to a decimal.

9. In the Price text box, enter the price per share of the stock.

10. In the Commission text box, enter the commission (if you paid one).

The amount in the Total text box should now equal the total purchase price for the stock that is listed on your statement. If the amount isn’t correct, review your statement and enter the correct quantity, price, and commission.

11. Click the OK button.

The purchase of the stock is entered in your account register.

---

**Recycling the sale of stocks**

Except for the problem of lots, recording the sales of stocks is pretty simple. A lot is a group of securities purchased at the same time for the same price (and also a nephew of Abraham whose wife got turned into a saltshaker, but that’s another story). Suppose that you buy 10 shares of Burger Heaven at $10 per share in January and then buy 10 more shares of the same company at $20 per share in February. In March, you sell 15 shares. How many shares you sell from the $10 lot and the $20 lot is important in determining how much profit you make and how much you have to pay in capital gains taxes. Fortunately, Money can help you decide which shares to sell.
To see which stock lots you have purchased, click the name of the stock in the Portfolio Manager window (click the stock's name, not its ticker symbol). You see a miniregister with recently made transactions, as shown in Figure 9-5. Click the More Investment Data button in the miniregister and choose View Lots from the pop-up menu. As shown in Figure 9-5, the View Lots dialog box shows you which lots you purchased and how much you paid for the stock in each lot.

Follow these steps to record the sale of stock shares:

1. Click the Investing tab and, in the Investing window, click the Portfolio Manager link.
   You land in the Portfolio Manager window.

2. Click the Work with Investments link and then click Record a Sell on the submenu.
   As shown in Figure 9-6, the Edit Transaction dialog box appears.

3. On the Investment drop-down menu, choose the investment with the shares you're selling.
4. In the Quantity text box, enter the number of shares that you sold; enter the price per share in the Price text box.

5. If a commission was charged on the sale, enter the amount of the commission in the Commission text box.

Money enters the total amount of the sale in the Total text box. If the figure is incorrect, double-check the Quantity and Price text boxes to make sure that you entered the numbers correctly.

6. Click the OK button.

An Advisor FYI Alerts message box informs you whether you need to pay capital gains taxes or the sale resulted in a capital loss. The proceeds from the sale are deposited in your investment or retirement account. See “Recording Payments to (and Disbursements from) Brokers,” earlier in this chapter, to find out how to handle profits from a sale of stock in your account registers.

That’s all there is to it — unless you purchased the shares in different lots. In that case, you see the What Shares Should I Use? dialog box after you click the OK button. Unless you tell it otherwise, Money assumes that you want to sell the shares in the lot that you purchased first. To do that, simply click the Finish button. But if you want to sell shares from different lots, follow these steps to tell Money which shares you want to sell:

1. Click the first option, Let Me Specify Which Shares to Sell or Transfer, and then click the Next button.

You see the Allocate Lots dialog box.

In this dialog box, you can select shares yourself from the lots, as the following steps demonstrate; you can click the Maximum Gain button to sell lots and pay the most capital gains taxes; or you can click the Minimum Gain button to sell lots to minimize your capital gains.

2. In the top of the dialog box, click one of the lots from which you sold shares.

3. In the Enter Shares to Allocate from Lot Above text box, enter the number of shares you sold from the lot.

4. Select another lot and repeat Steps 2 and 3 to tell Money how many shares you sold from it.

After you’re done declaring which shares you sold, the Total Selected and Total to Allocate numbers in the dialog box should be the same.

5. Click the Finish button.

Be sure to notify your broker of which shares you want to sell. If you forget to do that, your broker may assume that you want to sell shares beginning with the first lot you purchased. Chapter 14 explains how to investigate the capital gains tax you have to pay on the sale of a security.
If you incorrectly allocated shares from different lots you purchased, right-click an investment name and choose Reallocate Lots from the shortcut menu.

Recording and reinvesting dividends from stocks

Most stocks pay dividends, which means that you have to record dividends as they arrive. And rather than pay dividends in cash, some stocks give shareholders the opportunity to buy more shares with their dividends as part of a DRIP (dividend reinvestment program). The advantage of reinvesting a dividend is that you often don’t have to pay a broker’s commission to purchase the new stock.

To record a dividend or the reinvestment of a dividend, start from the Portfolio Manager window and click the name of the stock that paid a dividend. Then, in the miniregister, click the New button. You see the Add Transaction dialog box. Select Dividend or Reinvest Dividend from the Activity drop-down list and do one of the following:

- **Recording a dividend:** In the Total text box, enter the amount of the dividend. Make sure that the correct account name appears in the Transfer To drop-down list. Click OK when you’re done.

- **Recording a dividend reinvestment:** Enter the number of shares you purchased with the dividend in the Quantity text box, the price per share in the Price text box, and any commission in the Commission text box. Make sure that the total in the Total text box is correct before you click the OK button.

Recording stock splits, short sells, margin purchases, and other esoterica

The stock market, it seems, has a hundred different ways to trade stock, handle stock sales, and handle stock purchases. I suspect that the brokers like it that way because it makes them appear indispensable. Fortunately, you can use Money to record certain kinds of oddball stock trades and sales.

**Stock splits**

Occasionally, stock shares are split to lower the price of individual shares and make them more attractive to investors. In a 2-for-1 split, for example, investors are given twice as much stock, but the value of individual stocks is half what it was before, so the owner of 100 shares worth $2,000 now owns 200 shares worth the same amount, $2,000.
Follow these steps to record a stock split:

1. **Starting from the Portfolio Manager window, click the Record a Special Activity link and then choose Record a Split from the submenu.**
   You see the Split Shares dialog box.

2. **Click the Investment down arrow and select the stock that was split from the drop-down list.**

3. **Enter the date that the stock was split in the Date text box.**

4. **In the Split the Shares text boxes, enter the ratio of new stocks to old ones.**
   For example, in a 2-for-1 split, enter 2 in the first box and 1 in the second box.

5. **Click OK.**
   In the Portfolio Manager window, Money calculates and enters the number of shares you own. The total value of those shares, however, remains the same.

**Short sells**
A short sell is when you believe that a stock will fall in price and you attempt to profit by borrowing shares from a broker, selling them at a high price, and then buying shares when the price drops and using those low-priced shares to replace the ones you borrowed.

Suppose, for example, that you think that ABC Corporation’s shares will fall below their current price of $20 a share. You borrow ten shares from your broker and sell those shares for $200. When the price drops to $15 a share, you buy ten shares on your own, pay $150 for them, and give the broker back his or her ten shares. By selling the shares that didn’t belong to you first (for $200) and buying them later (for $150), you earn a $50 profit. Of course, if the stock rises in price, you end up paying the broker back out of your own pocket, not from the proceeds of the sale.

To record a short sell, click the Work with Investments link, choose Record a Sell on the submenu, and fill in the Add Transaction dialog box as you normally would, but select Short Sell from the Activity drop-down list. Typically, brokers charge interest for the shares you borrow. The interest is reported in the Commission text box.

**Return of capital**
A return of capital is a return of part of the price you paid for stock. Sometimes a return of capital is paid to investors in lieu of a dividend. You’ll know when you have been paid a return of capital because your statement tells you so. To record a return of capital, select Return of Capital from the Activity drop-down
list in the Add Transaction dialog box. Enter the amount of the return in the Total text box and select the account where you will stash it from the Transfer To drop-down list.

**Margin purchases**

Brokers gladly lend money to buy stocks and bonds. Buying a stock or bond with money you borrowed from a broker is called *buying on the margin*.

To record stocks or a bond you purchased on the margin, record it as you would a buy, but select Other Expense from the Activity drop-down list. When you select Other Expense, a category box appears on the transaction form so that you can categorize the expense. Select an expense category from the category drop-down list to describe the interest you had to pay your broker for the loan.

**Corporate mergers**

When one corporation merges with another and the two swap stock, you need to record how many shares are being issued for each share of the parent company and the share price that the parent company has to pay for each share of the company that it has swallowed.

When you own stock that is involved in a swap, go to the Portfolio Manager window, click the Record a Special Activity link, choose Record a Merger, and fill in the Record a Merger dialog boxes.

**Corporate securities spin-off**

When a corporation spins off, drops off, or lops off part of itself and you own shares in the corporation, you need to record how many new shares the corporation is issuing for each old share. To do that, go to the Portfolio Manager window, click the Record a Special Activity button, and choose Record a Spin-Off from the submenu. Then fill in the Record a Spin-Off dialog boxes.

**Handling Mutual Funds**

Mutual funds seem to be everybody’s favorite investment. A *mutual fund* is an investment company that raises money from shareholders and invests the money in a variety of places, including stocks, bonds, and money market securities. With a mutual fund, you let experts do the work of deciding what to invest in. All you have to do is collect the profits, count them, and hide them under your mattress.
Recording the sale or purchase of mutual funds

You record the sale or purchase of a mutual fund the same way you record the sale or purchase of stocks shares. Earlier in this chapter, the sections “Recording a purchase of stocks” and “Recording the sale of stocks” explain how.

When you buy shares in the fund, select Buy from the Activity drop-down list; when you sell shares, select (duh) Sell. Be sure to accurately describe the number of shares you purchased or sold in the Quantity text box. And don’t forget to enter the price per share correctly in the Price text box, either.

Recording dividends and distributions

From time to time, mutual fund managers send dividend distributions. More than likely, however, dividends are paid in the form of reinvestments. That is, instead of coming to you in a check, the profits that your shares have made are used to purchase more shares in the fund. Following are instructions for recording a dividend payment and for recording a mutual fund distribution.
Mutual fund dividend distributions
Follow these steps to record the receipt of mutual fund dividend distributions:

1. Go to the Portfolio Manager window and click the name of the account with which you track the mutual fund.
   
   A register appears showing transactions you made in the mutual fund.

2. Click the New button.

3. On the transaction form, enter the date that the dividend was disbursed in the Date text box.

4. From the Investment drop-down menu, select the name of the mutual fund.

5. From the Activity drop-down list, select the option that describes the dividend distribution.
   
   Look on your mutual fund statement to find out which option to select:
   
   - **Interest**: An interest distribution
   
   - **Dividend**: A dividend distribution

6. Enter the amount of the dividend in the Total text box.
   
   Make sure that the account into which you deposited the distribution appears in the Transfer To box.

7. Click the OK button.

Mutual fund reinvestment distributions
Follow these steps when the profits from a mutual fund are used to purchase more shares in the fund:

1. In the Portfolio Manager window, click the name of the mutual fund.
   
   As shown on the top of Figure 9-7, a miniregister appears with transactions you made in the mutual fund.

2. Click the New button.

3. Enter the date of the reinvestment in the Date text box.

4. From the Activity drop-down list, select Reinvest Dividend or Reinvest Interest.
   
   Your mutual fund statement tells you which of these options to select. Text boxes appear for recording how many mutual fund shares were reinvested and the value of those shares, as shown in Figure 9-7.
5. In the Quantity text box, enter the number of shares that the reinvestment purchased.

6. In the Price text box, enter the price of shares in the mutual fund.

7. If necessary, enter a commission you had to pay in the Commission text box.

   One of the advantages of reinvesting mutual fund profits is not having to pay a commission to purchase the shares. Most funds do not require you to pay a commission when you reinvest. If your fund makes you pay a commission, complain about it to the fund manager.

8. Click the OK button.

**Handling Bonds**

A bond is really a loan that you make to a government agency or private corporation. During the life of the loan, the government agency or corporation pays you interest, known as the *coupon rate*. Interest payments are usually made semiannually. Bonds are considered safer investments than stocks because the amount of the bond is paid back at the end of the loan term, known as the *maturity date*. Instead of owning part of the company, which is the case with stocks, bond holders own a debt that the company or government agency that issued the bond is obliged to pay back.

Read on to find out how to track bond purchases and interest distributions with Money.
Recording the purchase of a bond

When you purchase a bond, follow these steps to record its purchase:

1. **Click the Investing tab.**

2. **Click the Portfolio Manager link.**
   
   The Portfolio Manager window appears.

3. **Click the Work with Investments link and then choose Record a Buy on the drop-down menu.**
   
   The Add Transaction dialog box appears.

4. **On the Inv. Account drop-down menu, select the name of the investment or retirement account where you want to record the purchase of the bond.**

5. **In the Date text box, enter the date you purchased the bond.**
   
   Be sure to enter the date correctly. Money needs this date to calculate the bond’s value over time.

6. **On the Investment drop-down menu, enter a name for the bond, and click the Tab button.**
   
   After you enter the name, you see the Create New Investment dialog box.

7. **Select Bond in the What Type of Investment Is It list and click the Next button.**
   
   You see the first of several New Bond dialog boxes.

8. **Select the type of bond and click the Next button.**
   
   If you can’t find the kind of bond you are dealing with in the list, select the Other Bond Type option.

9. **Make sure that the name you entered is correct in the Name text box, choose a country in the Country/Region drop-down list, and click the Next button.**
   
   Now you’re getting somewhere. You see the Enter a Few More Bond Details dialog box, as shown in Figure 9-8.

10. **Describe the bond and click the Next button.**
    
    To describe the bond, enter information in these text boxes:
    
    - **Rating:** Moody and Standard & Poor’s rate bonds according to their reliability. If you know the rating, choose it from the drop-down menu. You can generate Money reports on the basis of bond ratings.
    
    - **Coupon Rate:** Enter the annual interest rate that the bond pays.
    
    - **Interest Paid:** From the drop-down menu, choose the frequency with which interest income from the bond is paid.
- Maturity Date: Enter the date at which the bond falls due and is to be paid back to you.

- Call Date: Enter the earliest date that the bond can be redeemed. If the bond is redeemable at more than one date, enter the earliest date. You are guaranteed interest payments only up to the call date.

- Status: Click the Tax-Exempt check box if interest income from the bond is exempt from federal taxes. This is the case with most municipal bonds.

11. Click the Finish button.
    
    You return to the Edit Transaction dialog box.

12. On the Transfer From drop-down menu, choose the account in which you track the value of the bond.

    Money to pay for the bond is transferred from the cash reserves in your investment or retirement account. At the start of this chapter, the section “Recording Payments to (and Disbursements from) Brokers” explains how to transfer money from a checking or savings account to an investment or retirement account to pay for securities.

13. In the Quantity text box, enter the face value of the bond.

    The face value, also called the par value, is the value of the bond when it matures. Most bonds have a $1,000 face value. The face value is used to calculate interest payments. For example, a 5 percent bond with a face value of $1,000 pays $50 interest annually.

14. In the Price text box, enter the price of the bond.

    The price of a bond is stated as a percentage of the bond’s face value.
15. In the Accrued Int. text box, enter how much interest income, if any, has accumulated between the last interest payment date and the date of the sale.

Enter 0 if you have not sold this bond yet.

16. If you paid your broker a commission for purchasing this bond, enter it in the Commission text box.

17. Click the OK button.

Your bond is listed in the Portfolio Manager window.

**Recording interest payments from bonds**

Periodically, creditors pay interest on bonds you own, and when they pay up, follow these steps to record an interest income from a bond:

1. Click the Investing tab and, in the Investing window, click the Portfolio Manager link.

You see the Portfolio Manager window.

2. If necessary, click the name of the account where you track the bond from which you received an interest payment.

To see the name of bonds and other investments in an account, you click the account’s name, but if the investment names are already displayed, you don’t have to click an account name.

3. Click the name of the bond.

4. Click the New button.

A transaction form appears.

5. On the Activity drop-down menu, choose Interest.

6. Enter the amount of the interest payment in the Total text box.

7. Click the OK button.

The interest payment is recorded in the miniregister.

**Other Kinds of Investments**

The tail end of this chapter is for investors who believe in precious metals and certificates of deposit. How do you handle those types of investment with Money? Read on.
**Precious metals**

To track precious metals in an investment account, treat the metal as you would stock shares and describe the investment by units of measurement. For example, to describe the purchase of two ounces of gold, record the purchase as if you would a purchase of two stock shares.

You can use the same method to track commodities. For example, if you are the proud purchaser of five bushels of wheat, record the purchase as you would a stock purchase and count the five bushels as five shares.

**Certificates of deposit**

You can track the value of a certificate of deposit (CD) in an investment or retirement account by selecting Certificates of Deposit in the Create New Investment dialog box. As the CD accumulates interest, record the interest payments by selecting Interest from the Activity drop-down list.

**Editing and Deleting Investment and Retirement Account Transactions**

Suppose that you enter a transaction in an investment or retirement account incorrectly. It can happen. And when it does happen, you will be glad to know, you can edit or delete it by using the same techniques you use in a checking account or savings account — by going into the account register and making the change.

To edit or delete an investment or retirement account transaction, open the Portfolio Manager window, locate the investment in question, and click its name (not its ticker symbol). You see a miniregister like the one shown in Figure 9-9. Select the transaction and edit or delete it:

- **Editing a transaction:** Click the Edit button. The Edit Transaction dialog box appears so that you can change the particulars of the transaction.

- **Deleting a transaction:** Click the Delete button and click Yes in the message box that asks whether you really want to go through with it.
To close a miniregister, click the investment’s name a second time.

If working in the miniregister is too much trouble for you, open the register of the account where the transaction that needs editing or deleting is located. To do so, start in the Portfolio Manager window, click the Work with Accounts link, and choose the name of an account on the drop-down menu. The Account Register window opens. Select the transaction and edit or delete it:

- **Editing a transaction**: Click the Edit button in the transaction form and change the particulars of the transaction.
- **Deleting a transaction**: Right-click the transaction and choose Delete on the shortcut menu.

**Updating the Price of Securities**

For investors who dabble in stocks, mutual funds, and bonds, being able to download share prices from the Internet with Money is too good to be true. Rather than update share prices yourself by entering numbers in text boxes, all you have to do is plug into the Internet, grab the numbers, and be done with it. No fooling — downloading share prices from the Internet with Money takes about two minutes. It’s free, too. By tracking changes in the value of a security, you can analyze the performance of your investments and then track the value of your portfolio over time (see Chapter 10). Money offers two ways to update security prices — from the Internet and on your own. Both techniques are described here.
Chapter 17 explains how to tell Money about your Internet connection so that the program knows how to download security prices. If you have trouble downloading prices, consult Chapter 17.

**Making sure you have the right ticker symbol**

While you’re describing the securities in an investment or retirement account, Money gives you the opportunity to enter ticker symbols, but if you chose not to enter them or you entered the wrong symbol, you can follow these steps to assign a ticker symbol to a stock or mutual fund and be able to download its current price from the Internet:

1. In the Portfolio Manager window, right-click the name of the security that needs a ticker symbol and choose Investment Details on the shortcut menu.

   You see the Details window.

2. Enter the ticker symbol in the Symbol text box.

If you’re running any version of Money except the Standard version, you can find out a company’s ticker symbol by clicking the Find Symbol button in the Details window.

---

**Downloading stock and mutual fund quotes from the Internet**

You can download stock, mutual fund, and bond prices as long as you have access to the Internet through an Internet service provider and you have entered ticker symbols for your investments. A ticker symbol is an abbreviated company name that is used for tracking the performance of stocks, mutual funds, and bonds. You can usually find these symbols on the statements you receive from brokers. Unless Money has a company’s ticker symbol on file, you can’t download the current price of a stock, bond, or mutual fund.
Follow these steps to update the prices of stocks, bonds, money market funds, and mutual funds in your portfolio:

1. Click the Investing tab and, in the Investing window, click the Portfolio Manager link.

You land in the Portfolio Manager window.

2. As shown in Figure 9-10, click the Update Prices link and choose an option from the submenu to update the price of the securities in your portfolio from the Internet.

The window offers two ways to update the price of securities:

- **Update the price of all securities:** Click the Update Prices Now option.

- **Update the price of a handful of securities:** Click the Pick Quotes to Download option. You see the Pick Quotes to Download dialog box (refer to Figure 9-10). Uncheck the securities whose prices you don’t want to update; then, click OK.

The Update Prices submenu also offers an option called Update Prices Manually. Choose this option to enter prices on your own, as explained in the next section of this chapter.
By default, security prices are updated every 30 minutes as long as your computer is connected to the Internet. If you prefer to update prices only when you give the command to do so, go to the Portfolio Manager window, click the Update Prices link, and deselect the Update Automatically (Every 30 Minutes) option on the submenu.

**Updating the price of securities on your own**

If a security you’re tracking doesn’t have a ticker symbol or you believe in tracking securities the old-fashioned way, follow these steps to manually update the price of a security in your portfolio:

1. **Open the Portfolio Manager window.**
   
   To get there, click the Investing tab and, in the Investing window, click the Portfolio Manager link.

2. **Click the Update Prices link and choose Update Prices Manually from the submenu.**

   You see the Update Price dialog box, also shown in Figure 9-11.

![Update Price dialog box](image)
3. Click the arrow to open the Investment drop-down list and select the investment whose price you want to update.

4. In the Date box, enter the date that the price changed.

5. Enter the new price in the Price ($) text box.

6. Click the Update button.

   The new price is entered in the price history list. Note that in Figure 9-11 the Source column says Online next to some entries. When you enter a price yourself, the column says Update, but it says Online when you get prices from the Internet.

7. If you want to record the price history of a security, keep entering new dates and new security prices; otherwise, select a new security from the Investment drop-down list and update its price.

8. Click the Close button when you’re done.
Chapter 10
Researching and Analyzing Your Investments

In This Chapter

- Analyzing investments in the Portfolio Manager window
- Examining and comparing investments in charts
- Examining the soundness of your financial portfolio
- Seeing how diversified your investments are
- Creating investment reports in the Portfolio Manager window
- Being alerted to a security’s price changes
- Researching investments at MoneyCentral
- Researching mutual funds and stocks on the Internet
- Shopping for a broker

Are you a good investor? Choosing profitable investments requires a bit of luck, knowledge of the markets, and the wherewithal to look past the hype and see what a company or mutual fund is really about.

One of the advantages of Money to investors is being able to get information quickly and find out at a moment’s notice how the investments you already own are performing. Using Money, you can analyze your investments, compare your investments to one another, and compare your investments to securities you don’t own. You can also get advice for diversifying your investments and tell Money to alert you when a security falls within a certain price range. Because Money was designed to work hand in glove with the MoneyCentral Web site, you can do all kinds of research at MoneyCentral without leaving the Money program. Better read on.

Analyzing Your Investments

The fun begins after you enter the securities and list their prices in investment and retirement accounts. Now you can examine your investments in different
ways. Like peering into the different windows of a house (with the occupants’ permission, of course), you can stare into your investments from different angles and see whether you gain any insights that way.

The simplest way, although not necessarily the most revealing way, to start analyzing your investments is to click the Investing tab and go to the Investing window. As shown in Figure 10-1, this window lists the current value of your different investment and retirement accounts. You can also see how much each account has gained or lost in value.

More revealing than the Investing window is the Portfolio Manager window, shown in Figure 10-2. To get there from the Investing window, click the Portfolio Manager link under My Investing Tools, click the Investing Tools button and choose Portfolio Manager on the drop-down menu, or click the View my Portfolio link.
Under each retirement or investment account name, the Portfolio Manager window lists the latest price of each security, the securities’ market value, and how much each has increased or decreased in value. Here are the basics of getting around in the Portfolio Manager window:

- Click the plus sign (+) next to an account name to view the securities that are tracked by the account. Click the minus sign next to an account name to hide the securities.

- Click a security name to open a miniregister and view transactions made with the security.

- Choose an option from the Select View drop-down menu (or click the Change Portfolio View link and choose an option) to analyze your investments in different ways. Table 10-1 describes the eleven different views from which you can choose. Test them all and see whether you can gain any insights and be a better investor.

- Choose an option from the Group By drop-down menu to arrange securities in the window under account names, by investment type, by capitalization (large cap and small cap), by currency, from least risky to most risky, or by position from worst earner to best earner.

The status bar at the bottom of the Portfolio Manager window lists the securities’ daily total change of value, the market value of all the securities, and the year-to-date percentage return. You can decide what appears on the status bar. Click the Change Portfolio Settings link and, on the Status Bar tab of the Preferences dialog box, choose options from the Position 1, 2, and 3 drop-down menus.

<table>
<thead>
<tr>
<th>Table 10-1 Views in the Portfolio Manager Window</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View Option</strong></td>
</tr>
<tr>
<td>Standard</td>
</tr>
<tr>
<td>Asset Allocation</td>
</tr>
<tr>
<td>Performance</td>
</tr>
</tbody>
</table>

(continued)
<table>
<thead>
<tr>
<th>View Option</th>
<th>What You See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return Calculations</td>
<td>Return-on-investment projections for the coming week, four weeks, year, and three-year period. Money makes these calculations based on investment type. Choose this view to see how the wizards at Microsoft think your investments will grow or shrink.</td>
</tr>
<tr>
<td>Valuation</td>
<td>Value information about your securities, including their cost bases, appreciation, and increase in value.</td>
</tr>
<tr>
<td>Quotes</td>
<td>Market data on each investment, including its latest price, latest change in price, and daily and yearly high and low.</td>
</tr>
<tr>
<td>Holdings</td>
<td>The latest price, number of units you own, and market value of your investment holdings.</td>
</tr>
<tr>
<td>Fundamental Data</td>
<td>Historical price information, including 52-week high and low prices and P/E ratios.</td>
</tr>
<tr>
<td>Options</td>
<td>Stock options in alphabetical order.</td>
</tr>
<tr>
<td>Employee Stock Options</td>
<td>Stocks options you have acquired from your place of employment.</td>
</tr>
<tr>
<td>Bonds</td>
<td>Bonds in your portfolio.</td>
</tr>
</tbody>
</table>

When you see the Interactive Charts icon in the Portfolio Manager window, you can click the icon to go to the MoneyCentral Web site (www.moneycentral.com) and see a chart showing how the security has performed in the past year. Click the Customize Chart link to change the date range or compare the security against a stock index such as NASDAQ or the S&P 500.

**Charting the Performance of an Investment**

If you want to press your nose to the glass and get a very, very close look at an investment, double-click its ticker symbol (not its name) in the Portfolio.
Manager window. That action takes you to the Price History window, where a chart shows you precisely how well the security is performing, as shown in Figure 10-3.

In the Price History window, make selections from the drop-down lists to compare an investment’s performance with another one of your investments or with an index. The chart in Figure 10-3 compares the performances of two different stocks and the NASDAQ Composite Index over a one-year period.

If you have the Deluxe version of Money, you can click the Interactive Charts link or the Do More In-Depth Analysis link in the Price History window to go to the MoneyCentral Web site and research your investment even further.

**Reviewing Your Portfolio**

If you pay an investment counselor to review your portfolio, he or she may give you good advice about changing your investment plan. Whether the advice is good or bad, the investment counselor will most certainly charge you a lot for the service. In the interest of saving money on investment counselors, Money offers an investment counselor in a can. The canned counselor reviews your portfolio and gives you a report showing how your investments are allocated, your tax liability, your investments’ performance, and how much risk you are exposing yourself to, as shown in Figure 10-4.
To put the investment counselor to work, click the Investing tab and, in the Investing window, click the Portfolio Review link. That’s all there is to it. Scroll through the Portfolio Review window to see what’s what with your investments.

**Seeing How Well Your Investments Are Allocated**

On the theory that you shouldn’t put all your eggs in one basket, many investment counselors advocate diversifying investments across many different investment classes. By allocating your investments this way, you minimize investment risks, because if one class of investments falters, the others will pick up the slack.

In the Portfolio Manager window, open the Select View drop-down menu and choose Asset Allocation to view your investments by investment class — stocks, mutual funds, bonds, and so on. If the majority of your investments fall in one or two classes, consider using the Asset Allocation Manager to get advice about diversifying your investments.

To use the Asset Allocation Manager, either click the Investing tab to go to the Investing window and then click the Asset Allocation link, or click the Investing Tools button and choose Asset Allocation from the drop-down menu. You see the Welcome to Asset Allocation window. Click the Learn link to embark on a lesson in asset allocation and develop a plan for diversifying your investments. As you go from window to window, clicking the Next button as you go along, you can see how well your investments are allocated.

**Portfolio Review**

**Risk Profile**

Your investments fall into these risk categories, relative to the stock market as a whole:

<table>
<thead>
<tr>
<th>Risk Type</th>
<th>Value</th>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Risk</td>
<td>$11,230.49</td>
<td>35.6%</td>
</tr>
<tr>
<td>Medium Risk</td>
<td>$11,882.42</td>
<td>41.5%</td>
</tr>
<tr>
<td>High Risk</td>
<td>$5,492.82</td>
<td>18.9%</td>
</tr>
<tr>
<td>Unknown Risk</td>
<td>$0.00</td>
<td>0.0%</td>
</tr>
<tr>
<td>Total Market Value</td>
<td>$28,605.52</td>
<td>100.0%</td>
</tr>
</tbody>
</table>

*To see all your investments grouped by Risk, customize your Portfolio view to group by Risk.*
get Money’s advice for reallocating your investments, and devise a plan for diversifying your investments. Figure 10-5 shows an Allocation Manager window comparing existing investments and Money’s target plan for creating a more diversified portfolio.

Another way to see how your investments are allocated is to run an Asset Allocation report. In the Portfolio Manager window, click the See Investment Reports link and choose Asset Allocation on the submenu. Chapter 15 explains reports in detail.

**Generating Investment Reports**

To make it easy for you to generate investment reports, the Portfolio Manager window offers the See Investment Reports link. Click this link to see a submenu with all the investment reports that you find in the Reports window. There are ten investment reports in all. Chapter 15 explains how to generate and customize reports.
Being Alerted When a Security Hits a Certain Price

As Chapter 13 explains, you can make Advisor FYI alerts appear on the Home Page when an important event occurs. By clicking an alert, you can go to the Review the Advisor FYI Details window, where you can find out why you are being alerted. Besides being alerted to account balances, your monthly spending in different categories, and important dates, you can be alerted when a stock or mutual fund reaches a certain price range.

Follow these steps to be alerted to changes in the price of a security you are tracking with Money:

1. Click the Investing tab to go to the Investing window.
2. Click the Portfolio Manager link.
3. In the Portfolio Manager window, click the Set Price Alerts link.

You can find this link under Other Tasks. After you click it, you see the Investment Alerts tab of the Advisor FYI Options dialog box, as shown in Figure 10-6.

Figure 10-6: Telling Money to alert you to security price changes.
4. Select the security for which you want to be alerted.

5. In the High Of and Low Of text boxes, enter figures to describe a price range.

6. If you want the alert to instruct you to buy or sell the security when its price falls within the range, select the Buy or the Sell check box and enter the date by which you want to be alerted.

7. Click OK.

If you want to be alerted to price changes of securities you don’t own or don’t track with Money, enter those securities in a Watch account (see Chapter 8). Watch account securities can also be placed on the Advisor FYI list.

Researching Investments at MoneyCentral

You may not realize it, but Money has a split personality. Besides being a program for tracking financial activity, Money is a Web browser. Clicking many links in the Money program takes you to the MoneyCentral Web site. However, the Web site appears inside the Money window, not in a browser window. To confuse matters even further, the MoneyCentral Web site looks much like the Money program. To see what I mean, open your browser and go to this address: www.moneycentral.com. You will find yourself at a Web site that looks deceptively like Money itself!

Because Money and the MoneyCentral Web site are on such friendly terms, it is easy to research investment opportunities on the MoneyCentral Web site while you are working in Money:

✔ In the Investing window, click one of the links under Markets, Stocks, Funds, Insight, or Brokers on the left side of the screen to go to MoneyCentral and research the markets, a stock, or a mutual fund.

✔ In any Investing window, click one of the five buttons — Markets, Stocks, Funds, ETFs (Exchange-Traded Funds), Commentary or Brokers — to go to the MoneyCentral Web site and conduct your research. Figure 10-7 shows the MoneyCentral Web page for researching stocks. Notice the ubiquitous advertisement. Is there any escaping advertisements?

✔ In the Portfolio Manager window, click the Research Online link to go to an all-purpose page with links to many parts of the MoneyCentral Web site. Pick your poison — find stocks, screen for mutual funds, get company reports, or get breaking financial news.
Other Ways to Research Investments Online

It goes without saying, but MoneyCentral isn’t the only place on the Internet to research investments. You are hereby encouraged to get investment advice from as many places as you possibly can. In my opinion, there are no experts when it comes to handing out investment advice. So-called experts are just people with opinions. The following pages unscrew the inscrutable. They show you where to go on the Internet to research mutual funds and stocks.

Researching mutual funds on the Internet

Before you start dabbling in mutual funds, you need to know about how fees are levied, the different kinds of funds, and the risks. After you know that, you
can start looking for a fund that meets your needs. Here are some Web sites where you can acquire the basics of mutual fund investing:

- **Brill’s Mutual Funds Interactive**: An all-purpose Web site for mutual fund investing. Here, you can read about mutual fund investing or search for funds by name and read about them. Address: [www.fundsinteractive.com](http://www.fundsinteractive.com)

- **Mutual Fund Investor’s Center**: An excellent Web site with articles about mutual fund investing. This site ranks mutual funds in various ways. You can also search for mutual funds using different criteria. Address: [www.mfea.com](http://www.mfea.com)

At last count, investors could choose from among 10,000 mutual funds. After you know what you want in a mutual fund, check out MoneyCentral to search for a mutual fund that fits your investment strategy. You can also search at these Web sites:

- **Fund Alarm**: “Know when to hold ’em, know when to fold ’em,” advises this unusual Web site. Instead of advising you what to buy, it tells you when to sell your mutual funds. Address: [www.fundalarm.com](http://www.fundalarm.com)

- **Morningstar.com**: The granddaddy of mutual fund analysis, this company offers reports on 7,000 mutual funds. You can get fund profiles, performance reports, financial statements, and news articles. Address: [www.morningstar.com](http://www.morningstar.com)

- **SmartMoney.com**: Offers a sophisticated search engine for pinpointing mutual funds. Address: [www.smartmoney.com](http://www.smartmoney.com)

## Researching stocks on the Internet

The stock market, it has been said, is 85 percent psychology and 15 percent economics. And that’s only half the problem. The other half has to do with the market’s hard-to-understand terminology and the numerous confusing ways to buy and sell stock.

When you want to hunker down and examine specific stocks, go to one of these sites:

- **Free Realtime**: Get financial news, the latest stock quotes, and company profiles at this Web site. Address: [http://quotes.freerealtime.com](http://quotes.freerealtime.com)

- **PCQuote**: You can enter a ticker symbol and get stock quotes and charts. This site also presents market news, a “stock pick of the week,” and news articles about the markets. Address: [www.pcquote.com](http://www.pcquote.com)
Yahoo! Finance: Enter a ticker symbol and you can get a price chart, news articles about a stock, charts that track its performance, and links to the company’s SEC filings. As Figure 10-8 shows, you can also compare the performance of two different stocks. Address: http://finance.yahoo.com

Suppose that you want to target a stock but you don’t know what it is yet. In other words, you believe that the future is bright for a certain industry and you want to buy shares in companies in that industry. Or, you want to buy a certain kind of stock — stock in a foreign corporation, a small-cap stock, or a blue-chip stock. Searching for stocks this way is called screening. The Reuter’s Investor Web site offers stock-screening databases that you can search using different variables. (Look for the Reuters PowerScreener.) Its address is www.investor.reuters.com.

Researching bonds on the Internet

Here are a handful of Web sites for investors who favor bonds:

Bond Buyer: Go to this site to investigate municipal bonds. Address: www.bondbuyer.com

Bond Market Association: This Web site tells you everything you need to know about bonds. It explains the different kinds of bonds, bond dealers, and bond indexes. Address: www.investinginbonds.com

Bonds Online: Go to the BondSearch/Quote Center to get historical data about different bond investment yields. Address: www.bondsonline.com
Finding a Broker

A broker is a person or company that purchases and sells securities on your behalf. As you choose a broker, the first question to ask is what your broker charges in commissions and fees. Most charge a commission or flat fee for each trade they make on your behalf. Many also charge yearly maintenance fees. Some also charge transfer fees to move money from your investment account to another account, such as a checking or savings account. Others charge inactivity fees, which you incur if you don’t trade securities on a regular basis.

Here are two Web sites that can help you select the broker who is right for you:

- **National Association of Securities Dealers**: Click the Investor Information link to investigate a broker. From there, you can check the background of any licensed broker in the United States. Address: [www.nasdr.com](http://www.nasdr.com)
- **Yahoo! Finance**: Get tips and articles about choosing a broker from Yahoo!. Address: [http://biz.yahoo.com/edu/ed_broker.html](http://biz.yahoo.com/edu/ed_broker.html)
Part IV

Getting Your Money’s Worth

The 5th Wave

By Rich Tennant

“Face it Vinnie – you’re gonna have a hard time getting people to subscribe online with a credit card to a newsletter called ‘Felons Interactive.’”
In this part . . .

Part IV shows you how to get the most out of Money. You find out how to draw up a budget, schedule bills so that you can pay them on time, and get ready for tax season. Oh, and you also pick up a handful of housekeeping hints, such as backing up your data files, that make your trip to Moneyland more enjoyable.
Chapter 11
Some Important Housekeeping Chores

In This Chapter
► Backing up and restoring your financial files
► Pruning the Payees list
► Handling passwords
► Deleting and closing a bank account you no longer use
► Creating an archive file for the past years’ transactions
► Creating a file for tracking business or other activity
► Renaming and deleting files

This chapter explains a handful of housekeeping chores that you must do from time to time. Sorry. Nobody likes housekeeping chores, but they have to get done.

In this chapter, you find out how to back up your data file so that you have a spare copy if your computer fails. You also discover how to restore a file — that is, load a backup copy of a file onto your computer. This chapter explains how to delete old bank accounts, create a second file for storing transactions, delete a file, and rename a file. You also find out how to archive a file to keep records of past transactions. For spies, secret agents, and people who often glance over their shoulder, this chapter also explains how to clamp a password on a Money file.

Backing Up and Restoring Money Files

Computers are wonderful machines — until they break down. If a computer breaks down entirely, it’s worse than useless because the data on its hard drive can’t be recovered. It can’t be recovered, I should say, unless someone had the foresight to back up the data.
In computerese, *backing up* means to make a second copy of a file so that the data can be recovered if something evil happens to the hard drive where the original file is stored. As long as you have a backup copy of your Money file, it doesn't matter whether your computer is run over by a bulldozer or struck by lightning. It doesn't matter because you can always restore your data from the backup file. *Restoring* means to load the backup copy of a file onto a computer and use it instead of the original file from which the backup was made.

**Telling Money how to back up your financial data**

Backing up is so important that Money gives you the opportunity to do it when you close the program or close a data file. You may have already noticed the Back Up When Money Closes dialog box, shown in Figure 11-1. By clicking the Back Up Now button in this dialog box each time you close Money, you can make a backup copy of your data file.

To be accurate, you make a backup copy to the `C:\My Documents` or the `C:\Documents and Settings\Your Name\My Documents` folder on the hard drive. Instead of the data file's being copied to a floppy disk, Zip disk, or CD-R that can be dropped in a drawer or filing cabinet, the backup copy is stored on the same computer that stores the original file. If something wicked happens to that computer — if it crashes or is stolen — you lose the Money data you so carefully assembled. You can't restore the file from a backup copy, because the backup copy is also on your computer.

To remedy this problem, you can tell Money that you want to make backup copies to a floppy disk, Zip disk, or other removable disk as well as the hard drive each time you close the program. Backing up this way takes all of five seconds. And by backing up this way, you always have a completely up-to-date copy of your data file on hand in case of an emergency.
Follow these steps to change the backup settings so that you back up your Money file to a floppy disk as well as the hard drive whenever you close the program:

1. **Open the Backup Options tab of the Settings dialog box.**
   
   You can get there two different ways:
   
   - Click the Options button in the Back Up dialog box (refer to Figure 11-1).
   - Choose Tools ➤ Settings and, in the Settings window, click the Backup Settings link.

   You see the Backup Settings tab, as shown in Figure 11-2.

[Figure 11-2: Enter a 1 in the Perform Scheduled Backups Every X Days text box to be reminded each time you use Money to back up your data file.]

2. **Select either or both of the Back Up check boxes.**
   
   The first check box, Automatically Back Up My Money File, makes a backup copy to a file in your My Documents folder. The second check box, Perform Scheduled Backups Every, makes a backup copy to a floppy disk or other removable drive (in Step 6, you will tell Money where that removable drive is). If you select both option buttons, you will have to negotiate two Back Up dialog boxes each time you close Money.

3. **Make sure that the check boxes called Ask Me Before Backing Up are selected.**

   This way, you are reminded to make backup copies of your data.
4. Enter 1 in the Perform Schedule Backups Every X Days text box.
   Unless you change this setting, you are asked every 14 days whether you want to back up the data file to a floppy disk or other removable drive. But 14 days is not often enough. I think you should back up the data file each day that you finish using the program.

5. Click the first Browse button and, in the Backup dialog box, choose a folder for storing backup copies of your Money file on the hard drive.
   Backup copies are stored in the My Documents folder by default, but most people reserve that folder for data files that they use on a daily basis. I suggest choosing or creating a more inconspicuous folder. The folder can be anywhere on your hard drive.

6. Click the Second Browse button and, in the Backup dialog box, choose a removable drive if you decide to take my advice and store the backup file outside your computer.
   If your computer is equipped with a Zip drive, for example, you can choose Removable Disk - (D:) from the Save In drop-down list to make backup copies to a Zip disk.

7. Click OK to close the Settings dialog box.
   You're all set. You will be reminded to back up your data file to a floppy disk or other disk whenever you close Money 2006.

**Backing up your data file**

Money gives you two ways to back up a data file. You can wait until you close the program and negotiate the Back Up When Money Closes dialog box as part of shutting down, or you can choose File ➪ Backup to back up the data file without closing the program (see the “Backing up on the fly” sidebar).

Assuming that you want to wait to back up your data, here are instructions for backing up a data file to the hard drive and a floppy disk when you close the program:

1. Click the Close button (the X in the upper-right corner of the screen) or choose File ➪ Exit to close Money.
   You see the familiar Back Up When Money Closes dialog box (refer to Figure 11-1).

2. Click the Back Up button.
   Your computer grinds away and then the deed is done — the file is backed up to the hard drive. The Scheduled Backup dialog box appears so you can back up the data to a removable drive.
3. Click the Back Up Now button in the Scheduled Backup dialog box.

That’s all she wrote — the file is copied to the floppy disk or other removable drive.

Be sure to put the removable disk in a safe place. A safe place is one where nothing can be spilled on it and no one is tempted to use it for a drink coaster.

**Restoring a file from its backup copy**

Suppose that doomsday arrives and you have to restore a data file from its backup copy on a floppy disk, a removable disk, or the hard drive. Perhaps you botched a find-and-replace operation or your computer went momentarily haywire. If that happens, follow these steps to start working with the backup copy of a file instead of the original copy:

1. **If you want to restore your data file from a disk or CD-R, put it in a computer drive.**

2. **Choose File ﹥ Restore Backup.**

   You see the Restore Backup dialog box.

3. **Select the Restore from a Backup File option button (if it isn’t already selected) and click the Next button.**

   The Restore Backup File dialog box, shown in Figure 11-3, appears. Take a close look at the filename that is listed in this dialog box. What you do in Step 4 depends on whether that file is the one you want to restore.

4. **Locate the backup file you will use to restore your Money data.**

   Money offers three ways to do that:

   - **The dialog box lists the backup file:** Select the Restore from Default Backup File option button and then click the Restore button if the file listed in the dialog box is the one you want to restore.
You don’t know where the file is: Select the Have Money Search My Hard Drive for Other Money Backup Files option and click the Next button if the dialog box lists the wrong backup file and you don’t know where the correct file is. After a moment, you see a list of backup files. Select the one you want to use as the restore file.

The dialog box lists the wrong backup file: Select the Let Me Browse for a Different Backup File option button and click the Next button if you want to restore a different file from its backup copy. In the Restore dialog box, select the correct file and click OK.

Backup files have the word “Backup” in their name and have the extension .mbf.

5. Make sure that the Restore Backup File dialog box lists the file that you want to restore from its backup copy; then click the Restore button.

In a moment or two, depending on how large the data file is, the backup file takes the place of the original. Now, all you have to do is enter the financial transactions that you entered between the time you last backed up the file and the time you restored it. I hope there aren’t many transactions to enter.

Backing up on the fly

You don’t have to wait till you shut down Money to back up a data file. To back up in the middle of your work, choose File ➪ Backup. In the Back Up Your Money File dialog box, choose a removable drive or folder for your data file; then click Save.
Transferring Your Money File to a New Computer

When you get a new computer, you may well ask yourself, “How do I get my Money data from my old computer to my new computer?” The answer is by backing up the data on your old computer to a floppy disk, Zip disk, or CD-R; loading the Money software on your new computer (if necessary); and restoring the backed-up Money file on your new computer. In other words, pretend on your new computer that you just lost your Money data; then restore the data from a backup file.

The previous section in this chapter explains how to restore data from a backup file. Turn a couple of pages back and start reading. I’ll wait for you here.

Pruning the Payees List

As you surely know, Money “remembers” the names of people and businesses that you enter in account registers. When you enter a payee name the second time, you have to type only the first two or three letters. Money enters the full name for you. And if you are the sort of person who would rather click than type, you can enter a payee name in an account register by selecting it from the Pay To drop-down list.

As wonderful as it is, the Payees list has a habit of getting very long. From time to time you need to prune the list to cut it down to size. That way, fewer names appear in the Payee To or From text box, and you can find the name you need faster on transaction forms.

When you delete a payee on the list, nothing happens to his, her, or its name in the account registers. The payee’s name remains intact for future generations to see and behold. Next time you try to enter the payee’s name in a transaction form, however, the name doesn’t appear automatically in the Pay To or From text box after you type the first couple of letters.

Follow these steps to remove names from the Payees list:

1. Press Ctrl+Shift+C or click the Banking tab, click the Account Tools button, and then choose Categories & Payees.
2. Click the Payees link.

The Set Up Your Payees window appears, as shown in Figure 11-4. The fastest way to scroll through a long Payees list is to press a letter on your keyboard. Press P, for example, to scroll to the names that begin with the letter P.
3. Select a payee name on the list and click the Delete button.

A dialog box asks whether you really want to go through with it.

4. Click the Yes button.

You can edit information about a payee anytime. Simply go to the Payees list, double-click a payee’s name, and change the information on the Payee screen.

**Organizing Your Favorite Accounts, Reports, and Web Sites**

If you have spent any time in Money, you know how to play favorites. By choosing Favorites➪Add to Favorites, you can place an account, report, or Web site on the Favorites list. Then all you have to do to go to the account, report, or Web site is choose a command from the Favorites menu: Favorites➪Favorite Accounts, Favorites➪Favorite Reports, or Favorites➪Favorite Web Sites.

Also on the Favorites menu is a command called Organize Favorites. Choose Favorites➪Organize Favorites when your Favorites lists get out of hand and need reorganizing. Money will take you to a window where you can prioritize your favorite accounts, reports, and Web sites; delete them; or rename them.

The Favorites lists are a very convenient device for getting around in Money. You can even put a list of your favorite accounts on the Home Page and open account registers from there (see Chapter 2). Use the Organize Favorites command to squeeze more pleasure and profit from your Favorites lists.
Protecting Files with a Password or Passport Network Credentials

Probably the last thing you want is someone snooping in your Money file. To keep jealous colleagues, future biographers, agents of Interpol, or anyone else from opening a file, you can protect it with a password. Money offers two ways to protect a file with a password:

- **Conventional password:** Enter the password each time you start Money. Fail to do so and you can’t open the Money file.

- **Microsoft passport:** Use a passport. Microsoft offers the passport service for free. The password is “encrypted,” a computer term that means “buried so deep in the crypt no one can uncover it.”

The following sections explain how to lock a file with a password or Microsoft passport, open a file that has been given a password, and change or remove passwords.

Locking a file with a password or Microsoft passport

Connect to the Internet if you want a Microsoft passport. Follow these steps to clamp a password — conventional or Microsoft — on a Money file:

1. If necessary, open the file that needs a password.

2. Choose File ➪ Password Manager.

   You see the Manage Your Password dialog box, shown in Figure 11-5.

3. Click the first option, I Want to Use Passport Network Credentials, if you’ve opted for a Microsoft passport; click the I Want to Use a Money Password option if you favor a conventional password.

4. Sign on for a conventional password or a Microsoft passport:

   - **Conventional password:** Click the second option, I Want to Use a Money Password, and click Next. Type a password in the New Password text box, type the same password in the Confirm New Password text box, and click Next. It doesn’t matter whether a password is uppercase, lowercase, or a combination of upper- and lowercase letters. If the password is Oaxaca, for example, it doesn’t matter whether you enter oaxaca, OAXACA, or Oaxaca in the Password dialog box when you open the file.
• **Microsoft passport:** Click the I Want to Use Existing Microsoft Passport Network Credentials option and then click Next. Enter your e-mail address and password and click the Sign In button. The password you entered is sent over the Internet to Passport.com, Microsoft’s name for the Web site where passports are kept under lock and key. Click the Done button.

It’s settled: Whoever tries to open the file next time, or whoever starts the Money program next time, will need the secret password.

---

**The Microsoft passport**

You have no choice but to use a Microsoft passport if you intend to record Money transactions online, download information from your bank, or see MoneyCentral information while you browse the Internet (these subjects are covered in Part VI). Here is some good news for people who use Hotmail or have an account with MSN (the Microsoft Network): You already have a passport. The same password that gets you into Hotmail or MSN can double as a password to Money.

Go to this Web site to get a Microsoft passport: [http://register.passport.com](http://register.passport.com). One benefit of using a passport instead of a conventional password is that you can forget the passport and still recover it from Microsoft. If you forget a conventional password, you’re plumb out of luck. You can’t open your Money file.
Opening a file that has been given a password

When you try to start Money or open a new Money file that has been given a password, you see an opening screen like the one in Figure 11-6 (people with Microsoft passports see a slightly different screen). I hope that you know the password. If you do, enter it and click the Sign In button.

People who enter Microsoft passports can click the Remember My Password check box, but clicking this check box sort of defeats the purpose of having a password. Next time you open Money, your sign-in name and password will already be entered on the Welcome screen. All you or a cat burglar has to do is click the Sign In button to access the Money file.

Some gratuitous advice about choosing passwords

Everybody has different advice for choosing a password that isn’t likely to be forgotten or discovered, and everybody agrees that you shouldn’t use your own name or the names of family members or pets, because devious souls try those names first when they try to crack open a file. Here’s a good tip for choosing passwords: Pick your favorite foreign city and spell it backward. My favorite foreign city is in Mexico. If I used a password, it would be acaxaO.
If you don’t remember the password and yours is a conventional password, wag your head and proclaim, “Woe is me.” All is not lost if yours is a Microsoft passport. You can go to this Web site on the Internet and recover your stray password: http://memberservices.passport.com. Click the I Forgot My Password link and take it from there.

Changing and removing passwords

How you change or remove a password from a file depends on what kind of password you have. Start by choosing File→Password Manager to open the Manage Your Password dialog box. Then take the following steps in the Manage Your Password dialog boxes:

- **Changing a conventional password:** Click the first option, I Want to Change or Remove My Money Password, and click the Next button. Enter your current password in the Old Password text box; enter the new password in the New Password and Confirm New Password text boxes. Then click Next.

- **Changing a Microsoft passport:** Click the Change button. In the following dialog box, click the first option, I Want to Change the Passport Network Credentials I Use to Sign in to My Money File, and click Next. Enter an e-mail address, enter a password, and click the Sign In button.

- **Removing a conventional password:** Select the first option, I Want to Change or Remove My Money Password, and click Next. Enter your password in the Old Password text box and click the Remove button. Finally, click the Next button to confirm the removal.

- **Removing a Microsoft passport:** Click the Remove button. In the following dialog box, click the first option, I Want to Remove My Passport Network Credentials from My Money File, and click Next. Then click the Done button.

Deleting and Closing Bank Accounts

When you close a bank account, you can either delete it or close it in the Accounts window. If the transactions in the account no longer matter for your financial history — and if the IRS wouldn’t care whether a history of the account remains in your records — delete the account. More likely than not, however, you need the records in the account for reports, charts, and other financial analyses.
Rather than delete an account, simply close it. You can still view transactions in a closed account. To view them, go to the Account List window, click the Sort Account List By link, and deselect Hide Closed Accounts on the submenu. Then double-click the name of the closed account to see its transactions.

**Closing an account**

Follow these steps to close an account:

1. **Click the Banking tab.**

   You see the Account List window, as shown in Figure 11-7. If the window is displaying closed accounts, their names are grayed out in the window.

   ![Account List](image)

   **Figure 11-7:** Marking an account as closed.

2. **Right-click the account you want to close and choose Account Is Closed on the shortcut menu.**

   The name of the account is either removed from the window or grayed out, depending on whether the window displays closed accounts.

   ![Account List](image)

   You can reopen an account that you closed by right-clicking its name and choosing Account is Open from the shortcut menu. To see closed accounts in the Account List window, click the Sort Account List By link and choose and deselect Hide Close Accounts on the submenu.
To close or reopen several accounts at the same time, choose Tools ➪ Settings and click the Account Settings (Global) link the Settings window. In the Global Settings window, click the Close or Reopen Accounts button. You see a list of your accounts. Select the ones you want to close; deselect the ones you want to reopen.

Deleting an account

Think twice before deleting an account. You might need the data later on. Follow these steps to delete an account:

1. Click the Banking tab to go to the Account List window.
2. Right-click the account you want to delete and choose Delete on the shortcut menu (refer to Figure 11-7).
   A dialog box warns you to think twice before deleting.
3. Think twice and click the Yes button.

Creating an Archive File for Past Transactions

An archive file stores all the previous transactions to a certain date for safekeeping. Archive your Money file at tax time, copy it to a floppy disk, and put it away with all your receipts and records from the previous year. That way, you have an electronic record of your financial transactions from the past.

Don’t create an archive file on January 1. Wait until you have cleared all transactions from the previous year and filed your income tax returns.

Follow these steps to create an archive file:

1. Make sure that the file you want to archive is open.
2. Choose File ➪ Archive.
   You see the Archive dialog box. Never mind all that verbiage; just glance at the text box in the lower-right corner to make sure that it shows January 1. All transactions in your registers prior to that day are copied to the archive file.
3. If the date box doesn’t show January 1, enter January 1 of this year.
4. Click the Next button.
   You see the Archive a Money File dialog box. Money suggests a name for
   the archive file — it wants to name the file after last year.

5. In the File Name text box, either enter your own name for the archive
   file or let Money's name stand.

6. Click the Next button.
   You see another Archive a Money File dialog box.

7. Select the check box next to the accounts whose transactions you
   want to include in the Archive file.

8. Click the Finish button.

Creating a Separate File for Financial Activity

You have to create a Money file for tracking a small business with Money. Self-employed people and people who operate very small businesses that require only one bank account can use their personal Money file, but all others need a separate file. As a rule, you need a separate file if you submit a separate income tax report for your business.

Read on to find out how to create a Money file and how to open a file. You also discover how to switch back and forth between the Money file where you track your personal finances and the one where you track your business’s finances.

Creating the separate file

Follow these steps to create a new file:

1. **Choose File ➤ New ➤ New File or press Ctrl+N.**
   You see the Create New File dialog box, shown in Figure 11-8.

2. **In the File Name text box, enter a descriptive name for the new file.**
   Be sure to choose a name that is easy to identify. Filenames can be 255
   characters long (though it’s hard to imagine anyone that longwinded). Filenames cannot include the following characters: / \ [ ] : ( " | <> = + ; , ? (if you saw these characters in a comic book, you would think that I was swearing at you).
3. Click OK.

The Back Up When Money Closes dialog box appears. Money wants to close the file that is on-screen and open the one you just created, but before it closes files or closes the Money program, it always asks whether you want to back up the file you have been working on.

4. Click the Back Up Now button.

5. Click the Next button and fill out the Set Up dialog boxes, if you so choose.

Chapter 2 explains setting up a new Money file. Click the Decline button if you want to start Money without using a Microsoft passport.

**Opening the Money file you want to work with**

The fastest way to go from one file to another is to click File on the main menu and select a filename from the bottom of the menu. But if the name of the file you want to open is not on the File menu, follow these steps to switch from one file to another:

1. **Choose File ➤ Open or press Ctrl+O.**

   You see the Open File dialog box.

2. **Find and select the file you want to open.**
3. Click the Open button.

Money insists on backing up a file when you close it to open another, so the Back Up When Money Closes dialog box appears. Earlier in this chapter, I explain all the details about backing up, but suffice it to say that you can click the Postpone button if you’re in a hurry.

4. Click the Back Up Now button.

The new file appears on-screen. You can tell which file you’ve opened by reading its name on the title bar in the upper-left corner of the window.

Renaming and Deleting Money Files

In order to rename a file, it can’t be open. Follow these steps to rename a Money file or delete one that you no longer need:

1. **Choose File**→**Open or press Ctrl+O.**

You see the Open File dialog box.

2. **Locate the file that needs renaming or deleting.**

3. **Right-click the file you want to rename or delete.**

A shortcut menu appears.

4. **Either rename or delete the file:**

   - **To rename:** Click Rename and type the new name over the old one.
   - **To delete:** Click Delete and then click Yes when Money asks whether you are brave enough to really do it.

5. **Click Cancel or press Esc to close the Open dialog box.**
Chapter 12
Pinching Your Pennies

In This Chapter
- Scheduling bills so that they are paid on time
- Formulating a budget with Money
- Tracking your frequent flyer miles
- Keeping your spending under control

“A penny saved is a penny earned,” according to Benjamin Franklin. Apart from finding a better-paying job (or a second job), the only way to make more money and stay out of debt is to save and spend wisely. This chapter explains how to get Money’s help to do just that.

In this chapter, you find out how to plan for a big-ticket purchase such as a house or car, schedule bills so that you pay them on time, put yourself on a budget, and track the frequent flyer miles or points that you earn with credit card purchases.

Scheduling Bills So That They Are Paid on Time

Everybody forgets to pay a bill now and then. Usually, an envelope with an ominous red warning appears in the mail, you pay the bill, and that’s the end of it. But sometimes you have to pay a fee for being late. Credit card issuers, for example, are notorious for charging late fees. Mortgage lenders also do not tolerate tardiness. And if you forget to pay the IRS on time . . . well, I shudder to think what happens if you forget to pay the IRS.

To make sure that you pay bills on time, schedule them in the Bills Summary window. If you want, a list of due and overdue bills can appear in the Money Express window and on the Home Page. (See Chapter 2 to find out how to make the list of bills appear.) On the Home Page in Figure 12-1, for example, one bill is overdue and two are upcoming. Bills are made a part of the budgets that you can create with Money and are used for cash-flow forecasting.
Which bills are candidates for scheduling? Any bill for which you have to pay a late fee. Go ahead and schedule the mortgage payment or rent, vehicle registration fees, credit card payments, alimony payments, and the like. But don’t crowd the Bills Summary window with every bill that you receive. The purpose of scheduling bills is to help pay them on time. A crowded Bills Summary window is very discouraging, for one thing. And facing all those bills is hard because, in a long list of bills, it’s difficult to identify which ones are the most important and need to be paid first.

Advanced versus essential bills

Money offers two ways to schedule bills and deposits — advanced bills and essential bills. Both methods permit you to schedule bill payments, track when payments are due, and assign categories to scheduled bills for budgeting purposes. With advanced bills, however, you can schedule deposits as well as bill payments. You can also schedule investment purchases. And you can tell Money to enter scheduled transactions automatically in your registers as well as stop scheduling transactions after a certain amount of time has elapsed.

Personally, I don’t think advanced bill scheduling is particularly advanced or that essential billing is particularly essential. You may as well go with advanced bill scheduling. It isn’t very much trouble. Follow these steps to switch between advanced bills and essential bills:

1. Click the Bills tab to go to the Bills Summary window.
2. Click the Change Bill Settings link. The Bill Settings tab of the Settings dialog box appears.
3. Click the Switch to Advanced Bills link or the Switch to Essential Bills link.
4. Click the Use Advanced Bills button or the Use Essential Bills button.
By the way, bills aren’t the only things that you can schedule. You can also schedule deposits and account transfers. (I show you how in the section “Scheduling a bill payment or deposit,” later in this chapter.) If your employer deposits your pay directly into a bank account, you can schedule the deposit. Or, you can simply schedule the deposit to remind yourself to do so and to make your future income a part of the financial projections and budgeting that Money does.

**Scheduling a bill payment or deposit**

Follow these steps to schedule a bill or deposit:

1. **Click the Bills tab.**

   You go to the Bills Summary window, as shown in Figure 12-2. You can also get to this window by clicking the Record or Pay Bills link in an Account Register window. The window lists bills, deposits, transfers, and investment purchases that have been scheduled thus far, if you have scheduled any transactions. Days on the calendar appear in boldface when a bill is due or a deposit is expected. (If you don’t see the calendar, select the Show Calendar check box.)

   ![Figure 12-2: Scheduled transactions are listed in the Bills Summary window.](image)

   Click a date to schedule a transaction.
2. If you opted for advanced bills, click the New button and, from the pop-up menu, choose Bill or Deposit. If you opted for essential bills, simply click the New button to schedule a bill.

You see the Create a Recurring Deposit window or the Create a Recurring Bill window (the latter is shown in Figure 12-3). In this window, you describe the bill or deposit, how frequently it is made, and in which account register you will record it.

![Create a recurring bill]

Figure 12-3: In this window, describe bill payments and scheduled deposits that you intend to make.

3. Answer the questions in the Create a Recurring Bill window and click OK.

And no peeking over the shoulder of the next guy to see how he answered these questions.

Questions with an asterisk (*) in the window must be answered. Here is the lowdown on scheduling a bill or deposit:

✔ Pay To/Receive From: Choose the person or business that you will pay or is paying you. These names come from the Payee list.

✔ Pay From/Deposit To: Choose the bank account that you will pay the bill from or enter the deposit in. The Bills Summary (refer to Figure 12-2) has a button called Enter into Register. By clicking that button, you can enter the transaction without having to visit the account register.
Next Payment Date: Enter the date when the next bill is due or the next deposit is to be made.

Payment Method: In the case of a bill, tell how the payment will be made. Choose Print This Transaction if you print checks; choose Write Check if you will write the check by hand. In the case of a deposit, choose Manual Deposit if you make the deposit yourself; choose Direct Deposit if your employer deposits checks directly into your bank account.

Frequency: Choose the option that describes how often the bill falls due or the deposit is made.

Amount: Enter the amount and then click the down arrow to open the pop-up menu and describe the amount:

- This Is a Fixed Amount: The amount never changes and is the same from time period to time period. Choose this option to describe a bill or salary that is the same each month.

- Estimate Because the Amount Varies: You estimate the amount. Choose this option to describe an amount that changes from period to period. Money uses your estimates in cash-flow forecasts and budgets.

- Estimate Based on the Last Number of Instances: If you have used Money for a while, choose this option as well as a number from the Time Period submenu, and Money enters the average amount of the payment or deposit for you.

Category: Choose a category or subcategory for the payment or deposit.

Automatically Enter Transaction: Rather than click the Enter into Register button in the Bills Summary window (refer to Figure 12-2) to enter a transaction, you can have Money enter it for you if you choose this option. (This option isn’t available with essential bills.)

This Series Will End: Choose this option if you know that the bill will stop falling due or that the deposit will stop being made at a certain time in the future. Either enter the number of transactions that remain or enter an ending date in the text boxes. (This option isn’t available with essential bills.)

The following are listed in the Bills Summary window: the payee, the amount, the due date, the frequency of the payment or deposit, and the payment method.

To get a very good look at when bills are due or deposits are supposed to be made, click the Bill Calendar button in the Bills Summary window (you can find it below the Bills tab). Instead of the baby bear calendar at the bottom of the window, you see a papa bear calendar in a new window called View Bills and Deposits on the Calendar.
**How Money tells you to pay bills**

After a bill or deposit is scheduled, Money gives you ten days’ warning to pay it. In other words, you get ten days to get out of Dodge, and if you don’t heed the warning but stick around and gamble at the saloon, Wyatt Earp and Doc Holiday ride you out of town on a rail (whatever that means).

Ten days before a bill is due, Money reminds you to pay it in these locations:

- **The Bills Summary window:** This window lists upcoming bills and deposits (refer to Figure 12-2). Bills that are overdue are shown in red.
- **Home Page:** If you so choose, you can make the Bills and Deposits list appear on the Home Page. (Refer to Figure 12-1, and see Chapter 2 to find out how to make the list appear.) Clicking a bill or deposit takes you to the Bills Summary window.

If ten days isn’t enough advance notice for you, follow these steps to tell Money precisely how to handle upcoming bills and deposits:

1. **Choose Tools ➪ Settings and click the Bill Settings link in the Settings window.**
   
   You can also click the Change Bill Settings link in the Bills Summary window. You see the Bill Settings tab of the Settings dialog box.

2. **In the Remind Me text box, enter how many days ahead of their due dates you want to be reminded that bills and deposits are due.**
   
   While you’re there, notice the Count Only Business Days check box. Select it to exclude weekends and holidays from the countdown.

3. **Click the OK button.**

**Recording a paycheck deposit automatically**

If you schedule advanced bills, the pop-up menu that appears when you click the New button in the Bills Summary window offers an option called Paycheck for recording paycheck deposits. Don’t bother choosing this option button unless you want to keep track of how much of your gross income is devoted to taxes, social security, employee-sponsored IRA accounts, health plans, and so on. In other words, don’t choose the Paycheck option unless you are a stickler for keeping records.

If your employer is worth anything, he or she keeps these records for you. You can consult your employer to get the numbers. If your employer contributes to an IRA account, record that contribution as a scheduled deposit in the IRA, not as a paycheck deposit in which part of your income is diverted to the IRA. The Paycheck option is really for people who want to track small business activity in Money.
Scheduling deposits, transfers, and investment purchases

People who opted for advanced bills (not essential bills) can schedule transfers and investment purchases as well as bill payments in the Bills Summary window. Schedule a transfer if, for example, you always transfer part of your paycheck to a savings account. You can also schedule an investment purchase if you regularly buy shares of a security.

In the case of transfers and investment purchases, the steps for scheduling the transaction are nearly identical to those for scheduling a bill payment: Starting from the Bills Summary window, click the New button, choose an option from the pop-up menu, and answer the questions in the dialog boxes. (See the section “Scheduling a bill payment or deposit,” earlier in this chapter, if you need help.)

Recording a scheduled transaction in a register

Terrible, isn’t it, when a bunch of bills raise their ugly heads in the Bills Summary window or the Bills and Deposits list in the Home Page window. How can you remove all those notices and start from a clean slate? I’m afraid you have to pay the bills (or else skip or cancel them, which is the subject of the next section in this chapter).

Many a Money user has recorded a bill that is due in the Bills Summary window but then forgotten to actually pay the bill. I don’t know why that is. Having gone to the trouble of recording a bill payment, it seems that many people think that the bill is really paid. It’s not paid. No, you still have to get out the old checkbook and mail the check.

Follow these steps to pay bills and make other transactions that you scheduled:

1. Click the Bills tab.

You go to the Bills Summary window (refer to Figure 12-2). You can also get to this window by clicking the Record or Pay Bills link in an Account Register window.

2. Double-click the transaction that needs recording.

You can also select a transaction and then click the Enter into Register button or right-click the transaction and choose Enter into Register. As shown in Figure 12-4, you see the Record dialog box. Looks like a transaction form, doesn’t it? And look — it’s already filled out. (Well, it’s mostly filled out, anyway.)
3. If necessary, fill in the Number box.

You can either enter a check number or click the arrow for a drop-down list of options. Select Print This Transaction to print the check on your printer.

4. If you are paying a bill or recording a transaction whose amount changes from month to month, enter the correct amount in the Amount text box.

5. Click the Record Payment button or press Enter.

To visit the account register where the scheduled transaction was recorded (and see what the new account balance is), right-click the transaction in the Bills Summary window and choose Go to Account from the shortcut menu.

Click the View History link in the Bills Summary window if you have second thoughts about whether a bill needs paying. After you click the link, you see a list of the scheduled transactions that you recorded in the last 60 days. The list tells you plain and simple which bills were paid and which might need to be paid again.

**Skipping a scheduled transaction**

Suppose that you want to skip a scheduled transaction this month, perhaps because you already recorded it in a register. Follow these steps:
1. Click the Bills tab to go to the Bills Summary window (refer to Figure 12-2).
2. Find the transaction that you want to skip and click it.
3. Click the Skip button.
   
The Skip Scheduled Transaction dialog box asks whether you want to skip it this time around, skip all overdue occurrences, or drop the transaction from the list of scheduled transactions.
4. Choose an option and click the OK button.

### Changing a scheduled transaction

If you need to alter a scheduled transaction, select it in the Bills Summary window, click the Edit button, and choose one of these options from the button’s pop-up menu:

- **Edit Series**: Takes you to an Edit window that looks and operates just like the Create a Recurring Deposit or the Create a Recurring Bill window (refer to Figure 12-3) so that you can change the scheduled transaction.
- **Edit a Single Occurrence**: Takes you to a window where you can choose the date of the scheduled transaction that you want to change and then change the transaction.

### Canceling a scheduled transaction

You’ve been a loyal subscriber to the by-mail body-building course and you’re as scrawny as ever, so you decide to quit making the monthly payments that you scheduled in the Bills Summary window. Follow these steps to cancel a scheduled transaction and remove it forever from the window:

1. Click the Bills tab to go to the Bills Summary window (refer to Figure 12-2).
2. Select the scheduled transaction that you want to abandon and click the Delete button.
3. Click the Yes button when Money asks whether you really want to delete the transaction.

You can also right-click a transaction and choose Delete.
**Budgeting with Money**

Except for getting a higher-paying or second job, begging, borrowing, or stealing, the only way to save more money is to put yourself on a budget. A budget is a plan for keeping spending down in different areas, the idea being to make more money available for the things that you want to do — go to college, go to Greece, pay off a credit card debt, and so on.

If you've ever tried to draft a budget on paper, you'll be delighted with the Money budgeting features. As long as you categorize expense transactions when you record them in registers (see Chapter 4), half the work of drafting your budget is already done. You already know how much you spend on groceries, clothing, and dining, for example. Now all you have to do is get Money's help to target the categories in which you spend too much. In other words, all you have to do now is to set budget goals for yourself.

This section of the chapter explains how to draft a budget with Money, including how to set budget goals and, just as important, how to generate graphs and reports that tell you whether you've met your budget.

I strongly recommend waiting at least three months before formulating a budget. Here's the reason: Money gathers data about your spending habits from the transactions that you enter in registers. You can save a good deal of time by using this data for budget projections. To use the data, however, you must have been recording transactions — *all* your transactions — in Money for at least three months.

---

**Some gratuitous budgeting advice**

Budgeting is like dieting: It requires discipline. When you are on a diet, your stomach rumbles. You feel hungry all the time. At dinner parties, you have to say "Just a sliver, please," no matter how delicious the cake looks. The only pleasures in going on a diet are noticing how well your clothes fit and seeing the needle on the bathroom scale point to new, uncharted regions.

Similarly, the only pleasure in living with a budget is seeing the balances in your savings and checking accounts rise to new, uncharted heights. Having to compare prices in the supermarket and go without fancy new duds is hard. Postponing a vacation is hard. Eating meat loaf at home when you could be enjoying *oie rotie aux pruneaux* (roast goose with prune stuffing) in a swanky restaurant is hard.

To make living with a budget easier, try to set realistic goals for yourself. Don't set yourself up for failure by making your budget too strict. Draft a budget that you can live with. Challenge yourself, but don't go overboard. That way, disciplining yourself is easier, more likely to be successful, and much more rewarding.
You formulate a budget in Money through the Budget windows, where you tell Money the following things:

- What you expect your income to be
- How much you propose to set aside for savings and reducing debt
- How much you want to set aside for retirement
- How much you prefer to spend in different expense categories

After making these determinations, you can find out how much money will be left for spending or saving if you meet your budget. You also can generate reports and charts to see whether you’ve met your budget in each spending category.

Before you visit the Budget windows, however, I suggest taking these two steps:

- **Prepare your budget estimates.** The mechanics of drawing up a budget with Money are pretty simple, but creating an actual budget is not. Before you start formulating your budget, create and print a Monthly Cash Flow report, which can help you decide how much to spend each month in different categories. Chapter 15 explains how to create and print reports.

- **Gather the necessary documents.** Figures from paycheck stubs and bills come in handy when budgeting with Money.

### Choosing between advanced and essential budgets

To make budgeting a little simpler, Money offers what it calls *essential budgeting* and *advanced budgeting*. Essential budgets don’t permit you to examine your income and spending in as much detail, but they are easier to set up. Advanced budgets permit you to peer into all the little details of your spending and income, but they require more thought on your part. In a nutshell, here are the differences between essential and advanced budgets:

- In an essential budget, you track your spending in three categories that you deem your “favorites,” but in an advanced budget, you can track your income and spending in every category and subcategory.

- You can formulate only one essential budget, but you can formulate as many advanced budgets as you need.

- You can enter savings goals only in an advanced budget. Savings goals represent a way to track the money that you save by budgeting.
You can account for variations in your income with an advanced budget but not with an essential one.

You can figure one-time expenses, such as car purchases and vacations, into an advanced budget but not into an essential budget.

Essential budgets are useful if you have a regular monthly income and you are concerned with your spending in only a handful of categories. Essential budgets take but a few minutes to set up. Follow these steps to declare whether you want to create an essential or an advanced budget:

1. **Choose Tools** → **Settings**.
2. **Click the Budget Settings link**.
   
   You see the Budget Settings window.

   When you switch from advanced budgeting to essential budgeting, the advanced budget that you already created (if you created one) is stripped down to the, well, bare essentials. And if you created more than one budget, all except the first one is deleted from your Money file.

3. **Click the Switch from the Essential Budget to the Advanced Budget link or the Switch from the Advanced Budget to the Essential Budget link**.
   
   The Budget Settings dialog box appears.

4. **Click the Use Essential Budget or the Use Advanced Budget button**.
   
   If you opted for essential budgets, Money opens the Welcome to Budget window. (For details, see the section “Formulating an essential budget,” later in this chapter.) Money opens the Create a Budget window if you opted for advanced budgets. (Click the Create a Budget link and skip to Step 3 in the next section of this chapter.)

**Getting started with an advanced budget**

The next four sections explain how to formulate an advanced budget. (Later in this chapter, “Formulating an essential budget” explains how to handle essential budgets.) You can start formulating an advanced budget by following these steps:

1. **Click the Budget tab**.
   
   If this is your first stab at creating a budget (and you told Money to create advanced budgets), you see the Create a Budget window. If you’ve already created one budget, you see the Budget Summary window.
2. Click the Next button if this is your first budget; click the Create a Budget link to start a new advanced budget.

You come to the Set Up a Budget window. It outlines what budgeting entails.

If the Enter Income window appears instead of the Set Up a Budget window, Money thinks that you want to create an essential budget, not an advanced one. See the previous section in this chapter to find out the difference between the two kinds of budgets.

To formulate a budget, you give Money information about your income, your expenses, your savings goals, and how much you want to spend in each category. To get from window to window, click the Next button (or the Previous button). These buttons are located at the bottom of windows.

3. Click the Next button to go to the Enter Your Income window.

This window is shown in Figure 12-5. If you’ve scheduled any deposits in the Bills Summary window (see “Scheduling Bills So That They Are Paid on Time,” earlier in this chapter), the monthly amounts of those deposits already appear in the window and are marked by an icon. Your next task is to enter your monthly income (and perhaps your spouse’s monthly income as well) in this window. After you are finished, the Total Monthly Income figure should describe your household’s monthly income. Better keep reading.
Enter your income: Telling Money about your income

To stay within the budget that you create, your spending cannot exceed your income. Unless your income varies wildly from month to month, you don’t have to be a rocket scientist to complete this part of the budget. You can simply tell Money to get your average monthly income and enter it in the window. However, if you are self-employed or if you use Money to track a business, your income probably varies from month to month, and estimating your monthly income is not as easy.

Follow these steps to report your income to the Budget Planner if you haven’t scheduled any deposits or if you earn income beyond what you’re scheduled to receive:

1. Click the Add button.
   You see the Budget Group Name dialog box.

2. Select the second option button, Add a Category to a Budget Group from the List Below, and choose a budget group from the drop-down list; then click the Next button.
   The budget groups are Regular Income, Irregular Income, and Miscellaneous Income. After you add an income category from the Categories list in the next step, the category’s name appears under a budget group in the Enter Your Income window.

   The Choose Categories dialog box, shown in Figure 12-6, appears after you click the Next button. Do these categories look familiar? They are the income categories in the Categories list.

Figure 12-6: Choosing budget categories and subcategories.
3. Choose income categories and subcategories by clicking the check boxes next to their names.

4. Click the Finish button to include each category’s subcategories in the budget estimate.

You return to the Enter Your Income window.

Based on the transactions that you have entered in your account registers, Money enters an average monthly income figure in the Amount column. But what if the figure doesn’t truly represent your monthly income in the category? Either double-click the category or select it and click the Edit button. You see the Edit dialog box, as shown in Figure 12-7. Describe your monthly income as follows:

- **Recurring**: Choose the Recurring option. From the Period drop-down list, choose the option that describes how often you receive income in the category. Enter the amount in the Amount text box.

- **Different each month**: Choose the Custom option. In the month text boxes, enter roughly how much you earn each month in the category.

![Figure 12-7: Describe your income here if Money didn’t estimate it correctly.](image)
The Enter Your Income window also offers these techniques for doing these chores:

- **Moving a category to a different budget group**: Click the Move button and choose the group in the Move dialog box.

- **Creating a new budget group**: Click the Add button and, in the Choose Categories dialog box (refer to Figure 12-6), select the first option button and enter a name for the group in the first text box. Then click the Next button and choose categories and subcategories for the group.

- **Removing categories**: Click a category name and then click the Remove button.

When you click the Autobudget link, you see the Autobudget dialog box. The dialog box analyzes your past spending (yeah, right) and lists the amounts that it thinks you should spend in most of your categories. Autobudget doesn’t work, however, if you haven’t entered at least a month’s worth of transactions.

To enter new budget goals quickly, get the numbers from the Autobudget dialog box. To do that, click the Clear All button, select the check box next to each category and subcategory that you want to enter in your budget, and then click OK. The numbers from the Autobudget dialog box are transferred to the Enter Your Income and the Enter Your Expenses windows.

![Autobudget dialog box](image)

The Enter Your Income window also offers these techniques for doing these chores:
Enter your expenses: Budgeting your monthly expenses

Now comes the hard but interesting part — the Enter Your Expenses window, which is shown in Figure 12-8. Your task now, if you choose to accept it, is to enter category-by-category budget goals and tell Money how much you intend to spend in each category. In this window, you look long and hard at your spending habits to find out where you spend and how you can rein in your spending. If you’ve scheduled any bills in the Bills Summary window (see “Scheduling Bills So That They Are Paid on Time,” earlier in this chapter), the monthly amounts of those bills are already listed in the window and are marked by an icon.

The buttons along the bottom of the window — Add, Move, Edit, Remove, and View Spending — work the same way in this window as they do in the Enter Your Income window. Click the Add button to add a category or subcategory to the list of budget categories. Select a category and click the Edit button to open the Edit dialog box (refer to Figure 12-8); then, declare how much you spend monthly in a category. Tinker with the numbers until you formulate a budget that challenges you to spend more wisely.
Entering category-by-category spending goals can be a tedious activity. Fortunately, Money offers a shortcut for doing the job a little faster — the Autobudget. Read the sidebar “Autobudgeting with Money” to find out how you can enter starting-point numbers for spending goals.

**Savings goals: Declaring what to do with extra money**

The Savings Goals window is for declaring what you will do with the money that you save by budgeting. Click the Spend All Excess Income option button if you want to spend it, but if you are looking ahead to a vacation, a new car, or something else you want to save for, you can put its name in the Savings Goals window. In Budget reports, Money lists these goals and shows you in monetary terms how close or far away you are from attaining them.

Click the Add Another Goal button, enter a name for the goal, declare the date by which you hope to achieve it, and enter the amount that you hope to save.

**Budget summary and status**

After you fill in the Savings Goals window, you come to the first Budget Summary window. Scroll through the window, admire the pie charts, and marvel at how much you will save by sticking to your budget. Then click the Finish button.

The final window, Budget Summary, is shown in Figure 12-9. It tells you whether you are meeting your budget goals this month. By choosing an option from the Change Time Period drop-down list, you can see whether your weekly or yearly income covers your budget expenses. Scroll down the list. Overbudgeted items are listed at the top.

The Budget Summary window offers a couple of buttons for tinkering with the budget. Click the Reallocate Funds button if you have exceeded your spending limit in one category and you want to “borrow” money from another category to cover the overrun. Click the Add a One-Time Item button to enter a one-time expense, such as a major car repair, into the budget. Personally, I think these buttons are silly. The purpose of a budget is not to track your spending more closely. The purpose is to get a better sense of where you spend and how you can spend more wisely. These buttons are meant to help you force your budget to balance, but is that really necessary?
Formulating an essential budget

Earlier in this chapter, the section “Choosing between advanced and essential budgets” explained the difference between the two budgets. Follow these steps to formulate a budget if you chose essential budgets over advanced ones:

1. **Click the Budget tab.**
   
   You see the Create a Budget window.

2. **Click the Next button.**
   
   The Enter Income window appears.

3. **Describe your income in this window by entering a figure in the middle text box and, from the drop-down menu, describing how often you are paid; then click the Next button.**
   
   For example, if you are paid $1,500 twice monthly, enter 1500 and choose Twice a Month from the drop-down menu. Money uses the figure that you enter to see whether your spending exceeds your income.

4. **In the Select Your Budget Categories window, select the name of each spending category that you want to track in your budget; then click the Next button.**
   
   Money compares your monthly spending in these categories to your monthly income.
5. In the Enter Your Expenses window, enter how much you want to spend monthly in each category that you select in Step 4; then click the Next button.

The total of your expenses appears in the upper-right corner of the screen, as shown in Figure 12-10. Make sure that the expense total doesn’t exceed your monthly income total.

![Figure 12-10: Formulating an essential budget.](image)

6. In the Select Your Spending Tracker Categories window, select the categories that you want to track closely; then click the Finish button.

Graphs showing your spending in these three categories appear in the Budget Summary window so that you can track your spending more carefully.

**Seeing whether you met your budget goals**

You’ve drawn up a budget and carefully recorded your income and expenses for a month or more, and now the moment of truth has arrived. It’s time to see whether you’ve met your budget. The envelope, please . . . . Follow these steps to create a budget report or graph and find out how well you did:

1. **Click the Reports tab.**
   The Reports Home window appears.

2. **Click the Monthly Budget or the Annual Budget link to create a monthly or annual budget.**
   You can find these links in the Income and Expenses report category.
You see a Budget report, as shown in Figure 12-11. It shows how your budget projections compare to your actual spending. Look in the Difference column to see whether you overspent or underspent your budget projections. Where you overspent, you see a red, negative number in parentheses.

| Monthly Budget  
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Categories</strong></td>
</tr>
<tr>
<td>-----------------</td>
</tr>
<tr>
<td>Other expenses</td>
</tr>
<tr>
<td>Auto: New Car</td>
</tr>
<tr>
<td>Auto: Registration Fee</td>
</tr>
<tr>
<td>Auto: Repair</td>
</tr>
<tr>
<td>Backpacking Equipment</td>
</tr>
<tr>
<td>Books</td>
</tr>
<tr>
<td>Donations</td>
</tr>
<tr>
<td>Donations: Non Tax</td>
</tr>
<tr>
<td>Education: Aid/Scholarship</td>
</tr>
<tr>
<td>Entertainment: Business</td>
</tr>
<tr>
<td>Food : All</td>
</tr>
<tr>
<td>Gardening</td>
</tr>
<tr>
<td>Gifts</td>
</tr>
<tr>
<td>Groceries</td>
</tr>
<tr>
<td>Home Repair</td>
</tr>
<tr>
<td>Housecleaning</td>
</tr>
<tr>
<td>Insurance: Homeowners</td>
</tr>
<tr>
<td>Kids Education</td>
</tr>
<tr>
<td>Leisure</td>
</tr>
<tr>
<td>Meals and Entertainments</td>
</tr>
<tr>
<td>Medical: Dental</td>
</tr>
<tr>
<td>Medical: Optometry</td>
</tr>
</tbody>
</table>

Care to see the report in chart form?

3. Under Common Tasks, click the Change View link and then choose Bar Chart from the submenu.

A pair of bars corresponds to each category and subcategory in your budget. Gently slide the mouse pointer over the bars to read the category names and spending amounts. The Actual bar on the left shows what you spent, and the Budgeted bar on the right shows how much the budget called for you to spend. The Difference bar shows by how much the Actual and Budgeted figures differ.

You can customize the Home Page to make it show a small budget summary report (see Chapter 2).

**Working with more than one budget . . .**

You can formulate more than one budget. Some people formulate a pessimistic and an optimistic budget. Some formulate a gloomy and a hopeful budget. In any case, if you have already fashioned a budget and you want to fashion a second one, click the Budget tab to go to the Budget Summary window; then click the Create a New Budget link. You see the Set Up a Budget window. Take it from there.
To open and examine different budgets, click the Budget tab and then click the Save or Open a New Budget link. You see the Save or Open a Budget dialog box, as shown in Figure 12-12. Select the budget that you want and click the Load Budget button.

![Figure 12-12: Choosing which budget to tinker with.](image)

### Tracking Your Frequent Flyer Miles

Some credit card companies entice their customers with frequent flyer miles or frequent flyer points. For every dollar that you charge to your credit card, you are awarded miles or points to be redeemed at an airline ticket counter. These programs provide a wonderful way to fly for free, and to make sure that you are being credited properly, you can track miles or points in a Frequent Flyer account.

Follow these steps to set up an account for tracking frequent flyer miles or points:

1. **Click the Banking tab to go to the Account List window.**
2. **Click the Add a Frequent Flyer Plan link.**
   
   You can find this link under Common Tasks. After you click it, you see the New Frequent Flyer dialog box.
3. **For tracking purposes, enter a name for the program and click the Next button.**
4. **Choose Track Miles or Track Points to describe how miles are earned; then click the Next button.**
5. **Enter how many miles or points you have already earned, if any; then click the Next button.**
6. **Declare how and when the program expires and click the Next button.**
7. **Click the Yes button to link the program to a Money credit card account; then choose the name of the account from the Account drop-down list.**
The name for the frequent flyer program that you entered in Step 1 is added to the Account List window. (If you don’t see a name, select the Show Frequent Flyer Programs check box.) To see how many miles or points you have earned, add more miles or points, or deduct miles or points, select the name of the account in the Account List window. You see a Frequent Flyer screen like the one shown in Figure 12-13. From here, you can keep careful tabs on your miles or points and make sure that you get that trip to Hawaii.

The name for the frequent flyer program that you entered in Step 1 is added to the Account List window. (If you don’t see a name, select the Show Frequent Flyer Programs check box.) To see how many miles or points you have earned, add more miles or points, or deduct miles or points, select the name of the account in the Account List window. You see a Frequent Flyer screen like the one shown in Figure 12-13. From here, you can keep careful tabs on your miles or points and make sure that you get that trip to Hawaii.
Chapter 13

Planning for the Years Ahead

In This Chapter
- Being alerted to important financial events
- Projecting your cash flow
- Projecting your financial future with the Lifetime Planner
- Devising a plan to get out of debt

Most people don’t like focusing on the future, and who can blame them? Retirement, children’s college expenses, next year’s taxes — who wants to think about all that? Maybe it’s better to live fast, die young, and leave a beautiful memory.

Actually, you would do well to plan ahead for, or at least give a moment’s consideration to, your financial future. This chapter explains how to enlist Money’s help in planning for your retirement and other long-term objectives. You also discover how to use Money as your executive secretary and have Money remind you when you need to make important financial decisions and considerations. This chapter even shows you how to use Money to gaze into the future and predict how full or empty your checking and savings accounts will be.

FYI Alerts, the Lifetime Planner, and the Debt Reduction Planner are not available in the Standard edition of Money.

Being Alerted to Important Events

Who doesn’t need a wake-up call now and then? To keep from slumbering, you can make what Money calls Advisor FYI alerts appear on the Home Page and in Monthly reports (if you generate Monthly reports). Clicking an alert takes you to the Review the Advisor FYI Details window, where you can find out why you are being alerted. Alerts are notices about upcoming financial events and dates. As part of the Advisor FYI feature, you can also get financial advice. Figure 13-1 shows an alert in the Review the Advisor FYI Details window.
To tell Money that you want to be alerted and what you want to be alerted about, choose Tools ➪ Alerts Center and click the Customize Your Advisor FYI alerts link in the Alerts Center window. You see the Advisor FYI Options dialog box, as shown in Figure 13-2.

Select check boxes beside the subjects that you deem important enough to be alerted about. If you have questions about a subject, read its description on the right side of the dialog box.
Notice that the first three alert check boxes on the Choose Advisor FYI tab also happen to be similar to the names of tabs in the Advisor FYI Options dialog box. If you selected one of the first four check boxes, visit its tab to tell Money precisely how to alert you:

- **Account Balances:** Choose an account and use the text boxes to tell Money to alert you when the balance rises above or falls below a certain level.
- **Important Dates:** Enter and describe a date. Money alerts you to important tax-filing dates. Click the New button and enter a date that means something to you — a birthday, for example.
- **Investment Alerts:** Have Money alert you when a security reaches a certain high or low level. (Chapter 9 explains this one in detail.)

The last six check boxes on the Choose Advisor FYI tab are for getting articles and advice about debt reduction, investing, mortgages, budgeting, taxes, and your frequent flyer program, if you are enrolled in one (Chapter 12 explains that one).

---

**Projecting Your Cash Flow**

Cash flow is a business term that describes how much day-to-day money will be on hand in the future. Cash flow is a measure of a business’s health. Thanks to the miracle of computing, you can look ahead to what your cash flow will be — sort of. Money permits you to peek into the future with the Cash Flow Review command, but for the command to do its job, you must have been using Money for a while and have a regular income. The Cash Flow Review command works best for people who make a monthly salary or earn roughly the same amount of money each month.

To make cash-flow projections, Money takes into account your present account balances, postdated transactions in account registers, average increases and decreases in your primary checking and savings accounts, scheduled transactions (if you’ve scheduled any), and your budget (if you formulated a budget). Scheduling transactions, a subject of Chapter 12, does wonders for cash-flow projections because it gives Money more data to work with. Money offers one or two ways to tinker with projections to make them more accurate.

Click the Bills tab and, in the Bills Summary window, click the Forecast Cash Flow link (you can find it under Common Tasks). You see the Forecast Your Cash Flow window, as shown in Figure 13-3. I hope the lines on your cash-flow chart are rising gloriously, not steeply falling. By choosing accounts from the
Account drop-down list and different time periods from the Time Period drop-down list, you can peer into different time frames. How do you like this crystal ball?

Choose an account.  
Choose a time period.

If you suspect that the cash-flow projections aren’t reported correctly, try adding transactions to the list at the bottom of the window to describe your financial activity. Choose an option from the Time Period drop-down list to describe how often the activity takes places, click the Add button at the bottom of the window, and choose Withdrawal, Deposit, or Transfer from the pop-up menu. You’ll see the Add Transaction window, which looks and works like a transaction form. Enter a transaction and click OK. The transaction is entered on the list in the window. Scheduled transactions, if you’ve made any, already appear on the list. Choose the One-Time Item option from the pop-up menu to find out how one-time expenses or earnings — the purchase of a boat, a cash gift from Aunt Enid — affect your cash flow.

Under Common Tasks on the left side of the window, Money offers techniques for adjusting cash-flow projections and playing what-if games. Check out these options to read the future more accurately:

- **Try Cash Flow Scenarios:** Takes you to the Play What-If Cash Flow window, where you can see what happens to projections if you spend or earn more

- **Add an Item:** Offers the same options as the Add button
Introducing the Lifetime Planner

I call the Lifetime Planner a “monster” because if you want to — and if you have a lot of spare time on your hands — you can use it to map out your hopes and dreams for the future and find out whether your income will support your hopes and dreams. The Lifetime Planner is a sort of financial counselor in a can. Rather than visit the offices of a financial counselor (and be charged accordingly), you can try your hand with the Lifetime Planner.

To check out the Lifetime Planner, click the Planning tab and, in the Planning window, click the Lifetime Planner link. You land in the Lifetime Planner window. Notice the links on the left side — About You, Income, Taxes & Inflation, and so on. By clicking those links and entering information in different windows, you tell Money how long you expect to live, what you expect your income to be, how you think taxes and inflation will affect your income, how much you expect your savings and investments to grow, what your assets are, how much debt you have, and what your living expenses are. (I show you how to do all these things shortly.)

When you finish prognosticating, you can go to the Summary window and generate a Bottom Line chart like the one displayed in Figure 13-4, which shows how much money you will have when you retire. To generate the chart, Money looks at the balances in your accounts, makes projections about your future income, and compares your future income to how much you expect your living expenses and financial obligations to cost in the future.

The fellow whose chart is shown in Figure 13-4 will retire in 2027 with an accumulated wealth of about $75,000, start drawing on his savings and retirement income, fall deeply into debt, die in the year 2047, and leave behind approximately $750,000 in debt. The eloquent understatement You need to fine-tune your plan appears at the top of the chart. Most people have to fine-tune their plan, but that is the purpose of the Lifetime Planner — to make you think long and hard about the future.

Besides the Bottom Line chart, you can generate many other charts when you finish formulating your lifetime plan. The chart in Figure 13-5, for example, shows how a couple’s combined salaries will grow over time. To forecast the future in a chart, select a question from the Pick a Question drop-down list.
The Lifetime Planner makes its projections in today’s dollars, not the inflated dollars of tomorrow. Most of the Lifetime Planner screens, however, have check boxes called Show Effects of Inflation that you can check to change the dollar figures to tomorrow’s dollars.
About you: Telling Money about yourself and your dependents

The first step in using the Lifetime Planner is to click the Lifetime Planner link to get to the Lifetime Planner window and then click the Get Going on Your Plan link or the About You link. You land in the Tell Us about Yourself window, as shown in Figure 13-6. Money uses the data you enter here to make long-term projections. For example, between your retirement age and your life expectancy age (read “the age you want to die”), you will draw from the money that you saved for retirement. Money uses that data to determine how much you need to save for retirement.

If you have dependents or a spouse, enter their data as well in the bottom half of the window. Click the New button and fill in the Add Person dialog box to describe a dependent. Money needs information about dependents because, with you as their sole support, they draw upon your income now and in the future. Click the Edit button to change the information about a dependent or the Delete button to delete a dependent from the list.

Income: Describing your present and future income

The next step is to click the Income link (or click Next) and tell the planner what your income is and how you expect it to increase (I certainly hope it increases) over time. The Lifetime Planner needs to know this information so that it can determine whether you will have enough income to meet your goals.
In the Career window, enter your gross annual salary or wage income (what you make before taxes) in the Annual Gross Salary text box. Notice the following gizmos on this screen that you can use to help describe your future income:

- **Annual Raises button**: Money assumes that your salary or wage income will increase by 3 percent each year until age 50, at which time society will cruelly stop giving you pay raises. To change these assumptions, click the Annual Raises button and make entries in the Annual Raises dialog box.

- **What Events will affect your salary?**: Click the New button to describe an event — a life change that affects your income, such as changing jobs, taking time off, or working fewer hours. If an event is looming in your future, click the New button and describe the event in the New Career Event dialog boxes.

If you have a spouse or partner and you are tracking his or her income in Money, fill in the second Career screen as well. Then click the Other Income button to go to the Other Income screen.

On the Other Income screen, you describe income from pensions, Social Security, inheritances, alimony, and other such income sources. Click the New Income button and make choices in the dialog boxes to describe this extra income.

### Taxes & Inflation: Describing the tax and inflation rate

When you click the Taxes & Inflation link (or click Next), you come to a window for describing the two things that eat away at your income: taxes and inflation. Tell Money what the tax rate in your state is and what you think the annual inflation rate will be:

- **Tax rate**: Select your home state from the Enter Your State drop-down list to let Money determine the tax rate. You can also select the Adjust the Effective Tax Rate Myself option button and then drag the slider option to the rate that you think is correct.

- **Inflation rate**: Money assumes that the inflation rate will be 3 percent, but if you disagree, click the Change Inflation Rate button and enter a different rate.
Savings & Investments: Describing your retirement savings

The next step is to click the Savings & Investments link in the Lifetime Planner window and tell Money which of your accounts are meant for retirement savings. When you click this link, you see the window that’s shown in Figure 13-7. The amounts in the Account Value column come directly from your account registers.

In this and the other two Savings & Investments windows, you tell Money whether to include an account in future projections, how much you will contribute to these accounts in the years ahead, and by what rate you expect the accounts to grow:

- **Accounts window**: Checking and savings accounts for day-to-day expenses do not belong in projections. To exclude an account, click its name and then select the Exclude from Lifetime Plan check box (you can find it in the lower-right corner of the window). Click the New Account button to describe an account that isn’t on the list.

- **Savings Contributions window**: Click the New Contribution button and fill in the dialog boxes to describe how much you will contribute to your retirement, savings, and investment accounts over the years. When you click a contribution on the Contribution Name list, its particulars appear in the bottom part of the window. To change a particular, click a link on the bottom of the screen and fill in the dialog box that appears.
Life Insurance window: Click the Add Policy button and describe any life insurance policies that you and your partner have (if you have a partner) in the dialog boxes. The Lifetime Planner uses the value of the policy as a means of calculating future income.

Expected Return: Describing how your money will grow

Click the Expected Return link to describe how you expect your savings and investments to grow until you retire and after you retire. Money has preconceived (and rather liberal) ideas about how much accounts will grow in value (by 9 percent before retirement and by 7 percent after retirement). If you don’t care for Money’s estimates, click the Simple Change link to enter a rate for all your retirement accounts, or click the Details Change link to enter rates for each account.

Homes & Assets: Describing things of value that you own or will own

Houses, property, and businesses that you own count as assets that will grow in value over the years. As such, they can be included in wealth projections. You can also count jewelry, antiques, and collectibles as assets. To include assets in projections, click the Homes & Assets link.

To tell Money about an asset, click the Add Asset button and fill in the dialog boxes. Assets appear on the Name of Asset or Asset Account list. To change the particulars of an asset — its value, appreciation rate, and so on — click the asset on the list and then click a link at the bottom of the screen. You see a dialog box for changing the particulars.

Do not count things that depreciate (decrease in value over the years), such as equipment or cars, as assets.

Loans & Debt: Describing current and future loans

No projection can be accurate unless it includes information about loans and debts. Click the Loans & Debt link to describe the money that you owe and will owe for future debts, loans, and mortgages.
Loan and mortgage accounts that you set up already (see Chapter 16) appear in the Loans & Debt window, as do the projections of your debt reduction plan if you make one. (See the section “Planning to Get Out Of Debt,” later in this chapter.)

To describe a future debt or loan, click the New Loan button and fill in the dialog boxes. Be sure to select the No, I Plan to Open This Loan in the Future option button; if you don’t, you go to the Loan Wizard, where you set up a new Loan account.

To change the particulars of a loan or debt on this screen, select the name of the loan or debt, click the Edit button, and then change the particulars in the Edit Loan dialog boxes.

**Expenses: Describing the cost of living**

When you click the Expenses link, you see the Living Expenses screen, as shown in Figure 13-8. Here you describe how much it costs for you and anyone you support to live. The names of people on this list come from the About You screen.

Money gets the annual living expenses figure at the top of the screen by deducting taxes, savings contributions, and loan payments from your annual income. If you want to get the figure from your budget (if you created a budget), click the Estimate Expenses button and, in the dialog box that appears, select the Use the Annual Budget Estimate check box to get the number from your budget. (Chapter 12 describes budgeting.)
Adjustments to your living expenses — for example, caring for an elderly person or having a child — appear on the list. Click the New button and fill in the New Living Expense Adjustment dialog box if an event in your future will affect your living expenses. Similarly, you can select an adjustment on the list and click the Edit button to adjust its cost or duration.

The College & Other window is for taking account of college expenses, trips to Madagascar, and other expensive interludes. Click the New Expense button and fill in the dialog boxes to describe these expenses.

Results: Reading your financial future

At last, you can click the Results link in the Lifetime Planner window and examine your plan to see whether you will be financially sound in the years to come. You can discover the following about your future by clicking these links:

✓ The Bottom Line: A chart that shows how much wealth you will have in the years to come and how well your savings will support you in retirement (refer to Figure 13-4).

✓ Comparing Plans: A chart showing different lifetime plans. If you click the Improving Your Plan link and tinker with your plan, the results of the new plan show on this screen in comparison to the baseline plan, the plan that you started with.

✓ Improving Your Plan: Practical advice for improving your financial future and links to Web sites where you can get financial advice.

✓ Forecasts: Charts that clearly show how much you will save each year, how your salary will increase, and when loans will be paid off, among other things. Choose a question from the Pick a Question drop-down list to generate a new chart. (Refer to Figure 13-5.)

✓ Assumptions: A summary of all the choices and entries that you made in the Lifetime Planner windows. Money uses this data for its financial projections.

✓ Yearly Snapshot: A report on the state of your future finances. Drag the Pick a Year slider or enter a new year to see what your financial picture will be in the years to come.

Action Plan: What you should do next

Click the Action Plan link to receive a ream of advice about improving your financial position. You can find advice about saving, choosing profitable investments, and choosing the right life insurance policy, among other things.
Playing “what if” with your future

After you have gone to the significant trouble of formulating a lifetime plan, you can use the plan as a means of playing “what if” with your future. What if you retire early — how well would your retirement savings and investments support you? Suppose that you decide to take a sabbatical from work — can you afford it? You can ask questions like these and see what happens to your lifetime plan. Figure 13-9 answers the question “What would happen to my retirement savings and investments if the stock market fell, gulp!, by 50 percent?”

Follow these steps to test different scenarios on your lifetime plan:

1. Click the Planning tab to go to the Planning window.
2. Click the Financial Events Modeler link.
   After you click this link, you see the Welcome to the Financial Event Modeler window.
3. Click the Start Exploring link.
4. In the Goal window, choose a question from the Scenario drop-down list and enter other information as necessary.
   Depending on the question that you pose, you are asked for different types of information.
Planning to Get Out of Debt

Paying off your credit card debt may be the single most important step you can take to improve your financial picture. Credit card issuers charge outrageous rates of interest, and you have to pay these interest charges every month if you don’t pay off, or at least pay down, the balance that you owe on your credit cards.

To help you get the discipline to pay off credit card debt, Money offers the Debt Reduction Planner. With this gizmo, you decide how much you can devote to reducing debt each month, and then you schedule an extra payment to help ensure that the debts are paid each month. (Chapter 11 explains scheduling payments.)

Follow these steps to devise a debt-reduction plan:

1. Click the Planning tab to go to the Planning window.

2. Click the Debt Reduction Planner link.

   You go to the Debt Reduction Planner window.

3. Click the Continue button.

   You see the Include Debt Accounts in Your Plan window, which lists all the credit card, liability, line of credit, loan, and mortgage accounts you set up with Money (Chapter 16 explains loan and mortgage accounts), as well as how much you owe on each account, the interest rate, and other information.

   Your next step is to tell Money which accounts you want to pay off, but you shouldn’t include loan and mortgage accounts in the plan. The interest rates on these types of accounts are not high, or they are at least reasonable, and the interest on some of them is tax deductible as well. To reduce your debt, your first job is to pay down credit card and line-of-credit debt.
4. Tell Money which accounts to include in your plan by selecting an account and clicking the Move Up or the Move Down button.

Clicking this button moves the plan under Account in Debt Plan or Debt Accounts Not in Debt Plan.

5. Select an account and click the Edit Debt Info button to describe the account to Money.

You must fill in dialog boxes to describe how much you owe and how much you have to pay each month on the debt, as well as describe the interest rate, payment frequency, and other particulars of the plan.

6. Click the Next button to move to the Define Your Payment Plan window.

Under Status, in the lower-left corner of the window, you see how much you owe, how much you spend to service your debts, and when you will be out of debt at the rate that you are paying now, as shown in Figure 13-10.

7. Do one of the following:

- Click the What I Want to Pay Each Month option button and enter in the text box how much extra money you want to pay each month to get out of debt.

- Click the The Date I Want to Be Out of Debt option button and drag the slider to choose a new target date.

Click the Next button. You see the View Your Debt Plan graph, which shows how your debt is reduced over time.
8. Click the Next button.

You see the Take Action and Reduce Your Debt window. It offers some gratuitous advice about reducing debt. If you want to schedule debt payments, click an item in the box and see Chapter 12 to see how scheduling works.

9. Click the Finish button.

You land on the Home Page.
Chapter 14
Preparing for Tax Time

In This Chapter
- Tagging categories for tax-reporting purposes
- Seeing line-item income and expenses
- Generating tax reports
- Estimating how much you will owe in taxes
- Scheduling tax dates
- Discovering tax-deductible expenses
- Calculating how much to withhold for taxes
- Estimating capital gains taxes
- Exporting Money data to a tax-preparation software package

Benjamin Franklin wrote, “In this world, nothing is certain but death and taxes.” This chapter explains how to do your best by one of these certainties. As for the other, all you can do about it is to eat right, get enough sleep and exercise, and hope for the best.

In this chapter, you discover how to estimate your next tax bill, get Money’s help finding tax-deductible expenses, and determine how much to withhold from your paycheck for taxes. You also find out how to determine capital gains taxes on the sale of a security, generate tax reports, and prepare Money data so that you can use it in a tax-preparation software package.

Tagging Categories for Tax-Reporting Purposes

Especially if you are self-employed, one of the most important things you will ever do in Money is tag categories that pertain to income taxes. By doing that, you can generate tax reports that tell you how much you spent in
tax-deductible categories such as Office Supplies or Business Travel. Accountants charge a small fortune to review registers and find tax-deductible expenses, and if you do your own taxes, searching for and tabulating tax-deductible expenses can take hours. Knowing what your income is can also be a chore if you are self-employed and you have to tabulate your income and determine precisely where all that money came from. However, if you tag tax-related categories, Money can tabulate your tax deductions and income in a matter of seconds. You can take the numbers that money generates in tax reports and plug them into your tax return or give them to your accountant.

Money offers a special window for tagging tax-related categories and subcategories. In the window, you can select a check box to make sure that a category is figured into the tax reports you can generate with Money. And you can also assign a category or subcategory to a line item on a tax form.

Follow these steps to give an existing category or subcategory tax-related status so that it is figured into tax reports and, if possible, assign tax forms and line items to a category or subcategory:

1. Click the Banking tab.
2. Click the Account Tools button and choose Categories & Payees from the drop-down menu.
   
   The Set Up Your Categories window opens. You can also get to this window by pressing Ctrl+Shift+C.
3. Click the Set Up Tax Categories link.
   
   You can find this link on the left side of the window under Common Tasks. After you click the link, you see the Categories window, only this time drop-down lists appear in the lower-right corner so that you can mark categories for tax reports and assign categories to line items on tax forms, as shown in Figure 14-1.

   Where possible, the generic categories and subcategories that Money creates automatically are assigned tax forms and form lines. You can see them by scrolling down the list. Tax-related categories show an X in the Tax column. In the Tax Form and Form Line columns, you can see where tax forms and lines have been assigned to categories and subcategories.

4. Scroll down the list until you find a category or subcategory whose tax status needs changing; then click the category or subcategory to select it.
5. Select the Include on Tax Reports check box.
6. **Click the down arrow on the Tax Form drop-down list and select a tax form.**

   Being able to tag categories and subcategories to tax forms (such as a W-2, Schedule B, or Form 1040) is a neat idea, but you have to know the tax forms well to pull it off. You have to know, for example, that tax-exempt interest is reported on the Interest Income line of Schedule B. Who besides a tax accountant knows that?

   If you want to be able to run Tax Software Reports, study your income tax returns from past years to see which forms and form lines to assign to the categories and subcategories that you use. You can also speak to an accountant. Be aware that tax forms change yearly, so what goes on one line one year may go somewhere else the next.

7. **Click the down arrow on the Form Line drop-down list and select the form line on which the income or expense is to be reported.**

8. **If you use multiple forms (more than one W-2, for example) to report your income, enter the number of forms that you use in the Form Copy text box.**

9. **Continue scrolling in the window until you have marked all the tax-related categories appropriately.**

   Later in this chapter, “Generating Tax Reports” explains how to generate reports that tell you precisely how much you spent or paid in tax-related categories and subcategories.
Looking at Line-Item Income and Expenses

As long as you went to the trouble to assign line items to different categories (see the previous section in this chapter), you can find out very quickly what your tax-related income and expenses are as reported on tax forms. Click the Taxes tab and, in the Taxes window, click the Tax Tools button and choose Tax Line Manager from the drop-down menu. You see the Review Your Tax-Related Income and Expenses window, shown in Figure 14-2. If you have the wherewithal to do your own taxes, you can plug these numbers right into your tax return. In fact, this window is modeled after a tax form to make plugging in the numbers easier.

![Figure 14-2: You can plug these numbers straight into a tax form.](image)

The View menu offers some nifty commands for examining tax lines. Choose Tax Lines That Have Been Used to see only the lines that pertain to your income and expenses in the window.

To remove a line item from the window or change a line item, select the line item and click the Go to Details button. You land in a window for deleting line items (click the Remove button) and changing income and expense figures (click the Edit button).
**Generating Tax Reports**

Money tax reports are very convenient indeed. Instead of scouring an account register for tax-related income and expenses, you can simply generate a report. You know right away what your income is and how many adjustments and deductions you can make.

The fastest way to generate a tax report is to click the Reports tab. You land in the Reports Home window, where you can generate one of these reports (if you don’t see the Taxes reports listed here, click the Change Report Settings link and then click Switch from Essential Reports to Advanced Reports):

- **Tax-Related Transactions**: Shows category by category what your income and expenses are in tax-related categories. Use this report to calculate income and tax-deductible expenses for tax returns.

- **Capital Gains**: Shows capital gains and losses for the securities that you sold or purchased this year. Use this report to calculate and tabulate capital gains and losses.

- **Loan Interest**: Shows how much of your loan payments went to servicing interest. Use this report to calculate tax-deductible interest payments. You must have set up a loan account to generate this report. (See Chapter 16.)

- **Tax Software Report**: Shows your total income and expenses as they are to be reported on tax lines on various tax forms. Use this report to gather data for tax-software programs.

Chapter 15 explains reports and charts in detail, including how to customize them and change their reporting dates.

**Estimating Your Tax Bill**

Knowing what you will owe in taxes next year never hurts, especially if you don’t like surprises. Money offers the Tax Estimator to help you estimate what you owe for last year and what you will owe for this year. Notice, however, that the thing is called the Tax Estimator, not the Tax Accountant. The Tax Estimator can give you a rough idea of what you owe or will owe the IRS, but it can’t take the place of a tax accountant and do your income taxes for you.
To find out what your tax bill is for last year or maybe for the coming year, click the Taxes tab to go to the Tax window and then click the Tax Estimator link. You land in the Welcome to the Tax Estimator window. Clicking the Next button as you go along, you answer Money's survey questions about you, your income, adjustments to your income, deductions, and tax credits. These questions are the very same ones that tax accountants ask when they determine how to lower your taxes. By the time you reach the Summary window, Money has prepared an estimated tax return for you, like the one shown in Figure 14-3. Either click the Next button or click the Tax Estimator Steps links on the left side of the Money screen to get from window to window.

Finding out the tax rates

Built into the Money 2006 Tax Estimator are accurate tax rates for 2005. But suppose that you are trying to estimate your income taxes for 2007 or 2008. How can you obtain the correct tax rates for those years?

Follow these steps to download the latest tax rates from Microsoft:

1. Choose Tools ➪ Settings to go to the Settings window.
2. Click the Tax Settings link. You land in the Set Up Your File for Tax Tracking window.
3. Click the Set Your Filing Status and View Tax Rates by Income Bracket link.
4. A window appears and shows you the latest tax rates.
5. Click the Update Internet Info link.
6. Click the Update button in the Update Online Information dialog box.

Your machine connects to the Internet, and the latest tax rates are downloaded to your computer.

<table>
<thead>
<tr>
<th>Income</th>
<th>Tax Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>$0.00</td>
<td>15%</td>
</tr>
<tr>
<td>$14,000.00</td>
<td>15%</td>
</tr>
<tr>
<td>$54,000.00</td>
<td>25%</td>
</tr>
<tr>
<td>$114,051.00</td>
<td>28%</td>
</tr>
<tr>
<td>$124,701.00</td>
<td>33%</td>
</tr>
<tr>
<td>$1,011,951.00</td>
<td>35%</td>
</tr>
<tr>
<td>Long-Term Capital Gains taxed at a maximum rate of 20%</td>
<td></td>
</tr>
<tr>
<td>Dividends taxed at a maximum rate of 20%</td>
<td></td>
</tr>
</tbody>
</table>

Standard Deduction: $9,800.00
Exemption Amount: $3,925.00
Exemption cutoff: $39,750.00
Deduction cutoff: $139,750.00
Here’s some good news: Some of the information is already entered in these windows because Money grabbed it from the data file. If you enter your own numbers and regret doing so, you can get the numbers from Money by clicking the Reset Values button along the bottom of a window and choosing an option from the pop-up menu that describes how you want Money to plug in its numbers.

Describe your tax situation in these six windows:

- **Getting Started:** Enter your personal information. In the first window, declare your filing status, number of dependents, and whether you are blind and over age 65. Question 5, Estimated Taxes Paid and Withheld, should already be entered. Money gets this information from Tax categories. It is very likely quite correct, but you can enter your own numbers if you want.

- **Income:** Enter your income. Describe your income from salaries, wages, alimony, unemployment, and so on. Once again, many of these values come straight from the data file. Do your best to estimate these numbers.

- **Adjustments:** Enter your adjustments to income. Describe adjustments to your income — contributions to IRAs and SEPs, health insurance payments, and so on. The numbers that you enter here lower your tax bill.

- **Deductions:** Enter your itemized deductions. Describe the payments that you made that can be deducted from your gross income — payments for medical and dental work, taxes, mortgage interest, charitable contributions, and so on.
Credits: Enter your tax credit information. Describe credits for childcare, education, and so on. Click the Detail links in this window to find out whether you are eligible for any of these credits.

Summary: This is an estimated tax summary. There it is — a mini tax return that shows your taxable income and roughly what you will owe in taxes (refer to Figure 14-3). If a number needs adjusting, click a link to return to the window where the number came from and make an adjustment.

Scheduling Important Tax Dates

Especially if you are self-employed and you pay quarterly tax estimates, certain dates are sacrosanct. Quarterly tax estimates are due on June 15, September 15, January 15, and April 15. Miss those dates at your peril! As Chapter 13 explains in detail, you can use the Advisor FYI feature to help you remember these dates. Choose Tools Alert Center and click the Customize Your Advisor FYI Alerts link to view the Advisor FYI Options dialog box; then click the Important Dates tab. Make sure that the quarterly estimated tax payment check boxes on the tab are selected. This way, the dates will appear on the Home Page to remind you when the IRS needs feeding.

Getting Help for Lowering Your Tax Bill

If you itemize deductions on income tax reports or you use Money to track business expenses, you owe it to yourself to find every tax-deductible expense that you can claim on income tax forms. Money offers a way to do that.

To get Money's help to locate tax-deductible expenses, click the Taxes tab and then click the Deduction Finder link (or click the Tax Tools button and choose Deduction Finder from the drop-down menu). In the What Deductions Are You Eligible For window, click the Next button. Very shortly, you land in the Tax Deduction Finder form, a questionnaire that you fill out. Keep answering the questions and clicking the Continue button. These questions are the very same ones that tax accountants ask when they determine how to lower your taxes. When you're done, the Deductions You May Qualify For window explains in detail all the different deductions for which you are eligible, as shown in Figure 14-4.
Determining How Much to Withhold

How much should you withhold from your paycheck for taxes? This question has puzzled philosophers for centuries. Being told on April 15 that you didn’t withhold enough and that you owe taxes is very unpleasant. Most people like to be told that they are due a refund because they withheld too much in taxes from their paycheck. To help you determine how much to withhold, Money offers the Tax Withholding Estimator. With this gizmo, you declare your income, state whether you want a tax refund, and find out precisely how much to withhold.

You must have used the Tax Estimator to estimate what you owe in taxes before you can take the Tax Withholding Estimator for a spin. Money uses information you entered in the Tax Estimator to determine how much to withhold. See “Estimating Your Tax Bill,” earlier in this chapter.

To get Money’s help to locate tax-deductible expenses, click the Taxes tab and then click the Withholding Estimator link (or click the Tax Tools button and choose Withholding Estimator from the drop-down menu). You see the Estimate My Withholding window shown in Figure 14-5. Answer the questions in this and the subsequent window. When you are done, Money tells you the total amount to withhold per paycheck to reach your refund goal.
Estimating Capital Gains Taxes

Estimating the capital gains taxes on the sale of a security can be difficult, so Money offers the Capital Gains Estimator. In the Capital Gains Estimator, you tell Money the rate at which you are taxed, select one of the securities that you own, enter how much you propose to sell your shares for, and find out how much you stand to profit and how much capital gains tax you have to pay on your profits.

Use the Capital Gains Estimator before you sell a security to see whether selling it is worthwhile, given the taxes you have to pay on the profits. In order to use the Estimator, you must have set up an investment account and recorded the purchase of the security in the account. (See Chapter 8.)

To estimate capital gains taxes, click the Taxes tab and then click the Capital Gains Estimator link. (You can also find this link on the Investing tab.) You land in the Welcome to the Capital Gains Estimator window. Click the Get Started button and provide information about your tax situation and the security in these four windows:

✔ **Set Tax Rates:** Describe your filing status, your income bracket, and whether you want to estimate state as well as federal capital gains taxes. The Capital Loss Carryover input boxes are for declaring a capital loss from the previous year that you have carried into the current year. You can deduct up to $1,500 per year per taxpayer and per spouse in capital losses.

✔ **Select Accounts:** Choose the name of the investment account where you track the security.
**Estimate Capital Gains Tax**: Select the security that you propose to sell; update its price by clicking the Update Prices button under Common Tasks. Then enter the sale price and the quantity of shares you want to sell, as shown in Figure 14-6.

If you bought the security in more than one lot, choose an option from the Distribution Method drop-down list to describe which shares you want to sell. A *lot* is a group of securities purchased at the same time and at the same price. FIFO means “first in, first out,” and LIFO is “last in, first out.” Choosing FIFO sells the oldest shares, no matter which lot they belong to; LIFO sells the newest shares. Choosing Max Gain or Min Gain tells Money to sell shares from whichever lot will earn the most or the least money. Choose Custom to pick and choose shares from different lots.

**View Action Plan**: Read the summary information about how much you stand to lose or gain by selling the security.

![Figure 14-6: Seeing how much in capital gains taxes you must pay when you sell a security.]

After you go to the trouble to investigate the capital gains implications of selling a security, you can save the information that you entered in a *scenario*. To examine the sale later on, you can simply call up its scenario without going to the trouble of entering the stock sale information again. To save a scenario, click the Scenarios button under Common Tasks, choose Save This Scenario, and enter a name in the Save This Capital Gains Scenario text box. To call up the scenario, click the Scenarios button and choose its name from the submenu that appears.
Exporting Money Data to a Tax-Preparation Program

The TaxCut Deluxe tax-preparation program (published by H&R Block) accepts data from Money files. In other words, you can draw on data from Money as you prepare your taxes with TaxCut. To provide tax information to TaxCut, you save your Money data in a TXF file, open TaxCut, and import the TXF file into the tax-preparation program. Money has a special command for saving data in a TXF file. Before you create the TXF file, however, you need to tell Money which accounts to include in the file.

Follow these steps to tell Money which accounts hold tax data:

1. **Choose Tools ➤ Settings.**
   You go to the Settings window.

2. **Click the Tax Settings link.**
   The Set Up Your File for Tax Tracking window appears.

3. **Click the Choose Accounts to Include in Tax Return Information link.**
   The Choose Accounts for Tax Preparation dialog box appears.

4. **Select the names of accounts where you keep tax data and click OK.**
   I find it easiest to click the Clear All button to deselect all the check boxes and then check off the handful of accounts where tax data is kept.

Now you’re ready to create the TXF file for the TaxCut tax-preparation package. Go to it:

1. **Choose File ➤ Export to Tax Software.**
   You land in the Prepare to Export Tax Information window.

2. **Choose a year from the Review Taxes For drop-down list.**

3. **Click the Continue button.**
   As shown in Figure 14-7, the next window asks which line items to include in the file.

4. **Go down the list and check off line items that pertain to your tax situation; then click the Continue button.**
   Very likely, the line items that pertain to you are the ones with monetary figures in them.
   After you click the Continue button, you come to the Prepare Your Taxes Using Software window.
5. Choose Export Your Tax Information as a Data File link.

The Export Tax dialog box appears.

6. Name and save the file.

Don’t forget what you named the file and where you saved it. TaxCut or the other tax-preparation software that you use will ask you where to get this file.

As I write this, only TaxCut accepts TXF files from Money, but if your taxes aren’t complicated, you can use other programs for tax reporting by generating a Tax Software report and entering the numbers by hand in the tax-preparation program. The previous section in this chapter explains how to generate a Tax Software report. Table 14-1 describes the leading tax-preparation software packages.

### Table 14-1: Tax-Preparation Software Packages

<table>
<thead>
<tr>
<th>Program</th>
<th>Cost*</th>
<th>Imports Directly from Money?</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaxAct Deluxe</td>
<td>$29.95</td>
<td>No</td>
</tr>
<tr>
<td>TaxCut Deluxe</td>
<td>$39.95</td>
<td>Yes</td>
</tr>
<tr>
<td>TurboTax</td>
<td>$39.95</td>
<td>No</td>
</tr>
</tbody>
</table>

*Prices listed here are current as of May 2005.*
For reviews and information about software, including tax-preparation programs, go to www.cnet.com, type tax in the Search box, and click the Go button. Cnet.com offers detailed information about software, and you can purchase software from Cnet.com as well.

**Getting Tax Help on the Internet**

The MoneyCentral Web site (www.moneycentral.com) offers advice about tax planning and preparation. Here are a handful of other Web sites that are useful to taxpayers:

✔ **The Digital Daily**: The Digital Daily is the official home page of the Internal Revenue Service. The site offers tax information as well as a means of downloading any tax form (click the Forms & Pubs hyperlink). Address: www.irs.gov

✔ **Federal forms and publications**: Save yourself a trip to the post office by going to this Web site. From here, you can download tax-reporting forms, schedules, and publications. Address: www.irs.gov/formspubs/index.html

✔ **State forms and publications**: From here, you can click a link, go to your state’s tax Web site, and download forms, schedules, and publications for reporting state income taxes. Address: www.taxadmin.org/fta/forms.ssi

✔ **Yahoo! Finance Tax Center**: Offers tax tips as well as information about estimating and lowering tax bills. Address: http://taxes.yahoo.com
Part V
Improving Your Financial Picture

The 5th Wave  By Rich Tennant

“The new technology has really helped me get organized. I keep my project reports under the PC, budgets under my laptop, and memos under my pager.”
Is your financial picture out of focus? Can’t tell how much you’re earning or where you’re spending all that money? Can’t see what your financial future looks like?

Part V explains how to create reports and charts that show in no uncertain terms where you stand financially. You also find advice here for tracking loans, mortgages, and other assets, as well as liabilities. In Part V, you find out what your net worth as a financial entity is. What’s your net worth as a human being? That’s for you to decide.
Chapter 15

Reports and Charts for Seeing Where You Stand Financially

In This Chapter
► Figuring out how the Reports Home window works
► Investigating the different kinds of reports and charts
► Creating a report or chart
► Seeing the figures with which a report or chart was constructed
► Customizing the content and appearance of reports and charts
► Printing reports and charts
► Exporting a report for use in another program

Reports and charts are two of my favorite things in Money 2006. Reports and charts determine right away what your financial standing is. Until I discovered the Tax-Related Transactions report, I used to spend hours and hours on April 14 tabulating tax-deductible expenses for my income tax report. Until I discovered the Spending by Category chart, I had no idea where I spent all that money. Until I spent a night in the Sierra Mountains, I didn’t know that the sky has so many stars, but that’s another story.

Maybe you want to create a report or chart to prove to a loan officer how creditworthy you are. Maybe you want to find out how much it cost to drive your car last year. Maybe you want to see how a stock price fluctuated to find out whether the price fluctuation really resembled a roller-coaster ride. Whatever you need, Money can help.

This chapter tells you about the 39 types of reports and two dozen kinds of charts that you can create with Money; how to customize a report or chart so that it yields precisely the information that you want it to yield; how to print reports and charts; and how to export the reports to other computer programs.
A Look at the Reports Home Window

To create a report or chart, you start from the Reports Home window, shown in Figure 15-1. Click the Reports tab to get to the Reports Home window. (If you chose essential reports over advanced reports, your window will look somewhat different from the one in the figure. The sidebar “Advanced and essential reports” explains the differences between the two kinds of reports.)

![Figure 15-1: The Reports Home window is the starting point for creating a report or chart.](image)

All you have to do to generate a report or chart is click a link in the Reports Home window. By now you must be wondering, “But how can I tell which of these names are reports and which are charts?” Good question. The answer is that you can make a report or a chart from almost every name in the Reports Home window. For example, Figure 15-2 shows both the report and the chart that you can create with the Spending by Category option in the Income and Expenses category. On the left side of Figure 15-2 is a Spending by Category report; on the right side is a Spending by Category pie chart. To change a report into a chart or vice versa, click the Change Views link and then choose Report or a chart option on the drop-down menu.
Advanced and essential reports

For people who abide by the “keep it simple” philosophy, Money gives you the opportunity to see fewer charts and reports in the Reports Home window. If you opt for essential reports rather than advanced reports, you get 8 reports rather than 39, which makes it easier to find your way around the Reports Home window.

Follow these steps to tell Money whether you want advanced or essential reports:

1. On the Reports tab, click the Change Report Settings link to go to the Report Settings window.

2. Click the Switch from Advanced Reports to Essential Reports link or the Switch from Essential Reports to Advanced Reports link.

3. In the Report Settings dialog box, click the Use Essential Reports or the Use Advanced Reports button.

This illustration shows which reports are available in the Reports Home window if you opt for essential reports.

### Advanced Reports

- Spending by Category
- Spending by Payee
- Spending by Category Comparison
- Monthly Budget
- Net Worth
- Credit Card Debt
- Portfolio Value by Investment Type
- Options

### Essential Reports

- Spending by Category
- Spending by Payee
- Spending by Category Comparison
- Monthly Budget
- Net Worth
- Credit Card Debt
- Portfolio Value by Investment Type
- Options
Looking at the Different Reports

Money offers no fewer than 39 types of reports (8 if you opted for essential reports). As fast as I can — because I know that you’re in a hurry — I briefly tell you in the following sections what the different reports and charts are. Turn to these pages when you are looking for a report or chart to illuminate your financial picture.

**Income and Expenses**

You can create these reports and charts in the Income category (reports marked with an asterisk are the only ones available if you asked for essential reports, not advanced reports):

<table>
<thead>
<tr>
<th>Report</th>
<th>What It Tells You</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Spending by Category</td>
<td>How much you spend by category, ranked from largest expense to smallest (refer to Figure 15-2).</td>
<td>To find out your biggest expenses.</td>
</tr>
<tr>
<td>*Spending by Payee</td>
<td>The names of payees to whom you paid money, and the amounts you paid.</td>
<td>To find out where you shop most often and perhaps where you should stop shopping so often.</td>
</tr>
<tr>
<td>*Monthly Budget</td>
<td>Your monthly budget goals.</td>
<td>To help find out whether you met your budget.</td>
</tr>
<tr>
<td>Monthly Income and Expenses</td>
<td>How much you spent and how much you earned in the past three months, by category, in your bank and credit card accounts.</td>
<td>To find out what your expenses and sources of income were.</td>
</tr>
<tr>
<td>Transactions by Category</td>
<td>A report that lists, under each expense category, the spending transactions you entered so far this year.</td>
<td>To examine your spending habits.</td>
</tr>
<tr>
<td>Transactions by Payee</td>
<td>A report that lists, under each category, who you paid money to or received money from.</td>
<td>To examine sources of income and expenses.</td>
</tr>
<tr>
<td>Account Transactions</td>
<td>A report that lists all the transactions in an account by month, or a line chart that shows a running account balance of the history of the account.</td>
<td>To find transactions in an account or to list and print part of an account register.</td>
</tr>
</tbody>
</table>
**Investment**

The Investments category in the Reports Home window offers these reports and charts for finding out how skilled an investor you are (reports marked with an asterisk are the only ones available if you asked for essential reports, not advanced reports):

<table>
<thead>
<tr>
<th>Report</th>
<th>What It Tells You</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Portfolio Value by Investment Type</td>
<td>What percentage of your investments are in mutual funds, stocks, and so on.</td>
<td>To find out how diversified your investments are.</td>
</tr>
<tr>
<td>Portfolio Value by Investment Account</td>
<td>The value of each of your investment accounts, as well as each security in the accounts.</td>
<td>To see changes in the monetary value of your securities.</td>
</tr>
<tr>
<td>Performance by Investment Account</td>
<td>The gain or loss in monetary terms and the gain or loss as a percentage of the security’s total value in the past year of each security you own.</td>
<td>To compare investments to determine which is performing the best.</td>
</tr>
<tr>
<td>Performance by Investment Type</td>
<td>The gain or loss in monetary terms and by percentage for each of your securities, with securities grouped by investment type.</td>
<td>To compare types of investments — stocks, mutual funds, and so on — to see which type performs best.</td>
</tr>
<tr>
<td>Report</td>
<td>What It Tells You</td>
<td>Use</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Price History</td>
<td>The up-and-down performance of individual stocks and other securities this year so far, as shown in Figure 15-3. Choose a type of investment from the Investments drop-down list.</td>
<td>To exercise your eyeballs and make them move up and down.</td>
</tr>
<tr>
<td>Investment Transactions</td>
<td>The investment transactions you entered in investment registers.</td>
<td>To review activity in investment accounts.</td>
</tr>
<tr>
<td>Asset Allocation</td>
<td>How diversified your investment portfolio is.</td>
<td>To find out whether all your eggs are in one basket.</td>
</tr>
<tr>
<td>Bond Summary</td>
<td>The value and latest price, as well as other details, of the bonds you own.</td>
<td>To examine your bond investments.</td>
</tr>
<tr>
<td>Bond Performance</td>
<td>Performance data concerning the bonds you own, including the percentage price gain and annual return.</td>
<td>To see how well your bond investments are performing.</td>
</tr>
</tbody>
</table>

**Figure 15-3:** The Price History line chart traces the performance of stocks and securities.

**Assets and Liabilities**

The following reports and charts fall under the Assets and Liabilities category (reports marked with an asterisk are the only ones available if you asked for essential reports, not advanced reports):
<table>
<thead>
<tr>
<th><strong>Report</strong></th>
<th><strong>What It Tells You</strong></th>
<th><strong>Use</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Net Worth</em></td>
<td>How the values of your assets and liabilities compare to one another.</td>
<td>To find out your net worth.</td>
</tr>
<tr>
<td><em>Credit Card Debt</em></td>
<td>Your total credit card debt.</td>
<td>To suffer despair over credit card debt and see which one you owe the most on.</td>
</tr>
<tr>
<td>Net Worth Less Capital Gains Tax</td>
<td>How the value of your assets and liabilities is affected by capital gains taxes.</td>
<td>To get a better look at your net worth.</td>
</tr>
<tr>
<td>Net Worth Over Time</td>
<td>How the values of your assets and liabilities compare over a certain time period. (Use the Date Range drop-down list to select a time period.)</td>
<td>To examine your net worth over time.</td>
</tr>
<tr>
<td>Net Worth Over Time Less Capital Gains Tax</td>
<td>How the values of your assets and liabilities, affected by capital gains taxes, change over time.</td>
<td>To get a focused picture of your net worth.</td>
</tr>
<tr>
<td>Account Balances</td>
<td>How much money is in your bank and other kinds of accounts at present.</td>
<td>To find out how much money is on hand.</td>
</tr>
<tr>
<td>Account Balance History</td>
<td>How the balance and value of all your accounts have changed over time. (Choose an option from the Accounts drop-down list if you want to select a single account.) Figure 15-4 shows an Account Balance History chart.</td>
<td>To see how fickle time, fate, and one’s spending habits are.</td>
</tr>
<tr>
<td>Account Balances with Details</td>
<td>The information about your accounts that is kept in the Account Details window — the account number, opening balance, and so on.</td>
<td>To quickly look up account numbers and other information.</td>
</tr>
<tr>
<td>Asset Allocation</td>
<td>A description of how diversified your investments are.</td>
<td>To see whether all your eggs are in one basket.</td>
</tr>
<tr>
<td>Frequent Flyer Miles</td>
<td>Information about the frequent flyer points or miles you’ve earned.</td>
<td>To see whether you have enough miles or points for a vacation you’ve been planning.</td>
</tr>
<tr>
<td>Report</td>
<td>What It Tells You</td>
<td>Use</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Scheduled Bills</td>
<td>Which bills you have scheduled in the Bills Summary window.</td>
<td>To find out which bills are due or nearly due.</td>
</tr>
<tr>
<td>Upcoming Bills and Deposits</td>
<td>Which bills and deposits in the Bills Summary window are due this month.</td>
<td>To compare your income to your expenses so that you can decide which bills to pay.</td>
</tr>
<tr>
<td>Loan Terms</td>
<td>The information about your loans that is kept in the Payment Terms window — the loan amount, remaining balance, interest rate, and so on.</td>
<td>Print this report if you apply for a new loan so that you can give the lender details about your other loans.</td>
</tr>
<tr>
<td>Loan Amortization</td>
<td>How much of each loan payment goes toward servicing interest, how much goes toward reducing the principal, and a running balance of how much you owe. (You must have set up a loan account in Money, as described in Chapter 16, to run this report.) Choose a new loan or mortgage from the Accounts drop-down list.</td>
<td>To see how principal and interest payments on a loan break down.</td>
</tr>
</tbody>
</table>

**Figure 15-4: An Account Balance History chart.**
**Taxes**

As tax time draws nigh, go to the Taxes category in the Reports Home window and create a handful of these reports (these reports are not available if you opted for essential, not advanced, reports):

<table>
<thead>
<tr>
<th>Report</th>
<th>What It Tells You</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax-Related Transactions</td>
<td>Category by category, your total income and expenses in tax-related categories.</td>
<td>For calculating income and tax-deductible expenses on tax returns.</td>
</tr>
<tr>
<td>Capital Gains</td>
<td>Capital gains and losses for each security you own or owned.</td>
<td>For calculating capital gains and losses.</td>
</tr>
<tr>
<td>Loan Interest</td>
<td>How much of your loan payments go each month and year toward servicing interest.</td>
<td>For determining what your loan interest payments were. Some loan interest payments are tax deductible.</td>
</tr>
<tr>
<td>Tax Software Report</td>
<td>Your total income and expenses as can be reported on the tax lines on various tax forms.</td>
<td>For gathering data so that you can plug it into tax-preparation software programs.</td>
</tr>
</tbody>
</table>

**Comparison Reports: For comparing the past with the present**

Are you better off than you were four years ago? You can find out very quickly by generating a report in the Comparison Reports category (reports marked with an asterisk are the only ones available if you asked for essential reports, not advanced reports):

<table>
<thead>
<tr>
<th>Report</th>
<th>What It Tells You</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Spending by Category Comparison</td>
<td>How you spent in different categories in two different time periods. Choose time periods from the drop-down lists.</td>
<td>For understanding your spending habits better.</td>
</tr>
<tr>
<td>Spending by Payee Comparison</td>
<td>Your income in two different time periods. Choose time periods from the drop-down lists.</td>
<td>For comparing your earnings from year to year.</td>
</tr>
</tbody>
</table>
### Monthly Reports

Money creates monthly reports automatically. The reports show where you spent money and your net worth, among other things. To see a report from your economic past, click a monthly report link in the Reports Home window.

### My Favorites

The My Favorites category in the Reports Home window is for you and you alone. The “Adding a Customized Report or Chart to the Favorites Menu” section, later in this chapter, explains how you can keep your own customized reports in the My Favorites category and draw upon them whenever you please.

### Creating a Report or Chart

To create a report or chart, you need to be familiar with the different types that Money offers. (Refer to the section “A Look at the Reports Home Window,” earlier in this chapter.) You may be interested to know that you can usually turn a report into a chart and a chart into a report. Too bad life isn’t always that easy.

### Generating the report or chart

Follow these steps to create a report or chart:

1. **Click the Reports tab.**
   
   The Reports Home window appears (refer to Figure 15-1).

2. **Click a report or chart name in the Reports Home window.**
   
   Depending on the report or chart you select, a drop-down list or two appear along the bottom of the window.

3. **Make a selection from a drop-down list to make your report or chart show exactly what you want it to show.**

<table>
<thead>
<tr>
<th>Report</th>
<th>What It Tells You</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Income and Spending Comparison</td>
<td>Your expenses and earnings presented by category in different time periods.</td>
<td>For comparing what was with what is.</td>
</tr>
</tbody>
</table>
What you see next depends on which report or chart you created. Sometimes you get a chart and sometimes you get a report. Sometimes the report or chart covers the right time period; sometimes it doesn’t. Read on to find out how to turn a report into a chart or a chart into a report. Later in this chapter, the “Customizing Reports and Charts” section explains how to change the appearance and parameters of a report or chart.

To create a report or chart in one mighty stroke, click the View Reports link, select a report category from the drop-down list, and then select a report/chart name, as shown in Figure 15-5.

After you add a report to your Favorite Reports list, you can generate it by choosing Favorites➪Favorite Reports and clicking the report’s name on the submenu. See the section “Adding a Customized Report or Chart to the Favorites Menu,” later in this chapter.

### Turning reports into charts and charts into reports

When you create a report or chart from the Reports Home window, Money does its best to give you the report or chart you want, but sometimes it makes the wrong choice. Frequently, the program gives you a chart when you wanted a report or a report when you wanted a chart. And sometimes the program gives you the wrong kind of chart.

You can sometimes fix that dilemma by clicking the Change View link, the first link under Common Tasks, and choosing an option from the submenu. To turn a report into a chart, for example, choose Bar Chart or Line Chart from the submenu.
Investigating the figures from which a chart or report is constructed

The figures on reports and the lines on charts are constructed from numbers that you entered in your account registers. Suppose that you get curious about a number on a report or pie slice in a pie chart. Maybe you want to know why a number is so high or a pie slice is so fat. Maybe you can’t believe that you spent so much or profited so little. You can move the mouse pointer over the number or pie slice and do some investigating.

In Figure 15-6, a pie slice on the right side of the chart is awfully large. Suppose that you want to know why it’s so large. As the figure shows, you can move the pointer over part of a chart and see a box with a figure that shows you what the chart segment represents in monetary terms. In the figure, you can see that this person spent a whopping $18,692.34 on home repairs. That must have been a big hailstorm.

In reports and charts, the pointer turns into a magnifying glass when you move it over a summary figure, pie slice, bar, or whatnot. It does that, I should say, if you can double-click to see the figures from which the chart was constructed. By double-clicking when the pointer looks like a magnifying glass, you can see the account transactions from which the part of the chart or report was constructed.

Customizing Reports and Charts

Chances are, the report or chart you created doesn’t meet your high expectations. Perhaps it doesn’t look right or it covers the wrong time period. Perhaps you want to remove data from one or two accounts in a report to keep the report’s figures from being skewed. Maybe you want to change a chart’s title.
Miscellaneous reports and charts

The Reports Home window isn’t the only place where you can get a report or chart that describes your financial picture. You can also get reports and charts from the following places:

- **Home Page**: If you so choose, you can make a Spending by Category chart appear on the Home Page. This chart shows, for the past month, in which categories you spent your hard-earned money. See Chapter 2 for details.

- **A register**: While you are staring at an account register, click the Analyze Spending link and choose an option from the menu to generate a report or chart that illuminates activity in the account.

- **Set Up Your Categories window**: Click a category name in the Set Up Your Categories window and click the Go to Category button to see a chart that shows how much you spent in the category in each of the past six months. Click a Payee name in the Payees window and click the Go to Payee button to see a miniregister that shows what you paid the payee.

- **Bills Summary window**: Click the Forecast Cash Flow link to see a chart that shows how the bills you have scheduled affect account balances.

- **Find and Replace dialog box**: On the Search Results screen of the Find and Replace dialog box is a button called Create Report. Click it and you get an Account Transactions report that shows when and where the transactions you were looking for were entered.

When you want to change anything about a report or chart, click the Customize link (you can find it under Common Tasks on the left side of the window). Whether you are dealing with a report or a chart, you see the Customize Report dialog box, shown in Figure 15-7.
This dialog box offers a number of tabs for tinkering with the contents of a report or chart. Experiment freely, but don’t forget the rules of engagement (the buttons) that apply to the Customize Report dialog box:

✔️ **Apply**: Applies the changes you’ve made but does not close the dialog box. Click the Apply button after you make a change but you aren’t sure whether you want it to be permanent. After your improvements have been applied, drag the Customize Report dialog box to a corner of the screen and look at the damage you did. If you don’t like what you see, select different options in the dialog box.

✔️ **Reset**: Unravels all the work you did to the report or chart and applies the default settings that you had to begin with.

✔️ **Cancel**: Closes the dialog box. Click this button if you decide not to customize.

Maybe the biggest change you want to make to a chart or report is to its title. Change it by typing a new name in the Title box. Beyond that, read on to find out how to customize charts and reports with the 11 tabs in the Customize Report dialog box.

**Rows & Columns tab: Changing the rows and columns**

The Rows & Columns tab in the Customize Report dialog box is for changing the rows (legend items, if you are customizing a chart) and columns (labels, if you are dealing with a chart):

✔️ **Rows**: The Rows drop-down list is for selecting how items on the report or chart are grouped. In the case of reports, you specify which items appear as row headings along the left side. In the case of charts, you decide which items comprise the bars, pie slices, or Y-axis values in a line chart.

✔️ **Columns**: The Columns drop-down list offers a number of different choices. For reports, select the items that are to appear along the top of the report as column headings. For charts, select the X-axis values.

✔️ **Combine All Values Under % of Total**: Rather than include every scrap of data in a report or chart, you can bundle the smaller amounts into a single row, pie slice, or whatever. Enter a percentage in this box to tell Money where to draw the line between amounts that get bundled and items that don’t get bundled. This option cleans up pie charts and makes them look much better.

✔️ **Sort By**: Usually, items are sorted by amount from highest to lowest, but you can arrange items in different ways from this drop-down list.

✔️ **Include Abbreviations**: If you entered abbreviations for categories in the Details window, selecting this check box makes abbreviations as well as category names appear on reports and charts.
**Chart tab: Choosing chart types and other chart options**

The options on the Chart tab for changing the look of a chart are self-explanatory, I think. True, it’s difficult to figure out what the bar chart’s Stacked option is, but all you have to do to find out is click one of the options, click the Apply button, and peek at your bar chart.

On the other hand, in case you really need an explanation, here are descriptions of the options for changing the look of a chart:

- **View As:** Select the appropriate radio button to change the chart to a bar chart, a line chart, or a pie chart, or to turn a chart into a report.

- **Stacked option:** When you are working with a bar chart, select Stacked to put the bars one on top of the other and show total amounts.

- **Broken bars:** Select this option to make breaks appear in bars when they have reached important thresholds.

- **Pie Labels:** Select None to keep labels off the chart, Percents to display a percentage figure that shows how fat each pie slice is, or Dollar amounts to list dollar figures rather than percentage figures next to each pie slice.

- **Show in 3D:** Select this option to give the chart a third dimension. Line charts look especially good in three dimensions. Three-dimensional charts look great (refer to Figure 15-6).

- **Show Gridlines:** Select this option to draw or remove gridlines — the lines on bar and line charts that show roughly how big or small a value is — on the chart.

- **Show Legend:** Select this option to tell Money where to place the legend, the key that tells what the pie slices, bars, or lines mean, and whether to show the option at all.

- **Mark Events:** Select this option to mark highs and lows on line charts.

---

**Date tab: Changing the date range**

To change the time period that the report or chart covers, select an option from the Range drop-down list or enter a beginning and ending date of your own in the From and To text boxes.

**Account tab: Choosing accounts for the report or chart**

To start with, your report or chart gathers data from all your accounts, but perhaps you want it to focus on two, three, or four. To decide which accounts get covered, click the Clear All button on the Account tab and then click each account whose data you want to include in the report or chart. You can also click the All Open Accounts button to gather data only from accounts that are open.
**Category tab: Excluding categories from reports and charts**

To begin with, reports and charts gather data from all categories and subcategories, but you can exclude categories by way of the Category tab. Click a button to generate a report solely with Income, Expense, or Tax-related categories, or else click the Clear All button and select each category on the list from which the report is to draw data. Deselect the Show Subcategories check box to keep subcategories from appearing on reports and charts.

**Payee tab: Excluding payees and income sources**

If you want to get really picky, you can even exclude certain payees and sources of income from reports and charts. Perhaps including a certain payee or income source would skew a report or chart and render it invalid. In that case, go to the Payee tab and click to remove the check mark beside the name of the payee or income source.

**Text tab: Using text criteria to gather data**

This odd tab is for gathering data on the basis of the words in transactions. For example, entering *Bills* in the text box results in having data gathered only from transactions in which the word *Bills* appears, be it in the Payee field, the Category field, or the Memo field.

Be sure to click the Apply button if you use this tab. Gathering data this way can have weird consequences.

**Details tab: Gathering data on the basis of type and status**

Use the Type drop-down list on the Details tab to generate reports about payments, deposits, unprinted checks, online bill payments that were not sent, or transfers, and whether these transaction types have been reconciled. You can also generate reports around check numbers from this tab.

**Amount tab: Querying by amount**

On the Amount tab, you can fish in your records for certain amounts or within a certain range.

**Classification tab: Including classes and subclasses in reports**

If you track your spending and income with classes as well as categories, your Customize Report dialog box includes a Classification tab (it is named after the classification you created). From this tab, you can exclude classes and subclasses from reports and charts.
**Fonts tab: Changing how reports and charts look**

To change the way the letters look on reports and graphs, go to the Fonts tab and choose a new font and type size. You can also make columns on reports wider or narrower from this tab, but be sure to click the Apply button first. Changing fonts, especially font sizes, has a way of throwing everything out of whack on a report or chart. You can always click the Reset button if you create too much chaos.

**Adding a Customized Report or Chart to the Favorites Menu**

After you go to the trouble of customizing a report or chart, you may as well put it in the My Favorites category of the Reports Home window. That way, you can generate it again without having to tinker with the settings in the Customize Report dialog box.

Follow these steps to add a report or chart to the My Favorites category:

1. **Create and customize the report or chart.**
2. **Click the Add to My Favorite Reports link.**
   You see the Add to Favorites dialog box.
3. **Enter a descriptive name in the Report Name text box.**
4. **Click OK.**

Besides landing in the My Favorites category of the Reports Home window, the name of your customized report or chart also appears on the Favorites ➪ Favorite Reports menu. You can select it there, too.

To remove a customized report from the Reports Home window, choose Favorites ➪ Organize Favorites ➪ Reports. You land in the Modify Favorite Reports window. Select the name of the report or chart, click the Delete button along the bottom of the window, and click Yes in the confirmation box.

**Printing Reports and Charts**

Before you print a report or chart, I strongly recommend visiting the Report and Chart Setup dialog box, where you tell Money what kind of printer you
use and whether you want to print in portrait or landscape style. The following pages reveal intimate secrets that I got from a tabloid about the Report and Chart Setup dialog box. They also tell you how to print a report or chart.

**Getting ready to print a report or chart**

Follow these steps to tell Money how you want to print your report or chart:

1. **Choose File ➤ Print Setup ➤ Report and Chart Setup.**
   
   You see the Report and Chart Setup dialog box.

2. **From the Printer drop-down list, select the name of the printer with which you will print, if you print on more than one printer.**

3. **Under Orientation, select the Landscape option if you want to print lengthwise on the paper.**
   
   Wide reports and charts fit on the page better when they are printed in landscape fashion. With the Landscape option, the page is turned on its side and it is longer on the top and bottom, like a landscape painting.

4. **Click OK.**

   If you are printing a detailed chart and you want it to look especially good, click the Options button in the Report and Chart Setup dialog box. The Option button opens the Printer Properties dialog box, where you can choose options for changing the resolution of your printer, if your printer permits resolution options to be changed.

**Printing the report or chart**

To make a hard copy of your report or chart, follow these steps:

1. **Put the report or chart on your computer screen.**

2. **Press Ctrl+P or choose File ➤ Print.**
   
   You see the Print Report or Print Chart dialog box.

3. **In the Copies box, enter the number of copies you want, if you want more than one copy.**

4. **Click OK.**
Exporting a Report or Chart

The wonderful report or chart that you created is not trapped inside the Money program. No indeed. You can export it to other programs so that you can include it in an annual report or a slide presentation, for example. Follow these steps to export a report and help improve the trade deficit:

1. **With the report or chart on-screen, choose Edit ➤ Copy (or press Ctrl+C).**
   Doing so copies the report or chart to the Windows Clipboard.

2. **Move to the program to which you want to make the copy and choose Edit ➤ Paste (or press Ctrl+V).**
   After a chart is copied, it lands in the other program in the form of a vector graphic. You can change the shape of a vector graphic by pulling and tugging at its perimeters.
   After a report is copied, it lands in the other program in the form of a **tab-delimited text file**, a list in which each component is separated from the next by a tab space. That’s no big deal, however, because most spreadsheet and word processing programs can handle tab-delimited text files. The only thing you have to worry about is reformatting your report after it lands in the other program.

---

### Exporting a report to an Excel worksheet

Fans of Microsoft Excel will be glad to know that Money offers a special command for turning a Money report into an Excel worksheet. For that matter, you can use a Money report in any program that can handle comma-separated value (CSV) files (these files are sometimes called “flat files”).

Follow these steps to transplant a Money report in an Excel worksheet:

1. **Generate the report and click the Export to Microsoft Excel link under Common Tasks.**
   You see the Export Report dialog box.

2. **Enter a name for the report and click OK.**
   The Excel program opens, if it isn’t open already, so you can open and see your report in a worksheet.
To format a report in Microsoft Word, remove all empty rows from the report and then select the table part of the file — that is, select everything except the title, date, and so on. To do that, click to the left of the first row in the report (the row with the column headings), hold down the mouse button, and drag down the screen until the last row is selected. Then choose Table Convert Text to Table and click OK in the Convert Text to Table dialog box.
Chapter 16

Tracking Assets, Liabilities, Loans, and Mortgages

In This Chapter

- Deciding when to create asset, house, liability, and loan accounts
- Defining assets and liabilities
- Setting up an asset and house account
- Associating an asset or house account with a loan account
- Recording changes in the value of an asset or equity in a house
- Setting up and recording transactions in a liability account
- Setting up an account for tracking loans and mortgages
- Recording loan and mortgage payments
- Paying extra on a loan or mortgage payment

Anything of value that you own or that adds to your net worth can be counted as an asset — jewelry, stock, the equity in a house, a vintage baseball card autographed by the great Willie Mays. The money in your checking and savings account is an asset. So is money that is owed to you.

A liability, on the other hand, counts against net worth. A debt that you owe is considered a liability. Credit card debt is a liability, as are taxes owed to the IRS, a mortgage, a student loan, and a car loan.

If you want a clear picture of your net worth or the net worth of your business, you need to identify your assets and liabilities. Fortunately, Money offers account types to track not only assets and liabilities but also loans and mortgages — two other critical elements in the net-worth equation. In this chapter, you discover how and why to set up and use these kinds of accounts. You also find out how to fine-tune them so that they track exactly what you want them to track.
If you think about it, all the accounts you can set up in Money fall either into the asset or liability category. The money in savings and checking accounts is an asset. Debt that you track in a credit card account is a liability. However, Money offers the following special account types for keeping a close tab on assets and liabilities:

- **Asset account**: For tracking the value of personal property, such as art collections, coin collections, and other valuables. If you use Money to track a business, you can create asset accounts for office equipment, tools, machinery, or anything else that adds to the worth of the business or can be used as collateral.

- **Car or Other Vehicle account**: For tracking the value of a car or boat. Even if you own a car, don’t bother tracking its value unless you want to put it up as collateral for a loan or figure its value into your net worth.

- **Cash account**: For tracking cash on hand for business expenses. This very simple kind of account is for businesses that want to track petty-cash spending.

- **Home account**: For tracking how much equity is in a house. *Equity* is a house’s market value minus the amount that is owed on the house. For example, if $100,000 is owed on the house and its market value is $150,000, the owner has $50,000 equity in the house. Each time you make a mortgage payment, you can transfer the principal part of the payment to a house account and thereby track how much equity is in the house. A house account is a specific type of asset account.

- **Liability account**: For tracking no-interest debt, such as quarterly tax payments that you owe the IRS, property taxes, insurance premiums, or money you owe a friend. This account is for tracking business expenses.

- **Loan account**: For tracking loans on which you have to pay interest, such as student loans and car loans. Loans on which you pay interest are called *amortized loans*. With an amortized loan, part of each payment goes toward paying interest on the debt and part goes toward reducing the principal (the amount you borrowed). A loan account is a type of liability account.

- **Mortgage account**: Similar to a loan account, a mortgage account is for tracking a mortgage. A mortgage is also an amortized loan. And a mortgage counts, of course, as a liability.
Tracking the Value of a House or Other Asset

Ask most homeowners what their most valuable asset is and they’ll say their house. But ask them how much equity they have in that house and you usually get a much less definitive answer — if you get an answer at all. And you would probably get the same response if you ask about other tangible assets, such as art collections, baseball cards, or office equipment. Money can help you peg the value of your assets.

Read on to find out how to track the equity in a house or the value of tangible assets, such as art collections, baseball cards, office equipment, and other property that you can sell.

Setting up an asset or house account

A Money house account and a Money asset account work exactly the same way. Setting them up is easy. You can find more specific instructions for setting up accounts in Chapter 3 (where I show you how to set up checking and savings accounts), but for now, follow these steps to set up a house or asset account:

1. Click the Banking tab to go to the Account List window and click the Add a New Account link under Common Tasks.
2. In the Choose an Account Type window, select the Other Account Type option button; then click Next.
   You see the first of several windows for setting up new accounts.
3. Select the Asset or Home option and click Next.
   You see the Choose Level of Detail window.
4. Tell Money whether you want to simply track the value of the property or asset or to associate the account with a loan or mortgage you are tracking with Money.

If all you want to do is record how the value of the property or asset fluctuates over time, choose the first option; if you want to associate the account with a home or mortgage account so that the principal portion of loan payments counts toward the value of the property or asset, choose the second option.

- **Tracking the value of the property or asset value:** Click the Just Track the Total Value option, enter a name for the account in the Account Name text box, enter the value of the property or asset,
and click the Finish button. For the value, enter its value as of today if you just acquired it or if you don’t want to track its growth since the time you acquired it. If you want to track how the asset or property has grown or shrunk in value since you acquired it, enter 0. Later, you can go into the account register and enter dates and values to show how the value of the property or asset has increased or decreased over time.

- **Associating the property or asset with a mortgage or loan:** Click the Track Transactions and Other Details option and click the Next button. In the ensuing dialog boxes, you are asked to name the account, enter the value of the property or asset, and declare whether you want to associate a loan or mortgage with the property or asset. As the “Tracking Loans and Mortgages” section explains, later in this chapter, you can transfer the principal portion of a loan or mortgage payment to an asset or house account. By doing so, you can track how much the value of the asset or the equity in the house increases each time you make a loan or mortgage payment.

To track value or equity increases this way, click the Yes button when Money asks whether you would like to associate a loan account with the asset or house. When you click the Next button, you see a dialog box for selecting loan accounts. From the drop-down list, select the loan account from which you will transfer the principal portion of the loan payments.

Home equity loans should be associated with a house. When you take out a home equity loan, you use your house as collateral. Even if you use the money from the loan to buy a car or boat, for example, associate the home equity loan with your house, not with the asset you purchased with money from the loan.

**Recording changes in the value of an asset or house**

After you set up the asset or house account, you can record changes in its value simply by opening the account register and entering amounts in the Decrease or Increase column. However, if you associated the asset or house account with a loan or mortgage account, changes in value are recorded automatically each time you make a loan payment. Follow these steps to record a change in value by hand:

1. **Open the register of the house or asset account.**

   Figure 16-1 shows an asset account for tracking the value of a Ming vase collection.
What's your most valuable asset?

Did you know that your most valuable asset is not your car or truck, your most profitable investment, or even your house? No, your most valuable asset is you—your abilities and talents. They are the qualities employers value you for. And they can't be measured by any computer program.

2. Click the New button or the Update Current Value link.

You see the Adjust Account Balance dialog box, shown in Figure 16-1.

3. In the New Ending Balance text box, enter what the value of the asset or home is as of the date you will enter in the next step.

4. Enter the date of the change in value in the As of Date text box.

5. Categorize the change in value in the Category for Adjustment dropdown list.

For example, I suggest creating an income category called Increase Mkt Value (Increase Market Value) to record an increase in value, or a category called Decrease Mkt Value (Decrease Market Value) to record a decrease in value. Chapter 4 explains how to create new categories.

6. Click the OK button.

In the Decrease or Increase columns of the account register, Money enters the amount by which the asset or home increased or decreased in value.
As you can see, the value of the Ming Vase Collection asset account in Figure 16-1 has been fluctuating, but the collection nevertheless is slowly increasing in value. Let’s hope none of the vases gets broken.

Tracking Your Liabilities

Set up a liability account to track loans on which you don’t have to pay interest, such as income tax payments. This is not the place for debts that fall in the credit card, line of credit, mortgage, or other interest-paying loan category, but it is the place to include anything else that counts against your net worth, such as insurance premiums.

It’s hard to imagine anything easier than creating a liability account in Money. Follow these steps:
1. Go to the Account List window and click the Add a New Account link.
2. Click the Other Account Type option; then click the Next button.
3. In the Choose an Account Type window, select Liability and click the Next button.
   You land in the Choose Level of Detail window.
4. Select the Just Track the Total Value option.
5. Enter a name for the liability account in the Account Name text box.
6. In the Total Value text box, enter what you owe for the liability.
   Enter what you owe as of today if you just started owing or if you don’t care to track how your liability has shrunk or grown since the time you started owing. If you want to track how the liability has grown or shrunk since the time you acquired it, enter 0.
7. Click the Finish button.

To record transactions in a liability account, click the Update Amount Owed link in the account register window. Then, in the Adjust Account Balance dialog box, enter a date and the amount you owe as of that date. Money will calculate increases or decreases for you in the register.

Tracking Loans and Mortgages

The following sections explain how to set up a loan or mortgage account for tracking amortized loan payments and mortgage payments. An amortized loan is a loan for which you make regular payments of the same amount. Part of each payment goes toward paying interest on the loan and part goes toward reducing the principal (the amount you borrowed).

After you find out how to set up a loan account, I show you how to stand on your head and sing Dixie. Actually, I do no such thing. I show you how to record loan payments in loan account registers, handle irregular loan payments that involve escrow accounts, and record a payment above and beyond the amount you are expected to pay.
## Is creating a loan or mortgage account worthwhile?

Before you go to the considerable trouble of creating a loan or mortgage account, you should know that you may not have to create one to track mortgage or loan payments.

As long as the lender tells you how much you owe after each payment and how much you are paying in interest, you really don’t need to track the loan. You can simply get the numbers from the lender and record the interest portion of the payment as a decrease in a liability account and the principal part of the payment under Loan: Loan Interest or a similar category. In other words, when you record the check you used to make a loan or mortgage payment, split the payment so that the principal portion is recorded as a transfer to the liability account and the interest portion is recorded in the Loan: Loan Interest category.

In the case of mortgages, business loans, and investment loans, the lender should send you a 1098 tax form at the end of the year that explains how much of your payments went toward interest. That is the amount you need to know for income tax purposes. To save time and heartache, you may as well let the lender do the work and get the numbers from the lender rather than track the loan yourself.

## Setting up a loan or mortgage account

When you set up a loan or mortgage account, Money asks you all kinds of questions and uses the information to break down the loan payments into interest charges and principal reductions. With each payment you make on the loan or mortgage, Money reduces the amount you owe in the loan or mortgage register and records how much of the payment did not lower the total debt but went only toward servicing the interest in a mortgage or loan category.

Gather all the papers that pertain to the loan or mortgage and then follow these steps to set up a loan or mortgage account for tracking the payments:

1. **Go to the Account List window and click the Add a New Account link.**
   
   You go to the Choose an Account Type window.

2. **Click the Other Account Type option; then click the Next button.**

3. **In the next window, which asks what kind of account you want to set up, select Loan or Mortgage; then click the Next button.**

4. **Click the Track Transactions and Other Details option; then click Next.**
   
   You see the New Loan Wizard dialog box.
5. Speed-read the “You are about to enter the Twilight Zone” message box and click the Next button.

No, it doesn’t really say that you are about to enter the Twilight Zone. It just tells you what the dialog boxes in the New Loan Account Wizard are about to ask you.

6. Speed-read the next message, which explains the three types of general information that will be needed, and click the Next button.

7. You’re borrowing money, and the Borrowing Money option is already selected, so click the Next button.

8. Enter a name in the Loan Name text box and choose to whom the payments will be made by entering a name in the Make Payments To box or by selecting a name from the drop-down list; then click the Next button.

The name you enter will appear in the Account List window when you finish setting up the loan or mortgage account.

9. Select Adjustable Rate Loan (ARM) or Fixed Rate Loan and click the Next button.

The interest rate remains the same in a fixed-rate loan or mortgage. In an adjustable-rate loan or mortgage, the rate of interest is subject to change.

Which dialog box you see next depends on the option you choose in this step.

10. If you selected Fixed Rate Loan in Step 9, click the Yes or No option to say whether payments have been made on the loan; if you selected Adjustable Rate Loan, enter the date that the first interest rate adjustment is to be made and enter the number of years or months between adjustments.

If you are setting up a fixed-rate loan or mortgage and you select the Yes, Payments Have Been Made option, you see an additional dialog box that asks whether to schedule all the payments made on the loan or mortgage since you began paying it. Money needs this information to create a loan payment schedule. Money can gather information for scheduling no matter how you answer this question.

Click the Next button, of course, after you’re done.

11. Enter the due date of the first payment on the loan or mortgage.

Be sure to enter the due date of the first payment, not the next payment. Money needs the first due date to create the amortization schedule.

12. Speed-read the next dialog box, which tells you how far you’ve come, and click the Next button.
13. From the Paid How Often drop-down list, select the option that describes how often payments are due (probably Monthly) and click the Next button.

14. Select the option that describes how the loan is calculated and click the Next button.

Home mortgages are usually calculated based on the date the payment is due; consumer loans (such as car loans) are based on the date the lender receives payment. However, you may have to dig into the paperwork that came with your loan or call the lender to find out how interest is calculated.

15. In the following five dialog boxes, enter the amount of the loan, the interest rate, the loan length, the principal and interest, and the balloon payment, if there is one.

Keep clicking the Next button after you make each entry. After you are done, your dialog box looks something like Figure 16-2. Click the Back button if you need to go back and change an entry.

![Figure 16-2: Calculating the particulars of the loan. If you leave one of the entries blank, Money calculates it for you.](image)

The Principal + Interest entry is a little confusing. What Money is really asking for is the amount of your monthly payment (or weekly payment or whatever). If you don’t know the amount offhand, leave the box blank. Money can calculate payment amounts for you as long as you can provide information in the other four boxes.

When you enter the interest rate, be sure to enter the loan interest rate, not the compounded interest rate. The two are different.

16. Speed-read the dialog box, which tells you how far you have come, and click the Next button.

It’s not as though you have any choice in the matter, is it?
17. Type in category names or select the names from the drop-down lists; then click the Next button.

When you make a loan or mortgage payment, the portion of the payment that goes toward interest is categorized under the category choice you make in this step. The portion that goes toward reducing the debt is recorded in the loan account register as a decrease in the amount you owe.

You can create a new category and subcategory if you want. If you enter names that Money doesn’t know, you see the New Category dialog box. Fill in the dialog boxes (and click the Next or Finish button) to create your new category.

18. Click the Yes or the No button to tell Money whether interest on the loan or mortgage is tax deductible; then click the Next button.

The interest portion of mortgages and home-equity loans is usually tax deductible. This is an important matter. If you aren’t sure whether your loan or mortgage is tax deductible, ask an accountant.

19. If part of your payment goes toward fees such as escrow accounts, click the Other Fees button; otherwise, click the Next button.

This dialog box asks whether you must pay fees on top of the principal and interest payments that are due. Chiefly, this dialog box is for people who pay into escrow accounts when they make their mortgage payments. An escrow account is an account that a mortgage company takes out on behalf of a borrower to make sure that property taxes and property insurance get paid.

If you click the Other Fees button, you see the Other Fees dialog box, shown in Figure 16-3. This box works exactly like the Transaction with Multiple Categories dialog box I describe in Chapter 4. Use the Other Fees dialog box to categorize the fees you have to pay; then click the Done button.

20. If you want to schedule a payment in the Bills Summary window so that you are reminded when payments are due, click the Yes, Remind...
Me check box, fill in the dialog box, and click the Next button; otherwise, click the No, Do Not Remind Me check box and then click the Next button.

Chapter 12 explains how the Bills Summary window works. I strongly recommend scheduling the loan or mortgage payment. Lenders charge hefty fees for late payments. By scheduling your loan or mortgage payment, you increase your chances of paying it on time.

21. Study the Summary Information dialog box and then click the Next button.

As shown in Figure 16-4, the next dialog box you see provides a rundown of all the information you gave Money in the previous (whew!) 20 steps. Study this dialog box for a moment, and if anything is wrong, start clicking the Back button like crazy until you reach the dialog box where you can correct the error.

22. If you want to associate your new mortgage or loan account with a house or asset account, click the Yes button, click the Next button, and select the asset or house account from the dialog box; otherwise, click the No button and then click the Finish button.

The dialog box you see if you click Yes asks whether you want to associate an asset account with this loan account. Choose the account from the drop-down list and then click the Next button.

If you already created a house account for tracking the equity in a house, or if you already created an asset account for tracking the value of a car or other asset, you can associate your house or asset account with the loan account you are almost finished setting up.

You can always go back later and associate an asset or house account with your new loan account (see the sidebar “Another way to associate an asset account with a loan account,” earlier in this chapter).
Fixing loan or mortgage account errors

Suppose that you make an error when you set up a loan or mortgage account. One little mistake — an incorrect due date, for example — can throw everything out of whack. To fix mistakes you made when you set up a loan or mortgage account, open the account register, click the Analyze Loan link, and choose View Loan Amortization Schedule. You see a Loan Amortization report.

Recording loan and mortgage payments

If you are not tracking the principal portion of loan or mortgage payments in a loan or mortgage account, simply write a check to the bank or lender from whom you received the loan or mortgage and be done with it. But if you linked your loan or mortgage account to a checking account so that you can track how the amount you owe decreases with each payment, follow these steps to record it:
1. Open the loan or mortgage account register with which you track the loan or mortgage.

2. Click the New button in the transaction tab.

   A dialog box asks, “What do you want to do?”

3. Select the Make a Regular Loan Payment option and click OK.

   You see the Add Transaction dialog box, as shown in Figure 16-5. The amount of your monthly (or weekly or yearly) payment already appears in the Amount box.

4. In the Account drop-down list, choose the account from which you will make the payment.

   Your choice is probably a checking account.

   Try clicking the Split button to see how much of your payment is devoted to reducing the principal and how much is devoted to servicing interest. In Figure 16-5, part of the payment is a transfer to a House account to show how the principal of the loan is reduced; part is categorized as Loan: Mortgage Interest. At tax time, you could run a report and see in the Loan: Mortgage Interest category how much you paid for the year in tax-deductible interest payments.

5. In the Pay To box, enter the name of the bank or lender to whom you will write the check.
6. **Click OK.**

   In the loan account register, the balance is reduced by the amount of the payment that is devoted to reducing the principal of the loan.

   The transaction is entered in both the loan or mortgage account register and the checking account register from which the payment was made. To go to the checking account in which the payment was made, right-click the transaction and choose Go to Account.

When you record a mortgage or loan payment, the payment is divided:

- The portion that goes toward reducing the principal (your debt) is recorded as a transfer to the loan or mortgage account. In the loan or mortgage account register, the balance is reduced accordingly.

- The portion that goes toward paying the interest is categorized as mortgage interest (or another category, depending on which category you selected when you set up the account).

- If you have to pay fees, the payment is divided even further.

**Paying early and often**

The faster you pay off an amortized loan or mortgage, the less you have to pay altogether, because much of the cost of an amortized loan goes toward paying interest. Suppose that you want to pay more than you are required to pay so that you can pay off the loan quicker and save on interest costs. How do you record a payment you’ve made above and beyond what the lender expects of you?

Follow these steps to record a larger-than-usual or extra loan or mortgage payment:

1. Open the loan or mortgage account register.

2. **Click the New button.**

   You see the dialog box that asks “What do you want to do?”

3. **Either make an extra payment or pay more on top of your usual payment:**

   - **Extra payment:** Select the Make an Extra Loan Payment option and click OK to go to the Add Transaction dialog box (refer to Figure 16-5). Fill in this dialog box as you normally would, and enter the amount of the extra payment in the Amount box.

   - **Larger-than-usual payment:** Select the Make a Regular Loan Payment option and click OK. Fill in the Add Transaction dialog box as you normally would and then click the Split button. In the Loan Payment dialog box (refer to Figure 16-5), increase the
Amount on the Principal Transfer line by the additional amount you’re paying. Next, click Done. You see the Adjust Loan Payment Amount dialog box shown in Figure 16-6. Select the third option, Change the Loan Payment Amount to Be the Sum of the Loan Split Amounts, and click OK.

Amounts you pay above and beyond what the lender expects go toward reducing the principal of the loan — they go directly toward reducing the total amount you owe. Therefore, you have to add the extra amount to the amount already shown on the Principal Transfer line.

For example, if the amount of principal you are scheduled to pay is $68.63 and you want to pay an extra $100 this time around, enter $168.63 on the Principal Transfer line.

4. Click OK in the Edit Transaction dialog box.

You are hereby encouraged to make extra payments on a loan or mortgage when you can afford to. Not only do you increase the amount of equity you have in the thing you borrowed money to purchase, you also dramatically lower the interest amounts you have to pay to service the debt.

**Adjusting loan account balances**

Money does its best to calculate interest and principal payments, but computers are only human, and sometimes they make mistakes. When you receive a statement from a lender, compare the balance on the statement to the balance in your loan or mortgage account, and if the balances are out of line with each other, follow these steps:

1. Open the mortgage or loan account register.
2. **Click the Update Amount Owed link.**
   
   You’ll find the button under Common Tasks. You see the Adjust Loan Balances dialog box, shown in Figure 16-7.

![Adjust Loan Balances dialog box](image)

3. **Enter the date shown on the statement in the As of Date text box.**

4. **Enter the ending balance shown on the statement in the New Ending Balance text box.**

5. **Use the Category for Adjustment box to describe the few cents’ or few dollars’ difference between your records and the lender’s.**

   Select an expense category such as Miscellaneous if the lender’s records show a higher amount than what your records show; select an income category such as Other Income if the lender’s records show a lower amount.

6. **Click OK.**

   Money makes an account adjustment entry in the register and all’s well that ends well, as Shakespeare used to say when he used Money version 1603.

### Updating the interest rate on a loan or mortgage

Suppose that the interest rate on your loan or mortgage changes. If yours is an adjustable-rate mortgage (ARM), it’s bound to happen sooner or later. When the interest rate changes, you have to burrow into your loan account and record the change.

To adjust the interest rate, open the loan or mortgage account register and click the Change Account Settings link. You land in the Change Accounts Settings window. Scroll toward the bottom of the window and click the Update Interest Rate button. Money presents you with a series of dialog boxes for changing the interest rate. Keep answering the questions and clicking the Next button until, gratefully, you finish.
Part VI

Going Online with Money

The 5th Wave  By Rich Tennant

"Can't I just give you riches or something?"
In this part . . .

Part VI is dedicated to Buck Rogers, that citizen of the future who banks online and pays all his bills in digital cash. You won’t catch Buck Rogers standing in line at a bank or ATM machine. You won’t see him reconciling his bank accounts from a measly paper statement. You won’t see him thumbing through the newspaper in search of a stock quote, because Buck Rogers downloads stock quotes from the Internet.

If your computer is connected to the Internet, you’re invited to go online and make like Buck Rogers. Here’s your chance to take advantage of the Money program’s many online features. This part of the book explains how.
Chapter 17

Getting Ready to Go Online

In This Chapter
- Exploring the online services that Money offers
- Getting the equipment and services you need to bank online
- Seeing whether your bank offers online services
- Setting up bank accounts to work online
- Canceling the online banking service

The makers of Money are betting that people will soon rely on home computers to do their banking in the same way that people rely on ATMs to do most of their banking today. Not so long ago, ATMs were regarded with suspicion: “What if the machine shortchanges me?” However, most people don’t think twice about using ATMs nowadays, and someday they probably won’t think twice about banking online, either.

This chapter explains the steps you must take before you can start banking online. I describe the online services and equipment that you need and show you how to find out whether your bank offers the services, how to sign up for them, and how to cancel them if it comes to that.

Reviewing the Online Services That Money Offers

The Money program’s online services enable you to do everything from pay your bills to investigate potential investments. Table 17-1 describes the Money online services. If you have the Premium edition of the program, some of these services are free.
Table 17-1 The Online Services That Money Offers

<table>
<thead>
<tr>
<th>Service</th>
<th>What You Can Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online banking</td>
<td>Download records from your bank or credit card company to find out which transactions have cleared the bank (and then balance the account, if you choose). Money automatically enters records that you download in the account register, which saves you some of the trouble of entering the records yourself. You can also download brokerage statements. Cost: Depends on whether you download transaction records directly into Money or go to the bank’s Web site first. Varies from institution to institution. Some banks charge nothing and some charge $3 to $5 per month.</td>
</tr>
<tr>
<td>Online bill payment</td>
<td>Pay bills online with MSN Bill Pay. You can use this service to pay anyone, even Uncle Ernie. If your bank doesn’t permit you to pay bills online, you can still do it through these third-party corporations such as CheckFree. Cost: MSN Bill Pay charges $5.95 per month for the first 15 payments (the first three months of the service are free). After 15, payments cost 50 cents a piece.</td>
</tr>
<tr>
<td>Online stock and mutual funds</td>
<td>Download stock, bond, and mutual fund prices from the Internet. Money automatically enters the current prices of the stocks, bonds, and mutual funds in your portfolio in the Portfolio Manager window. By using this service, your portfolio is always up-to-date (see Chapter 9). Cost: Free.</td>
</tr>
</tbody>
</table>

Before you can start banking or paying bills online, you have to sign up with your bank. After you sign up, the bank assigns you a password or a PIN (personal identification number) similar to the PINs used in automatic teller machines. You have to supply the password or PIN whenever you engage in an online activity.

Not all banks and financial institutions offer online banking, but the ones that offer the service do so in one of these ways:

- **Direct services:** You send instructions from inside Money to download a bank statement or transfer funds between accounts, and the instruction is sent directly from your computer over the Internet to the bank’s computers. Usually, banks charge for this service.

- **Web services:** You go to the bank’s Web site, enter your password, and download a statement to Money. You can’t transfer funds with this type of online account. All you can do is view and download bank statements. Usually, this service is free.
When you pay a bill online through your bank, the payment order is sent to a third party such as MSN Bill Pay or CheckFree. Its computers contact your bank’s computers and withdraw the money necessary for the payment. The third party sends a paper check or an electronic funds transfer to the payee. Which company handles these money transfers depends on your bank. Banks contract bill-pay services to other companies.

By the way, Microsoft isn’t the only company that offers online bill payment services. If you’re keen to pay bills online, look into the services described in Table 17-2 as well.

<table>
<thead>
<tr>
<th>Service</th>
<th>Monthly Cost/No. Payments</th>
<th>Web Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>AOL Bill Pay</td>
<td>Free*</td>
<td><a href="http://www.aol.com/product/billpay.adp">www.aol.com/product/billpay.adp</a></td>
</tr>
<tr>
<td>Bills</td>
<td>$6.95 for 20</td>
<td><a href="http://www.bills.com">www.bills.com</a></td>
</tr>
<tr>
<td>CheckFree</td>
<td>Free**</td>
<td><a href="http://www.checkfree.com">www.checkfree.com</a></td>
</tr>
<tr>
<td>Paytrust</td>
<td>$4.95 + $0.50 per payment</td>
<td><a href="http://www.paytrust.com">www.paytrust.com</a></td>
</tr>
<tr>
<td>Status Factory</td>
<td>$11.30 for 15</td>
<td><a href="http://www.statusfactory.com">www.statusfactory.com</a></td>
</tr>
<tr>
<td>Yahoo! Bill Pay</td>
<td>$4.95 for 12</td>
<td><a href="http://finance.yahoo.com/bp">http://finance.yahoo.com/bp</a></td>
</tr>
</tbody>
</table>

*AOL Bill Pay is free to America Online subscribers.
**Individual banks offer CheckFree for free or for a small monthly fee.

What about using your bank’s online services?

Before you consider using the Microsoft Money online banking services, you might investigate whether your bank offers these services and whether your bank’s services are superior to Money’s. Banks prefer their customers to bank online because it spares them from having to manage paper records. For this reason, banks have gone out of their way to make banking online easy for their customers. At some banks, you can pay bills online for free. You can also transfer money between accounts and take care of routine banking chores such as ordering more checks or stopping a check payment. You can also schedule future money transfers, view scanned images of checks that have cleared the bank, and be alerted by e-mail when an account balance drops below a certain amount or a check bounces.

Paying bills online costs $5.95 per month with Microsoft Money. If your bank offers this service for free, why shell out the $5.95? You might be better off banking without the services of the mighty Microsoft Corporation.
Laying the Groundwork

I'm afraid that getting online isn't as easy as counting one, two, three. Before you can start exploring cyberspace, you have to complete two or three irksome little chores. Sorry about that.

The following sections explain what equipment you need to go online, how to establish a connection between your computer and the Internet, how to investigate whether your bank offers online services, how to sign up for the services, and how to set up an account so that you can go online with it.

The good news is that you have to complete these irksome little chores only once.

The equipment you need

Before you even think about going online with Money, make sure that your computer is capable of connecting to the Internet. You also need a browser, a computer program that connects to Web sites and displays Web pages (browser is not a contraction of the word brown-noser, by the way). When you installed Money, you also installed Internet Explorer — the browser made by the Microsoft Corporation — unless it was already on your computer. So, a browser is already installed on your system.

One more thing: You need an account with an Internet service provider (ISP). When you download stock quotes or bank online, Money runs piggyback on your ISP connection. Money can’t establish or make the connection on its own.

You may need a Microsoft passport!

Stop! Do not pass Go. Do not collect $200. Before you can use some of the online banking services, you need a passport from Microsoft. You can obtain the passport at this Web address: http://register.passport.com. As Chapter 11 explains in excruciating detail, you have to enter your Microsoft passport when you start Money. You need the passport to download bank transactions online or record Money transactions online.
Disabling call waiting

Call waiting is wonderful unless you connect to the Internet by dial-up modem. The noise that call waiting makes to tell you someone is trying to call disrupts Internet connections. You can, however, enter a prefix before you call to disable call waiting for the duration of a telephone call. When you connect to the Internet by dial-up modem, make sure that your modem dials the prefix as well as the telephone number of your Internet provider. Find out what the prefix is and then follow these instructions to disable call waiting when you connect to the Internet:

**In Windows 98**: Go to the Control Panel and double-click the Modems icon. Select a modem on the list, if necessary, and click the Dialing Properties button. Select the To Disable Call Waiting Dial check box, enter the prefix, and click OK.

**In Windows 2000, Me, and XP**: Go to the Control Panel and double-click the Phone and Modem Options icon. On the Dialing Rules tab, click the Edit button, select the To Disable Call Waiting Dial check box, enter the prefix, and click OK.

Signing Up with Your Bank

If the Microsoft Money online banking services tickle your fancy, the next step is to get in touch with your bank and find out whether it offers online services and which services it offers. One way to do that is to visit the bank’s Web site by following these steps:

1. **Click the Banking tab to go to the Account List window.**
2. **Click the name of the account with which you want to bank online.**
   
   You see the Account Register window.
3. **Click the Go to Your Bank’s Name link or, if you can’t find that link, click the Connect to Bank link.**
   
   If you don’t see the Go to Your Bank’s Name link or the Connect to Bank Link, click the Change Account Settings link in the Account Register window. You go to the Change Account Settings window. Choose the name of your bank from the Financial Institution drop-down menu and then click the Done button.
4. **On the submenu that appears, choose Go to Your Bank’s Name Website.**
   
   If you selected a bank when you set up the account, Money opens to the bank’s Web site, as shown in Figure 17-1.
If the Go to Your Bank's Name Website option isn't available, Money doesn't know your bank's Web site address. In the Account Register window, click the Change Account Settings link to go to the Change Account Settings window. Then click the Update Contact Info for This Bank or Broker link and enter your bank's Web address in the Internet Address check box. Finally, click the Done button.

If you didn’t select a bank when you set up the account, or if Money doesn’t recognize your bank, click the Manage Online Services link in the Account List window. In the Manage Online Services window, click the Check for New Online Services link next to the bank's name. A series of windows appears so that you can name the bank.

**Figure 17-1:** Going to a bank's Web site in Money.
Whether you talk to a bank representative or look for information at your bank’s Web site, be sure to get answers to these important questions before you decide whether to bank online:

- Can I download transactions directly into Money without visiting the bank’s Web site? Probably the person on the other end of the line will be confused by this question. Explain that you want to know whether it is necessary to go to the bank’s Web site to download a bank statement. Explain that some banks permit Money users to download the data right into their Money file without visiting a bank’s Web site.

- How much do the services cost? How much for bill payment and banking online? Do you charge a flat rate or do you charge per transaction? Is there a trial period for using the services?

- Can I transfer money between accounts?

- Which accounts can be online accounts? (For example, banks as a rule do not allow IRA accounts to be online accounts.)

- If I decide to cancel the service, what is the quickest way to do so?

- How will I be billed? Will the charges show up on my monthly bank statement, for example? If I bank online with more than one account, which statement will the bill appear on?

If you like the replies and decide to sign up for online banking, the bank or credit card company needs some or all of the following information, so be ready to provide it:

- Your address, home telephone number, and work telephone number
- Your account number(s) and perhaps your ATM card number
- Your birthday and birthplace
- Your mother’s maiden name
- Your Social Security number
- Your e-mail address

What happens next depends on what kind of online services the bank offers. If the bank offers only Web services, you can get going very quickly. The bank will issue you a password. If you intend to bank online from inside Money, you usually have to wait a few days to receive a start-up kit in the mail. The kit includes the personal identification number (PIN) you need to access your accounts, as well as instructions for banking online.
Occasionally you read in the newspaper about an evil, twisted computer genius who crashes into others’ computers and steals bank account numbers and so on. And stories like that make you wonder whether banking online is safe.

Online banking is safe from the bank’s side. The chances of anyone’s breaking into a bank’s computers and stealing from bank accounts is nil because of encryption technology. This technology encodes — maybe the better word is scrambles — data so that only computers with the encryption key can decode it. No hacker, however bold or intelligent he or she is, can get an encryption key.

All the danger of an online bank account’s being robbed lies on the customer’s side. Conceivably, a spyware program could look over a customer’s shoulder (so to speak), note which keys are being pressed on the keyboard, and in so doing, acquire the user ID and password to an online bank account.

A more likely way for a criminal to obtain a user ID and password, however, is by means of a fraudulent e-mail solicitation like the one shown here. This e-mail message looks like it comes from a bank. It looks authentic. Clicking the link in the message takes you to an authentic-looking Web site that asks for your user ID, password, and Social Security number.

Never reply to e-mail messages like this. Banks do not solicit personal information this way. Fraudulently obtaining personal information by e-mail or at a phony Web site is called phishing, and phishing is turning into a big problem for banks. The first time you open an online bank account, you will be asked to supply an account number and password. After that, any attempt to obtain your account number or password is almost certainly fraudulent and should be reported to your bank.
Setting Up a Money Account So That It Works Online

After you learn your password or get your PIN from the start-up kit that the bank sends, your next step is to give the account you want to work with online status. In other words, you need to set up the account so that you can use it to bank online and perhaps pay bills online. Connect to the Internet and follow these steps:

1. Click the Banking tab to go to the Account List window.
2. Click the Manage Online Services link.

You land in the Manage Online Services window, shown in Figure 17-2. The names of banks and financial institutions where you have open accounts are listed in this window. If you can sign up for online banking with an institution, a Complete Setup for Online Services link appears beside its name. If an account has been set up for online services, the lightning bolt icon appears to the left of its name.

3. Click the Complete Setup for Online Services link next to the name of the bank where you want to bank online.

You see the Select a Bank or Brokerage window.
4. Make sure that the correct bank or brokerage firm is selected and click Next.

Probably the correct bank is already selected, but this is your chance to select the right name if you chose the wrong one when you set up the account.

5. Click the Next button.

Money downloads information from the bank to your computer. What happens next depends on which bank you are dealing with and whether your bank offers Web services or direct services. Keep reading.

**Setting up an account for Web services**

If your bank offers Web services, you see windows for entering your online ID and password. Enter the information. Chapter 18 explains how to download a bank statement from your bank.

**Setting up an account for direct services**

If your bank offers direct services, including the ability to pay bills online, you see windows for entering particulars about your bank account. Starting here and clicking the Next button as you go along, provide the information that Money needs to bank and pay bills online. In the course of filling in these windows, your computer will download information from your bank. Provide this information:

- **User ID (Social Security Number):** You know what that is, I hope.
- **PIN:** The personal identification number that the bank supplied you in the startup kit.
- **Account name:** The name of an account you want to bank online with.
- **Bill pay:** Declare whether you want to pay bills online as well as bank online.
- **Routing number:** The routing number (which you find in the start-up kit) consists of the first nine numbers in the lower-left corner of checks. On either side of the routing number is a colon (:).
Signing Up for MSN Bill Pay

To sign up for MNS Bill Pay, start by making sure that you are signed into Money with a Microsoft passport. Click the Banking tab to go to the Account List window and then click the Manage Online Services link to open the Manage Online Services window. From there, do one of the following:

- **The bank account is listed under You Have Set Up Online Updates:**
  Click the bank’s name and then click the Update Accounts and Other Information Online link. Under Account Transactions, select the account from which you want to pay the bills, enter the sign-in information, and click the Update button.

- **The account is listed under You Haven’t Set Up Online Updates:** Click the Complete Setup for Online Services link and follow the on-screen instructions. You will be asked for a security key (a four-character code you choose yourself), for your address, for your Social Security number, and for your bank account number and routing number on your check.

Changing Your Mind about the Online Banking Services

You tried. You tried your best and really put your heart into it, but banking online was not for you. It just didn’t work out. You weren’t ready for an online relationship.

Follow these steps to disable an online account:

1. Click the Banking button to go to the Account List window.
2. Click the Manage Online Services link.
   You see the Manage Online Services window.
3. Click MSN Bill Pay.
4. Click the Stop Using Bill Pay in Money and follow the instructions on the screen.
Chapter 18
Banking and Bill Paying Online

In This Chapter
- Connecting to the Internet and your bank
- Downloading a bank statement and updating an account register
- Paying your bills online
- Transferring money between online accounts

Banking online and paying bills online represent a brave new world. If you’ve made the arrangements with your bank and have prepared Money for online banking (see Chapter 17), you’re ready to blast off for that world. You’re going to do for the first time what many people will consider routine by 2007. You’re about to enter the future. You’re about to take your digital cash into cyberspace.

In this chapter, you find out how to pay bills electronically over the Internet and how to keep tabs on a bank account by banking online. Throughout this chapter, I show you how to record online transactions and online payments in account registers. So strap yourself in. Liftoff is approaching.

Sending Banking Instructions over the Internet

After you record online transactions and online payments (I show you how shortly), they appear in the Update Online Information dialog box, shown in Figure 18-1. This dialog box also lists commands for downloading stock quotes and updating Money. The Update Online Information dialog box is
where you tell Money which instructions to send to your bank, credit card company, or brokerage firm. Select each instruction you want to send and click the Update button to go onto the Internet and download information to your computer.

Money offers no fewer than four ways to open the Update Online Information dialog box:

- Click the down arrow on the Online Updates button and choose Update Now. This button is located in the northeast corner of the screen, next to the Show Help Pane button (refer to Figure 18-2).
- Click an Update Now link in the Account List window.
- Click the Update icon in the Account List window. This icon appears beside the names of accounts.
- Choose Tools ➪ Internet Updates ➪ Update Now.

You hear your phone dialing (if you have a dial-up modem rather than high-speed DSL or cable-modem line) and then you see the Update in Progress dialog box. If all goes well, the Update Status message box appears and tells you that the update is complete (refer to Figure 18-1).
As shown in Figure 18-2, the Tools ➪ Internet Updates submenu and the drop-down menu on the Online Updates button offer commands for handling online transactions:

- **Update Now**: Displays the Update Online Information dialog box so that you can choose which online banking instructions to send.

- **Read Call Summary Messages**: Displays the Review Update Results window so that you can see the dates and times when instructions were last sent (refer to Figure 18-2).

- **View Electronic Transactions**: Displays the View All Electronic Payments and Transfers window so that you can see which online payments and money transfers need sending.

- **Customize Updates**: Displays the Customize Update Schedule window so that you can tell Money how often to send online transactions and receive online updates.
Banking Online

You may remember the old movies and TV shows about Buck Rogers. Not one of them showed Buck banking online. Sure, you got to see Buck battle Ming the Merciless, but you never saw him battle his checkbook as he tried to balance it. Too bad Buck didn’t have Money to download a bank statement and use it to update an account register, transfer money between online accounts, or send e-mail messages to a bank. (He could even have used e-mail to taunt Ming.)

Getting accurate, up-to-date account information

With the online banking service, you can find out how much money is in an account and which transactions have cleared the bank. After you get the information, you can compare it to the records in your account register and update the register with the downloaded information. You can even let Money do the work of recording transactions in registers. Instead of entering the transactions yourself, the bank “pours” them into the account register when you download.

Unless you specify otherwise, you get months and months of information the first time you download a bank statement. You don’t want that. You want about a month’s worth of transactions.

How you download statements from a bank depends on whether you use direct services or Web services to bank online. Better read on.

Downloading a bank statement with Web services

To download a bank statement with Web services, start by going to your bank’s Web site. You can get there in Money by using one of these techniques:

捺 Choose Favorites ➪ Favorite Web Sites ➪ Your Banks ➪ Name of Your Bank ➪ Home Page.

捺 In the Account Register window, click the Connect to Bank link and choose Go To Your Bank’s Name on the submenu.

On your bank’s Home page, enter your Online ID and password. Then follow the instructions on the page for downloading a bank statement. Each bank’s instructions are a little different. Select the name of your account, look for a Download to Microsoft Money button, and click the button.
After the account information is downloaded to your computer, you see the Import a File screen, shown in Figure 18-3. Follow these steps to download your bank statement:

1. On the Money Accounts drop-down list, choose the name of the account where the transactions belong.

2. Click the Next button.

The You Have Statements to Read window, shown in Figure 18-4, appears.

---

**Download a bank statement with direct services**

Options for getting bank statements appear automatically in the Update Online Information dialog box, the dialog box you see when you click the Online Updates button and choose Update Now (refer to Figure 18-1). Money assumes that you want to download your bank statement whenever you connect to the Internet by way of Money. Enter your PIN, if necessary, and click the Update button. The You Have Statements to Read window (refer to Figure 18-4) lists the bank statements you downloaded.
Viewing and updating a register whose transactions you downloaded

After you’ve downloaded transactions from the bank, you can compare the bank’s records to yours for the sake of accuracy. By doing so, you make sure that the amounts in your register match the amounts in the bank’s records. If you find a discrepancy, Money gives you the chance to fix it.

In the You Have Statements to Read window (refer to Figure 18-4), click the name of the bank account whose statement you want to examine. You see an account register like the one in Figure 18-5. Here’s how to read confusing registers like this one:

- Under “Downloaded” on the left side of the screen, Money tells you how many transactions need reviewing.
- Where Money thinks there is a discrepancy between a transaction you entered and a transaction you downloaded from the bank, the transaction appears in boldface type and a red exclamation point (!) appears in the ! column.
- If Money thinks that an entry you made in the register and one you downloaded may be different, the words Your Entry and Bank Entry appear in the register. As I explain shortly, you can fix these discrepancies by selecting the transaction and clicking the Accept or Change button.
- Where you entered a transaction in the register that is identical to a transaction you downloaded from the bank, the words Your Entry and Bank Entry don’t appear in the register. These transactions are very likely accurate. You can simply click the Accept button to acknowledge them.
- If you downloaded a transaction but it is nowhere to be found in your register, the transaction appears in CAPITAL letters.

Your mission now, should you choose to accept it, is to examine the transactions, make sure they are accurate, and then accept or edit them as necessary. You don’t have to clear all the transactions. You can always uncheck the mysterious ones and clear them later, when the paper statement arrives.

Click each boldface transaction that needs reviewing to select it; then do one of the following:

- **Accept it:** Click the Accept button. You hear a “beep,” and that’s the end of it. The transaction is officially entered in the register. Before you accept a transaction, make sure it is categorized correctly.

Under Common Tasks, click the Reconcile Transactions link and choose Accept All Transactions if you are certain that the matches are accurate and you want to save a little time.
Edit it: Right-click the transaction and choose Edit. Then edit the transaction to make it accurate.

Change it: Click the Change button if you want to match the transaction to one you already entered or create two separate transactions. You see the Change Transaction Matching window, shown in Figure 18-6. This window gives you the chance to repair the little problem.

Figure 18-6: Changing transactions downloaded from the bank.

Click Accept to enter the boldface transaction.

Click Change to edit it.

Figure 18-5: Reviewing transactions downloaded from the bank.

Change transaction matching

<table>
<thead>
<tr>
<th>Bank Entry: 2461</th>
<th>7/15/2006</th>
<th>Homecoming Financial Mortgage Payment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>434.61</td>
<td></td>
</tr>
<tr>
<td></td>
<td>28,837.71</td>
<td></td>
</tr>
</tbody>
</table>

(1) Don’t match these transactions. Money will unmatch the transactions and enter them as individual items in your register.

(2) Match the bank transaction to a different item. Money will combine the bank transaction with the item(s) you select.
In the Change Transaction Matching window, do one of the following:

- **Enter two separate transactions**: Select the first option, Don’t Match These Transactions. Then click the Done button.
- **Assign the transaction to another entry in your register**: Select the second option, Match the Bank Transaction to a Different Item. At the bottom of the screen, a list of unreconciled transactions in your account register appears. If the transaction is one you entered already, select its check box in the list and click the Done button.

---

**Deciding how to download transactions**

Be sure to visit the Online Service Settings tab of the Settings dialog box if you are serious about downloading transactions from banks. This tab gives you many opportunities to decide how you want to download stuff from the bank. Choose Tools ➪ Settings and click the Online Service Settings link in the Settings window. You see the Online Service Settings tab of the Settings dialog box. From top to bottom, here are the options on the Online Services tab:

- **Add a description to the Memo field**: Banks automatically enter descriptions in the Memo field for withdrawals, for example. Choose this option to enter those descriptions in your account registers.

- **Match transactions**: When looking for matches, this option tells Money to search a certain number of days in the past. Sixty days is usually adequate, because that represents about two statement periods.

- **Automatically accept all downloaded transactions**: I wouldn’t touch this one with a ten-foot pole! I think you should review downloaded transactions before entering them in the register.

- **Overwrite transaction dates**: Instead of entering the date on which you made a transaction into the account register, Money enters the date on which the transaction cleared the bank.

- **Replace downloaded payee names with user-altered names**: Money offers a feature for filling in payee names for downloaded transactions. I don’t cover it in this book because it doesn’t work very well. You’re welcome to try it, though, by choosing this option.

- **Automatically mark accepted transactions as Reconciled**: Choose this option if you don’t want to balance your bank account against the monthly statements that the bank sends in the mail and you prefer to balance the account on the basis of transactions that you download from the bank.

- **Show standardized payee names**: The payee name feature again!

- **Enter electronic payments in the register**: Instead of entering the date on which you made an electronic payment, Money enters into the register the date the payment clears the bank.

- **After accepting a transaction**: What do you want to do after you click the Done button in the Change Transaction Matching window (refer to Figure 18-6)? Choose an option from this drop-down list.
Paying the Bills Online

Sure, paying bills online is disconcerting at first. That’s your hard-earned money flying across cyberspace. Those coins that used to jangle in your pocket have been digitized and turned into bits and bytes — nothing you could feed a jukebox, for example.

On the other hand, you don’t have to rummage through desk drawers to find stamps and envelopes when you pay bills online. Paying bills online is a little cheaper than paying bills by mail.

Money offers a shortcut to MSN Bill Pay. Click the Bills tab to go to the Bills Summary window. Then click the Go to MSN Bill Pay link. You’ll find it under Common Tasks.

Recording the online payment

To record an online payment, follow these steps:

1. Click the Banking tab.
   You land in the Account List window.

2. Click the name of the bank from which you will pay the bill.
   You go to the Account Register window.

3. Click the Make a One-Time Payment link and choose the Make an Electronic Payment option on the submenu.
   The first time you record an online payment to a company or person and you click OK in the Add Transaction dialog box, you see a dialog box for entering information about the company or person. Here you tell Money everything you know about the payee. Be sure to enter the information correctly.

   You have to fill out the Online Payee Details dialog box only once for each payee. After you make the first online payment, Money doesn’t ask you for the payee’s address and phone number again. If a payee’s address or phone number changes, go to the Categories & Payees window and record the changes there (see Chapter 11).

   If you don’t have an account number, enter your name in the Account Number text box.

4. Click the Submit Payment button.
   When you click the button, you see the Add Transaction dialog box. Except for the Due Date text box and the Number box, which says Epay (for Electronic Payment), this dialog box works exactly like the Withdrawal transaction form I describe in Chapter 4.
What about check numbers for online payments?

When you record an online payment and send it across the Internet, Money assigns it a check number that is far, far removed from the numbers on the checks you enter by hand. The check number isn’t assigned until the payment has been sent. Money even puts the online icon — an envelope being struck by lightning — next to the check number in the register so that you know that the payment was made online.

Stopping a payment after it’s sent

What? You sent a payment over the Internet and now you regret doing so? If you sent the payment in the past four days, you can try to stop it by following these steps:

1. Click the Bills tab to go to the Bills Summary window.
2. Click the View Electronic Transactions link.
   
   The View All Electronic Payments and Transfers window appears. It lists all transactions you sent in the past 60 days.
3. Select the electronic transaction you want to stop and click the Delete button.

Transferring money between accounts

As long as both accounts are signed up for the online banking service and both accounts are at the same bank, you can transfer money between accounts. In fact, you can play digital Ping-Pong and send the money back and forth between accounts as many times as you wish. Sorry, you can’t transfer money from, for example, a credit card account to a checking account. Also, you can’t transfer money to someone else’s bank account. Money laundering is not allowed.

Transfer funds between accounts the same way you record a normal money transfer in a register. However, choose Electronic Transfer (Xfer) in the Number box and click the Submit button to send the transfer across the Internet.
"I bought a software program that should help us monitor and control our spending habits, and while I was there, I picked up a few new games, a couple of screen savers, 4 new mousepads, this nifty pull out keyboard cradle..."
In this part . . .

Each chapter in Part VII offers ten tidbits of good, rock-solid advice. With four chapters in this part, that makes — count ‘em — 40 tidbits in all.

You’ll find suggestions for staying on top of your finances, improving your financial health, using Money when you are self-employed, and converting from Quicken to Money.
Chapter 19

Ten Things You Should Do Periodically

In This Chapter

- Back up your data file
- Update your savings and checking account registers
- Balance your bank statements
- Balance your credit card accounts
- Personalize the Home Page
- Generate an “Income versus Spending” report
- Print your account registers
- Make an archive file and put it away
- Prune your Payee list
- Stop and smell the roses

This little chapter explains ten things you should do from time to time with Money. Do these ten things and you will live happily ever after.

Back Up Your Data File

Whenever you shut down Money, the Back Up When Money Closes dialog box appears, and you get an opportunity to back up your data file. Seize this opportunity! Grab it by both ears and shout, “Yes, I want to back up my data file.” If you don’t back up your file and something bad happens to your computer, you may lose all the financial data you so carefully assembled.

Chapter 11 explains how to back up a file — and how to restore a file from its backup copy. Be sure to back up your file to a floppy disk, CD, or other removable device. The data needs to be outside your computer, preferably in a hidden place that is safe from hurricanes, tornadoes, and earthquakes.
Update Your Savings and Checking Account Registers

Breaking up may be hard to do, but falling behind is easy — especially when it comes to entering the checks you’ve written in a checking account and the transactions you’ve made in a savings account.

If you procrastinate, you fall further and further behind. Soon, updating your savings and checking accounts seems like a monumental task. You stop updating your accounts, and not long after that, you stop using Money.

Set aside ten minutes in the middle of the month and ten minutes at the end of the month to update your account registers. Twenty minutes a month isn’t that bad, is it? Okay, you may miss a third of an “I Love Lucy” rerun each time, and that could be the death of you, but life isn’t exciting unless you take a few risks.

Balance Your Accounts

Balance your bank accounts each month when the statements arrive. Balancing, also known as reconciling, is easy to put off until tomorrow. However, if you keep putting it off, you end up with a stack of unreconciled bank statements and a bad case of the blues.

In Chapter 6, I explain a few tricks for recognizing and fixing reconciliation problems. After a while, you get good at balancing your records with the bank’s. Not that you enjoy it, but you do start to understand it. Eventually, a minute or two is all you need to reconcile. No kidding.

Balance Your Credit Card Accounts

Not only do you have to record credit card purchases from the statement if you don’t record purchases throughout the month, but you also have to balance your credit card account when the statement arrives. Balancing a credit card statement is, as with balancing a bank statement, one of those monthly jobs that’s easy to put off until next month. Try to do it each month. If you don’t, you get behind, become discouraged, fall into a state of despair, stop grooming yourself, stare at the ground a lot, and wear a permanent grimace on your face.
Personalize the Home Page

The Home Page is the first thing you see when you start Money. You can always return to the Home Page by clicking the Home button. The Home Page is supposed to give you a quick overview of your finances — your changing finances, I should say. As your financial picture changes, as you buy and sell investments, or take on new debt, or win the lottery, or donate all you own to a worthy cause, periodically change what is shown on the Home Page so that you see precisely where you stand financially.

To change the Home Page, start by clicking the Customize Content or Layout link on the Home Page. Chapter 2 explains the Home Page in detail.

Generate a Monthly Income and Expenses Report

One of my favorite Money reports, and certainly one of the most revealing, is the Monthly Income and Expenses report. It shows in no uncertain terms where you spent all that money, how you earned it, and whether you earned more than you spent.

Chapter 15 explains how to generate and customize reports and charts. The Monthly Income and Expenses report shows spending and income in the past month, but you can customize the report to show what you did financially in the past year or the past six months, for example.

Print Your Account Registers

When you file your income tax return in April, print a copy of your account registers from the previous year and put them away with the rest of your income tax stuff — copies of your returns, receipts, and bank statements. I explain how to generate and print reports in Chapter 15.

By printing the past year’s transactions, you leave behind a wide, easy-to-follow paper trail that the IRS posse can follow if it audits you.
Make an Archive File and Put It Away

Besides filing away a printed copy of your registers, make an archive file and put it away, too. An archive file is a file in which you store transactions from a certain time period. Make an archive file of transactions from the past year and file it away with copies of your tax returns and other important tax records. That way, you have a file of one year’s records that auditors can examine at their leisure. Chapter 11 explains how to generate an archive file.

Prune Your Payee List

Once in a blue moon, go into the Payee list and remove the names of payees you no longer write checks to or receive money from. Money enters payee names automatically in the Payee text box on transaction forms. Type the first few letters, and Money immediately enters a name for you.

When the Payee list gets too long, however, Money throws outdated names in the Payee text box. To keep from seeing the names of people and companies you haven’t dealt with for months or years, prune the Payee list. Chapter 11 explains how to do it.

Stop and Smell the Roses

I’m going to propose a radical idea: Computers aren’t as wonderful as many people make them out to be. Even when you’re surfing the Internet or exploring new cyberspace worlds, all you’re really doing is staring into the glare of a monitor.

You can easily get carried away with all the features that Money has to offer. If you own stocks and track them with Money, you may be tempted to download stock quotes each day from the Internet. If you’ve read Chapter 13 of this book, you know how to forecast your future income, and you may be tempted to find out, for example, how rich you’ll be in the year 2014.

Money is simply a tool to help keep your financial house in order. It simplifies the task of tracking your finances so that you can devote time to other things. So do those other things! Stop and smell the roses. Money shouldn’t be another computer toy that distracts you from the rich and intriguing real world, the one that begins just outside your computer screen.
Chapter 20

Ten Ways to Good Health — Financially Speaking, That Is

In This Chapter
► Record credit card transactions as you make them
► Pay off all your credit cards
► Leave your plastic at home
► Create a Spending by Category chart
► Create a Monthly Income and Expenses report
► Create a budget
► Plan ahead for your retirement
► Set aside money for a rainy day
► Make like a young dog — learn new tricks
► Take the day off

Warning: The Surgeon General has determined that not being in good financial health causes undue stress and worry and can lead to other health complications. The ten tidbits of advice in this chapter are meant to improve your financial health.

Record Credit Card Transactions As You Make Them

You can very, very easily run up credit card debt. A purchase here and a purchase there, and pretty soon you owe $3,000, $4,000, or $5,000. Ouch!
To keep from spending so much with a credit card, record the transactions as you make them. After you buy the expensive piece of stereo equipment or the designer-label jacket, carry the credit card receipt home, lay it flat on your desk, and record the purchase in a credit card register. Watching the amount that you owe climb higher may discourage you from buying so many things with your credit card.

**Pay Off All Your Credit Card Debt**

Paying down or paying off a large credit card debt isn’t easy, but it’s worth it because credit card companies charge outrageous interest rates on credit card debt. Unless you pay off your credit card each month, you’re paying extra for everything you buy with your credit card.

Look at it this way: If your credit card company charges 18 percent interest (the common rate in the United States) and you don’t pay off your credit card debt over the course of a year, you pay an extra 18 percent with every purchase you make. The fancy handbag on sale for $180 doesn’t really cost $180; it costs $212.40 after you add the 18 percent interest. The two tires don’t really cost $112; they cost $132.16.

**Leave Your Plastic at Home**

Do you notice a theme developing in this chapter? Sorry for harping on credit card debt, but it is the single most daunting obstacle that comes between people and their financial well-being. If you have trouble keeping credit card spending in check, try leaving your credit card at home. Studies show that people are far more apt to spend with a credit card than they are to spend cash.

**Create a Spending by Category Chart**

I can’t get enough of Money’s Spending by Category chart. It’s easy to generate, and it shows so plainly and nakedly where you spend money. The first time I saw the chart was a revelation. “Eureka!” I shouted. “So that’s where all the money went — to ice cream!” Actually, my two biggest spending categories were Taxes and Home: Mortgage, which wasn’t a very big surprise. It was surprising, however, to discover what a large chunk of my income I spent in those two categories.

Chapter 15 explains how to generate a Spending by Category chart. Money can generate many different revealing charts and reports.
Create a Monthly Income and Expenses Report

Another way to get a good look at your finances is to create a Monthly Income and Expenses report. The report shows how much you earned in the last six months and how you earned it. It also shows how much you spent in each category and subcategory. Chapter 15 explains how to generate reports.

Reading down the Expenses list, you may find a few surprises. You may discover one or two categories in which you spent much more than you thought. Next time you consider buying an item that falls into one of those categories, think twice.

Create a Budget

Chapter 12 explains how to formulate a budget with Money. Formulating a budget takes an entire evening, but if you have trouble keeping your spending in check, it is an evening well spent. Also, Money makes it very easy to find out whether you met your budget.

Plan Ahead for Your Retirement

For some people, retirement is a dirty word. They don’t want to think that far ahead. But you really ought to plan for your retirement for two reasons. First, to spend your golden years comfortably, you have to start saving now. Second, setting aside money for retirement is the best way to lower your tax bill. With 401(k) plans, SEPs, and other tax-deferred investment plans, the federal government has made saving for retirement very practical.

Chapter 13 explains how to use Money to help plan for your retirement.

Set Aside Money for a Rainy Day

One of the first things that you realize when you read most financial self-help books is how important “rainy day” money is. Most authors recommend setting aside two month’s income, the idea being that it usually takes two months to find a new job if you’re bounced out of your present job.
Make Like a Young Dog — Learn New Tricks

In Chapter 16, which describes how to set up an asset account, I explain that assets are things that add to your net worth — the money in savings and checking accounts, an object of value that you own, the equity in a house. However, you can’t record your most important asset in an account register: Your most important asset is you.

Your talents, your abilities, and your know-how are your most important assets. As such, you can make like a young dog and learn new tricks. Go back to school and acquire a few new skills. Or volunteer somewhere, gain new skills, and acquire new experiences. Doing so can make you a more valuable employee to others.

Take the Day Off

To use one of those man-as-machine metaphors, sometimes you have to relax and recharge your batteries. Take the day off. In fact (I’m writing this chapter late Friday afternoon), take the rest of the week off! You deserve it. The object of using Money is to get more free time to enjoy yourself.
Chapter 21

Ten Things to Do If You Are Self-Employed

In This Chapter

- Diligently record your financial activity
- Make sure that all tax-related expenses are marked as such
- Print a Tax-Related Transactions report for your accountant
- Use the memo box early and often
- Set aside a tenth of your income in a savings account
- Schedule your quarterly tax payments
- Use classifications to track business expenses
- Open a checking account for business transactions
- Write a check to yourself periodically
- Keep your irons on the fire

As of the year 2006, I will have been self-employed for 16 years. Not bad for a country boy from Idyllwild, California!

Being self-employed isn’t for everyone. You need the right temperament, and you have to be willing to suffer the risks as well as reap the rewards. The following pages offer a few suggestions for self-employed people who use Money.

Diligently Record Your Financial Activity

One of the difficulties of being self-employed is that you have to account for all the money you spend. At tax time, you use your records, not those of an employer, to calculate how much income tax you owe. And because you can deduct certain expenses from your gross income on your income tax report, you have to record expenses as carefully as income.

Money, of course, makes recording income and expenses an easy task. But you have to stay on top of it. Don’t let several weeks or months pass before
you update your savings and checking account registers. Be sure to reconcile your account on a monthly basis, too. Falling behind is too easy.

**Make Sure That All Tax-Related Expenses Are Marked As Such**

Being self-employed, you can deduct certain expenses from your gross income when you file an income tax report. Office expenses, rent payments (if you rent an office), and any payment you make on behalf of your business is tax deductible.

To mark an expense as tax deductible, you assign it to a category or subcategory that has tax-related status. Chapter 14 explains how to give categories and subcategories tax-related status. Give all categories and subcategories that have anything whatsoever to do with taxes a tax-related status.

**Print a Tax-Related Transactions Report for Your Accountant**

Transactions that are assigned to a tax-related category appear on the Tax-Related Transactions report. Under the name of each tax-related category and subcategory, the report lists transactions and gives the total amount that was spent. For example, the report lists each transaction assigned to the Charitable Donations category. At the bottom of the list is the total amount you spent on charitable donations.

Charitable donations are tax deductible. An accountant who examines the Tax-Related Transactions report knows right away how much you can deduct for charitable donations. You don’t have to pay the accountant to study your account registers and find charitable donations, because the numbers are right there on the Tax-Related Transactions report.

Chapter 15 explains how to generate reports. You can save a great deal of money on accounting fees by generating a Tax-Related Transactions report for your accountant.

**Use the Memo Box Early and Often**

As a self-employed individual, you have to track your own finances — your income, expenses, and so on. In account registers, you have to describe the
money you spend and the money you take in. Usually, the Category boxes on transaction forms are adequate for describing your income and expenses, but consider using the Memo text box as well. When you record an odd expense, describe it in the Memo box in case you have to explain it to an accountant months from now, when you will have forgotten what it was.

**Set Aside a Tenth of Your Income in a Savings Account**

Being self-employed takes discipline. Employers deduct income taxes, Social Security payments, and Medicare payments from the paychecks of wage earners and salaried employees. Not so with self-employed individuals. The self-employed are responsible for paying their own taxes and Social Security.

You should make tax payments four times a year, on April 15, June 15, September 15, and January 15. More important, you have to be ready to make these payments, which means setting aside some of your income throughout the year to meet your tax obligations.

I suggest stashing a tenth of your income in a savings account. If you’re making more money than the previous year, set aside more than a tenth, because you’ll owe extra when April rolls around.

**Schedule Your Quarterly Tax Payments**

Missing or being late with a quarterly tax payment is catastrophic. Heads roll. There is much sorrow and gnashing of teeth. To make sure that you make the quarterly payments on time, schedule them. Chapter 12 explains how to use Money to schedule a payment. Depending on how you set up your Home Page (see Chapter 2), you can make scheduled bills appear very prominently on the Home Page under Bills & Deposits.

**Use Classifications to Track Business Expenses**

One of the dilemmas of being self-employed is keeping your personal expenses separate from your business expenses. One way to keep them separate is to create a classification called Business and assign transactions that pertain to your business to the Business classification. See Chapter 5 for more about classifications.
Open a Checking Account for Business Transactions

Another way to keep business expenses and personal expenses separate is to open a checking account for business transactions. I got this idea from my accountant, who told me — mysteriously I thought — that I had “some ambiguity” between my personal and business expenses, but I could “resolve these ambiguities” by opening a business checking account.

Now, I deposit all incoming checks in my business checking account. When I need money for my family’s personal finances, I transfer it into the family checking account. Expenses for office supplies and such that fall in the business category are all paid out of my business checking account. I’m unambiguous. I’m as cut-and-dried as a salami sandwich.

Write a Check to Yourself Periodically

My accountant also told me that I need to spend more money on my business. “Why should I spend more money?” I asked. “I’m trying to save money.” He said that my overhead was extremely low and that I should “beef it up.” To do so, he suggested writing down all the piddley cash payments I make — for pencils, bus fare, and so on — in a book, and when the total expenses reach $100 or so, to write myself a check for that amount. By doing this, I can spend more money on my business and lower my tax bill.

I was surprised by how much the little expenses added up. Personally, I don’t like having to write down payments in a book, but I do like saving money on taxes.

Keep Your Irons on the Fire

In the days before the electric iron, when people used irons that were made out of, well, iron to smooth the wrinkles from their clothes, the person whose job it was to iron clothes had to keep more than one iron on the fire. While one iron was in use, a second and third iron lay on the fire. That way, the person who ironed clothes never lacked a hot iron.

If you are self-employed, you also have to keep more than one iron on the fire. You need to devote an afternoon every other week to looking for work. Looking for work means sending out your résumé, making phone calls, and maybe going to lunch. Looking for work does not pay well. In fact, the hourly wage for looking for work is zip. But looking for work is something you have to do if you expect to stay self-employed.
Chapter 22

Ten Things Ex-Quicken Users Should Know about Money

In This Chapter

- You can use Quicken data files in Money
- You can find the modified transactions
- Some things are lost in the conversion
- Some Quicken features have no equivalent in Money
- In Money, transactions are entered on forms
- Some old transactions are not shown as reconciled
- Your Quicken checks are good in Money
- Quicken’s online banking services are no good with Money
- Your Payee list is way, way too long
- Money offers helpful advice for Quicken users

About nine years ago, on the idea that “if you can’t beat ’em, buy ’em,” the mighty Microsoft Corporation made a bold attempt to purchase Intuit, the company that makes Quicken, Money’s rival. Everyone shook hands and the deal appeared completed until the Federal Trade Commission stepped in. The FTC insisted that the deal created a monopoly and constituted unfair business practices.

After being rebuffed by the federal government, Microsoft redoubled its efforts to make a financial management application as good as or better than Quicken. I believe Microsoft has succeeded in doing that. As one who has written books about Quicken and Money, I know both products very well, and Money is the better of the two by far. It offers more features, it is better integrated with the Internet, and it is much, much easier to customize. I think the interface is easier to use, too.

This brief chapter is for people who have made the switch from Quicken to Money. I describe the chief differences between the programs and tell ex-Quicken users what to watch out for as they use Money.
You Can Use Your Old Quicken File in Money

Money offers a wizard that you can use to convert a Quicken data file to a Money file. Actually, the wizard doesn’t convert the file. It makes a copy of the Quicken data file, converts the copy, and leaves the original data file intact. So if you decide after all that you like Quicken better than Money, you can go back to Quicken and continue using the data file as if nothing happened. After you convert a Quicken file, a new file called Qdata.mny opens on the Money screen. The file extension of Money files is .mny.

Before you convert your Quicken file, open the Quicken file (in Quicken, of course) and do the following to make the conversion go smoothly:

- Back up your Quicken file so that the backup copy is completely up-to-date.
- Validate the file. To do so, choose File ➪ File Operations ➪ Validate.
- If you formulated more than one budget, open the one you want to keep. Sorry, only one budget can make the trip from Quicken to Money.

Follow these steps to convert a Quicken data file to Money:

1. Close Quicken if the program is running and open the Money program.
2. Choose File ➪ Convert Quicken File.
   You see the Convert Quicken File dialog box.
3. Find and select your Quicken data file.
   Unless you tinkered with Quicken’s default settings, the Quicken data file is called Qdata.QDG, Qdata.QDF, Quicken.QDF, or Quicken.QDT, and it is located in the C:\Quickenw folder.
4. Click the Convert button.
5. In the Back Up When Money Closes dialog boxes, click the Back Up Now button to back up whatever data file is currently open in Money.
   You land in the Quicken File Conversion window.
6. Click the Next button and follow the on-screen directions.
   When Money asks where you want to store your new Qdata.mny file, be sure to choose a folder whose name and location you will remember.
After the conversion is complete, a Summary of the Conversion window appears. It lists account balances in Quicken and account balances in Money. Compare the two to make sure that the Quicken data was converted successfully. You can click the Save button, save the file, open it in your word processing program, and print it.

You Can Find the Modified Transactions

To look for transactions that were modified when you converted your Quicken file to Money, choose Tools ➤ Find and Replace and, in the Find and Replace dialog box, choose Regular Accounts or Investment Accounts in the Search Across drop-down list. Then type modified in the Find This Text box and click the Next button.

Some Things Are Lost in the Conversion

The following elements are not converted from Quicken files because Money does not offer similar features:

- Memorized charts
- Transaction passwords
- Category groups
- Savings goals

Some Quicken Features Have No Equivalent in Money

Besides savings goals, converts and forced converts to the Money 2006 Standard edition will not find equivalents to Quicken alerts and the financial planners. You have to own the Money 2006 Deluxe or Premium edition if you want to plan ahead.
In Money, Transactions Are Entered on Forms

In my opinion, the biggest difference between Quicken and Money is that, in Money, you enter transactions on forms at the bottom of the account register. In Quicken, you enter a transaction by typing it directly into the register. True, you can choose Enter Transactions Directly into the Register on the View menu in an account register window and enter transactions that way, but the people who designed Money make that hard to do. The drop-down lists in the account register are unwieldy and hard to use.

The transaction forms in Money take a bit of getting used to. Chapter 4 explains how forms work and how to record a transaction on a form.

Some Old Bank Transactions Are not Shown as Reconciled

As Chapter 6 explains, you can reconcile, or balance, bank accounts in Money to make sure that your records jibe with the bank’s. You can do that in Quicken too, as you probably know. When you convert a Quicken data file to Money, some transfers between accounts are shown as unreconciled, and this can cause a problem when the time comes for you to reconcile a bank account. Instead of seeing a month’s worth of unreconciled transactions in the Balance Account window, you see some old transactions from years past.

You can find these unreconciled transfers very quickly and reconcile them by following these steps:

1. Click the Banking tab to go to the Account List window.
2. Click the name of a bank account.
   You see the Account Register window.
3. Click the Balance This Account link.
   The first Balance dialog box appears.
4. Enter any number you want in the Ending Balance text box; and then click the Next button.
   It doesn’t matter what number you enter. Your purpose is to get to the Balance Account window and find unreconciled transactions.
5. In the Balance Account window, look for transactions from years past and reconcile them by right-clicking each one and choosing Mark As Reconciled on the shortcut menu.

Each time you reconcile a transaction this way, it is removed from the Balance Account window. These old transactions will not bother you next time you reconcile this account.

6. Click the Postpone button to leave the Account Balance window.

Your Quicken Checks Are Good in Money

Money puts Quicken check options in the Check Setup dialog box so that users who switch from Quicken to Money can use their Quicken checks. As long as you printed checks with Quicken, you can find the following options in the Check Setup dialog box:

- Laser Standard (Quicken)
- Laser Voucher (Quicken)
- Laser Wallet (Quicken)

Chapter 7 explains how to reach the Check Setup dialog box and select a check option.

If the Quicken check options do not appear in the Check Setup dialog box, choose Tools ⇒ Settings, and, on the Microsoft Money 2006 Settings page, click the Print Checks link to open the Print Checks tab of the Options dialog box. Under Printing Checks, select the Use My Existing Checks from Quicken check box.

Quicken's Online Banking Services Are No Good with Money

If you bank or pay bills online with Quicken, you can’t pick up where you left off after you switch to Money. Sorry. You have to cancel the online services you use with Quicken, reapply for the services, tell your bank that you use Money now, and start all over again. Chapter 17 explains how to set up the online banking services in Money.
Your Payee List Is Way, Way Too Long

Quicken has a very nice feature whereby payees whose names haven’t been entered in account registers for a certain amount of time are dropped from the Payees list. Unfortunately, Money has no such feature. When you import a large Quicken file, you may end up with a Payees list as long as a brontosaurus’s tail.

The only way to delete payees is to do so on the Payees list. Chapter 11 explains how.

Money Offers Help for Quicken Users

So anxious is Microsoft to woo Quicken users to Money, the program offers special help instructions for converts from Quicken. Choose Help ➪ Microsoft Money Help (or press F1). In the Help panel, click the Find button, enter Quicken in the Search for Help text box, and press Enter. You will see a list of help topics that help you leap the chasm to become a better user of Money 2006.
**Glossary of Financial Terms**

**401(k) plan**: A tax-deferred retirement plan by which a portion of an employee’s pay is deducted from each paycheck and invested. Employees do not have to pay taxes on income from the plan until they start withdrawing it at retirement age.

**403(b) plan**: A 401(k) plan for public school teachers and employees. See *401(k) plan*.

**adjustable-rate mortgage (ARM)**: A mortgage whose interest rate is changed periodically. Usually, ARMs are tied to a money index such as the prime lending rate.

**amortized loan**: A loan for which you make regular payments of equal size. With each payment, some money goes toward paying interest on the loan and some goes toward reducing the principal (the amount you borrowed). See *interest* and *principal*.

**asset**: Something of value that you own, such as a house, stocks, or jewelry. Money that is owed to you is also an asset, as is the money in savings and checking accounts. See also *liability* and *net worth*.

**asset allocation**: Refers to how investments are allocated among different investment classes such as bonds, stocks, mutual funds, and real estate. Asset allocation is an investment technique for minimizing risk.

**balance**: The amount of money in a bank account when all outstanding deposits and withdrawals are accounted for; also, the amount left to pay off on a debt. In the case of an asset account or investment account, the balance is the worth of the account. The balance on a liability is what you owe.

**basis**: See *cost basis*.

**bond**: A paper promise to pay back a debt with interest by a certain date. Governments issue bonds, as do companies. With a standard bond, regular interest payments are made to investors. With a discount bond, the buyer pays less than the face value (also known as the par value) of the bond. When the bond is redeemed, the owner receives the face value or more than the face value if the bond has increased in value. Discount bonds are also known as zero-coupon bonds.
**CD (certificate of deposit):** A bank deposit in which the depositor agrees to leave the money in the bank for a certain period of time. Banks guarantee a fixed rate of interest on CDs that is higher than the interest rate paid on savings accounts, for example.

**Closing costs:** The appraisal fees, sales commissions, and other fees that are charged when you take out a loan or mortgage. The costs, sometimes called points, are expressed as a percentage of the loan.

**Cost basis:** The total cost of purchasing a security, including commissions, fees, and mutual fund loads.

**Creditor:** A person or institution that lends money.

**Dividend:** From the word *divide*, a portion of a company's earnings that is distributed to the holders of stock in the company. Usually, dividends are paid quarterly.

**Equity:** A house's market value less the amount that is owed on the house. For example, if $100,000 is owed on the house and its market value is $150,000, the owner has $50,000 equity in the house.

**Escrow account:** An account that a mortgage lender takes out on behalf of a borrower to make sure that property taxes, property insurance, and other such fees are paid.

**Index fund:** A mutual fund that invests in all the companies listed in an index such as the S&P 500. Index funds provide returns similar to that by which the index grows or declines.

**Interest:** The cost, expressed as a percentage of the loan amount, for borrowing money. Also, money paid to a lender or bank patron for the use of his or her money. See also *principal*.

**IRA (individual retirement account):** A tax-deferred retirement plan for employees. The maximum contribution is $3,000 per year. You do not have to pay taxes on income from an IRA until you start withdrawing income from it at retirement age. See also *Roth IRA*.

**Keogh plan:** A tax-deferred retirement plan for self-employed individuals. Money invested in Keogh plans is tax deductible. Withdrawals are taxed.

**Liability:** A debt that you owe. Credit card debt is an example of a liability, as are taxes owed to the IRS. See also *asset* and *net worth*.

**Lot:** A group of securities purchased simultaneously at the same price. Also a nephew of Abraham whose wife got turned into a saltshaker.
**money market fund:** An interest-earning mutual fund that invests in Treasury bills and other short-term securities.

**mutual fund:** An investment company that raises money from shareholders and invests the money in a variety of places, including stocks, bonds, and money market securities.

**net worth:** What you are worth, not as a human being but as a financial entity. Assets add to net worth; liabilities count against it. See also **asset** and **liability**.

**P/E ratio:** The price of a stock divided by its per-share earnings. If the price-to-earnings ratio is high, the stock is being traded for its future value, not for its present value, which indicates that the investors are expecting high earnings on the stock.

**points:** The amount, expressed as a percentage of a loan, that you have to pay to a loan broker or bank to take out a loan. Also called **discount points**.

**portfolio:** The securities owned by an individual or investment firm.

**principal:** The actual amount of money borrowed on a loan. The principal is different from the interest, which is the price — expressed as a percentage of the loan amount — that you pay for borrowing the money. See also **interest**.

**rollover:** When you transfer funds from one investment or retirement account to another. Also, what Beethoven did in an old Chuck Berry song.

**Roth IRA:** An IRA to which investors can make after-tax contributions. Unlike an IRA, withdrawals from a Roth IRA are tax free because taxes on Roth IRA contributions are paid before the money is contributed. See also **IRA**.

**securities:** Bonds, stock certificates, and other financial instruments that can be traded and whose value fluctuates.

**SEP (Simplified Employee Pension):** A retirement plan, similar to an IRA, for the self-employed and small businesses. Money invested in SEPs is tax deductible. Earnings from SEPs are tax deferred.

**stock:** Shares of ownership in a company. Stocks pay dividends and can be bought and sold. See also **dividend**.

**tax deductible:** In income tax reporting, expenses that can be deducted from total income.
**tax deferred**: Refers to income for retirement on which you don’t have to pay taxes until you begin withdrawing it at retirement age.

**tax-deferred annuity**: An annuity for employees of nonprofit and education organizations whereby a part of the employees' income is excluded from taxes and is invested in securities. Tax on income from the annuity is paid when employees withdraw money from the plan.
Index

• A •

account. See also account register; setting up account; specific types of accounts balancing, 90–94, 312
contact information for, 32–34, 124
description of, 27
favorite, selecting, 35
name or type of, changing, 34
transferring money between, 51–52, 308
types of, 27–29
Account List window
Add a New Account link, 31
closing account, 185
opening account, 40–41
overview of, 20
Update icon, 300
account register
changing or editing, 60–61
correcting, 55–60
Credit Card and Line of Credit, 52–55
moving transaction, 63–64
navigating, 56
opening, 39–42
overview of, 12, 29–30
printing, 64–65, 313
reconciling, 89–90
recording transaction in, 42–47
reports and charts, 259
scheduled transaction in, 197–198
updating, 312
voiding or deleting transaction, 61–63
ad, turning off, 15
address, including on check, 113
adjusting account balance, 282–283
advanced bills, 192, 197
advanced budgeting, 201–209
advanced reports, 249
Advanced Search option, 59–60
Advisor FYI Alerts, 141, 164–165, 215–217
Alt+F4 (Close), 15
analyzing investments, 157–160
archive file, 186–187, 314
asset, 267–268, 271, 318
Asset account, 28, 268–272
Asset Allocation view, 159, 162–163
assets and liabilities reports, 252–254
assigning
ticker symbol for company, 153
transaction to category, 69–71
AutoReconcile feature, 97

• B •

Back button, 18–19, 23
Back Up Now button, 174
backing up, 174–179, 311
balance
on account, 32, 282–283
in Account List window, 40
description of, 30
forcing account to, 97–98
balancing account, 90–94, 312. See also balance; reconciling
bank
routing (fractional) number of, 104, 296
statement, downloading, 302–303
transactions, downloading, 122–123
Bank account, 28, 184–186, 312
banking online
disabling account, 297
downloading statement, 302–303
overview of, 14–15, 288, 289
Quicken compared to Money, 327
safety of, 294
sending instructions for, 299–301
setting up, 31
signing up for, 288, 291–293
transferring money between accounts, 308
viewing and updating register, 304–306
Banking tab, 19, 20, 40
batch-printing checks, 101
bill payment, scheduling, 191–195
Bills Summary window  
- Bill Calendar button, 195  
- Edit button, 199  
- Enter into Register button, 194  
- Forecast Cash Flow link, 217  
- overview of, 38  
- reminder to pay bill in, 196  
- reports and charts, 259  
- scheduling bills and, 191–192, 193  
- View History link, 198  

Bills tab, 19, 20  
- bonds, 147–150, 168  
- broker  
  - downloading transactions from, 122–123  
  - fee, recording, 145  
  - notifying about shares to sell, 141  
  - payment to or disbursement from, 134–135  
  - searching for online, 169  
- browsing Web, 22–23, 165–166  
- budget  
  - advanced compared to essential, 201–202  
  - advanced, setting up, 202–209  
  - Autobudget link, 206  
  - creating, 317  
  - essential, setting up, 209–210  
  - goals for, 14, 210–211  
  - overview of, 200  
  - working with multiple, 211–212  
- Budget Summary window, 202, 208–209  
- Budget tab, 19, 20, 202  
- Budget window, 201

- C -

calculator, accessing, 43  
- canceling scheduled transaction, 199  
- Capital Gains Estimator, 240–241  
- Car or Other Vehicle account, 28, 268  
- Cash account, 28, 268  
- cash flow, projecting, 77, 217–219  
- cash-back deposit, 49–50  
- Categories window, 232, 233  
- category  
  - assigning transaction to, 69–71  
  - correcting transaction in wrong, 80–83  
  - creating, 71–74  
  - deleting, 85–87  
  - editing and refining, 75–77  
- finding unassigned transaction, 84  
- renaming, 84–85  
- for spending and income records, 12–13  
- splitting transaction among, 47–49  
- tagging for taxes, 231–233  
- category group, 73, 77  
- Category window, 75–77  
- CD-R, backing up to, 174–176  
- certificate of deposit (CD), tracking, 151  
- Change Account Settings window, 283  
- changing  
  - passport or password, 184  
  - scheduled transaction, 199  
  - transaction in register, 60–61  
  - charitable donation, 320  
- charting investment performance, 160–161  
- charts  
  - budget, 211  
  - customizing, 258–263  
  - exporting, 265–266  
  - generating, 256–257, 259  
  - investigating figures for, 258  
  - My Favorites category and, 263  
  - printing, 263–264  
  - turning into reports, 257  
- Checking account, 28, 30–32, 322  
- checks. See also printing checks  
  - address, including on, 113  
  - ordering, 101–104  
  - setting up printer for, 105–107  
  - splitting payment, 108  
  - starting number for, 104  
  - voiding, 115  
- class, defining, 79–80  
- classification  
  - assigning transaction to, 71, 77–78  
  - defining classes and subclasses, 79–80  
  - deleting, 87  
  - renaming, 85  
  - setting up, 78–79  
- Close button, 15  
- closing  
  - backing up file when, 174, 176–177, 311  
  - bank account, 184–186  
  - miniregister, 152  
  - program, 15  
- comma-separated value file, 265  
- Comparison Reports category, 255–256  
- computer-program-as-Web-site concept, 15
contact information for account, listing, 32–34, 124
converting Quicken file, 324–325
corporate information, recording, 144
correcting mistake
  in Loan or Mortgage account, 279
  in register, 55–60
  in transaction category, 80–83
  while reconciling, 94
coupon rate, 147
credit card
debt, paying off, 316
researching online, 213
transaction, recording, 315–316
Credit Card account
  balancing, 312
  overview of, 28
  reconciling, 98–100
  recording transaction in, 52–55
  setting up, 35–38
Ctrl+C (Copy), 265
Ctrl+D (Delete), 62
Ctrl+F (Find and Replace), 57
Ctrl+H (Find and Replace dialog box), 82
Ctrl+N (New File), 187
Ctrl+O (Open File), 188
Ctrl+P (Print), 64, 264
Ctrl+S (Split), 47
Ctrl+Shift+A (Account List window), 40
Ctrl+Shift+C (Set Up Your Categories window), 72
Ctrl+V (Mark As Void), 62, 115
Ctrl+V (Paste), 265
Customize Report dialog box, 259–263
customizing
  Advisor FYI alerts, 216
  Home Page window, 21–22, 313
  reports and charts, 258–263
  toolbar, 24–25

• D •
data
  for budget projections, 200
  entering, 12
  exporting to tax-preparation program, 242–244
  saving, 15
date, entering, 43
debit card purchase with cash back, 49–50
debt, paying off, 316
Debt Reduction Planner, 228–230
deductions, finding, 238–239
defining classes and subclasses, 79–80
deleting. See also removing
  bank account, 186
  category or subcategory, 85–87
  classification, 87
  file, 189
Investment or Retirement account
  transaction, 151–152
  name from Payees list, 179–180, 314
  transaction in register, 61–63
deposit, scheduling, 193–195
Deposit tab, 43
depreciation, 224
describing securities, 135–138
direct services
  bank statement and, 288, 303
  setting up account for, 296
disbursement from broker, 134–135
diversifying investments, 162–163
dividend from stocks, 142
downloading
  bank or brokerage transactions, 122–123
  bank statement, 302–303
  Online Service Settings tab and, 306
  stock and mutual fund quotes, 153–155
tax rates, 236
duplicate transactions, looking for, 96

• E •
Edit Transaction dialog box
  Investment or Retirement account
    and, 151
  purchase of stocks, 139
  reassigning transaction to category, 82, 83
  sale of stocks, 140
  Edit ➪ Copy, 265
editing
  bank statement transaction, 305
category or subcategory, 75–77
  Investment or Retirement account, 151–152
  line items and categories, 234
  Loan or Mortgage account, 279
editing (continued)
  Payees list information, 180
  register entry, 60–61
  Edit➪Paste, 265
  Employee Stock Option account, 28, 121, 128–130
  encryption, 181, 294
  Ending balance, 96
  Enter Your Expenses window, 207–208, 210
  Enter Your Income window, 203–206
  entering
    data, 12, 74
    transaction in register, 43–47
  envelope, printing, 113
  equity, 268
  escrow account, 277
  essential bills, 192
  essential budgeting, 201–202, 209–210
  essential reports, 249
  estimating
    balance of account, 123–124
    capital gains, 240–241
    income taxes, 13
    tax bill, 235–238
  expenses
    business, tracking, 321
    reports, 250–251
    tax-related, 234, 320
  exporting
    data to tax-preparation program, 242–244
    report or chart, 265–266

• F •

  favorite account, selecting, 35
  Favorites list, 24, 180
  FIFO (first in, first out), 241
  file
    archive, 186–187, 314
    backing up, 174–177, 311
    comma-separated value, 265
    converting Quicken, 324–325
    creating, 187–188
    deleting, 189
    My Money, creating, 30
    opening, 188–189
    renaming, 189
    restoring from backup, 177–178
  tab-delimited text, 265
  transferring to new computer, 179
  TXF, 242, 243
  File➪Archive, 186
  File➪Backup, 176, 178
  File➪Close, 15
  File➪Export to Tax Software, 242
  filename, choosing, 187
  File➪New➪New File, 187
  File➪Open, 188
  File➪Password Manager, 181
  File➪Print, 64, 264
  File➪Print Checks, 108
  File➪Print Setup➪Check Setup, 105, 113
  File➪Restore Backup, 177
  Financial Event Modeler, 227–228
  Find and Replace command, 80
  Find and Replace dialog box, 57–61, 64, 82, 259
  finding
    backup file for restoring, 177–178
    tax deductions, 238–239
    ticker symbol for company, 129, 131
    transaction, 47, 56–60, 93
    transaction unassigned, 84
    transposed number, 95
  first in, first out (FIFO), 241
  flagging transaction, 63
  floppy disk, backing up to, 174–176
  folder, creating for Favorites list, 24
  F1 (Help), 328
  forcing account to balance, 97–98
  Forecasts screen, 220, 226
  formatting report in Microsoft Word, 266
  Forward button, 18–19, 23
  frequent flyer miles, tracking, 212–213

• G •

  Go to this Page button, 22
  goals for budget, 200

• H •

  Help➪Microsoft Money Help, 328
  Home account, 28, 268–272
  Home Equity Line of Credit account, 28
  home equity loan, 270
Home Page window
Advisor FYI Alerts, 215–217
customizing, 21–22
list of bills in, 191–192
overview of, 17–18
personalizing, 313
reminder to pay bill in, 196
reports and charts, 259
Home tab, 20

• I •
income and expense reports, 250–251
income and spending reports, 256
income records, 11–13
income taxes, 13, 231–233
income, tax-related, 234
Interactive Charts icon, 160
interest earned amount, 96
interest paid on loan, viewing, 279
interest payment from bond, 150
interest rate on loan, updating, 283
Internet, downloading from
bank statement, 302–303
Online Service Settings tab and, 306
stock and mutual fund quotes, 153–155
tax rates, 236
transactions from bank or broker, 122–123
Internet, sending banking instructions over, 299–301
Investing tab, 19, 20, 119–120
Investing window, 158, 165
Investment account. See also bonds; mutual funds; stocks
analyzing investments, 157–160
Asset Allocation Manager and, 162–163
brokerage fee, 145
certificate of deposit, 151
charting performance, 160–161
corporate merger, 144
corporate securities spin-off, 144
describing securities, 135–138
dividend from stocks, 142
editing transaction, 151–152
margin purchase, 144
overview of, 28, 119
payment to or disbursement from broker, 134–135
precious metals, 151
purchase of stock, 138–139
return of capital, 143–144
reviewing portfolio, 161–162
sale of stocks, 139–142
setting up, 121–124
short sell, 143
stock split, 142–143
investments charts, 160–161
handling, 13–14
reports, 251–252

• K •
keyboard shortcuts for navigating register, 56. See also specific shortcuts

• L •
last in, first out (LIFO), 241
launching program, 8–11, 23
liability, 267–268, 272–273
Liability account, 28, 268
Lifetime Planner
Action Plan link, 226
Bottom Line chart, 219, 220, 226
Forecasts screen, 220
overview of, 219–220
results, reviewing, 226
setting up, 221–226
testing scenarios, 227–228
LIFO (last in, first out), 241
Line of Credit account, 28, 35–38, 52–55
links
finding, 18
in Home Page window, 17–18
to MoneyCentral Web site, 165
windows and, 20
listing contact information for account, 32–34, 124
loan
amortized, 268, 273
home equity, 270
Loan account
adjusting balance, 282–283
associating Asset account with, 270, 272, 278
editing, 279
extra payment to, 281–282
Loan account (continued)
  interest rate, updating, 283
  overview of, 29, 268
  payment to, 279–281
  setting up, 274–278
  tracking, 273
  loan reports, 279
  lot, 241

● M ●

  margin purchase, 144
  Mark As: Void, 62, 115
  maturity date, 147
  .mbf file extension, 178
  Memo text box, 320–321
  Microsoft
    Excel, exporting report to, 265
    Word, formatting report in, 266
  Microsoft Money Checks by Deluxe, 101, 103
  mistake. See correcting mistake
  MoneyCentral Web site, 160, 165–166
  monthly reports, 210–211, 256, 313, 317
  Mortgage account, 29, 268. See also
    Loan account
  mouse pointer, 18, 258
  Move button, 80, 81
  moving transaction from one register to
    another, 63–64
  MSN Bill Pay, 289, 297, 307
  mutual funds, 144–146, 166–167
  My Favorites category, 256, 263
  My Money file, creating, 30

● N ●

  name. See also renaming
    of account, changing, 34
    of category, changing, 76
    of classification, 78–79
    deleting from Payees list, 179–180, 314
  navigating
    account register, 56
    with Back and Forward buttons, 19
    Favorites list and, 180
    overview of, 17
    Portfolio Manager window, 159
    with tabs, 19–20
  net worth, definition of, 40
  New Account dialog boxes
    Credit Card or Line of Credit account, 36, 37, 38
    Investment account, 124
    Retirement account, 127
    Watch account, 131

● O ●

  online banking
    disabling account, 297
    downloading statement, 302–303
    overview of, 14–15, 288, 289
    Quicken compared to Money, 327
    safety of, 294
    sending instructions for, 299–301
    setting up, 31
    signing up for, 288, 291–293
    transferring money between
      accounts, 308
  viewing and updating register, 304–306
  online payment
    MSN Bill Pay, 289, 297, 307
    overview of, 288
    recording, 307
    services for, 289
    stopping, 308
  online research
    bonds, 168
    brokers, 169
    credit cards, 213
    mutual funds, 166–167
    stocks, 167–168
  online services
    call waiting and, 291
    equipment required for, 290
    overview of, 287–289
    setting up account for, 295–296
  opening
    account register, 39–42
    calculator, 43
    Change Account Settings window, 33
    file, 188–189
    file with password, 183–184
    program, 8–11, 23
    Set Up Your Categories window, 72
    Update Online Information dialog
      box, 300
ordering checks, 101–104
organizing Favorites list, 24, 180
Other account, 29

• P •

passport, 181–184, 290
password, 9–10, 181–184
Payees list, 179–180, 314
paying off debt, 228–230, 316
payment
  on account, 279–281
  to broker, 134–135
  on credit card, 54–55
  extra or larger, 281–282
  quarterly tax, scheduling, 321
  recording online, 307
  to self when self-employed, 322
  stopping online, 308
performance of investment, tracking, 160–161, 251
phishing, 294
Pick a Question drop-down list, 220
PIN (personal identification number), 288, 293
pinning program to Start menu, 8–9
planning
  debt reduction, 228–230
  for retirement, 14, 317
Planning tab, 20, 219, 227
portfolio, 119, 161–162
Portfolio Manager window
  analyzing investments and, 157–160
  Asset Allocation Manager, 162–163
  Interactive Charts icon, 160
  links to MoneyCentral in, 165
  navigating, 159
  overview of, 119–120
  See Investment Reports link, 163
status bar, 159
  Update Prices link, 154
  viewing information in, 140
views, 159–160
Portfolio Review window, 161–162
precious metals, tracking, 151
price change alert, setting up, 164–165
Price History
  chart and report, 252
  window, 161
price of securities, updating, 122, 152–155
Print Test button, 108–109
printer, setting up for checks, 105–107
printing
  account registers, 64–65, 313
  reports and charts, 263–264
printing checks
  advantages of, 101
  cost of, 103
  font, choosing, 106
  full sheet, 111–112
  partial sheet, 109, 112–114
  practicing, 108–109
  recording before, 106–108
  text alignment, adjusting, 109–111
projecting cash flow, 77, 217–219
purchase, recording
  bond, 148–150
  stock, 138–139
purchase, scheduling, 197

• Q •

quarterly tax payments, scheduling, 321
Quicken, migrating to Money from, 323–328

• R •

“rainy day” money, 317
Reallocate Lots command, 142
reassigning transaction to category, 82–83
reconciling. See also balancing account
  AutoReconcile feature, 97
  checklist for troubleshooting when, 94–96
  converting from Quicken and, 326–327
  correcting mistakes while, 94
  Credit Card account, 98–100
  overview of, 89–90, 91
recording
  cash-back transaction, 49–50
  check to be printed, 106–108
  credit, 54
  credit card payment, 54–55
  credit card transaction, 315–316
  financial activity when self-employed, 319
  online payment, 307
  past transactions, 46
  paycheck deposit automatically, 196
recording (continued)
   payment on Loan or Mortgage account, 279–281
   scheduled transaction in register, 197–198
   transaction in register, 42–47
records
   categorizing, 12–13, 69–71
   keeping accurate, 11–12
   refining category or subcategory, 75–77
   register. See account register
reinvestment
   dividend from stocks, 142
   mutual funds, 145–147
Remember My Password check box, 183
Remove Unused Categories button, 86
removing. See also deleting
   custom report from Reports Home window, 263
   passport or password, 184
renaming. See also name
   category or subcategory, 84–85
   class or subclass, 80
   classification, 85
   file, 189
reopening bank account, 185–186
reports
   adding to My Favorites category, 263
   advanced compared to essential, 249
   customizing, 258–263
   exporting, 265–266
   generating, 256–257, 259
   income and expenses, 250–251
   investigating figures for, 258
   investment, 163, 251–252
   monthly, 210–211, 256, 313, 317
   printing, 263–264
   tax, 235, 255, 320
   turning into charts, 257
Reports Home window
   budget links in, 210
   Income category, 250–251
   overview of, 248
   removing custom report from, 263
Reports tab, 19, 20
Reprint button, 114
researching online. See online research
Reset button, 25
Reset Values button, 237
restoring
   from backup copy, 177–178
   description of, 174
   when transferring file to new computer, 179
Retirement account, 29, 124–127. See also bonds; Investment account; mutual funds
   retirement, planning for, 14, 317
   return of capital, 143–144
   reviewing portfolio, 161–162

S

sale of stocks, 139–142
saving
   data, 15
   money, 317
   scenario, 241
   for taxes, 321
Savings account, 29, 30–32
   scenario, saving, 241
scheduling
   bill payment, 191–195
   loan or mortgage payment, 278
   tax payments, 238, 321
   transaction, 197–199, 217
   screening, 168
searching for transaction, 56–60
securities, 135
security issues, 181–184, 294
self-employed person, tips for, 319–322
service charge, 96
Set Up Your Categories window, 72, 73, 232, 259
Set up your Properties window, 79
setting up
   advanced budget, 202–203
   classification, 78–79
   essential budget, 209–210
   Price Alerts, 164–165
setting up account
   Asset or Home, 269–270
   Checking or Savings, 30–32
   Credit Card or Line of Credit, 35–38
   Employee Stock Option, 128–130
   Investment, 121–124
   Loan or Mortgage, 274–278
   for online services, 295–296
overview of, 27–29
Retirement, 124–127
Watch, 130–132
Settings dialog box, 23, 109–110, 175, 306
short sell, 143
shutting down program, 15
skipping scheduled transaction, 198–199
software, tax-preparation, 243–244
Spending by Category charts and reports, 70, 248–249, 250, 255, 316
spending records, 11–13
splitting
check payment, 108
transaction, 47–49
Start menu, 8–9
starting program, 8–11, 23
status bar, Portfolio Manager window, 159
stock split, 129, 142–143
stocks
brokerage fee, 145
corporate merger, 144
corporate securities spin-off, 144
dividend from, 142
margin purchase, 144
purchase of, 138–139
researching online, 167–168
return of capital, 143–144
sale of, 139–142
short sell, 143
stopping online payment, 308
strike price, 129
subcategory
assigning transaction to, 70–71
changing assignment to, 81–82
creating, 74–75
deleting, 85–87
editing and refining, 75–77
renaming, 84–85
subclass, defining, 79–80

T

tab-delimited text file, 265
tabs, navigating with, 19–20
tagging category for taxes, 231–233
tax deferred, 123, 125
Tax Estimator, 235–238, 239
tax exempt income, 125
tax rates, downloading, 236
tax reports, generating, 235
Tax Software Reports, 233, 235, 255
Tax Withholding Estimator, 239–240
TaxCut Deluxe program, 242
taxes
deductions, finding, 238–239
estimating, 235–238
exporting data to tax-preparation program, 242–244
income, estimating, 13
income, tagging category for, 231–233
reports, 255
saving money for, 321
scheduling payments, 238, 321
Web sites about, 244
withholding for, determining, 239–240
Taxes tab, 19, 20, 240
tax-related status, assigning transaction by, 71, 320
ticker symbol for company, 129, 131, 153
toolbar, 18–19, 24–25
Tools➪Alerts Center, 216
Tools➪Find and Replace, 57, 82
Tools➪Internet Updates➪Update Now, 300
Tools➪Settings, 15, 21, 23, 175
tracking
assets and liabilities, 268, 272–273
business expenses, 321
frequent flyer miles, 212–213
performance of investment, 160–161, 251
transactions
categorizing, 69–71
correcting entry in wrong category, 80–83
creating category when entering, 74
deleting, 151–152
downloading from bank or broker, 122–123
editing, 151–152
entering when reconciling, 95
finding, 93
finding unassigned, 84
flagging, 63
Quicken compared to Money, 326
recording in register, 42–47, 197–198
recording past, 46
scheduling, 197–199, 217
splitting, 47–49
types of, 42–43
transfer, scheduling, 193, 197
Transfer tab, 43, 51, 134
transferring
  between accounts, 51–52, 308
  file to new computer, 179
transposition of number, finding, 95
turning off ads, 15
TXF file, 242, 243
type of account, changing, 34

• U •
unvoiding transaction, 62
updating
  account register, 304–306, 312
  interest rate on loan, 283
  price of securities, 122, 152–156

• V •
View menu, 74, 93, 234
viewing
  bank account register, 304–306
  interest paid on loan, 279
  transactions in closed bank account, 185
views in Portfolio Manager window, 159–160
voiding
  check, 115
  register entry, 61–63

• W •
Watch account, 29, 130–132, 165
Web services
  bank statement and, 288, 302–303
  setting up account for, 296
Web sites
  adding to Favorites list, 24
  bonds, 168
  brokers, 169
  check vendors, 103
  credit cards, 213
  Microsoft passport, 182
  MoneyCentral, 160, 165–166
  mutual funds, 167
  online bill-payment, 289
  stocks, 167–168
  tax-related, 244
windows, 17–20, 23. See also specific windows
Withdrawal tab, 42
withholding for taxes, 239–240
writing checks with duplicate numbers, 104

• Z •
Zip disk, backing up to, 174–176